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CHAPTER 1

Preparing to Work with 
Effects

The Avid Composer system offers many effects that you can apply to 
your sequences. This chapter describes some of the concepts you must 
become familiar with before you begin creating and editing effects into 
sequences.

¥ Effect Types

¥ Effects Creation Tools

¥ Understanding Real-Time and Downstream Key Effects

¥ Displaying the Effect Palette

¥ Installing Third-Party Plug-in Effects

¥ Settings for Effects

Effect Types

There is much overlapping that occurs between the various types of 
effects you can create, as well as the methods used to create them. 
Roughly speaking, there are four basic types of effects:
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¥ Transition effects (dissolves, wipes, and so forth) are applied at 
the cut point between two video clips that are on the same video 
track (that is, the same video layer). Chapter 2 and Chapter 3 
describe techniques for creating transition effects.

¥ Segment effects (both single-layer and multilayer) are applied to 
an entire clip or group of clips. There are two types of segment 
effects:

- A single-layer segment effect, such as a Mask, is applied to a 
segment on one video track. Single-layer segment effects use 
one stream of video. Chapter 2 and Chapter 3 describe tech-
niques for creating single-layer segment effects.

- A multilayer segment effect, such as a Picture-in-Picture effect, 
is applied to the top layer or a middle layer of segments that 
contain two or more video tracks that will be played simulta-
neously. Chapter 4 describes techniques for creating multi-
layer effects.

¥ Title effects are created with the Title Tool and edited onto their 
own layers in a sequence. Chapter 5 and Chapter 6 describe tech-
niques for creating and editing title effects.

¥ Motion effects (freeze frame, variable speed, and strobe) are cre-
ated by manipulating the playback characteristics of a clip of foot-
age. Chapter 2 describes techniques for creating motion effects.

A number of effects across these categories have both 2D (two-dimen-
sional) and 3D (three-dimensional) versions on systems equipped 
with the 3D Effects option.

n For a list of effects for each model, see the Avid Media Composer Products 
Reference Guide.
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Effects Creation Tools

The following chart presents the basic tools used to create effects.

Sources of 
effects:

Effects editing in Source/
Record mode: 

Effects adjustment 
in Effect mode:

Effect Palette
Title Tool Motion Effect Parameters dialog box

Effect Editor:
Allows you to 
adjust effect 
parameters.

Effect Preview monitor:
Allows you to preview 
an effect, manipulate 
key frames, and 
manipulate wire-frame 
representations of the 
effect.

Apply transition 
and segment effects 
directly to tracks.

Title and motion 
effects appear first 
as clips in the bin.

Edit effect clips 
into the Timeline.
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Understanding Real-Time and Downstream Key 
Effects

Many effects are real time, which means you do not have to render 
them before you play them. You can preview effects that are not real 
time before rendering. In addition, titles and graphic elements 
imported with an alpha channel display as downstream key (DSK) 
effects. When you establish Effect settings and Render settings, you 
determine how the Avid Composer system will play real-time effects 
and non-real-time effects. For more information, see ÒSettings for 
EffectsÓ on page 41.

About Downstream Key Effects

By default, all titles are created using the Avid Composer systemÕs 
DSK capabilities. Graphic elements imported with an alpha channel 
are also created as DSK clips. 

Downstream keying allows you to add uncompressed titles or 
graphics over multiple streams of compressed media and continue to 
play the sequence in real time. The real beneÞts of downstream keying 
are seen during editing of Title Effect clips into sequences. 

n For information about editing with DSK titles, including descriptions of var-
ious restrictions and playback capabilities, see Chapter 6.

About Real-Time Effects

A real-time effect is an effect that you can apply to a sequence and play 
without having to render it Þrst (rendering takes time and disk space). 
A real-time effect has a small orange dot within the effect icon in the 
Timeline. Effects that must be rendered have a small green or blue dot 
within the effect icon in the Timeline. For more information, see 
ÒUnderstanding the Color CodingÓ on page 33.
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n Because real-time effects require an Advanced JPEG compression board and 
on some systems a DVE daughter board, not all Avid Composer systems have 
real-time effects. For a list of the Avid Composer systems that have real-time 
effects, see the ÒTable of Effects in Media Composer ProductsÓ in the 
Avid Media Composer Products Reference Guide.

Playing Real-Time Effects

Although you can create a sequence that has any number of real-time 
and non-real-time effects, the Avid Composer system can play only 
one real-time effect at a time. The following sections explain how the 
Avid Composer system handles situations with overlapping real-time 
effects. In any case, if you want to play two overlapping effects, you 
must render one of the effects.

n If you have a real-time Title effect and a real-time Dissolve effect, render the 
Dissolve effect because it takes less time.

Overlapping Real-Time Effects on the Same Track

If your sequence contains overlapping real-time effects on the same 
video track, only one effect can be played in real time. For example, if 
you have two real-time effects on the same track (for example, a Dis-
solve overlaps video with a Mask effect), the Avid Composer system 
will play the real-time Mask effect and play the real-time Dissolve as 
a cut.

Real-time
Dissolve transition effect

Real-time
Mask segment effect
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Overlapping Real-Time Effects and Non-Real-Time Effects

The combination of real-time and non-real-time effects on the same 
video track can show different results, depending on when you render 
the non-real-time effects.

¥ If you render the non-real-time segment effects after you apply the 
real-time transition effect, the sequence will play in real time.

¥ If you render the non-real-time segment effects and then apply the 
real-time transition effect, the transition effect will play as a cut.

Overlapping Real-Time Effects on Multiple Tracks

If your sequence contains overlapping real-time effects on multiple 
video tracks, only the effect on the highest numbered track can be 
played in real time. For example, if you have a real-time Superimpose 
segment effect on track V2 over a real-time Edge Wipe transition effect 
on track V1, the system plays the Superimpose effect in real time and 
plays the Edge Wipe effect as a cut.

Non-real-time
Matrix Wipe segment effect

Real-time
Edge Wipe transition effect
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In this example, the fastest way to play both effects is to render the 
Edge Wipe effect.

Overlapping Real-Time Effects with Downstream Key Titles and Graphics

You can stack a DSK title or graphic over a real-time effect, and both 
the title and the effect will play in real time. For more information on 
DSK titles and graphics, see Chapter 5, ÒCreating Titles and Graphic 
Objects.Ó

Real-time Superimpose 
segment effect

Real-time Edge Wipe 
transition effect
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Displaying the Effect Palette

The Effect Palette is a window that lists all the effects that are available 
on your Avid Composer system. The effects that are available on your 
Avid Composer system depend on the model and options that you 
purchased. For the list of effects available for your model, see the 
ÒTable of Effects in Media Composer ProductsÓ in the Avid Media 
Composer Products Reference Guide. 

You select transition and segment effects from the Effect Palette. The 
effects in the Effect Palette are grouped by category:

¥ Blend

¥ Box Wipe

¥ Conceal

¥ Edge Wipe

¥ Film

¥ Image

¥ Key

¥ L-Conceal

¥ Matrix Wipe

¥ Peel

¥ Push

¥ Saw Tooth Wipe

¥ Shape Wipe

¥ Spin

¥ Squeeze

¥ Xpress 3D Effect

Each of these effect categories contains multiple effects. Use the fol-
lowing procedure to display the Effect Palette.
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To display the Effect Palette:

1. Either choose Effect Palette from the Tools menu, or press kÐ8.

The palette for the Þrst effect category, Blend, appears:.

The left side of the Effect Palette displays a scrollable list of effect 
categories. The right side shows the various effects that are avail-
able for the currently selected effect category.

Blend effect choices

Scrollable list of effect 
categories
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2. Click an effect category to select it.

Note that the 3D Warp effect is available only on systems with the 3D 
Effects option. For information on 3D effects, see Chapter 9, ÒWorking 
with 3D Effects.Ó The Paint effect and AniMatte effect are available 
only on Avid Composer systems with the Intraframe Editing option.

Resizing the Effect Palette

You can resize the Effect Palette to display more effects when a partic-
ular category includes a long list of icons.

To resize the Effect Palette, click and drag the lower right corner of the 
palette to the size you want, and release the mouse button.
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Understanding the Color Coding

Effect icons in the Effect Palette and in the Timeline display color-
coded dots to help you determine whether an effect is real-time or 
non-real-time. After opening the Effect Palette, you will notice that:

¥ Real-time effects are preceded by an orange dot.

¥ Real-time effects that might not be playable in real time due to 
their position in a sequence or the options chosen in the Effect 
settings are preceded by a green dot. These effects take advantage 
of fast rendering.

¥ Non-real-time effects have no dot. In the Timeline, the effect icon 
contains a blue dot until the effect is rendered.

Orange dot indicates a 
real-time effect.

Green dot indicates a
real-time effect that might
not be playable in real time.

No dot (as in Matte Key above) indicates a non-real-time effect;
in the Timeline, the effect icon contains a blue dot until the effect is rendered.
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A real-time effect might not be playable in real time for one of the fol-
lowing reasons:

¥ There are two effect categories, Wipes and Keys, that contain 
effects that are mutually exclusive as real-time effects. If you have 
both effect categories in a sequence, only one can be real time. The 
other must be rendered. 

n The current Effect settings for the project determine which type of effect is real 
time during editing. For more information, see ÒEffect SettingsÓ on 
page 41.

¥ A real-time transition effect has been applied on top of another 
effect.

¥ There is more than one real-time overlapping effect.

n When you edit a non-real-time effect into a sequence, the effect icon appears 
with a blue dot in the Timeline, which indicates that you must render the 
effect to play it in real time. After you render the effect, the effect icon appears 
in the Timeline without a dot.

For more information on real-time effects, see ÒUnderstanding Real-
Time and Downstream Key EffectsÓ on page 26.

Displaying Effect Templates

Effect templates allow you to save the parameters of an effect to a bin 
and use them again to create or modify other effects.

In addition to allowing you to view all the standard effects, the Effect 
Palette allows you to view and access effect templates that are stored 
in open bins. The names of open bins containing effects appear in a list 
below the effect categories. To view the effect templates in the bin, 
click the bin name. The list appears in the right side of the Effect Pal-
ette. For example, in the following illustration the bin contains two 
effect templates named Matte Key: Avid Logo (With Alpha) and Title: 
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Show Open, which also appear in the right-hand list in the Effect 
Palette.

Whenever you open or close a bin or whenever you drop an effect into 
a bin, both lists automatically update.

Once a template appears in the right side of the Effect Palette, you can 
apply it like any other effect. See ÒUsing an Effect TemplateÓ on 
page 112 for more information.

Installing Third-Party Plug-in Effects

You can use third-party plug-in effects that are compatible with the 
Adobe Photoshop plug-in architecture and with the Avid Visual 
Extension (AVXª) standard. After you install these plug-ins, the 
effects appear in the Effect Palette. After you create an effect, you can 
save it as an effect template and reapply the template to other transi-
tions or segments in your sequence. Effect templates also appear in a 
special section at the bottom of the Effect Palette.
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Installing Photoshop-Compatible Plug-in Effects

The Avid Composer system can use many plug-in effects that are com-
patible with Adobe Photoshop Version 2.5. You purchase these plug-
ins directly from a third-party vendor.

To install Photoshop-compatible plug-ins:

1. Copy the plug-in Þles from the software vendorÕs folder to the 
3rd Party Plug-Ins folder in the Supporting Files folder in your 
Composer folder located on the Avid drive. You must place the 
plug-ins directly in this folder. They cannot be inside another 
folder within this folder or elsewhere on the Avid Composer sys-
tem. If they are, the system will not recognize them.

2. If the Avid Composer application is open, you must close it and 
reopen it before the third-party plug-in effects will appear in the 
Effect Palette.

The following is an example of how Photoshop-compatible plug-in 
effects appear in the Effect Palette.

For information on applying third party effects, see ÒApplying a 
Third-Party Plug-in EffectÓ on page 53.

Third-party plug-in effects

The Avid Composer
system creates a new 
effect category for the 
plug-ins
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Installing AVX Plug-in Effects

AVX (Avid Visual Extension) is a plug-in standard for integrating vari-
ous third-party effects with the Avid Composer system. AVX is a cross-
platform software architecture designed to allow software effect mod-
ules to be dynamically linked with a host application such as Media 
Composer or Film Composer.

You can purchase these plug-ins directly from a third-party vendor. 
The following lists three of the current vendors, the plug-in product 
names, and the vendorÕs web address:

¥ Ultimatte¨ Corporation (Ultimatteª)
http://www.ultimatte.com

¥ Artel Software (Boris FXª)
http://artelsoft.com

¥ ICE (Integrated Computing Engines, Inc.) (ICEfxª for Avid)
http://www.iced.com

AVX Plug-ins usually come complete with any necessary documenta-
tion. This section describes how to install the plug-ins and how to 
access them from the Avid Composer system.

To install AVX plug-ins:

1. Exit the Avid Composer application.

c Do not add or remove plug-ins while the Avid Composer applica-
tion is running.

1. Copy the plug-in Þles from the software vendorÕs folder to the 
AVX Plug-Ins folder on your Avid drive.
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c You must place the plug-ins directly in this folder. They cannot be 
inside another folder within this folder or elsewhere on the Avid 
Composer system. If they are, the system will not recognize them.

2. Restart the Avid Composer application and open the Effect Palette. 
The AVX plug-in effects will appear in the Effect Palette.

The following is an example of how AVX plug-in effects appear in 
the Effect Palette. This example shows several Boris effects.

Place AVX plug-ins in 
this folder

EffectsEffect category
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For information on applying third party effects, see ÒApplying a 
Third-Party Plug-in EffectÓ on page 53.

n Some plug-in effects come with their own installation program. In that case, 
follow the directions supplied with the package.

Troubleshooting AVX Plug-Ins

This section describes solutions to problems that you may encounter 
with AVX Plug-ins.

Blank Effect Icons in the Timeline

AVX Plug-ins have a plug icon in the Effect Palette and in the Timeline. 
If the Effect icon in the Timeline is blank, the Avid Composer system 
either could not Þnd the plug-in or the plug-in version doesnÕt match 
the version of software that you used to create the plug-in.

To determine the cause of the problem, open the Console window 
(choose Console from the Tools menu) and look for the message ÒCan't 
Þnd effect.Ó The message will identify the plug-in that can't be dis-
played.

The following are the most common problems:

¥ The plug-in may be missing from the AVX_Plug-Ins folder. Open 
the AVX_Plug-Ins folder (located in the SupportingFiles folder) 
and look for your plug-in. If it is missing, replace it. This may 
involve reinstalling the plugiIn.

¥ The plug-in in the AVX Plug-ins folder may be incompatible with 
the effect in the Timeline. This might happen if you update the 
Plug-ins on your system. For example, if you create an effect with 
Version 1.1 of the plug-in software and then update your plug-ins 
to Version 2.5, the new software may not be compatible with the 
old effect. 
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Plug-ins should be compatible with minor releases but not neces-
sarily with major releases of the Plug-in software. For example, 
Version 1.0 of a Plug-in should be compatible with Version 1.1 or 
1.2 (minor revision). But Version 1.0 may not be compatible with 
Version 2.0 (major revision change).

If the plug-in is correctly installed, contact the plug-in vendor and ask 
if there are any known version compatibility problems with the plug-
in.

Missing Effect Categories in the Effect Palette

If the plug-in categories are not visible in the Effect Palette, they are 
either not installed correctly or you may have an incorrect version of 
the AVXLibrary. In this case, check the Console window for a message 
that states that AVX was disabled. If it was not disabled, quit the Avid 
Composer application, reinstall the plug-ins, and restart the applica-
tion. 

If the message in the Console states that AVX software was disabled, 
call Avid Customer Support to determine whether you need a new 
version of the AVXLibrary.

The Avid Composer System Cannot Render the Plug-In

If the Avid Composer system cannot render the plug-in, check the 
Console window. Some plug-ins write more information about the 
failure to the Console window. Also, some plug-ins may report the 
problem as a message in the Bin or Edit monitor. In general, contact 
the plug-in vendor if a plug-in doesnÕt work as expected.
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Settings for Effects

The Avid Composer system has settings that control how you use 
effects. Some of these settings are User settings and some are menu 
selections. This section describes the User settings. The menu selec-
tions are described in ÒRendering an EffectÓ on page 116.

n For information about other settings in the system, see the ÒSettings Scroll 
ListÓ chapter in the Avid Media Composer Products Reference.

Effect Settings

There are two effect categories, Wipes and Keys, that contain effects 
that are mutually exclusive as real-time effects. If you have both effect 
categories in a sequence, only one can be real time. The other must be 
rendered. 

n Your Avid Composer system must have an Advanced JPEG compres-
sion board to have real-time effects. 

Use the Effect Settings dialog box to specify which effect category will 
be real time. Make this decision based on whether you will be creating 
more wipes or keys in your sequence.

n Because wipes and keys are real-time effects on Avid Composer systems with 
the 3D Effects option, the Effect settings do not apply to these systems.

To change the Effect settings:

1. Click the Settings button in the Project window.

2. Double-click the Effects setting. 

The Effect Settings dialog box appears.
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3. Select which effect category you want to be real time. The change 
takes place immediately in the Effect Palette.

Render Settings

You can control the size of an imported graphic and a rendered effect 
by changing the Render settings. This setting is intended to prevent 
playback pauses caused by PICT images, QuickTime¨ Þles, or ren-
dered composites that are too complex.

To change the Render settings:

1. Click the Settings button in the Project window.

2. Double-click the Render setting. 

The Render Settings dialog box appears.
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3. Enter the following parameters:

- Select Show Intermediate Results if you want the Avid Com-
poser system to display the rendering of the effect as it 
progresses in the third, full-screen monitor.

- Limit rendered frame size to n% of default limit Ñ This is a 
percent of the Avid Video ResolutionÕs (AVR) default limit for 
the frame size. The effectÕs AVR is the same as the sequenceÕs 
AVR. Enter a percent. The default is 100%.

- If frame size exceeds threshold Ñ The threshold is established 
by the above percent. Select an action. The default is ÒAsk 
me.Ó

If you select ÒAsk me,Ó and the threshold is exceeded during 
rendering, a dialog box appears:

If you select ÒDonÕt Soften,Ó you might get an error message, 
such as a video underrun, when you play the rendered Þle.

If you do not respond within 30 seconds, the system automati-
cally selects Soften.

Timeline View Settings

All effect icons are displayed in the Timeline by default. You can 
change the Timeline settings to display all effect icons, all effect icons 
except Dissolve icons, or no effect icons. If you have changed the set-
ting to display no effect icons, you have to reset it before you begin 
applying effects. The fewer effect icons you display, the faster the 
screen refreshes.
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To change the Timeline settings:

1. Click the Fast Menu button in the Timeline window.

The Timeline settings pop-up menu appears.

2. To display all effect icons in the Timeline, choose Effect Icons.

3. To display all effect icons except Dissolve icons, choose Effect 
Icons and deselect Dissolve Icons.

4. To display no effects icons, deselect Effect Icons. Dissolve Icons is 
automatically dimmed.

5. To save your Timeline settings, click the Timeline View Name but-
ton, select Save As, and enter a view name.

Timeline View Name button
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Trim Settings

When you are in Trim mode, you can control whether or not the effects 
you apply are computed immediately on the screen (that is, on-the-ßy) 
or rendered later when you select the Render Effect function; viewing 
a transition as a cut can facilitate the trimming process. This setting is 
deÞned in the Trim Settings dialog box.

To change the Trim settings:

1. Click the Settings button in the Project window.

2. Double-click the Trim setting. 

The Trim Settings dialog box appears.

n For information on changing the Trim settings, see the ÒWorking in Trim 
ModeÓ chapter in the Avid Media Composer UserÕs Guide or Avid Film Com-
poser UserÕs Guide.

Use the Render On-The-
Fly selection to determine 
when the Avid Composer 
system computes effects.



46

CHAPTER 2

Basics of Effects Editing

This chapter explains how to create basic transition and single-layer 
segment effects, including motion effects.

¥ Applying Effects to a Sequence

¥ Deleting Effects in a Sequence

¥ Working with Transition Effects

¥ Adjusting Transitions in the Timeline

¥ Creating Motion Effects

Applying Effects to a Sequence

This section explains how to apply an effect to a sequence in the 
Record monitor. Some effects can be applied only to transitions, other 
effects can be applied only to segments (clips in the sequence), and 
some effects can be applied to both transitions and segments.

You can apply an effect:

¥ To one transition or segment on a single video layer

¥ To multiple transitions or segments on a single video layer

¥ To multiple transitions or segments on multiple video layers
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The effect type (transition or segment) determines where you can 
place the effect in the sequence. For an explanation of the effect types, 
see ÒEffect TypesÓ on page 23.

After you apply an effect, the next step is to adjust the effectÕs parame-
ters. To understand how to adjust the effect parameters, see
ÒChanging a ParameterÓ on page 96.

Displaying Effect Icons

The default setting in the Timeline menu is to always display effect 
icons in the Timeline. If you have changed the setting, you have to 
reset it before you begin applying effects. For more information, see 
ÒTimeline View SettingsÓ on page 43.

Applying a Single Effect

Use the following procedures to apply an effect to one transition or 
segment on a single video layer.
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To apply a single effect:

1. Create a sequence in the Record monitor using the standard Avid 
Composer editing procedures. For information about editing a 
sequence, see the ÒFirst Edits in Source/Record ModeÓ chapter in 
the Avid Media Composer UserÕs Guide or Avid Film Composer UserÕs 
Guide.

2. Choose Effect Palette from the Tools menu.

For an explanation of the Effect Palette, see ÒEffect TypesÓ on 
page 23.

3. To apply an effect, do one of the following:

¥ Click and drag the desired effect to the segment or transition 
in the Timeline, and release the mouse button.

¥ Use the Segment Mode button to highlight the segment in the 
Timeline where you want to apply the effect, and double-click 
the effectÕs icon in the Effect Palette.

The effect icon appears in the Timeline as shown in the follow-
ing example.

Effect Palette

Timeline
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n While you are applying an effect, if the effect is a segment effect, one segment 
at a time is highlighted as you drag the effect within the Timeline. If the effect 
is a transition effect, one transition at a time is highlighted as you drag the 
effect within the Timeline. Some effects can be both a transition and a segment 
effect, in which case transitions and segments are highlighted in the Timeline.

Applying Multiple Effects

You can apply an effect to multiple transitions, segments, or video 
layers in a single step. First, select the sections in the sequence using a 
lasso and then apply the effect. The speciÞc procedures are explained 
below.

Selecting Multiple Transitions

To select multiple transitions:

1. Make sure that you have not selected any transitions or segments 
in the sequence, and click the Effect Mode button to enter Effect 
mode.

2. Click a transition in the Timeline.

3. Move the cursor above the Timeline, and click and drag the cursor 
to the right or left of the transition to activate a selection box.

4. Lasso any additional transitions you want to select.
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5. Release the mouse button when you have lassoed all the desired 
transitions.

The transitions that you selected are highlighted, and the position 
indicator moves to the Þrst transition.

6. If the desired transitions are not contiguous, Shift-click a transition 
to deselect it.

7. Open the Effect Palette and double-click the effectÕs icon that you 
want to apply to the transitions Ñ in this example, the Fade from 
Color Effect icon.

The effect is applied to the highlighted transitions in the Timeline.

Transition is deselected.
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If there is not enough incoming or outgoing media to apply the transi-
tion effect, a dialog box appears. For more information, see ÒSizing 
the Effect to Fit the MediaÓ on page 62.

Selecting Multiple Segments

To select multiple segments in the same video layer:

1. In Source/Record mode or Effect mode, move the cursor above 
the Timeline and to the left of the leftmost transition that you want 
to select. Click and drag the cursor to the right and down to activate 
a selection box.

2. Continue to drag the selection box to the right until you lasso the 
rightmost segment that you want to select.

3. Release the mouse button when you have lassoed all the desired 
segments. The segments that you selected are highlighted.

Cursor selection box

Three segments are lassoed.
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4. If the desired segments are not contiguous, Shift-click a segment to 
deselect it.

5. Open the Effect Palette and double-click the effectÕs icon that you 
want to apply to the segments Ñ in this example, the Mask Effect 
icon.

n To nest all clips inside one effect, Option-double-click the effect icon in the 
Effect Palette.

The effect is applied to the highlighted segments in the Timeline.

Selecting Multiple Layers

You can select transitions or segments on multiple layers using the 
same procedures described in ÒSelecting Multiple TransitionsÓ on 
page 49 and ÒSelecting Multiple SegmentsÓ on page 51.
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Applying a Third-Party Plug-in Effect

Third-party plug-in effects are applied to a sequence using procedures 
that are similar to those used for an Avid Composer system effect. The 
only difference is that parameters for third-party plug-in effects 
appear automatically in dialog boxes apart from the Effect Editor. 
Third-party plug-in effects you can apply to a sequence include plug-
ins compatible with Adobe Photoshop Version 2.5, AVX plug-ins, and 
Digidesign AudioSuite Plug-Ins.

n When a segment contains a third-party plug-in effect, the effectÕs parameter 
dialog box appears the Þrst time you move the position indicator to another 
frame in that segment.

Applying a plug-in effect is similar to applying a standard 
Avid Composer system effect.

1. Choose Effect Palette from the Tools menu.

The Effect Palette appears.

2. Choose the effect category that contains the plug-in. For example, 
the following illustration shows the Ultimatte plug-ins.

3. Drag the effect onto your clip or transition in the Timeline.

Effects

Effect category
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4. Click the Effect Mode button.

The Effect Editor appears. One of the following styles of dialog 
boxes appears:

¥ Avid Composer Effect Editor controls only. This means that 
you only see controls in the Effect Editor window.

¥ Custom dialog box only. In this case, when you click the Effect 
Mode button, the Effect Editor is empty except for the Other 
Options button. Click the button to open the plug-in dialog 
box.

¥ Combination of Avid Composer and custom. In this case, Avid 
Composer controls appear and you also see the Other Options 
button to access the custom options. Click the button to see the 
additional dialog box. 

5. Adjust and preview the effect, depending on the controls in the 
dialog box. The plug-in vendor usually supplies documentation 
on how to adjust the effect.

6. When it is appropriate, render the effect.

c Applying a third-party plug-in to a clip can cause the clip levels to 
be illegal by NTSC standards. Use an external vectorscope to check 
if the chroma and luma levels are still appropriate. If they are not, 
correct the levels by adjusting the parameters of the plug-in effect or 
by applying the Color Effect.

n Third-party effects can require longer rendering times than do native Avid 
Composer effects.

Other Options
button
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Deleting Effects in a Sequence

Transition effects can be deleted from a sequence in Source/Record 
mode, Trim mode, or Effect mode. Segment effects can be deleted in 
Source/Record mode or Effect mode. Use the following procedures to 
either delete a single effect from a sequence or delete effects in multi-
ple segments.

To delete a single effect:

1. Place the blue position indicator on the effectÕs icon in the 
Timeline.

In this example, the segment effect for the Þrst clip on video track 
V1 is being deleted.

2. If there are multiple tracks that contain effects at the same position 
in the Timeline, select only the track where the effect to be deleted 
resides.

In this example, only video track V1 is selected, because the Title 
effect on video track V2 should not be deleted.

c If you are deleting a segment effect and the segment contains a tran-
sition effect, the transition effect will be deleted also, because the 
transition effect resides Òon top ofÓ the segment effect. If necessary, 
you will have to reapply the transition effect.

Record monitor track 
selector
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3. In Source/Record mode, click the Remove Effect button located on 
the Fast menu above the Record monitor or in the second row of 
buttons below the Record monitor.

In Trim mode Ñ for transition effects only Ñ either press the 
Delete key or click the Remove Effect button.

In Effect mode, select the effect and press the Delete key.

n When you delete an effect from a sequence, the associated media Þle is NOT 
deleted. In order to delete the effectÕs media Þle, you must manually remove it 
from the drive. The system operates this way so that you will be able to undo 
the deletion of an effect or undo the change you made to an effect. To delete an 
effectÕs media Þle, see ÒManaging Your Media FilesÓ on page 121.

To delete multiple segment effects:

1. In either Source/Record mode or Effect mode, click either Seg-
ment Mode button below the Timeline and Shift-click each seg-
ment that contains a segment effect to be deleted.

2. Click the Remove Effect button, or press the Delete key.

Using the Fade Effect Button

You can use the Fade Effect button to fade segment effects quickly and 
easily. A dialog box appears that allows you to enter the number of 
frames to fade up and fade down.

The Fade Effect feature automatically creates key frames for the effect. 
You can access the key frames in the Effect Editor.

To fade a segment effect:

1. Load the sequence if you havenÕt already done so.

2. To fade a single segment effect, place the blue position indicator in 
the segment.
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To fade multiple segment effects, click either the yellow Extract/
Splice-in button or the red Lift/Overwrite button at the bottom of 
the Timeline window to enter Segment mode; then press and hold 
the Shift key and click the segments in the Timeline.

3. Click the Fade Effect button.

n You can map the Fade Effect button to the Record monitor or the User Com-
mand Palette. For more information on mapping buttons, see the Avid Media 
Composer UserÕs Guide or the Avid Film Composer UserÕs Guide.

4. In the dialog box that appears, enter the number of frames to fade 
up and fade down, and click OK.

You can immediately view the Fade effect by playing the segment 
or segments.
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Working with Transition Effects

You apply a transition effect to the cut point between two clips on the 
same video track. After you apply a transition effect, you can adjust its 
alignment and duration. Depending on the speciÞc effect, other effect 
parameters may apply.

Types of Transition Effects

Transition effects are included in all effect categories on the Effect Pal-
ette, except the Image effect category.

For an explanation of the transition effects in each effect category, 
see Chapter 10, Ò2D Effects Reference,Ó and Chapter 11 , Ò3D Effects 
Reference.Ó

Applying a Dissolve Effect

One of the most common transition effects is a Dissolve. The Avid 
Composer system has three methods you can use to apply a Dissolve 
effect:

¥ Select the Dissolve effect from the Effect Palette.

¥ Type a duration in the Transition parameters.

¥ Click the Add Dissolve button.

This section describes each of these methods.

Using the Effect Palette

To apply a Dissolve effect using the Effect Palette:

1. Create a sequence in the Record monitor using the standard Avid 
Composer editing procedures. For information about editing a 
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sequence, see the ÒFirst Edits in Source/Record ModeÓ chapter in 
the Avid Media Composer UserÕs Guide or Avid Film Composer UserÕs 
Guide.

2. Choose Effect Palette from the Tools menu.

3. From the Blend category of the Effect Palette, drag the Dissolve 
effect icon to the transition in the Timeline and release the mouse 
button.

The Dissolve Effect icon appears in the Timeline.

When there is not enough incoming or outgoing media to apply a tran-
sition effect, a dialog box appears. See ÒSizing the Effect to Fit the 
MediaÓ on page 62.

Using the Transition Parameters

You can create a Dissolve effect using the Transition parameters dis-
played in Trim mode and Effect mode. Simply enter the duration for 
which the effect will play, and the system adds the Dissolve to the 
sequence.

To create a Dissolve effect using the Transition parameters:

1. In Trim mode or Effect mode, click a transition in the Timeline.

2. In the Transition Duration parameter, enter the DissolveÕs dura-
tion. The Duration format is determined by the Duration setting 
above the Record monitor, for example, seconds:frames.

This adds the Dissolve effect at the transition, and a Dissolve 
Effect icon appears in the Timeline.

Transition Effect Alignment 
button

Transition Effect Alignment
pop-up menu

Duration
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3. Click the Transition Effect Alignment menu button, and select the 
effectÕs position relative to the cut point from the pop-up menu.

For an explanation of the Transition Alignment menu selections, 
see ÒTransition ParametersÓ on page 385.

Using the Add Dissolve Button

Another way to create a transition effect is to click the Add Dissolve 
button. This button allows you to apply a Dissolve or any other transi-
tion effect listed below without having to access the Effect Palette:

¥ Dissolve

¥ Film Dissolve

¥ Film Fade

¥ Fade to Color

¥ Fade from Color

¥ Dip to Color

To create an effect using the Add Dissolve button:

1. In Source/Record mode, Trim mode, or Effect mode, move the 
position indicator to the transition in the Timeline.

2. Click the Add Dissolve button located either below the Record 
monitor, in the monitor Fast menu, or in the Command Palette.
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A dialog box appears.

3. Click the Add Dissolve parameter and choose a transition effect 
from the pop-up menu.

For an explanation of individual effects, see Chapter 10, Ò2D 
Effects Reference.Ó

4. Enter the Duration of the transition effect in frames.
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5. Click the Position parameter and choose the effectÕs alignment to 
the cut point from the pop-up menu.

6. If you select Custom Start, in the Starts parameter you must enter 
the number of frames before the cut to start the effect.

7. Click Target Disk and from the pop-menu choose a disk on which 
to store the effect if you choose to render it.

The Effect Source Disk is the disk where the media on the outgoing 
shot of a transition resides.

8. If the effect you selected is real time on your Avid Composer sys-
tem, select the DonÕt Render Real-time Effects parameter to pre-
vent real-time effects from being rendered.

9. To add the effect without rendering it, click the Add button.

Or, to add the effect and render it, click the Add and Render 
button.

This adds the selected effect to the transition in the sequence.

Sizing the Effect to Fit the Media

When you select a transition effect from the Effect Palette, such as a 
Dissolve, and there is not enough source media to apply the effect, the 
following message appears:
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¥ Off Media A Ñ Refers to the number of frames by which the out-
going media is short.

¥ Off Media B Ñ Refers to the number of frames by which the 
incoming media is short.

To automatically size the effect to Þt the media:

¥ Click the Size To Fit button in the dialog box.

The system sets the duration of the effect to Þt the available media; if 
you have selected an alignment, the system attempts to preserve it.

To change the alignment or duration of the transition effect, see 
ÒUsing the Transition ParametersÓ on page 59.

Trimming a Transition Effect

You can trim a transition effect using the standard transition trim pro-
cedures or the Transition Corner Display function in Trim mode. 
For more information, see the ÒWorking in Trim ModeÓ chapter in the 
Avid Media Composer UserÕs Guide or Avid Film Composer UserÕs Guide.

Adjusting Transitions in the Timeline

You can change the duration of Dissolve effects just by dragging them 
in the Timeline. You must be in Transition Corner Display in Trim 
mode to use this feature.

To adjust a transition using the Transition Corner Display:

1. Click on the transition in the Timeline.

2. Enter Trim mode.

3. Click the Transition Corner Display button.
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The button turns bright green, and the display is enabled. As you 
position the cursor over the transition, it changes to look like a 
Þlm clip that has been cut for a splice.

4. Lengthen or shorten the transition effect by clicking and dragging 
to the desired length.

¥ To shorten a transition, drag toward the transition point.

¥ To lengthen a transition, drag away from the transition point.

The cursor changes to a hand that moves as you drag. You can 
adjust either the outgoing or the incoming video.

5. To review your edit, click the Play Loop button.

n To customize transition effect parameters, see ÒTransition ParametersÓ on 
page 385.

Creating Motion Effects

A motion effect, applied to a clip in the Source monitor, allows you to 
alter the playback characteristics of the clip. Motion effects include 
freeze frame, variable speed (such as slow motion or fast motion), and 
strobe motion effects. You can also combine variable speed and strobe 
effects in a single clip.

n When you use a motion effect to slow down a clip, the effect is real time. When 
you use a motion effect to speed up a clip, the effect is non-real-time and must 
be rendered before it can be played.

Creating a Freeze Frame

A Freeze Frame effect is a still image based on a chosen frame from a 
clip that continues to display for the duration that you choose. When 
combined with the original clip, the footage plays and then ÒfreezesÓ 
and holds on the frame that you speciÞed.
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To create a Freeze Frame effect:

1. Load a clip into the Source monitor.

2. Cue the clip to the frame that you want to freeze.

3. Choose Freeze Frame from the Clip menu.

A pop-up menu appears.

4. If you are using two-Þeld media (AVRs 70, 75, or 77), choose 
Freeze Frame from the Clip menu and choose an option from the 
Two Field Freeze Frames pop-up menu:

¥ Using Duplicated Field Ñ A single Þeld is displayed in the 
effect.

¥ Using Both Fields Ñ Both Þelds are used to create the effect.

¥ Using Interpolated Field Ñ A second Þeld is created for the 
effect by combining scan line pairs from the Þrst Þeld in the 
original media.

The chosen option becomes the default until you choose another 
option.

Duration

Custom duration
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5. Choose Freeze Frame from the Clip menu and choose a duration:

¥ Choose a preconÞgured duration from the list.

¥ Choose Other and type a custom duration into the dialog box; 
then click OK to enter the new duration.

A dialog box appears, prompting you to choose a target drive for 
the freeze frame media.

6. Choose a drive from the pop-up menu and click OK.

A new clip appears in the Source monitor and in the current bin 
preceded by a Motion Effect icon. The new clip has the original 
clip name followed by the letters FF.

Creating a Rolling Clip That Freezes

One common use for freeze frames is to create a segment that plays 
normally and then freezes, either to superimpose text information or 
to add emphasis to the end of a sequence before fading.

To create a rolling clip that freezes:

1. Load the original source clip from which you created the freeze 
frame.

2. Edit the clip into the sequence.

3. Place an IN mark in the sequence at the frame used to create the 
freeze frame.

4. Load the Freeze Frame clip into the Source monitor.

5. (Option) Mark the clip if necessary to shorten the duration of the 
clip.
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6. Click the Splice-in button to edit the freeze frame into the 
sequence.

When you play the sequence, the footage plays full-motion and then 
freezes at the chosen frame.

Creating a Variable Speed Effect

Variable Speed effects involve changing the rate of playback to achieve 
fast-motion or slow-motion effects. The Avid Composer system creates 
slow-motion effects by duplicating frames in the original media. It cre-
ates fast-motion effects by eliminating frames from the original media. 
The resulting motion might appear to be jerky.

To create a Variable Speed effect:

1. (Option) If you require a Þxed duration for the clip based on a seg-
ment in the sequence, mark the segment in the Timeline with IN 
and OUT marks.

2. Click the Motion Effect button.

n The Motion Effect button does not appear on the interface by default. You can 
map the Motion Effect button from the Command Palette to the Edit monitor 
or to the keyboard. For more information, see the Avid Media Composer 
UserÕs Guide or the Avid Film Composer UserÕs Guide.
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The Motion Effect Parameters dialog box appears. 

3. Select the Variable Speed option.

4. Specify the play speed for the Variable Speed Motion effect in one 
of the following ways: 

¥ Type a number of frames into the frames Þeld.

¥ Type a frame rate into the FPS Þeld. To indicate reverse 
motion, enter a negative number for the play rate.

¥ Type a percentage of the current play rate into the % speed 
Þeld. To indicate reverse motion, enter a negative number for 
the percentage.

¥ Select the Fit To Fill option to automatically set the Variable 
Speed parameters so that the duration of the motion effect will 
match the IN to OUT duration marked in the Record monitor.

When one of these is set, all values change to reßect the speciÞed 
play rate.

Variable Speed 
option 
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5. (Option) If your clip was digitized in one of the two-Þeld AVRs 
(AVRs 70, 75, or 77), choose a Render 2-Field Motion Effect option:

¥ Duplicated Field Ñ A single Þeld is displayed in the effect.

¥ Both Fields Ñ Both Þelds are displayed in the effect.

¥ Interpolated Field Ñ A second Þeld is created for the effect by 
combining scan line pairs from the Þrst Þeld in the original 
media.

6. Complete the effect by doing one of the following:

¥ Click Create to create the new clip and close the dialog box. 

n An unrendered Variable Speed Effect clip displays a green dot when edited 
into a sequence to indicate that the clip might not play in real time in certain 
circumstances. For more information, see ÒUnderstanding Real-Time and 
Downstream Key EffectsÓ on page 26.

¥ Click Create and Render to render the clip Ñ creating new 
media Þles Ñ and close the dialog box.

A new clip is created in the Source monitor and in the current bin. 
The clip is named with the original clip name followed by the 
frame rate in parentheses. This clip can then be edited into your 
sequence like any other clip.

Creating a Strobe Motion Effect

Strobe motion results in a stuttering effect during playback of a clip. 
You determine the degree of the ÒstutterÓ or strobe when you create 
the effect.



70

n You can also combine strobe motion with the Variable Speed effect. For more 
information on the Variable Speed effect, see ÒCreating a Variable Speed 
EffectÓ on page 67.

To create a Strobe Motion effect:

1. Click the Motion Effect button.

n The Motion Effect button does not appear on the interface by default. You can 
map the Motion Effect button from the Command Palette to the Edit monitor 
or to the keyboard. For more information, see the Avid Media Composer 
UserÕs Guide or the Avid Film Composer UserÕs Guide.

The Motion Effect Parameters dialog box appears. 

2. Select the Strobe Motion option.

Strobe Motion 
option 



71

3. Specify the update rate in frames for the Strobe Motion effect. For 
example, a rate of 5 causes every Þfth frame to be displayed in the 
Strobe Motion effect. 

4. (Option) If your clip was digitized in one of the two-Þeld AVRs 
(AVRs 70, 75, or 77), choose a Render 2-Field Motion Effect option:

¥ Duplicated Field Ñ A single Þeld is displayed in the effect.

¥ Both Fields Ñ Both Þelds are displayed in the effect.

¥ Interpolated Field Ñ A second Þeld is created for the effect by 
combining scan line pairs from the Þrst Þeld in the original 
media.

5. Click Create and Render to render the clip and close the dialog 
box.

n You must render a Strobe Motion effect in order to play it back in real time.

A new clip appears in the Source monitor and in the current bin 
preceded by a Motion Effect icon. The clip includes the original 
clip name followed by the word Strobe and the number of update 
frames in parentheses.



72

CHAPTER 3

Working in Effect Mode

After you have created an effect and applied it to a transition or seg-
ment in your sequence, you can adjust its appearance and operation 
by changing its effect parameters. This chapter explains how to go to 
Effect mode and use the Effect Preview monitor and the Effect Editor, 
and how to adjust the most common effect parameters.

¥ Entering Effect Mode

¥ Understanding the Effect Preview Monitor

¥ Using Big Effect Mode

¥ Working with the Effect Grid

¥ Using the Effect Editor

¥ Using Key Frames

¥ Adjusting Basic Parameters

¥ Using an Effect Template

¥ Playing an Effect

¥ Rendering an Effect

¥ Managing Your Media Files
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Entering Effect Mode

After you add an effect to a sequence, you must enter Effect mode to 
change the parameters of the effect. Entering Effect mode transforms 
the Source/Record monitor into the Effect Preview monitor and opens 
the Effect Editor. 

To enter Effect mode:

1. Place the blue position indicator on the effectÕs icon in the 
Timeline.

2. Click the Effect Mode button.

The Record monitor is transformed into the Effect Preview moni-
tor, and the Effect Editor, which includes buttons and parameter 
panes to change effects, appears in the Bin monitor. 

Effect Editor

Effect
Preview
monitor
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Understanding the Effect Preview Monitor

The Effect Preview monitor displays the selected effect in the sequence 
where the position indicator is located in the Timeline. The effectÕs 
position bar, located directly below the Effect Preview monitor, repre-
sents only the selected effect, not the entire sequence.

n If the effect you expect does not appear in the Effect Preview monitor, make 
sure that you have activated the monitor in the monitor column of the effectÕs 
track. If a black frame appears in the Effect Preview monitor, the position indi-
cator might be at a location in the Timeline where an effect has not been 
applied to the sequence.

The two boxes above the Effect Preview monitor display the length of 
the effect in seconds and frames and the current position in the effectÕs 
Timeline. In Effect mode, these boxes replace the name of the sequence 
that appears in this area when you are in Source/Record mode. 

Length of effect
Current position in effect

Press and hold mouse button
for tracking information.

Effect’s position

Edit Mode buttons

Timeline

Effect’s position

Position indicator

indicator

Monitor icon

Effect Preview

bar

monitor

Key frame



75

You can press and hold the mouse button to display a menu for view-
ing and changing the tracking information. For information on dis-
playing tracking information, see the ÒViewing and Marking FootageÓ 
chapter in the Avid Media Composer UserÕs Guide or Avid Film Composer 
UserÕs Guide.

n If the position information boxes do not appear above the Effect Preview mon-
itor, increase the size of the window.

The following buttons appear below the Effect Preview monitor and 
below the Timeline.

¥ Source/Record mode Ñ Use this button to go to Source/Record 
mode.

¥ Trim mode Ñ Use this button to go to Trim mode.

¥ Effect mode Ñ This button is highlighted, to indicate that you are 
in Effect mode. If you are using a high-resolution monitor, click 
this button once to enter Big Effect mode. For more information on 
Big Effect mode, see ÒUsing Big Effect ModeÓ on page 76.

Navigating in Effect Mode

The following sections describe helpful techniques for moving 
through footage in Effect mode.

Changing Position

You can change your position in the effect either by dragging the posi-
tion indicator in the effectÕs position bar or by typing the timecode in 
the same way you do in Source/Record mode. The type of timecode 

Source/Record mode

Trim mode

Effect mode
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you enter (master timecode or absolute timecode) depends on the top 
row of tracking information you are displaying. The position informa-
tion boxes above the Effect Preview monitor update as you change 
position. For more information on entering timecode to change the 
current position, see the ÒViewing and Marking FootageÓ chapter in 
the Avid Media Composer UserÕs Guide or Avid Film Composer UserÕs 
Guide.

Using Single-Field Step

Single-Þeld step enables you to view Þeld 1 and Þeld 2 of each frame 
of video. This feature is useful when you want to locate a defect on a 
speciÞc Þeld and use an effect to correct the defect. Any effect edits 
you make affect both Þeld 1 and Þeld 2 of each frame.

When you enter Effect mode, the tracking display above the Effect Pre-
view monitor indicates the currently displayed Þeld by adding Ò.01Ó 
to the tracking number for the Þrst Þeld, or Ò.02Ó for the second Þeld.

To step through the footage one Þeld at a time, press the Option key 
and click either the Step Forward or the Step Backward button. As you 
step, the tracking number updates to reßect the currently displayed 
Þeld.

Using Big Effect Mode

Once you choose the Effect Editor, if you have a high-resolution moni-
tor, you can click the Effect Mode button again to bring up Big Effect 
mode, which offers you a larger Effect Preview monitor.

Big Effect mode provides an enlarged window that makes working 
with effects easier. The Source monitor disappears, and the Effect Pre-
view monitor transforms into a larger working space that makes it eas-
ier to create effects and make changes to them.
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n You must be using a high-resolution monitor as the Edit monitor to enter Big 
Effect mode.

To enable Big Effect mode:

1. In Source/Record mode, click and drag the Source/Record win-
dow so that it Þlls the width of your high-resolution Edit monitor.

2. Enter Effect mode by clicking the Effect Mode button.

3. Click the Effect Mode button again.

The Avid Composer system enables Big Effect mode. You can click 
and drag the Effect Editor to the left of the enlarged Effect Preview 
monitor.

Length of effect Current position in effect
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4. To return to normal Effect mode, click the Effect Mode button at 
the bottom of the screen.

n If you do not return to normal Effect mode, Big Effect mode remains the 
default state when you enter Effect mode in the future.

Working with the Effect Grid

The Effect Grid provides a variety of ways to position effects with 
accuracy and previsualize them in the Effect Preview monitor. The 
grid coordinates can be expressed in traditional Þelds or XÐY pixels 
in any resolution. The following illustration shows a 12-Þeld grid 
displayed in a video project.

Grid points

Safe title area

Axis with
tick marks

Grid 
Coordinates 
(at cursor 
position)
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In video and Þlm projects, you can use the Effect Grid to:

¥ Display Safe Title and Safe Action guidelines.

¥ Display the aspect ratios for Þlm categories such as standard Þlm, 
Academy, Super 35 mm, and Anamorphic, as well as the 4 x 3 
safety area for the 16 x 9 aspect ratio.

¥ Show coordinate information to track the exact location of an 
effect in the frame.

¥ Use the snap-to-grid feature to easily position effects.

In Þlm projects only, you can use the Effect Grid to:

¥ View the results of a Blowup, Paint, or AniMatte effect.

¥ Interpret the path of a Paint or AniMatte effect over a series of 
frames using key frames. The coordinates show up when you gen-
erate a cut list, which enables the editor at the optical facility to 
track your effects accurately. 

Setting the Effect Grid Options

To set the default grid values on your system, choose Grid from the 
Settings scroll list in the Project window. The following illustration 
shows the Grid Settings dialog box.



80

You can turn the Effect Grid on or off by clicking the Grid button in 
either Source/Record or Effect mode.

n If you are working in a video project and want to see only the Safe Action and 
Safe Title guidelines, Option-click the Grid button; the Effect Grid options 
now default to Safe Action and Safe Title guidelines. To toggle the display 
back to the full range of Effect Grid options, Option-click the Grid button.

Setting Up the Effect Grid in a Film Project

In a Þlm project, the Grid parameter pane values in Effect mode deÞne 
a local grid effect that allows you to set the grid differently for each 
effect. If you save the effect as a template, the Avid Composer system 
automatically saves the local grid parameters as part of the template.
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Use the Grid Enable button to turn the local Grid effect on or off. If you 
disable the local Grid effect, the Avid Composer system uses the global 
settings deÞned by the Grid dialog box. You can display the dialog box 
from two locations:

¥ Choose Grid from the Settings scroll list in the Project window.

¥ Click the Other Options button in the Effect Editor.

The Transfer Fast menu values appear on the parameter pane but do 
not appear in the Grid Settings dialog box. The Fast menu enables you 
to specify how the Þlm was transferred to video as follows:

¥ Full Aperture Ñ Transferred everything that is visible in the frame

¥ Academy Ñ Did not transfer the sound track area that appears on 
the left-hand side of the Þlm

Grid Options

Table 3-1 describes the features of the Grid Settings dialog box.

Other Options button Grid Enable button

Grid parameter
pane

Transfer fast
menu

(opens Grid Settings)
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Table 3-1 Grid Settings Dialog Box Options 

Heading Description

Fields Determines the number of tick marks along the grid axes as well as the number of visi-
ble grid points. Since different optical houses expect different Fields and Sub Fields val-
ues, you should check with your optical house before deÞning your grid.

Sub Fields Determines the snap-to-grid feature between visible grid points. The value determines 
how many jumps are in between each visible point. A value of 1 snaps only to visible 
points. A value of 2 provides 1/2 Þeld jumps. A value of 4 provides 1/4 Þeld jumps, 
and so on. A value of 0 turns off the snap-to-grid feature.

Source Scan
Size

Use these values if an optical house will use a Þlm scanner to process your Þlm (and 
add visual effects). Match the values to those used by your effects house.

Source Grid 
Offset

These values enable you to move the grid on the image. They are typically applied for 
reference purposes after the Þlm has been scanned at the optical house. The offset 
allows you to sync up the telecine version with the scanned version. For example, you 
can add a marker to identify a speciÞc location on one frame. If the optical house has 
different coordinate values for that point, you can offset the grid on the Avid Composer 
system to match the optical houseÕs coordinates.

Type Selects a different grid for each of the standard Þlm types:

Square

Standard 
Film

Academy

Super 35

Anamorphic

Used for video projects

For 1.85, 1.77, and 1.66 and aspect ratios

For 1.85, 1.77, and 1.66 aspect ratios with guides for the loss 
soundtrack area

For 2.35 aspect ratio (pixel values count the entire frame)

For 2.35 aspect ratio (pixel values count only in 2.35 area)

Color Enables you to choose a color for the grid axes and the grid points.

Show Safe 
Title

Displays the safe title area. Create Þlm titles within this area.

Show Safe 
Action

Displays the safe action area for video display. This box is self-adjusting for PAL and 
NTSC projects.
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Displaying the Position Coordinates in Effect Mode

The Avid Composer system uses compass coordinates and X, Y coordi-
nates to describe the position of an effect. To view the coordinates, you 
must choose the Show Position Info option in the Grid Settings dialog 
box and enable the Effect Grid. For compass coordinates, the point 
(0, 0) is the center of the axes. For X, Y coordinates, the point (0, 0) is 
the upper-left corner of the Source monitor. X values increase to the 
right, and Y values increase as you move up.

The compass coordinates describe the effectÕs position in terms of opti-
cal house standards. Each compass coordinate begins with a direction 
(N, S, E, or W, the abbreviations for North, South, East, or West) 
followed by a numerical value. This numerical component reßects the 
Fields and Sub Fields parameters you choose in the Grid Settings dia-
log box or the Grid parameter pane. 

4 x 3 Safety for 
16 x 9

Displays the safe area for the 4 x 3 aspect ratio when you are working in a 16 x 9 aspect 
ratio project.

Show Axes Displays the axes.

Show Tick 
Marks

Shows tick marks along the axes. Use the Fields parameter to set the number of tick 
marks.

Show Aspect 
Lines

Displays the aspect-ratio lines. Each grid type has different aspect-ratio lines.

Show Points Shows the grid points. Use the Fields parameter to set the number of grid points.

Show Position 
Info

Enables you to display the coordinates of any point in the Record monitor. 

Table 3-1 Grid Settings Dialog Box Options (Continued)

Heading Description
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The X, Y coordinates describe position in terms of the Source Scan Size 
parameters you choose in the Grid Settings dialog box or the Grid 
parameter pane.

To display the coordinates in Source/Record mode, press and hold the 
mouse button, and drag the cursor in the Record monitor.

To display the coordinates in Effect mode:

1. Deselect all tools in the Effect Editor (including the Selection Tool 
and the Outline/Path button).

2. Press and hold the mouse button and drag the cursor in the Effect 
Preview monitor.

Using the Effect Grid in a Film Project

You can use the Effect Grid to include position information in a cut list 
for the Paint and AniMatte effects on a key-frame-by-key-frame basis. 
Additionally, you can display the position information for the Þrst key 
frame of a Blowup effect in a cut list. You must enable the Effect Grid 
before you generate the cut list to display the coordinate information 
in the cut list.

Position Information for the Blowup Effect

The event section of the cut list displays the compass coordinates of 
the effect at the Þrst key frame in the segment. Additionally, the Fields 
parameter you have chosen for the effect appears before the position 
coordinates.
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For information on the parameters available with the Blowup effect, 
see ÒBlowupÓ on page 403.

Field
parameter

X, Y
coordinates
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Position Information for the Paint and AniMatte Effects

By enabling Key Frames in the Cut List Tool options for optical lists, 
you can track the position of each Paint and AniMatte effect on a key-
frame-by-key-frame basis. You must enable the Effect Grid before you 
generate the cut list, or the coordinate information will not appear in 
the cut list. The following illustration shows a cut list that includes 
coordinates for a Paint effect.

.
Compass coordinates X, Y coordinates
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The compass coordinates for Paint and AniMatte effects indicate the 
position of each corner of the effect for each key frame. For example, a 
pentagon you create with the Paint effect shows Þve associated com-
pass coordinates. The X, Y coordinates in the cut list indicate the posi-
tion of the center of the effect at each key frame.

For information on getting started with the Effect Grid and the Paint 
and AniMatte effects, see ÒPrevisualization Marker Tool for Film 
ProjectsÓ on page 277. For information on generating a cut list that 
shows the position coordinates, see ÒCreating a Cut List with Effect 
Grid InformationÓ on page 279.

Displaying the Safe Title and Safe Action Guidelines

Many effects can utilize the outer edges of the viewing screen area. If 
you are editing material that will be viewed on screens with more lim-
ited viewing areas, such as standard televisions, you can use the Safe 
Title and Safe Action options to provide visual guidelines in the Effect 
Preview monitor that replicate the actual viewable area on a standard 
television screen.

For example, you can use the Safe Title option as a template for the 
area in which you want the effect to operate. In this way, you can 
avoid the appearance of the effect ßoating off into a nonviewable area 
of a standard television screen.

Activate the Safe Title and Safe Action options in the Grid Settings dia-
log box as described in ÒSetting the Effect Grid OptionsÓ on page 79. 
To display the Safe Title and Safe Action guidlelines in Source/Record 
mode or Effect mode, Option-click the Grid button.
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Two outlined boxes appear in the Effect Preview monitor. The inner 
box is the safe title area. All text and objects should remain within the 
inner box. The outer box is the safe action area for video display.

Effect Preview 
monitor

Safe title area

Safe action area
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Displaying the Aspect Ratio Grid for Film Projects

The Effect Grid displays several guidelines to show you where you 
could crop the top or bottom of your frame to achieve the Òletter-boxÓ 
effect. Use this feature to determine if an undesired element can be 
seen during screening, if an alternate take should be used, or if a resize 
is required. The following illustration shows the Standard Film aspect 
ratios.

Activate the Þlm aspect ratio options as described in ÒSetting the 
Effect Grid OptionsÓ on page 79. To display the aspect ratios in Effect 
mode or Source/Record mode, click the Grid button.

If you want to apply a Mask effect, select one of the Film masks from 
the Effect Palette. For more information about applying effects, see 
ÒApplying Effects to a SequenceÓ on page 46.

1.66 aspect ratio

1.77 (16 x 9)
aspect ratio

1.85 aspect ratio
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Using the Effect Editor

When an effect is selected and the Effect Editor is active, the selected 
effect displays in the Effect Preview monitor. The Effect Preview moni-
torÕs position bar represents only the selected effect, not the entire 
sequence.

n If you are in Effect mode already, the Effect Editor is open and active. You can 
just select the segment or transition effect to display the effectÕs parameters in 
the Effect Editor.

When you click the Effect Mode button to enter Effect mode, the 
Effect Editor appears.

Other Options button

Effect name

Triangular

Parameter pane

Slider used to adjust
parameter

Effect icon

opener
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This example shows the Grid Wipe effect parameters.

Not all effect parameters apply to all effects. Parameters that do not 
apply to an effect do not appear in the Effect Editor for that effect. To 
determine which parameters pertain to an effect, refer to the effectÕs 
description in Chapter 10, Ò2D Effects Reference,Ó and Chapter 11, 
Ò3D Effects Reference.Ó

n If the position indicator is not on an effectÕs icon in the Timeline or the track 
that contains the effect is not selected, then the Effect Editor is blank.

Effect Editor Buttons

This section describes the buttons in the Effect Editor, starting from the 
top-left button in the window. Not all buttons apply to each effect. If a 
button is not applicable, it does not appear in the Effect Editor for that 
effect. For more information about using each of the buttons, refer to 
the associated topic in this chapter.

Additional buttons appear in the Effect Editor, depending on which 
effect you are using. For example, if you are working with a 3D effect, 
a set of 3D-speciÞc buttons appear on the right side of the Effect 
Editor.

¥ Other Options button Ñ Click to access additional parameters for 
matrix effects, third-party plug-in effects, and the Title Tool.

¥ Triangular opener Ñ Click to display or hide the parameter pane. 
A downward-pointing triangle displays the parameter pane; a 
right-pointing triangle displays only the parameter name.
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¥ Other Options button Ð Click the Other Options button next to the 
Color Preview window to display the color wheel palette when 
selecting a color. The Color Preview window displays the selected 
color. For more information, see ÒAdjusting a Color ParameterÓ 
on page 104.

The following buttons appear along the right side of the Effect Editor.

¥ Play Loop button Ñ Plays back a transition or segment effect in a 
loop. Click the button again to stop the looped playback.

¥ Dual Split button Ñ Splits the Effect Preview monitor in half to 
show the image with and without effects applied to it.

¥ Reduce button Ñ Reduces the image in the Effect Preview 
monitor.

Triangle

Parameter pane

Other Options button Color Preview window

Reduce button

Enlarge button

Dual Split button

Play Loop
button

Play button
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¥ Enlarge button Ñ Enlarges the image in the Effect Preview 
monitor.

¥ Play button Ñ Plays the effect from the current position in the 
effectÕs Timeline for most 2D and 3D effects.

The following buttons appear at the bottom of the Effect Editor.

¥ Add Key Frame button Ñ Creates a key frame at the frame in the 
effectÕs Timeline where you place the position indicator. Option-
clicking this button deletes a key frame.

The Add Key Frame button on the Command Palette is mapped to 
the double quote key (Ò) on the keyboard. You can map the button 
from the Command Palette to another key, or you can map the 
button to an existing button in the Source/Record monitor.

¥ Play Preview button Ñ Plays back a preview of an unrendered 
effect.

¥ Render Effect button Ñ Renders the effect.

¥ Outline/Path button Ñ Displays a wire-frame representation to 
illustrate the movement of an effect from the Þrst key frame 
through the last key frame.

¥ Grid button Ñ Displays the Safe Title and Safe Action guidelines, 
and enables the Effect Grid for precise placement of effects.

Add Key Frame button

Play Preview button

Render Effect button Outline/Path button

Grid button
Transition Effect Alignment pop-up menu

Transition Effect Duration
box

Transition Effect
Alignment 

Transition Effect Duration box

pop-up menu
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¥ Transition Effect Alignment menu Ñ Use this menu button to 
select the alignment of a transition effect to the cut point.

¥ Transition Effect Duration box Ñ Click in this display to enter 
a duration for the transition effect other than the duration 
displayed.

For a detailed explanation of the above two parameters, see 
ÒUsing the Transition ParametersÓ on page 59.

¥ 3D Promotion Ñ This button appears when you use a 2D effect on 
systems with the 3D Effects option installed. You can click the but-
ton to promote the effect to a 3D effect. For example, you can pro-
mote a 2D Picture-in-Picture effect to a 3D effect and make use of 
the 3D Effects parameters. Before you promote the effect to 3D, 
you may want to save a 2D copy as a template so you can go back 
to it again at a later time. For more information, see ÒPromoting 
2D Effects to 3D EffectsÓ on page 331.

Moving an Enlarged Image in Effect Mode

When you use the Enlarge button to increase the size of the image in 
the Effect Preview monitor, you cannot view the entire frame all at 
once. When you are creating an effect that requires great detail, you 
can reposition the enlarged frame in the monitor to view the sections 
that need your attention.

n This feature applies only to an enlarged image in tbe Effect Preview monitor, 
not a standard-sized or reduced image.

To move the image within the Effect Preview monitor:

1. Click within the boundaries of the Effect Preview monitor.

2. Press and hold kÐOption.

The cursor becomes a hand.
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3. Drag the hand in any direction to reposition the image within the 
Effect Preview monitor.

n Similarly, you can enlarge the frame in the Source monitor when you are 
working in Source/Record mode and move the frame around by pressing 
and holding kÐOption. To access the Enlarge and Reduce buttons in 
Source/Record mode, you must map the buttons to your keyboard or to 
the user-selectable palettes.

Cursor Pixel Size display
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Selecting a Parameter

Some effects have additional parameters that you select from the cur-
rent parameterÕs Fast menu. For example, border types for 3D effects 
are on the same Fast menu.

Changing a Parameter

To change a parameter that has a slider, you must click its slider. When 
a slider is activated, it turns pink. Use the Tab key to move from one 
slider to the next slider. 

Use any of the following methods to change the value of a parameter 
that has a slider.

¥ Move the slider with the mouse.

¥ Type a new value using the numeric keypad, and, if you entered 
less than 3 digits, press Enter.

Fast Menu button

Pop-up menu 
showing other 
parameters

Parameter’s slider

Parameter’s numeric value
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¥ Use the Left Arrow and Right Arrow keys to change the value by Ð
1 or +1.

¥ Press the Shift key and use the Left Arrow and Right Arrow keys 
to change the value by Ð10 or +10.

Reversing an Effect’s Direction

You can set many of the effects in the Effect Palette to operate in 
reverse. When you operate the effect in reverse, in most cases the 
incoming (B) video changes places with the outgoing (A) video. The 
reversal changes the positions of the A and B video only for the dura-
tion of the effect.

To reverse an effectÕs direction, click the Reverse button in the Fore-
ground parameter pane.

When the Reverse button is selected, the effect operates in reverse; 
when the button is deselected, the effect operates normally. For an 
explanation of changing the effectÕs level, see ÒAdjusting the Level 
Between Key FramesÓ on page 103.

Accessing an Effect’s Additional Parameters

Some effects have additional parameters that control their operation. 
For example, the Grid Wipe effect has additional parameters in which 
you set the number of columns and rows in the wipe. When an effect 
has additional parameters, the Other Options button appears next to 
the effect name in the Effect Editor. The Other Options button also 
appears in a parameter pane in the Effect Editor if the pane can access 
additional parameters.

Reverse button
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To access an effectÕs additional parameters, click the Other Options 
button next to the effect name or in a parameter pane.

A dialog box appears in which you set the additional parameters.

n You also use the Other Options button to access the parameters for third-
party plug-in effects and for the Macintosh Color Picker in the 
Title Tool and other effects that allow you to change color parameters.

Replacing an Effect

While in Effect mode, you can replace an existing effect.

To add a replacement effect:

1. Choose Effect Palette from the Tools menu.

2. Choose an effect category.

3. Use one of the following methods to replace the effect:

- Drag the new effectÕs icon to the Timeline. To replace an exist-
ing effect, place the new effectÕs icon on top of the existing 
effectÕs icon.

- Drag the new effectÕs icon to the Effect Preview monitor.

- Highlight the effect in the Timeline, and double-click the new 
effectÕs icon in the Effect Palette.

4. Set the applicable effect parameters in the Effect Editor.
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Using Key Frames

A key frame is a point in the effectÕs Timeline at which you can set 
parameters. Key-frame indicators appear as triangles in the effectÕs 
Timeline below the Effect Preview monitor.

By default, the Avid Composer system always provides the starting 
and ending key frames of an effect. These key frames are selected by 
default and thus any parameter changes are constant throughout the 

Starting key frame Ending key frame
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effect. By using techniques for adding, deleting, moving, selecting, 
and deselecting key frames, you can begin to change the appearance 
and operation of the effect over time by applying parameter changes 
to speciÞc key frames.

Adding a Key Frame

You can create a key frame at any point in the effectÕs Timeline.

To create a key frame:

1. Click the position in the effectÕs Timeline below the Effect Preview 
monitor where you want to add the key frame. The position indi-
cator moves to that frame.

2. Click the Add Key Frame button to add the key frame.

Selecting a Key Frame

You can select a key frame or multiple key frames using the following 
procedures. A key frame turns pink when selected.

¥ To select one key frame, click the key-frame indicator in the 
effectÕs Timeline.

¥ To select multiple key frames, hold down the Shift key and click 
the desired key-frame indicators in the effectÕs Timeline.

¥ To select all key frames in the effectÕs Timeline, press kÐA, or kÐ
click on one key frame.

n For a fast way to jump to the previous or next key frame, you can map the 
Fast Forward and Rewind buttons from the Command Palette to your key-
board.
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Moving a Key Frame

After you have created a key frame, you can move it to another posi-
tion in the effectÕs Timeline.

n The starting and ending key frames cannot be moved.

To move a key frame, press and hold the Option key and click and 
drag the key frame to its new position.

n Alternatively, you can select a key frame and click the Trim Left One Frame 
and Trim Right One Frame buttons or the Trim Left Ten Frames and Trim 
Right Ten Frames buttons.

Changing a Key Frame’s Parameters

In addition to the Level and Acceleration parameters, you can change 
many of the parameters for any key frame, including the starting and 
ending key frames.

To change a key frameÕs parameters:

1. Click the key-frame indicator in the effectÕs Timeline to select it. 
The key-frame indicator turns pink when selected.

2. Adjust any of the applicable parameters in the Effect Editor.

Copying and Pasting Key-Frame Parameters

You can copy and paste parameters from one key frame and apply 
them to another key frame. You can also copy key-frame parameters 
from one effect to another effect.

To copy and paste key-frame parameters:

1. Click one key-frame indicator in the effectÕs Timeline whose 
parameters you want to copy.
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2. Choose Copy from the Edit menu.

3. To copy the parameters to one key frame, click the key frame. To 
copy the parameters to multiple key frames, Shift-click multiple 
key frames. To copy the parameters to all key frames, choose 
Select All from the Edit menu.

4. Choose Paste from the Edit menu.

The parameters that you copied from one key frame are pasted to 
the key frame, or frames, you selected.

n You can also use Cut and Paste from the Edit menu to delete and paste a key 
frame.

Deleting a Key Frame

You can delete any key frame you create. You cannot delete the start-
ing and ending key frames that the Avid Composer system creates.

To delete a key frame:

1. Click the key-frame indicator in the effectÕs Timeline. The key- 
frame indicator turns pink when selected.

2. Press Delete.

n Alternatively, you can Option-click the Add Key Frame button to delete a key 
frame.
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Adjusting Basic Parameters

A number of parameters are common to many effects, such as parame-
ters affecting size, position, or foreground level (transparency). You 
can adjust these parameters once for the entire effect, or you can use 
the Effect Editor along with key frames to change the effect parameter 
over time.

n For reference information on all effect parameters, see Ò2D Effect Parame-
ters ReferenceÓ on page 367 and ÒBasic 3D Effects ParametersÓ on 
page 490.

Adjusting the Level Between Key Frames

Use the Level parameter, together with key frames, to set the relative 
amount of the effect to be displayed over time Ñ for example, to fade a 
Superimpose effect in or out. 

For Blend and Key effects, the Level parameter represents the effectÕs 
opacity. A Level of 100 is 100 percent opaque, a Level of 50 is 50 per-
cent transparent, and a Level of 0 is 100 percent transparent.

For wipes and all other transition effects (except Dissolves), the Level 
parameter represents the proportion of incoming frames to outgoing 
frames. A Level of 0 is 100 percent of outgoing, a Level of 50 is 50 per-
cent of outgoing, and a Level of 100 is 0 percent of outgoing.

Dissolve effects are a special case, in which the Level parameter repre-
sents both the effectÕs opacity and the proportion of incoming to out-
going frames.
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To adjust the Level parameter:

1. Click a key-frame indicator in the effectÕs Timeline to select it. 

2. Adjust the Level parameter using the standard procedures 
explained in ÒChanging a ParameterÓ on page 96.

Adjusting a Color Parameter

You can change a color parameter or select a key color using the eye-
dropper or the Macintosh Color Picker instead of the Hue, Sat (satura-
tion), and Lum (luminance) sliders.

Using the Eyedropper

To select a color using the eyedropper:

1. Position the cursor over the Color Preview window to activate the 
eyedropper.

2. Click and drag the eyedropper into the Effect Preview monitor, 
and release the mouse button on the color you want to select from 
the video image.

The parameterÕs numeric values are updated, and the selected 
color appears in the Color Preview window.

Other Options button
Eyedropper

Color Preview window
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Using the Macintosh Color Picker

The Macintosh Color Picker is a standard application that ships with 
Macintosh systems. Its appearance varies, depending on the current 
release of the Macintosh operating system. You can access the 
Macintosh Color Picker through the Other Options button as follows:

1. Click the Other Options button in the parameter pane.

The Macintosh Color Picker dialog box appears.

Figure 3-1 Macintosh Color Picker

The Macintosh Color Picker displays the HSV (hue, saturation, value) 
color wheel by default for Macintosh operating system Version 8.0, as 
shown in the above illustration. You can also select an RGB (red, green, 
blue) slider interface or an HLS (hue, luminance, saturation ) interface 

Color
selection
text
boxes

Other interface choices

Value slider

Color wheel

Color selector
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by selecting the appropriate icon in the left side of the Color Picker 
window. For a complete description of how to use the other Macintosh 
Color Picker interfaces, see the documentation that ships with your 
Macintosh.

To use the HSV color wheel:

1. Drag the color selector to select a color.

2. Drag the Value slider to make colors brighter or darker.

You can also enter color values using the color selection text boxes on 
the right of the dialog box. The color selector automatically changes 
position in the color wheel as you change values.

Adjusting the Effect’s Position

You can deÞne how the foreground image of a multilayer effect will 
move across the background video by building a motion path, or string 
of key frames. You can deÞne a motion path on multilayer video 
effects such as the Picture-In-Picture effect. Click the Outline/Path 
button to use the wire-frame feature when you want to see the path an 
image takes on the screen. 

When you are creating a motion path that moves beyond the viewing 
screen, you can use the Reduce button to view an outline of the image 
at a reduced scale. The reduced scale view shows the area outside the 
background image and allows you to extend the motion path into that 
area. The Enlarge button returns the screen to full view.

You can change the position of a multilayer effect by using the Position 
parameterÕs sliders or by clicking and dragging the effect. The click-
and-drag, or direct, method also provides you with the ability to 
rescale the effect.
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Using the Position Sliders to Adjust the Position

The Position sliders represent the position of the effect center along 
both the X axis (Horizontal Position) and Y axis (Vertical Position) at a 
key frame. If the effect center is positioned at H Pos = 0 and V Pos = 0, 
the effect is centered in the frame.

On the X axis, an H Pos value of Ð999 places the center of the effect at 
the extreme left of the frame (off the visible screen), and a value of 999 
places it at the extreme right (off the visible screen).

On the Y axis, a V Pos value of Ð999 places the center of the effect at the 
extreme top of the frame (off the visible screen), and a value of 999 
places it at the extreme bottom of the frame (off the visible screen).

As you move the sliders, you can see the frame outline moving in the 
Effect Preview monitor.

Changing the Position of the Effect Directly

To change the position of the effect directly:

1. Click the Outline/Path button.

2. Click the center of the effectÕs outline in the Effect Preview moni-
tor and drag it to the new position.

As you move the effect, the H Pos and V Pos sliders in the Position 
parameter pane move.

Position parameters
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You also can rescale the effect by clicking and dragging the wire-frame 
handles located on the effectÕs outline.

The parameter pane values change automatically as you adjust the 
wire-frame handles.

For 3D effects, see ÒPosition Ñ Moving the ImageÓ on page 496 and 
ÒMoving in 3D SpaceÓ on page 333.

Click
and
drag the
effect.

Effect outlineWire-frame handle
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Adjusting the Effect’s Scale

For effects that use the Scaling parameters, you can change the scale of 
the effect at key frames. When you activate Fixed Aspect, the Wid 
(width) and Hgt (height) sliders move in unison.

The range of values for the Wid and Hgt sliders is 0 to 400. A value 
of 100 means you have not scaled the effect (it is 100 percent of its
normal size). A value of 400 means the effect is scaled 4 times its origi-
nal size.

You can adjust the Scaling parameters using the standard procedures 
explained in the topic ÒChanging a ParameterÓ on page 96. You also 
can click and drag the effectÕs wire-frame handles, as described in 
ÒAdjusting the EffectÕs PositionÓ on page 106.

For 3D effects, refer to the Scaling and Target parameters in Chapter 
11, Ò3D Effects Reference.Ó

Cropping an Effect

The Crop parameter enables you to remove video from the top, bot-
tom, left, and right edges of the video. This parameter applies to 
effects such as Picture-in-Picture, Resize, Chroma Key, and Luma Key.

Scaling parameters

Fixed Aspect is enabled.
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The following table describes the actions of each of the Crop sliders.

You can adjust the Crop parameter using the standard procedures 
explained in ÒChanging a ParameterÓ on page 96. For 3D effects, see 
ÒCrop Ñ Cropping the ImageÓ on page 491.

Adjusting the Acceleration

The Acceleration parameter allows you to adjust the ßuidity of the 
effect, by having the effect Òease inÓ and Òease outÓ of every key 
frame. The Acceleration parameter applies to the entire effect, not
speciÞc key frames.

Table 3-2 Cropping Parameters 

Slider Description

T (top) Removes video from the top of the inner or incoming video. 
Values range from 0 to 999; 0 is the top of the screen, 500 is 
the middle of the screen, and 999 is the bottom of the screen.

B (bottom) Removes video from the bottom of the inner or incoming 
video. Values range from Ð999 to 0; 0 is the bottom of the 
screen, Ð500 is the middle of the screen, and Ð999 is the top 
of the screen.

L (left) Removes video from the left side of the inner or incoming 
video. Values range from 0 to 99; 0 is the left side of the 
screen, 500 is the middle of the screen, and 999 is the right 
side of the screen.

R (right) Removes video from the right side of the inner or incoming 
video. Values range from Ð999 to 0; 0 is the right side of the 
screen, Ð500 is the middle of the screen, and Ð999 is the left 
side of the screen.
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Table 3-3 includes some sample Acceleration settings.

n The overall speed of an effect is determined by the duration of the effect, which 
is determined by the length of the clip in the sequence. If you want to slow 
down or speed up the movement of an effect, you will need to change the 
length of your sequence; or you can use add edits to limit the portion of the 
clip affected by the effect.

To adjust the Acceleration parameter, use the standard procedures 
explained in ÒChanging a ParameterÓ on page 96.

Table 3-3 Acceleration Settings 

Setting Result

0 Linear acceleration

50 Slight Òease inÓ and Òease outÓ

100 Maximum Òease inÓ and Òease outÓ
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Using an Effect Template

The parameters for an effect are called the effect template. You can 
reuse an effect template in multiple places in a sequence by saving the 
template in a bin and later applying the template to other effects or 
video clips in the sequence.

Saving an Effect Template

You can save the parameters from the rendered effect in the Effect
Editor and reuse them for another effect.

To save an effect template:

1. Drag the effect icon from the Effect Editor to a bin.

Effect icons for open 
bins are also displayed 
in the Effect Palette.

This creates a new effect template in the bin, containing the parameter 
setting information for the rendered effect. The new effect template is 
identiÞed in the bin by its effect icon.

n Alternatively, you can save a segment effect with its source media, which is 
useful when you want to save an imported PICT Þle or matte key clip for 
future editing into a sequence. Press and hold the Option key while you drag 
the effect icon from the Effect Editor to a bin.

Effect icon
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2. To rename the template, click the template name below the icon 
and type a new name.

Applying an Effect Template

You can take an effect template that has been saved in a bin and apply 
the template and its parameters to other transitions or segments in 
your sequence. 

To apply an effect template, use one of the following methods:

¥ Click the effect template in the bin or in the Effect Palette, and 
drag it to either the Timeline or the Effect Preview monitor.

¥ Place the position indicator on a segment or transition, and
double-click the effect template in the bin or Effect Palette.

This applies all the parameters from the effect template to the new 
video clip that you are creating.

To apply only part of an effect template:

¥ Click the effect template in the bin or in the Effect Palette, and 
drag it to the speciÞc effect parameter pane in the Effect Editor.

The effect template is applied only to the effect parameter pane to 
which you drag the template.

Effect template
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c Do not drag the effect template through the Timeline window, 
because this deselects the effect.

Playing an Effect

To play an effect:

1. Drag the position indicator to the effect you want to play in the 
Timeline.

2. Click the Play button.

n The system plays a non-real-time effect as fast as it can compute the image for 
each frame. To play the effect at its normal rate, you must render the effect 
Þrst. However, if an effect is real time, it is played in real time.

3. To stop playing an effect, click the Play button, or press the space 
bar.

Position parameter pane
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Playing an Effect in a Continuous Loop

To play the effect in a continuous loop:

1. Drag the position indicator to the effect you want to play in the 
Timeline.

2. Click the Play Loop button.

n The system plays a non-real-time effect as fast as it can compute the image for 
each frame. To play the effect at its normal rate, you must render the effect 
Þrst. However, if an effect is real time, it is played in real time.

3. To stop playing an effect, click the Play Loop button, or press the 
space bar.

Playing a Preview of an Effect

You might want to play an effect or its outline to check its appearance 
and operation. An effectÕs outline is a wire-frame representation of the 
effect.

To play an effectÕs outline:

1. Click the Play Preview button.

n The effectÕs outline plays from the current position. For non-real-time effects, 
the outline does not play in real time. However, if an effect is real time, it is 
played in real time.

2. To stop playing the effect outline, click the Play Preview button, or 
press the space bar.
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Rendering an Effect

You must render a non-real-time effect before it can be played. When 
an effect is rendered, the system stores the effect and its media Þle as a 
precomputed master clip (often referred to as a precompute). The sys-
tem uses the precompute the next time to play the effect at its normal 
speed.

Selecting the Render Setting for a Project

You can control the size of a rendered effect to Þt within a playable 
range by changing the Render settings. For more information, see 
ÒRender SettingsÓ on page 42.

Combining Real-Time Effects and Rendered Effects

The Avid Composer system can process only two streams of video at 
one time. Therefore, when two or more real-time effects overlap, the 
Avid Composer system can play only one of these effects in real time. 
The other effects will not be displayed.

Overlapping Real-Time Effects

The Avid Composer system handles situations with overlapping real-
time effects in the following ways:

¥ In cases where two or more real-time effects overlap, the Avid 
Composer system plays one of the effects in real time and substi-
tutes video from track V1 for the real-time effect that it cannot cre-
ate. If the video on track V1 is not readily available because it is 
also a real-time effect, then the Avid Composer system substitutes 
black for the real-time effect that it cannot create.
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¥ If real-time effects on different video tracks overlap, the Avid 
Composer system plays the effect on the highest numbered track 
in real time.

¥ If you have two real-time effects on the same track (for example, a 
Dissolve or Wipe overlaps video with Color effects), the Avid 
Composer system plays the real-time transition effect using video 
without the segment effect, or, in some cases, using black.

In summary, if you want to view the video with both effects, render 
one of the overlapping effects. 

Overlapping Real-Time and Rendered Effects

In cases where you are rendering effects that will overlap real-time 
transition effects, place the real-time transition effects in the sequence 
before rendering the non-real-time effects. This ensures that you ren-
der enough extra frames of video to create the real-time effect in real 
time. 

The Avid Composer system renders only this section of video if the 
real-time transition effect is present before you render the segment 
effect.

Speed Considerations

If you have multiple short clips with multiple real-time effects or 
images with a high level of complexity, you may exceed the capacity of 
the hardware to play these in real time, resulting in Video Underrun 
error messages. In this case, render some of the intermediate effects 
before playing the sequence.

Displaying Effects On-the-Fly

You can display the results of effects automatically as soon as you cre-
ate them. Note that this can slow down your editing of the sequence.
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To display effects automatically, choose the Render On-The-Fly option 
in the Special menu.

For another method of setting the Render On-The-Fly option, see 
ÒTrim SettingsÓ on page 45.

Rendering a Single Effect

After you have adjusted an effectÕs parameters, you can render the 
effect.

To render a single effect:

1. Place the blue position indicator on the effect in the Timeline.

2. Click the Render Effect button, or choose Render at Position from 
the Clip menu.

In Effect mode, the button is in the Fast menu below the Effect Pre-
view monitor and in the Effect Editor. In Trim mode, the button is 
below the Source monitor. In Source/Record mode, the button is 
in the Fast menu. The button is also on the Command Palette.

A dialog box appears.

n To prevent this dialog box from displaying, press and hold the Option key 
when you click the Render Effect button. The system will use the last disk 
selected.
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To display the esti-
mated render time, 
press the letter T on the 
keyboard. Press T again 
to clear the display.

3. Select a disk drive from the pop-up menu on which to store the 
rendered effect and click OK.

The Effect Source Disk is the disk where the media on the outgoing 
shot of a transition resides.

The effect is rendered, and a precompute master clip is stored on 
the disk drive you selected.

Rendering Multiple Effects

When you have more than one effect to render, you can render them as 
a group.

n Save your sequence before you use this feature, because this is a long batch 
process during which you can leave the Avid Composer system unattended.

To render multiple effects:

1. Click the track selector button in the Timeline for each track on 
which you have effects to be rendered.

2. Mark an IN point before the start of the Þrst effect to be rendered 
in your sequence; mark an OUT point after the last effect to be 
rendered.
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3. Choose Render In/Out from the Clip menu.

The Render Preferences dialog box appears.

4. Select the quality if necessary. The default quality is Highest 
Quality. 

n You are able to select the effect quality only for certain non-real-time effects.

5. If you do not want to render the real-time effects in the selected 
group of effects, select the parameter Skip Real-Time Effects.

To display the esti-
mated render time, 
press the letter T on the 
keyboard. Press T again 
to clear the display.

6. Click OK.

The Avid Composer system renders all effects between the IN and 
OUT marks.

n Another way to speed up rendering is to use the Submaster effect. See 
ÒSubmaster EditingÓ on page 138.
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Rendering Third-Party Plug-in Effects

Third-party plug-in effects must be rendered. Rendering times can be 
longer than native Avid Composer system effects. Use the same proce-
dures explained in this section.

Managing Your Media Files

When you render an effect, create a title, or import a graphic Þle, the 
Avid Composer system creates two elements: an effect clip and a ren-
dered effect media Þle (also known as a precompute master clip).

The Avid Composer system overwrites or automatically deletes a 
media Þle from your disk drive only if you:

1. Render an effect two or more times with the Render Effect button.

2. Close the project before either an Auto Save or a manual save 
occurs.

In this case, the Avid Composer system automatically saves the 
last-rendered effect and deletes the earlier, unreferenced versions. 
This autodeletion applies only to effects rendered since the last 
save or project close.

This prevents you from deleting media that may be necessary to play 
other versions of the sequence. If you want to remove media Þles from 
your disk to save disk space, you will have to manually delete the Þles.

Locating and Deleting Effect Media Files

Use this procedure to locate and delete unwanted media Þles on your 
disk drive for your current project.

1. Choose Media Tool from the Tools menu.

The Display Media Selector dialog box appears.
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2. Select Current Project and Precompute Master Clips and click OK.

The Media Tool window opens and displays all precompute mas-
ter clips associated with your current project.

3. Resize the Media Tool window, until you can see all or most of the 
precomputes.

4. Open the bin or bins that contain all the sequences in the current 
project whose media Þles you want to preserve.

5. Highlight all sequences whose media Þles you want to preserve.

6. Choose Select Media Relatives from the Bin menu.

In the Media Tool , all the precompute media Þles used in the 
selected sequences are highlighted.

7. Click the title bar of the Media Tool to make it the active window.

8. Choose Reverse Selection from the Bin menu to highlight all the 
precompute clips you are not using in the selected sequences.

9. Press Delete.

The Delete Media Files dialog box appears.
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10. Click OK to delete the selected precomputes.
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CHAPTER 4

Creating Vertical and 
Nested Effects

This chapter describes how to apply multilayer effects to your 
sequence. Vertical effects consist of two or more layers of video that 
play back simultaneously with effects such as Picture-in-Picture, 
Superimpose, or Submaster applied to the tracks. Nested effects con-
sist of one or more effect layers that are contained within another effect 
on the same video layer. 

The methods and concepts for creating multilayer effects Ñ described 
in the following sections Ñ build on the procedures for creating 
single-layer effects described in Chapter 2.

¥ Creating a Chroma Key or Luma Key Effect

¥ Creating a Matte Key Effect

¥ Working with Imported Graphics and Animation

¥ Nesting Effects

¥ Expanding Nested Effects in the Timeline

¥ Submaster Editing
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Creating a Chroma Key or Luma Key Effect

When you apply a YUV Chroma Key effect, the Avid Composer sys-
tem replaces one part of the video image with another video image 
based on color. The Luma Key works in a similar way, but the system 
replaces one part of the video image with another video image based 
on luminance (brightness). 

The following procedure describes the application and adjustment of a 
YUV Chroma Key effect. Use the same procedure to apply a Luma key, 
and see Chapter 10 for information on adjusting luminance parame-
ters.

To create a Chroma Key effect:

The YUV Chroma Key effect is used most frequently with a fore-
ground image shot in front of a highly saturated color screen (for 
example, a meteorologist shot in front of a blue screen and layered 
over a weather map). Use the following procedure to create a YUV 
Chroma Key effect:

1. Create a sequence with two layers. Place the foreground image on 
track V2 and place the background image on track V1.

n If you have been building foreground segments on the V1 track and Þnd that 
you want to create a key effect, you can use segment mode techniques to select 
all segments and drag them to V2. For more information on Segment mode, 
see the Avid Media Composer UserÕs Guide or the Avid Film Composer 
UserÕs Guide.

2. Choose Effect Palette from the Tools menu, or press kÐ8.

3. Drag the YUV Chroma Key effect from the Effect Palette to the clip 
on track V2.

The key effect is added. Ultimatte Blue is the default key color.

4. Place the blue position indicator over the Key effect in the Time-
line and click the Effect Mode button.
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The following illustration shows the parameters for controlling 
chroma key and also shows the Color Preview window, used to 
activate the eyedropper.

5. Select the Key color. For more information on methods of selecting 
a color, see ÒAdjusting a Color ParameterÓ on page 104.

6. For additional Þne-tuning, enable Secondary Key parameters, or 
the Spill Suppression parameters, and adjust the sliders.

n For more information on the proper use of Secondary Key and Spill Supres-
sion parameters, see ÒKey Control ParametersÓ on page 374.

n When you enable spill suppression, the effect changes from a real-time effect 
(orange dot) to a non-real-time effect (blue dot). Typically you would rough 
out the primary and secondary key colors Þrst in real time and then work on 
the spill suppression. This allows you to play the effect until you start work 
on spill suppression.

Move the mouse to the 
Color Preview window to 
activate the eyedropper.

Enable button
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Creating a Matte Key Effect

The Matte Key effect uses three layers of video to create the effect. The 
bottom layer is the background image, the middle layer is the fore-
ground image, and the top layer contains the matte or alpha channel.

To create a Matte Key effect:

1. Create a sequence with three video layers.

2. Edit the background image onto track V1.

3. Edit the foreground image onto track V2.

4. Load a high-contrast image into the Source monitor, and edit it 
onto track V3. The high-contrast image can be an imported 
graphic or a clip that you adjust within the Avid Composer 
system.

n If the image is not high enough in contrast, you can adjust the contrast by 
applying the Color Effect and adjusting its parameters in Effect mode. For 
more information, see ÒUsing the Color Effect to Prepare a High-Con-
trast ImageÓ on page 128.

5. Choose Effect Palette from the Tools menu, or press kÐ8.

6. Apply the Matte Key effect as follows:

¥ If your high-contrast image was created with the Color Effect, 
Option-drag the Matte Key icon from the Effect Palette onto 
the segment on track V3 to nest the Color Effect within the 
Matte Key effect.

¥ If your high-contrast image on track V3 does not include a 
Color Effect, drag the Matte Key icon from the Effect Palette 
onto the segment on track V3.

7. Click the monitor selector for track V3. You should see tracks V2 
and V1 through the high-contrast image on track V3.

8. Place the blue position indicator over the Matte Key effect and 
render the effect.
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For an example of a Matte Key effect, see ÒMatte KeyÓ on page 423.

On systems with the 3D Effects option, see ÒUsing Matte Keys with 
3D EffectsÓ on page 332.

Using the Color Effect to Prepare a High-Contrast Image

This section describes how to enhance high-contrast images for use in 
creating Matte Key effects.

To create a high-contrast image from available footage:

1. Apply the Color Effect to the clip and change the Luma Range to 0 
to 255.

2. Set the Luma Clip High and Low sliders to 255 and 0, respectively.

3. Use the Chroma Adjust to remove all saturation from the image. 

4. Adjust the Gamma to change the color of the mid tones. Note that 
this is the only non-linear function in the Color Effect.

The high-contrast image can now be used as a matte for the key 
effect, as described in ÒCreating a Matte Key EffectÓ on page 127.

Black portions of the high-contrast image will be transparent and 
white portions will be opaque. To switch the order, use the Reverse 
option on the Foreground parameter pane of the Matte Key effect.

Working with Imported Graphics and Animation

This section describes two different approaches to editing with 
imported graphic images, depending upon whether the image was 
imported as a master clip with no alpha channel (an opaque graphic 
element), or as a Matte Key Effect clip with an alpha channel (a key-
able graphic element for video overlay).
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These alternatives apply to both single-frame graphic images or ani-
mation. In addition, you can edit imported images into sequences 
using standard Avid Composer system effects. These topics are 
described in this section.

n For more information on importing graphic and animation clips, see the 
ÒImporting FilesÓ chapter in the Avid Media Composer UserÕs Guide or Avid 
Film Composer UserÕs Guide. See also the ÒFile Format SpeciÞcationsÓ chap-
ter in the Avid Media Composer Products Reference Guide.

Editing with Imported Matte Key Clips

When an imported clip includes an alpha channel for keying the 
graphic over video, it appears in the bin with an effect icon and the 
words ÒMatte KeyÓ attached to the front of the clip name and Ò(With 
Alpha)Ó attached to the end. You can shorten or change this name at 
any time.

Both single-frame graphic images (such as a single PICT Þle) and 
multiple-frame animation sequences (such as a PICT sequence Þle) 
appear in the bin in the same form after import, and you use the same 
editing techniques for both. You can edit this type of clip into a 
sequence as a standard matte key overlay.

n Only single-frame Þles can be used as real-time keyed graphics. PICT 
sequences, QuickTime Þles, PICS animation Þles, and ERI Movie Þles cannot 
be used as real-time keyed graphics.

Matte key clip with 
alpha channel

Graphic master clip 
with no alpha channel
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To edit a matte key clip into the sequence:

1. Edit the main video sequence onto track V1.

2. Add track V2 to the sequence by choosing New Video Track from 
the Clip menu, or by pressing kÐY.

n You must edit matte key clips onto track V2 or higher to achieve the keying 
effect. If you edit a matte key clip onto V1, the image is keyed over black 
unless the V1 track contains nested tracks.

3. Play the sequence and mark an IN point and an OUT point where 
you want to overlay the graphic.

4. Load a matte key clip into the Source monitor. Mark an IN point 
toward the center of the clip if it is a still.

5. In the Timeline, click and drag the Source monitor V1 track selec-
tor to the Record monitor V2 track selector to patch the video from 
V1 of the Source monitor to V2 in the sequence.

6. Click the Overwrite button to edit the matte key onto V2.

The graphic is keyed over the video on V1.

In the Timeline, the graphic appears on the track above the main 
video sequence. A Matte Key Effect icon appears in the Timeline 
segment. The blue dot in the icon indicates that the effect must be 
rendered before it can be played.

Record monitor track 
selector

Source monitor track 
selector

Timeline

Before After

Record monitor 
selector

Source monitor 
selector
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7. Adjust effect parameters in Effect mode, if necessary, using proce-
dures described in ÒChanging a ParameterÓ on page 96.

n If the keyed portions of the images are the reverse of the intended effect, then 
you must reimport and reverse on import. See the Avid Media Composer 
UserÕs Guide or the Avid Film Composer UserÕs Guide for more information.

8. Use the standard effect editing procedures to preview, render, or 
play the matte key clip.

n Make sure the Monitor selector is on the topmost track, in this case V2, in 
order to see the complete effect.

Editing with Imported Master Clips

When an imported clip does not include an alpha channel for keying 
the graphic over video, its icon is the standard Master Clip icon. This is 
true for both single-image graphics or animation sequences. You can 
edit this type of clip into a sequence as an opaque image or animation 
(in other words, as a single layer) using basic editing techniques 
described in this section.

To edit an imported master clip into the sequence:

1. Load a graphic clip into the Source monitor, and load a sequence 
into the Record monitor.

Matte key graphic 
keyed over video

Monitor selector

Key effect icon
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2. In the Source monitor, mark an IN point at the start of the clip and 
mark an OUT point to specify the duration of the graphic.

3. In the Record monitor, mark an IN point where you want to edit 
the graphic clip into the sequence.

4. Select the Source and Record monitorsÕ track selectors.

5. Click the Splice-in or Overwrite button to add the opaque graphic 
to the sequence.

The opaque image appears in the sequence. In the Timeline, the 
graphic looks like a standard video clip edited into the sequence.

6. Play the clip using the standard editing procedures to play and 
edit the graphic, the same as you would a video clip.

Nesting Effects

You can use the Avid Composer system to place effect tracks inside 
one another to better combine multiple images and digital video 
effects. This involves a process known as nesting, which allows you to 
use the Timeline to step into a trackÕs edit, perform a series of editing 
operations, and then step out to view and render the effect as one seg-
ment on the track.

You can edit up to 24 video track layers (depending on the Avid 
Composer model you are using). Into each layer of video, you can 
additionally nest (stack inside) up to 24 additional video tracks. In 

Opaque graphic master clip



133

addition, you can step into each video track indeÞnitely, constrained 
only by your Avid Composer systemÕs memory.

n Nested effects must be rendered in order to play back correctly.

You can use nesting when you want to create layered effects. In this 
case, the nested layers are treated as one element during the transition. 
Since transition effects, such as dissolves, fades, and wipes, are not 
multilayered, nesting is not applicable to these types of effects; nor is 
nesting effects applicable to audio tracks.

n Some effects are incompatible with each other when nesting. For example, Box 
Wipes and Edge Wipes cannot be used together in a nested segment because 
the two effects are competing to establish the shape of the wipe.

Another use of nesting is to constrain one effect using another effect. 
For example, you can use a Circle Wipe to constrain an image poster-
ization inside a region.

n Nested effects do not appear in the edit decision list (EDL).

Nesting a Split Screen

If you want to create a split screen that transitions into or out of 
another clip, you have to nest one layer inside the other. To create this 
effect, you can use a nested Edge Wipe to position the images.
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To nest a split screen:

1. Edit one of the video sources onto track V1.

2. Choose Effect Palette from the Tools menu, or press kÐ8.

3. Open the Effect Palette and drag the Horizontal Wipe effect from 
the Edge Wipe category onto track V1.

The monitor now contains half the shot on track V1 and black on 
the other half.

4. Click the Step In button on the Timeline tool bar to step into the 
Horizontal Wipe effect on track V1.

5. Edit the second video source onto the blank track V1 to replace the 
black half of the screen with the second video source.

6. Click the Step Out button on the Timeline tool bar.

You now have a split screen that is nested on one track. You can now 
treat this split screen as a single element and easily transition to 
another clip.
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Another Nesting Technique

You can also nest effects by using a combination of keys as follows:

1. Create a sequence and add a segment effect.

2. Choose Effect Palette from the Tools menu, or press kÐ8.

3. Option-drag another effect from the Effect Palette to the Timeline 
and place it on top of the Þrst effect.

The Þrst effect is automatically nested inside the second effect.

Expanding Nested Effects in the Timeline

In Effect mode, you can double-click a nested effect to expand the 
effect in the Timeline and display the effectÕs contents. All editing and 
patching features are available for the expanded effect; you can listen 
to audio while playing the nested effect. Double-click the effectÕs icon 
in the Timeline to step out of the nested effect.

Nesting a Title Within a Picture-in-Picture

If you want to create a moving picture-in-picture that includes a title, 
you will have to create a nested effect so the title moves with the 
Picture-in-Picture as one unit.

The following illustration shows a title within a Picture-in-Picture 
effect.
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Use the following procedure to nest a title within a Picture-in-Picture 
effect:

1. Create a sequence with two video layers. Put your foreground 
video in V2 and your background video in V1.

2. Create a Title effect and place it in an open bin. For information on 
how to create a title, see Chapter 5, “Creating Titles and Graphic 
Objects.Ó

3. Choose Effect Palette from the Tools menu.

4. Apply the Picture-in-Picture effect from the Blend category to the 
segment on V2. The following illustration shows an example.
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5. Click one of the Segment Mode buttons at the bottom of the 
Timeline.

6. Double-click the Picture-in-Picture Effect icon in the segment. The 
Timeline expands to display the nested tracks 1.1 and 1.2.

7. Deselect the Segment Mode button so you can edit the tracks.

8. Drag the Source monitor track selector to nested track 1.2.

9. Choose New Video Track from the Clip menu. The Avid 
Composer system creates nested track 1.3.

10. Drag the Source monitor track selector to nested track 1.3. 

11. Edit the title into the new nested track 1.3 as shown below.

12. Select one of the Segment Mode buttons again, and double-click 
the Picture-in-Picture effect on track V2.

The Avid Composer system collapses the nested track.

Segment Mode buttons

Source monitor
track selector



138

Submaster Editing

The Submaster effect is in the Image category of the Effect Palette. 
When you render this effect, the Avid Composer system creates a sin-
gle media Þle from several clips or effects in a sequence. This saves the 
new submaster clip to the disk as a single media Þle. However, each 
element that makes up the composite is left untouched so you can still 
manipulate any element.

The Submaster effect is a single-track segment effect and is available 
only if your Avid Composer system supports the nested editing 
option.

n You can nest up to 24 tracks inside a Submaster effect.

n An EDL for a sequence that contains a Submaster effect represents the con-
tents of the submaster as a single cut. To work around this, you can create a 
new sequence with the contents of the submastered material and generate a 
separate EDL for that sequence.

Submaster Editing of Multiple Clips

The Submaster effect is useful when you want to play back band-
width-limited sequences, such as sequences made of several seconds 
of single-frame clips. It is much faster to use the submaster clip than to 
use methods such as applying a graphic, Picture-in-Picture, Mask, or 
Resize effect. Normally, submaster effects render at about the same 
rate as motion effects.

To apply a Submaster effect to multiple clips:

1. Choose New Video Track from the Clip menu.

2. On the new video track (V2 in the example), create one add edit 
before and another after the group of clips to be submastered.
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3. Choose Effect Palette from the Tools menu.

4. Drag the Submaster Effect icon from the Image category in the 
Effect Palette to the space between the add edits you added on the 
new track (V2 in the example).

The system creates a new single-track segment clip from the clips 
below the Submaster effect.

Submaster Editing of Multiple Effects

The Submaster effect is also useful when you have combined effects, 
such as when you have layered or nested effects, or when you have 
segments or motion effects that begin or end with a transition effect. 

Rendering a Submaster effect creates a single media Þle that contains 
all the selected effects.

n A Submaster effect maintains links to the original media Þles so you should 
not delete the original Þles. If you want to combine tracks to create a sequence 
that is independent from the original media Þles, use Video Mixdown.

Add edit marks on new track V2; 
bracket clips on track V1

Submaster effect on track V2
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n The Submaster effect does not render each track separately, so you cannot play 
each track individually, and the blue dot remains in the effect icon. In addi-
tion, you cannot delete a track below a Submaster effect or it becomes unren-
dered.

To apply a Submaster effect to effects:

1. Choose New Video Track from the Clip menu.

2. On the new video track (V4 in the following example), mark two 
add edits at the start and end of the clips that contain effects to be 
submastered.

3. Choose Effect Palette from the Tools menu.

4. Click and drag the Submaster Effect icon from the Image category 
of the Effect Palette between the add edits you added on the new 
track.

5. Highlight the V4 track selector and deselect any other tracks.

Add edit marks on new track V4; 
bracket clips on tracks V1, V2, V3

Submaster effect on track V4
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6. Place the blue position indicator over the Submaster effect in the 
Timeline.

7. Choose Render at Position from the Clip menu.

The Render Preferences dialog box appears.

8. Select the effectsÕ quality. The default quality is Highest Quality. 
This parameter does not apply to all effects.

9. If you do not want to render the real-time effects in the selected 
group of effects, select the parameter Skip Real-Time Effects.

10. Click OK.

All effects at the position indicator are rendered.

Collapsing Layers into One Submaster Effect

You can use the Collapse button to build a multilayer effect. This fea-
ture allows you to nest your effects after building them on separate 
tracks. To use this feature, map the Collapse button from the Com-
mand Palette to your keyboard or a user-selectable palette.
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The Collapse function allows you to build your effect at the topmost 
level and when you are Þnished, collapse the layers automatically into 
one Submaster effect. This function is useful for simplifying a 
sequence with complex compositing. Once you have collapsed a 
complex composite, you can easily add transition effects to the start 
and end of the newly created Submaster composite effect.

n You can also use the Collapse feature to simplify the deletion of multilayered 
segment effects. After collapsing the effects, you can select the resulting seg-
ment and press the Delete key twice to delete the effect and all the layers.

After the tracks are collapsed into a Submaster effect, the Avid 
Composer system recognizes a Submaster effect as a multilayer effect 
instead of a single-layer effect. This allows you to add chroma keys 
and other additional multilayer effects to the nested tracks within a 
Submaster effect.

n You can drag Òtwo-channelÓ effects (such as chroma key) onto Submaster 
effects if the submaster contains two or more nested tracks. This is useful after 
performing a Collapse operation to composite the newly created submaster 
over another background.

To collapse a sequence:

1. Highlight all the tracks you want to collapse. The tracks must be 
adjacent.

2. Mark an IN point and an OUT point around the area to be 
collapsed.

3. Press the Collapse button.

The following procedure shows an alternate way to use the Collapse 
feature:

1. Enter Segment mode.

2. Select the segments you want to collapse.

3. Press the Collapse button.
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Performing a Video Mixdown

Video Mixdown allows you to combine several tracks into a new mas-
ter clip. You can use Video Mixdown after you have Þnished building 
your sequence and want to make it into one piece (for example, a stan-
dard opening to a program). It can be useful for a complex sequence 
you need to use repeatedly or if you want to add a motion effect to an 
entire sequence. 

Video Mixdown is similar to Collapse; the difference is the end result. 

¥ With Collapse, you collapse the tracks into a Submaster effect. 
After you perform a Collapse, you are still able to step inside the 
submaster nest and continue to work on the individual elements 
that make up the composite effect. 

¥ With Video Mixdown, your end result is a new master clip made 
up of all the tracks you built on different layers. Those tracks 
become one clip; you cannot separate the tracks to work on them 
or step into the sequence.

n You cannot generate an EDL or Þlm cut list for a sequence that contains a 
video mixdown. To work around this, you can either remove the video mix-
down or maintain a version of the sequence that does not contain a video 
mixdown.

To perform a video mixdown:

1. Activate the Video monitor in the Timeline for the highest track 
you want to include in the video mixdown.

2. Mark an IN point and an OUT point around the area to mix down.

3. Select Video Mixdown from the Special menu.
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The Video Mixdown dialog box appears.

4. Choose a Target Disk for storing the new master clip and click OK.

A thermometer appears, indicating the progress of the video mix-
down. When the video mixdown is completed, a new clip appears 
in the bin along with the sequence, and a new media Þle is created 
on the target disk.
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CHAPTER 5

Creating Titles and 
Graphic Objects

The Title Tool enables you to create titles that incorporate text, graphic 
objects, imported graphics, and video. Each title you create is saved in 
a bin and can be edited into your sequences. This chapter explains 
how to create titles, including graphic objects. Throughout this chap-
ter, the term ÒtitleÓ refers to both text and graphics.

¥ Task Overview Ñ Creating and Editing Titles

¥ Downstream Keying of Titles and Graphics

¥ Opening the Title Tool

¥ Understanding the Title Tool Window

¥ Setting Up the Drawing Environment

¥ Creating Graphic Objects

¥ Creating Rolling or Crawling Titles

¥ Choosing Colors and Setting Transparency

¥ Working with Shadows

¥ Manipulating Objects

¥ Saving Titles and Title Styles

¥ Exporting a Title as a Graphics File
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Task Overview — Creating and Editing Titles

The following is an overview of the tasks you will perform to create a 
title:

¥ Set up the drawing environment. After you open the Title Tool, 
you can choose whether to display a color background or a frame 
of video from your sequence. You can also use safe colors or safe 
title and action guidelines, or apply a grid for the placement of 
objects.

¥ Create a new title with the Title Tool. You create the title by work-
ing with text and graphics objects, and then applying and adjust-
ing borders, colors, transparency, and shadows.

¥ Save the title and exit the Title Tool. When you save a new title, 
you select an AVR that is compatible with your project and a target 
disk for the title media. You can also save just the styles for the title 
for future use. When you close the Title Tool, the new title appears 
in the bin and in the Source window, ready for editing.

These basic procedures are described throughout this chapter. For 
information on editing a title into a sequence, see Chapter 6.

Downstream Keying of Titles and Graphics

By default, all titles are created using the Avid Composer systemÕs 
downstream key (DSK) capabilities. Graphic elements imported with an 
alpha channel are also created as DSK clips. 

Downstream keying allows you to add uncompressed titles or graph-
ics over multiple streams of compressed media and continue to play 
the sequence in real time. The real beneÞts of downstream keying are 
seen during editing of Title Effect clips into sequences. 

n For information about editing with DSK titles, including descriptions of var-
ious restrictions and playback capabilities, see Chapter 6.
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Opening the Title Tool

To open the Title Tool:

1. In the Record monitor, place the blue position indicator on the 
video frame to be used as a reference. 

If you are not using video as the background, you can skip this 
step. For more information, see ÒSelecting a BackgroundÓ on 
page 153.

2. Choose New Title from the Clip menu.

The Title Tool window opens. The Text Tool is automatically 
selected, and the cursor becomes an I-beam, ready for entering 
text.
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Understanding the Title Tool Window 

The following illustration shows a title over a video background:

The Title Tool window has several major components: 

¥ A video background based on a sequence, or a color background 
that you create.

¥ The title or graphic in the foreground that you create.

¥ The safe title and safe action area guidelines. For more informa-
tion, see ÒUsing Title and Action GuidelinesÓ on page 152.

¥ The tool bar at the bottom of the screen. For more information see 
ÒUnderstanding the Tool BarÓ on page 149.

¥ In addition, there are title-related menu items on the File, Edit, 
Object, and Alignment menus. These menu items are described 
throughout this chapter.

Tool bar

Safe action
area

Video
background

Title objects

Safe title
area
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Understanding the Tool Bar

At the bottom of the Title Tool window are tools and pop-up menus 
you can use for creating and editing text and objects. They work much 
like similar tools in other draw and paint programs.

Table 5-1 brießy describes each section of the tool bar:

Text formatting 
Tools Line attribute 

tools

Shadow tools

Background
selection 
tools

Transparency 
Level boxes

Color Selection 
boxes

Save parameters to
a Style sheet

Drawing tools

Video Pan Tool
Text Tool

Selection 
Tool

Color and Transparency 
Blend tools

Display/Select 
Styles button

Rolling and 
Crawling 
Title buttons

Table 5-1 Tool Bar Elements  

Tool Description

Selection Tool Changes the cursor to an arrow and allows you to select text or objects for 
operations. See ÒUsing the Selection ToolÓ on page 151.

Text Tool Changes the cursor to an I-beam and allows you to enter text. See ÒWorking 
with TextÓ on page 156.

Video Pan Tool Changes the cursor to a hand and allows you to pan around the entire video 
clip within the Title Tool window.

Drawing tools Allow you to draw boxes, circles, ovals, and lines. See ÒCreating Graphic 
ObjectsÓ on page 165.

Style sheet Allows you to set up title style templates that you can use repeatedly. See 
ÒSaving Title StylesÓ on page 197.
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Display/Select Styles  Displays examples of the styles you deÞned and allows you to select one.

Text formatting tools Allow you to set various text attributes such as font, font size, kerning, and 
leading. See ÒFormatting the TextÓ on page 158.

Color Selection boxes Allows you to change the color of text and objects. See ÒChoosing Colors and 
Setting TransparencyÓ on page 177.

Transparency Level 
boxes

Allows you to change the transparency levels of text and objects. See ÒAdjust-
ing the TransparencyÓ on page 181.

Color and Transpar-
ency Blend tools

Allow you to create a blend between two colors or two transparency values.

Shadow tools Allow you to create drop shadows and depth shadows for text and objects. 
See ÒWorking with ShadowsÓ on page 183.

Line attribute tools Allow you to change the corners of boxes, line and border thickness, and 
arrowhead styles. See ÒSelecting Line AttributesÓ on page 167.

Rolling and Crawling 
Title buttons

Allow you to create rolling and crawling titles. See ÒCreating Rolling or 
Crawling TitlesÓ on page 170.

Background selection 
tools

Allows you to switch between a video and opaque background and change 
the color of opaque backgrounds. See ÒSelecting a BackgroundÓ on page 153.

Table 5-1 Tool Bar Elements  (Continued)

Tool Description



151

Using the Selection Tool

The Selection Tool is one of the most frequently used tools. You use the 
Selection Tool when performing certain operations on objects you cre-
ate, such as moving, formatting, resizing, or applying color.

To select an object, choose the Selection Tool and click an object. Selec-
tion handles appear around the object.

n You can Option-click anywhere in the Title Tool window to switch between 
the Selection Tool and the Text Tool. You can also press and hold the Control 
key to display the Selection Tool temporarily at any time.

To select multiple objects, Shift-click with the Selection Tool, or click 
and drag the cursor to draw a lasso around the objects.

n After you use a tool in the tool bar, the system reverts to the Selection Tool, 
and the cursor becomes an arrow. To prevent a tool from automatically revert-
ing to the Selection Tool, double-click the toolÕs icon.

Selection Tool

Selection handle 
for width
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Setting Up the Drawing Environment

This section describes some aspects of the Title Tool that you can use to 
set up your titling/drawing session.

n You can set or change these features at any time during your work on a title. 
These settings are stored with User settings and will appear each time a par-
ticular user opens the Title Tool.

Previewing Titles

Titles are always saved 
in anti-aliased format.

Text and objects in titles are created anti-aliased with an 8-bit alpha 
channel. Anti-aliasing ensures that text, lines, and object edges appear 
smooth, regardless of size. You can preview a title to see the title 
drawn with anti-aliasing, just as it will be saved. 

To display anti-aliased titles, choose Preview from the Object menu. 

As you continue to edit the title, the anti-aliased preview disappears. 
Choose Preview again each time you want to view the title with anti-
aliasing.

Using Title and Action Guidelines

For Film projects, see 
ÒDisplaying the Aspect 
Ratio Grid for Film 
ProjectsÓ on page 89.

By default, the system displays two outlined boxes in the Title Tool 
window to use as guidelines (see the illustration at the beginning of 
the section ÒUnderstanding the Title Tool WindowÓ on page 148). 
The inner box is the safe title area. All text for television broadcast 
should remain within this inner box. The outer box is the safe action 
area for video display. These guidelines are self-adjusting for PAL and 
NTSC projects.

c All DSK titles must be created within (or cropped to within) the safe 
title area to guarantee real-time playback.
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To display the safe title area or safe action area guidelines, choose Safe 
Title Area/Global Grid from the Object menu. You can also click the 
Grid button in the Effect Editor.

Using Safe Colors

If you plan to use your title for television broadcast, you can set the 
Safe Colors command in the Object menu. This command displays 
only low saturation colors for use in text, objects, and background. 
Colors with low saturation look best when combined with video. By 
default, Safe Colors is turned on.

To display only safe colors, choose Safe Colors from the Object menu.

Selecting a Background

Use the Video Background button to toggle between a video back-
ground and an opaque color background.

Using a Video Background

If there is a sequence in the Record monitor, the Title Tool opens with a 
video background. The location of the position indicator in the Time-
line at the time you open the Title Tool determines the initial video 
frame that displays. If there is no sequence in the Record monitor, the 
Title Tool opens with no video showing (the background appears 
black).

Background color window Video Background button
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The Video Background button is green when you are creating a title for 
display over a video background.

Use the background video frame as a reference. It does not become 
part of the title you create. You can edit the title anywhere else in the 
current sequence or in another sequence.

Updating the Video Background

You can update the video background at any time while creating titles 
within the Title Tool.

To update the video background:

1. Click the Video Background (V) button in the Title Tool to activate 
video background if you have not already done so.

2. Activate Source/Record mode with the sequence loaded into the 
Record monitor.

3. Move the position bar in the Timeline or Record monitor to dis-
play the new frame.

4. Click again in the Title Tool to activate its window.

The background is updated to reßect the current contents of the 
Record monitor.

Creating a Color Background

To create a title that appears over an opaque color background:

1. Click the Video Background button to toggle off the video back-
ground. The V in the Video Background button turns black.

2. Click and hold on the Background color window.

The Title Tool Color Picker dialog box appears.

3. Use the Title Tool Color Picker dialog box, eyedropper, or Macin-
tosh Color Picker to select a color. See ÒChoosing Colors and Set-
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ting TransparencyÓ on page 177 for a description of how to use 
these tools. The default background color is black.

n When you create a title with a color background, it is opaque and it cannot be 
used to key over video. 

n You cannot create rolling or crawling titles with a color background.

Displaying a Grid

You can display a grid to help you position text and objects. The visi-
ble grid does not appear when you save the title.

To display a grid, choose Show Alignment Grid from the Alignment 
menu.

Snapping to a Grid

The snap grid is an invisible grid that helps position and connect 
objects. The snap grid has four lines for each line in the visible grid. 
Each square in the grid is subdivided by four invisible vertical and 
horizontal grid lines. Text and objects can snap to these lines.

To snap to a grid, choose Align to Grid from the Alignment menu.

When you create or drag an object in the Title Tool, the object snaps to 
the nearest grid line.

Bringing the Title Tool Window to the Foreground

If the Title Tool becomes obscured by another window, you can 
instruct the Avid Composer system to redisplay the tool. Choose Title 
Tool from the Windows menu.
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Working with Text

By default, the Text Tool is active when you open the Title Tool, and 
you can begin entering text as soon as you click in the Title Tool win-
dow.

Option-click anywhere 
in the Title Tool win-
dow to switch between 
the Selection Tool and 
the Text Tool.

To use the Text Tool at any other time, click the Text Tool icon, click 
anywhere within the text object, and begin typing. An I-beam cursor 
indicates your position within the text. The Text Tool remains selected 
until you select another tool.

n For information on previewing smooth text, see ÒPreviewing TitlesÓ on 
page 152.

Creating Text

To create text:

1. Click the Text Tool on the tool bar.

The cursor becomes an I-beam.

2. Click the position in the frame where you want to add text.

A blinking insertion point appears.

3. Type the text. To insert a line return, press Return.

n Text is word-wrapped automatically as you type. You can adjust the wrap-
ping by changing the width of the text object. For more information, see 
ÒResizing Text ObjectsÓ on page 157.

Text Tool



157

4. When you have Þnished typing, click the Selection Tool on the tool 
bar to deselect the text object.

n When you create text that is lined up on the left side using left justiÞcation 
(the default), you can eliminate the unused space on the right side of the 
newly created text object, especially if you want to use the Alignment menu 
commands. To eliminate the space, click the middle handle on the right side of 
the Text selection box and drag it to the left until it is closer to the text.

Resizing Text Objects

When you resize a text object, the text remains the same size but 
rewraps to Þll the reshaped area.

To resize a text object:

1. Select the object with the Selection Tool.

2. Click and drag one of the object selection handles for width.

n You can resize only the width of a text object. The height of a text object is 
automatically determined by the amount of text.

Repositioning Text Objects

To reposition a text object:

1. Click the Selection Tool on the tool bar and click the text object to 
select it.

2. Move the text:

¥ Click in the middle of the object (not a handle) and drag it to a 
new position.

¥ Use the arrow keys to move the object one pixel at a time.

¥ Use commands on the Alignment menu to position the text. 
For more information, see ÒAligning ObjectsÓ on page 189.
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Editing a Text String

To edit an existing text string, choose the Text Tool, and click anywhere 
in the text. You can perform the following tasks:

¥ Use the arrow keys to move around within the text string.

¥ Type additional characters.

¥ Press Return to enter a line return.

¥ Drag to select characters.

¥ Use the Cut, Copy, and Paste commands from the Edit menu.

¥ Use the Delete key.

¥ Change the formatting of the selected text, as described in ÒFor-
matting the TextÓ on page 158.

Formatting the Text

The text formatting tools control the appearance of text. You can click a 
text object with the Selection Tool to format all the text within it, or you 
can use the Text Tool to select a string of text within a text object to for-
mat individual characters or words.

You can modify the following text attributes for either a text object or a 
selected text string: 

¥ Current font

¥ Bold and italic

Text formatting tools
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¥ Point size

¥ Kerning

¥ Leading

You can modify the following attributes for an entire text object only:

¥ Color (see ÒAdjusting the ColorÓ on page 178)

¥ Transparency (see ÒAdjusting the TransparencyÓ on page 181)

¥ Drop and depth shadows (see ÒWorking with ShadowsÓ on 
page 183)

¥ Outlined text (see ÒSelecting a Line or Border WidthÓ on 
page 167)

¥ JustiÞcation

n If you want to create text elements in the title with different appearances, then 
create a separate text object for each set of attributes.

Setting the Default Text Attributes

When you start the application and open the Title Tool, the Avid Com-
poser system uses default text attributes (including 48-point Geneva 
font). You can change the defaults at any time. Changes you make to 
the default text attributes apply until you quit the application.

To change the default text attributes:

1. Click the Selection Tool (arrow).

2. Click in the Title Tool window but do not select any text.

3. Change any of the text attributes.

Now whenever you start typing a new text string, the Avid Composer 
system uses your new defaults.
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Selecting a Font

The Font Selection menu shows the current font for a text selection and 
allows you to change the font.

When you Þrst open the Title Tool, the font listed is the Macintosh pre-
ferred system font. If an existing text object is selected, the Font Selec-
tion menu displays the font of the text object.

The Font Selection menu displays all fonts currently installed in the 
Fonts folder of the Macintosh System Folder.

To change the font:

1. Click the Font Selection menu to display the Font pop-up menu. 

2. Select a font from the menu. 

Adjusting Point Size

The point size controls the size of the selected text. A point is a typo-
graphical unit of measure. There are 12 points to the pica and 72 points 
to the inch. 

You can enter a point size either before or after you type text.

Font Selection menu

Point Size buttonPoint Size text box
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To change the point size:

¥ Click the Point Size button and choose a standard point size from 
the pop-up menu.

¥ Double-click in the text box and enter a point size between 5 and 
999; then press Return.

¥ Click in the text box and use the Up Arrow and Down Arrow keys 
to change the value incrementally.

Making Text Bold or Italic

The Bold and Italics buttons are located under the Point Size text box. 

In addition, the Object menu contains commands for bold and italics.

To change the text style, select the text you want to change and click 
the appropriate button, or select the appropriate command from the 
Object menu. You can also use ShiftÐkÐB for bold and ShiftÐkÐI for 
italic.

Justifying the Text

Below the Font Selection menu are the buttons for text justiÞcation. 
Text justiÞcation controls the alignment of text.

Point Size
pop-up menu

Bold and Italics buttons
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Click the left Text JustiÞcation button to left justify text within the 
object. Click the center button to center text as you type within the 
object. Click the right button to right justify the text as you type. 

Kerning the Text

Kerning improves the appearance of titles by controlling the amount of 
space between characters. You can expand or condense the character 
spacing to make text more readable or to create special effects, such as 
dramatically expanded spacing in a title. 

The text kerning controls are located beneath the Text JustiÞcation 
buttons.

You can kern the text for an entire text object, or you can manually 
kern individual character pairs or character strings. For example, if 
you mix italic and plain versions of a font in a title, you might want to 
adjust the spacing between characters.

n You can adjust kerning for individual characters or selected groups of charac-
ters using the arrow keys only.

Text Justification buttons

Kerning Text box and Kerning Selection button
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You can use the menu options to select predeÞned kerning options, or 
specify your own custom kerning value. Positive numbers increase the 
spacing; negative numbers decrease the spacing. You can also use the 
arrow keys to make incremental adjustments.

To adjust kerning with the arrow keys:

1. Choose the Text Tool.

2. Click between a character pair or select a group of characters to be 
kerned.

3. Press the Option key and use the Left Arrow or Right Arrow keys 
to increase or decrease the kerning.

To adjust kerning with the menu options:

You can choose the 
kerning value before 
you type text.

1. Select the text.

2. (Option) Click the arrow next to the Kerning text box and choose 
Pair Kerning to eliminate excessive space between some character 
pairs. Note that pair kerning works only on fonts that support 
kerning tables (for example, Palatino).

 Loose kerning

 Normal kerning

 Tight kerning
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3. Choose a kerning option from the Kerning pop-up menu:

- Loose adds space between letters.

- Normal leaves spacing unchanged.

- Tight closes up the spacing between letters.

To adjust kerning with the text box:

¥ Click in the Kerning text box and enter a positive or negative 
numerical value for custom kerning. Kerning values are a per-
centage of the point size.

¥ Click in the Kerning text box and use the Up Arrow and Down 
Arrow keys to change the value incrementally.

The system applies the kerning to the entire text object.

Adjusting Leading

Use leading to adjust the line spacing between lines in a title. Leading is 
measured in points, from baseline to baseline of the lines of text. The 
Title Tool uses the leading that is built into the font as the default. Pos-
itive leading values add space between lines; negative values decrease 
space. You might want to add leading for sans serif, tall, or boldface 
fonts, and for fonts with a strong vertical emphasis.

To set leading:

1. Click in the Leading text box. 

2. Enter a number to indicate the leading value you want.

The Avid Composer system adjusts leading immediately. 

Leading text box
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Creating Graphic Objects

The drawing tools enable you to draw squares, rectangles, circles, 
ovals, and lines. To use the drawing tools, select one of these shapes.

After creating graphic objects, you can change the following attributes:

¥ To round the corners of a box, adjust the width of lines and text 
borders, or add arrowheads to lines, see ÒSelecting Line 
AttributesÓ on page 167.

¥ To change or blend colors in a graphic object, see ÒAdjusting the 
ColorÓ on page 178.

¥ To apply a drop or depth shadow, see ÒWorking with ShadowsÓ 
on page 183.

¥ To add transparency to an object or an objectÕs shadow, see 
ÒAdjusting the TransparencyÓ on page 181.

n By default, when you use a drawing tool and deselect the created object, the 
cursor reverts back to the Selection tool. To avoid this, double-click the draw-
ing tool when you select it in the Title Tool tool bar.

Drawing a Square or Rectangle

To draw a square or a rectangle:

1. Select the Rectangle Tool on the tool bar.

The cursor becomes a crosshair pointer.

2. Click and drag to create an object.

Drawing tools
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n Shift-dragging constrains the Rectangle Tool to create a square.

Drawing a Circle or Oval

To draw a circle or oval:

1. Select the Oval Tool on the tool bar.

The cursor becomes a crosshair pointer.

2. Click and drag in the Title Tool window to create an object.

n Shift-dragging constrains the Oval Tool to create a circle.

Drawing a Line

To draw a line:

1. Select the Line Tool (slanted line) on the tool bar.

The cursor becomes a crosshair pointer.

2. Click and drag to create a line.

Rectangle 
drawn over 
video back-
ground
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n Shift-dragging constrains the Line Tool to create a horizontal or vertical line.

Selecting Line Attributes

Use the line attribute tools to round the corners of a box, select the 
width of lines and borders, and add arrowheads to line endpoints.

Rounding Corners

To round box corners:

1. Select a box.

2. Click the Corner button (the button on the left).

The Corner Selection pop-up menu appears.

3. Choose a rounding option from the pop-up menu.

If you choose the Custom Radius option, a dialog box appears for 
you to enter a custom corner radius.

Selecting a Line or Border Width

You can use the Line Width button to change the width of lines created 
with the drawing tools, or to apply a border outline to text or graphic 
objects.

Line attribute tools

Custom radius 
option
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To select a line or border width:

1. Select an object (such as a line, shape, or text object).

2. Click the Line Width button (the middle button) and choose a 
width from the pop-up menu.

3. Choose from the standard width selections or choose the Custom 
Width option to open a dialog box and enter a custom width.

4. If you choose the Custom Width option, in the dialog box type a 
whole number in pixels to specify a custom width. Use a width of 
1 or greater for lines and 0 or greater for object outlines. The maxi-
mum width is 200.

If you selected a line for modiÞcation, the width of the line changes. If 
you selected an object for modiÞcation, the width of the outline 
changes.

Custom Width 
option

Turns off 
border

Text with 
borders
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Adding Arrowheads

To add arrowheads to a line:

1. Select a line.

2. Click the Arrowhead button on the right edge of the tool bar. 

The Arrowhead Selection pop-up menu appears.

3. Choose an arrowhead style from the pop-up menu, or choose the 
Edit Arrowhead option as described in the following section.

Changing Arrowhead Size

To change the arrowhead size:

1. Select a line.

2. Click the Arrowhead button.

3. Choose the Edit Arrowhead option from the pop-up menu.

The Edit Arrowhead Size dialog box appears. 

4. Click the handle on the arrowhead and drag it vertically or hori-
zontally to resize and reshape it.

The shape of the arrow-
head is in scale with the 
line width.

5. Click OK. The arrowhead is applied to the line.

Edit Arrowhead 
option

Remove 
arrowhead

Handle
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Creating Rolling or Crawling Titles

You can create text or graphics that move across the screen. You create 
the title in the Title Tool and reÞne the motion during editing.

Rolling titles scroll vertically, moving from top to bottom or bottom to 
top, as shown in the following example.

Crawling titles scroll horizontally, moving from left to right or right to 
left, as shown in the following example.

Rolling titles 
scroll from bottom 
to top by default.

Crawling titles 
scroll from right to 
left by default.
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Page Count Limits for Rolling or Crawling Titles

Rolling or crawling titles form pages in the Title Tool that are similar to 
the pages you create in a word processor. A page in a rolling or crawl-
ing title is a unit the size of a National Television Standards Committee 
(NTSC) or Phase Alternating Line (PAL) frame.

Table 5-2 shows the maximum number of pages you can create for roll-
ing or crawling titles.

Page limitations are based on the overall size of the text object. Typing 
more text, increasing the size of the font, or adjusting kerning and 
leading all affect the number of pages in the object.

¥ If you reach the end of the page limitation during typing of text, 
the object stops getting bigger and text entry stops.

¥ If you attempt to make changes to the text formatting that cause 
the text to exceed the page limit, an alert box appears stating that 
the operation will exceed the limit. Click OK to abort the operation 
and keep the title within the limit.

Table 5-2 Title Object Size

Width Width Height Height

Graphic objects 6 pages NTSC
5 pages PAL

4 K pixels 17 pages NTSC
14 pages PAL

8 K pixels

Text objects 12 pages NTSC
11 pages PAL

8 K pixels 67 pages NTSC
57 pages PAL

32 K pixels
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Using Auto Size Mode

For more information 
on adding extra pages 
with Auto Size mode 
disabled, see ÒAdding 
PagesÓ on page 175.

Auto Size mode causes the Title Tool to add or remove pages automat-
ically as you add, delete, or reformat the text. You can disable Auto 
Size mode if you want to add extra pages before or after the text to 
make room for additional title elements, for example.

Auto Size mode is active by default in rolling or crawling modes. To 
toggle Auto Size mode off or on, choose Auto Size Mode from the 
Object menu. A check mark indicates that Auto Size mode is enabled.

Setting Up Text Formatting for Rolling Titles

Before creating a rolling title, consider setting up the text formatting 
defaults, if possible, for such things as font, point size, leading, and 
kerning.

When you type the text for a rolling title, lines of text wrap appropri-
ately within the safe title area, and the title scrolls down as you type, 
providing a realistic sense of positioning, word wrap, and page count 
limitations.

n To set up the defaults, see ÒSetting the Default Text AttributesÓ on 
page 159.

Workflow Options for Creating Crawling Titles

Unlike rolling titles, which scroll in the direction of the roll as you type 
the text, crawling titles do not scroll horizontally in the direction of the 
crawl during typing. To facilitate the creation of crawling text, con-
sider the following workßow options:

¥ You can begin typing with a small font size, such as 12 point, to 
view as much of the text in the window as possible before chang-
ing the font size and resizing the text box in a horizontal direction.
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n To set up font and point size attributes, see ÒSetting the Default Text 
AttributesÓ on page 159.

¥ You can type the text Þrst as a rolling title. This allows you to view 
the text as it scrolls down during typing, and also provides you 
with a scroll bar on the right side of the screen for moving quickly 
through the text. You can then click the C button in the tool bar to 
convert it to a crawling title before resizing, reformatting, and sav-
ing the title.

Typing the Rolling or Crawling Text

To type rolling or crawling text:

1. Choose New Title from the Clip menu. 

The Title Tool appears.

2. Choose the Text Tool.

3. To make a rolling title, click the R button; to make a crawling title, 
click the C button. You cannot select both.

The button turns green, and a page number display appears in the 
bottom right corner of the Title Tool. 

n The Video Background button is automatically enabled (you cannot create 
rolling or crawling titles over a color background).

4. Type the title text. The text wraps automatically as you type.

Rolling mode

Page number display

Crawling mode
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c All DSK rolling titles must be created within (or cropped to within) 
the safe title area on the left and right sides to guarantee real-time 
playback. Crawling titles must be created within (or cropped to 
within) the safe title area on the top and bottom.

5. When Þnished, click the Selection Tool in the Title Tool tool bar to 
select the new text object.

Resizing a Rolling or Crawling Title

To resize a rolling or crawling title:

1. Select the title object with the Selection Tool.

2. Click the object selection handle, and drag to resize the title until it 
appears as you wish.

n You can resize only the width of a text object. The height of a text object is 
automatically determined by the amount of text.

n Unlike still titles, a rolling or crawling title object can be sized to extend 
beyond the boundaries of the screen in the direction of the roll or crawl.

Scrolling Through a Title

When you create a rolling or crawling title, scroll bars appear:

¥ In rolling titles, a scroll bar appears along the right side of the Title 
Tool window for moving vertically through the title.

¥ In crawling titles, a scroll bar appears along the bottom of the win-
dow for moving horizontally through the title.

Use standard Macintosh techniques for scrolling, such as clicking the 
arrow icons, dragging the scroll box, or clicking in the gray areas 
between the scroll box and the arrows. You can also do the following:
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¥ Press the Page Up or Page Down keys on the keyboard to move 
through the title one page at a time.

¥ Press the Home or End keys to go to the beginning or end of the 
title.

¥ Press the Up Arrow and Down Arrow keys to move the cursor 
through the title one line at a time.

Going to a Page

When you Þrst create a rolling or crawling title, a page number text 
box appears in the lower right corner of the Title Tool.

To go to a different page:

1. Click in the page number display.

2. Enter a page number for a speciÞc page, or use the Up Arrow and 
Down Arrow keys to cycle through the page numbers.

3. Press Enter or Return.

Adding Pages

You can add pages to a rolling or crawling title to create space for add-
ing new elements.

To add pages:

1. Choose Auto Size Mode from the Object menu to disable it (the 
check mark should no longer appear in the menu).

Page number display
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n The Add Page command is not available when Auto Size mode is enabled.

2. Choose Add Page from the Object menu to add a page. You can 
choose Add Page repeatedly to continue adding pages up to the 
maximum page count.

n For more information on maximum page counts, see ÒPage Count Limits 
for Rolling or Crawling TitlesÓ on page 171.

3. Select text or graphic objects within the title and position them 
within the range of available pages, or create new elements.

Deleting Additional Pages

You cannot select individual pages to delete during the creation of a 
rolling or crawling title. However, if you add pages to the title with 
Auto Size mode disabled, once you complete the title you can remove 
excess pages after the title elements.

To delete additional pages, choose Auto Size Mode from the Object 
menu. Excess pages at the end of the title are removed.

Formatting Rolling or Crawling Titles

You can modify the text attributes of a rolling or crawling title with the 
same methods used to format still text elements:

¥ For information on adjusting font, point size, style, justiÞcation, 
kerning and leading, see ÒFormatting the TextÓ on page 158.

¥ To create outlines surrounding the text, see ÒSelecting a Line or 
Border WidthÓ on page 167.

¥ For information on adjusting color and transparency, see ÒChoos-
ing Colors and Setting TransparencyÓ on page 177.

¥ To add a drop or depth shadow, see ÒWorking with ShadowsÓ on 
page 183.
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Choosing Colors and Setting Transparency

You can select the color and transparency for text and graphic objects, 
their shadows and borders.

The following illustration shows the boxes associated with color and 
transparency:

¥ The Color Selection boxes control Þll (Fill), shadow (Shad), and 
border (Bord) color, respectively. 

¥ The Transparency Level boxes control Þll, shadow, and border 
transparency, respectively. 

¥ The Color and Transparency Blend tools appear when you select 
the Fill or Border color or Transparency Level box. 

If you select a Color Selection box, the top boxes show the two col-
ors that are used to create the blend. The bottom box shows the 
blended color and allows you to control the direction of the blend 
or transparency.

If you select a Transparency Level box, the top boxes show the two 
transparency values that are used to create the blend. The bottom 
box allows you to control the direction of the transparency blend.

Color and Transparency Blend tools

Transparency Level boxesColor Selection boxes
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Adjusting the Color

You can select a color from the Title Tool Color Picker, use an eyedrop-
per to select a color from any open application on your computer, or 
use the Macintosh Color Picker to select a color. All these features are 
available through the Title Tool Color Picker (see Figure 5-1).

Figure 5-1 Title Tool Color Picker

To choose a color:

1. Select a text or graphic object. If you do not select an object, the 
color will be applied to the next object you create.

2. Click one of the Color Selection boxes on the Title Tool tool bar: 

¥ Fill (Fill) applies the color to the selected object.

¥ Shadow (Shad) applies the color to the selected objectÕs 
shadow.

¥ Border (Bord) applies the color to the selected objectÕs outline 
or border.

3. The Title Tool Color Picker appears.

n You can drag the Color Picker from the tool bar to create a ßoating palette.

Color selection bar

Shade selection palette

Original Color window

New Color window

Gray-scale
selection bar

Eyedropper

Select to open
Macintosh Color Picker
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To choose a gray-scale 
value, choose a value 
from the gray-scale 
selection bar.

4. Choose a color:

¥ To choose from the Title Tool Color Picker, drag the cursor 
along the color selection bar to the color you want, and then 
move the cursor down into the shade selection palette to 
choose a shade. The color is applied when you release the 
mouse button.

¥ To use the eyedropper, drag the cursor to the eyedropper icon 
and release the mouse button. The cursor changes to the eye-
dropper. Click the color you want from anywhere in the win-
dow to apply the color to the selected object.

¥ To use the Macintosh Color Picker, drag the cursor to the 
round button icon under the eyedropper, and release the 
mouse button. The Macintosh Color Picker dialog box 
appears. For more information, see ÒUsing the Macintosh 
Color PickerÓ on page 105.

Blending Two Colors in an Object

You can blend the Þll 
and border but you can-
not blend a shadow.

The Avid Composer system lets you blend two colors in a text or 
graphic object, or in a border. You can also specify the direction of the 
blend.

To blend two colors:

1. Select text or another object.

2. Click the Color Selection box for either Þll or border.

The Color Blend tools appear. 
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3. Click one of the Color Blend Selection boxes and choose a color 
using either the Color Palette, the eyedropper, or the Color Picker.

4. Click the other Color Blend Selection box, and choose the second 
color for your blend.

The Blend Direction box appears below the two Color Blend selec-
tion boxes. This box displays the blend and allows you to specify 
the direction of the blend (for example, left to right).

5. Click and drag clockwise in the Blend Direction box or counter-
clockwise to achieve the effect you want. 

Color Selection boxes

Color Blend Selection boxes

Blend Direction box

Color blend 
tools apply a gra-
dient blend to the 
selected object.
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As you rotate the pointer, the position of the two colors rotates. 
The change takes effect as soon as you release the mouse button.

Adjusting the Transparency

After you select a color, you can select the color transparency. To do so, 
click the appropriate Transparency Level box, depending on whether 
the transparency will apply to an object, or adjust a shadow or outline 
around the selected object.

The Transparency Level box displays the text ÒHiÓ with a background 
that changes from black to white. A completely white background rep-
resents a fully transparent object or portion of an object. The following 
illustration shows an example:

In the pop-up control that appears, drag the slider until you attain the 
transparency you want, and then release the mouse button. The sys-
tem immediately applies the transparency to your selection. 

n You might Þnd it useful to turn off the shadow for an object while experiment-
ing with transparency. Set the shadow value to 0 in the Shadow Depth Depth 
text box described in ÒWorking with ShadowsÓ on page 183.

Transparency 
Level boxes

Transparency Blend Selection boxes

Blend Direction box
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Blending Transparency

You can blend the transparency of Þlls and borders by using a tech-
nique similar to blending colors. Use the Transparency Blend Selection 
boxes to set the blend values. Use the Blend Direction box to set the 
direction of the blend.

n For more information on creating a blend, see ÒBlending Two Colors in an 
ObjectÓ on page 179.

Transparency 
blend controls 
apply a gradient 
transparency to 
the selected 
object.
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Working with Shadows 

You can add a drop shadow or depth shadow to text and objects. A 
drop shadow is offset from the title itself, as though cast by a light 
source. A depth shadow extends from the edges of the title, as though 
the title were three-dimensional. The following illustration shows an 
example of drop and depth shadows.

You can also select the color, width, direction, and transparency for the 
shadow. You can place the shadow anywhere within the title without 
restriction. The following illustration shows the tools used to create 
and modify shadows:

Text with 
drop shadow

Text with 
depth shadow

Shadow Depth text box Drop and Depth Shadow button

Shadow Depth and Direction buttonShadow Color and Transparency boxes
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Applying Shadows

To apply shadows to objects:

1. Select text or an object.

2. Toggle the Drop and Depth Shadow button to select a drop or 
depth shadow.

3. Adjust the depth or direction of the shadow as follows:

¥ Click the Shadow Depth and Direction button and drag the 
shadow displayed to any position.

¥ Press the Shift key; then click and drag the shadow in the 
Shadow Depth and Direction button to restrict shadow place-
ment to 45-degree angles around the title.

¥ Press the Shift key and use the arrow keys to move the 
shadow to any position around the title.

¥ You can also type a value in the Shadow Depth text box to 
change the shadow depth by increments.

The Avid Composer system automatically orients the shadow to the 
selected object. You can continue to follow these procedures to adjust 
the shadow until you achieve the effect you want.

Adjusting Shadow Color and Transparency

Use the procedures described in ÒChoosing Colors and Setting Trans-
parencyÓ on page 177 to apply color and transparency to shadows.
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Manipulating Objects

This section describes how to manipulate objects after you have cre-
ated them. See ÒUsing the Selection ToolÓ on page 151 for a descrip-
tion of how to select objects.

Viewing Titles Full Frame

If you are working on an Avid Composer system with monitor resolu-
tion of 640 x 480 pixels, you can use the Full Frame command in the 
Object menu to get a better view of your title against the video or color 
background.

n If your monitor is set to a higher resolution, such as 1024 x 768, the Full 
Frame command does not appear in the Object menu.

To view a title full frame in a 640 x 480 display:

¥ Choose Full Frame from the Object menu to hide the tool bar and 
view the title full frame.

¥ Choose Full Frame again to return to normal view.

Basic Manipulation Operations

You can use commands from the Edit menu to manipulate objects.

To perform basic operations:

1. Select an object, such as text, a square, a rectangle, a circle, or an 
oval.

2. Perform one of the following:

¥ Choose Cut from the Edit menu to cut an object and move it to 
the Clipboard.
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¥ Choose Copy from the Edit menu to copy an object to the 
Clipboard.

¥ Choose Paste from the Edit menu to paste an object from the 
Clipboard to the same location as the object selected for the 
last Cut or Copy operation.

¥ Choose Select All from the Edit menu to select all objects.

¥ Choose Clear from the Edit menu to delete selected objects.

n You cannot delete locked objects. Unlock objects you want to delete.

¥ Choose Duplicate from the Edit menu to duplicate an object.

Layering Text and Objects

You can use commands on the upper portion of the Object menu to 
layer text and objects to create complex graphics. 

The last object created occupies the top layer, but you can move objects 
forward or backward within the screen area.

To adjust the layering of objects in a title:

1. Select an object with the Selection Tool.

2. Choose one of the following commands from the Object menu:

¥ Choose Bring To Front to bring an object to the top layer.

¥ Choose Send To Back to send an object to the bottom layer.
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¥ Choose Bring Forward to move an object forward one layer.

¥ Choose Send Backward to move an object back one layer.

Grouping and Ungrouping Objects

After creating a number of text and graphic objects, you can use com-
mands on the Object menu to group the objects and treat them as a sin-
gle object. 

Combining the objects into a group means that actions, such as mov-
ing or applying color, affect all objects in the group.

To group objects:

1. Shift-click multiple objects with the Selection Tool to select them.

2. Choose Group from the Object menu.

The selected objects are grouped together. Changes to any individ-
ual object in the group affect all objects in the group.

To ungroup objects:

1. Select a grouped object.

2. Choose UnGroup from the Object menu.

Everything in the group becomes an individual object that you can 
move or change separately.

Grouping commands
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Locking and Unlocking Objects

You can lock objects using commands on the Object menu so that 
changes to default settings, such as the font setting or object posi-
tion, do not affect the locked objects. 

You may also want to lock objects so that you do not inadvertently 
change them while working on other objects. You can lock an individ-
ual object or multiple objects.

To lock objects:

1. Select an object.

2. Choose Lock from the Object menu.

The object is locked and cannot be changed until you unlock it. 
When selected, the object displays hollow selection handles to 
indicate that it is locked.

Locking commands

Hollow object selection handles
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To unlock objects:

1.  Select a locked object.

2. Choose Unlock from the Object menu.

The object is unlocked and can be changed.

Aligning Objects

You can use the Alignment menu commands to align text and objects 
to each other and to the frame. Aligning to the frame refers to the safe 
title area. For information about the safe title area, see ÒSaving Titles 
and Title StylesÓ on page 192.

To align objects to the frame:

1. Select an object with the Selection Tool, or Shift-select multiple 
objects.

2. Choose a frame alignment direction from the upper portion of the 
Alignment menu.

The objects are aligned within the safe title area.

Frame alignment
commands
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To align objects to each other:

1. Shift-select or lasso more than one object with the Selection Tool.

2. Choose an object alignment direction from the Alignment menu.

n For information on aligning objects to a grid, see ÒDisplaying a GridÓ on 
page 155.

Distributing Objects

You can use Alignment menu commands to distribute text and graphic 
objects evenly across the safe title area. For information about the safe 
title area, see ÒSaving Titles and Title StylesÓ on page 192.

To distribute objects:

1. Shift-select at least three objects with the Selection Tool.

2. Choose a distribute command from the Alignment menu:

¥ Choose Distribute Left to Right to distribute the objects evenly 
from left to right across the safe title area.

Object alignment
commands
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¥ Choose Distribute Top to Bottom to distribute the objects 
evenly from top to bottom across the safe title area.

¥ Choose Distribute First to Last to distribute the objects evenly 
between the position of the Þrst object selected and the posi-
tion of the last object selected. This option is especially useful 
for aligning object diagonally, or for roughly positioning a 
group of objects and then lining them up without spreading 
them out to the edges of the safe title area.

Distribute
commands
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Saving Titles and Title Styles

After creating a new title, there are three basic ways to save your work:

¥ Save the title and exit the Title Tool.

¥ Save the title and continue creating additional titles based on the 
Þrst title.

¥ Save a title style that you can apply to titles you create in the 
future.

You can also reopen in the Title Tool a previously saved title and make 
further changes, as described in this section.

n After editing a title into a sequence and adjusting effect parameters, you can 
also save a Title Effect template that contains only the effect information 
(without title media), for applying to other previously created titles. For more 
information, see ÒSaving a Title Effect TemplateÓ on page 222.

Matching Resolutions

When you save a new title, you must choose an AVR for the title that is 
compatible with the project, based on the following:

¥ The rules regarding single-Þeld, two-Þeld, and multicamera AVRs 
apply to titles. In other words, you cannot mix single-Þeld AVR 
titles with two-Þeld AVR media in a sequence, and you cannot mix 
either single-Þeld or two-Þeld with m resolutions (multicamera 
resolution).

n For more information on available AVRs and mixing resolutions in a project, 
see the Avid Media Composer Products Reference.

¥ Your Avid Composer system uses the resolution information to 
compute the dimensions of the title.

¥ Even though DSK titles are uncompressed, if you decide during 
editing that you need to render the title to create a layered effect, 
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the title renders with the AVR you select when you Þrst save the 
title.

Using the Fast Save Option

You can use the Fast Save option to work more quickly when creating 
and saving multiple titles in a Title Tool session. Fast Save skips the 
steps that create anti-aliased images from title objects. Instead, just the 
raw title objects (text and graphics) are saved in the bin, with the preÞx 
Òunrendered.Ó Fast Save is ideal for working with multipage rolling or 
crawling titles with complex styles and shading.

n A title with the ÒunrenderedÓ preÞx cannot be displayed in the Source or 
Record monitors or edited into a sequence.

To use the Fast Save option, select the option Fast Save (unrendered) in 
the Save Title To Bin dialog box when saving the title.

For complete procedures for saving titles, see ÒSaving a Title and Exit-
ing the Title ToolÓ on page 194 or ÒSaving Multiple Titles in a Ses-
sionÓ on page 195.

n Fast Save remains in effect until you either deselect it, load a title that was 
saved without Fast Save selected, or exit the Title Tool.

To render a fast-saved title:

1. Press the Control key and double-click the title in the bin to load it 
into the Title Tool.

n If the Title Tool is already open, you can drag a Title Effect clip from the bin 
directly into the Title Tool window.

2. Choose Save Title As from the File menu.

3. Choose an AVR, target bin, and target disk for the title.

4. Deselect Fast Save, and click OK.
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Saving a Title and Exiting the Title Tool

To save the title and exit the Title Tool:

1. Choose Close from the File menu.

A dialog box appears, asking if you want to save the existing title.

2. Click Save. The Save Title To Bin dialog box appears.

3. Enter a title name to identify the title in the bin; then choose a bin, 
target disk, and AVR from the pop-up menus.

4. Select or deselect Fast Save, depending on your needs. For more 
information, see ÒUsing the Fast Save OptionÓ on page 193.

5. Click OK.

The Title Tool window closes, and the new title is loaded into the 
Source monitor. A two-minute Title Effect clip that corresponds to 
the new title appears in the bin.



195

Saving Multiple Titles in a Session

To save multiple titles:

1. Choose Save Title from the File menu. The Save Title To Bin dialog 
box appears.

2. Enter a title name to identify the title in the bin; then choose a bin, 
target disk, and AVR from the pop-up menus. 

3. Select or deselect the Fast Save option, depending on your needs. 
For information, see ÒUsing the Fast Save OptionÓ on page 193.

4. Click OK.

The new Title Effect clip appears in the bin.

5. Create another title.

6. Choose Save Title As from the File menu and repeat step 2 for each 
subsequent title that you create.

When you close the Title Tool, the last title created is loaded into 
the Source monitor.

n If you keep the same name for the title when you choose ÒSave Title As,Ò the 
system retains the Þrst clip and creates a new one with the same name plus a 
two-digit extension that adds incremental numbering for each revised title.
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Revising a Title in a Bin

If you want to revise a title that has not been edited into a sequence, 
you can reopen the title in the Title Tool directly from the bin. 

To revise a Title effect in a bin:

1. Press the Control key and double-click the Title Effect icon in the 
bin. The title opens in the Title Tool.

n If the Title Tool is already open, you can drag a Title Effect clip from the bin 
directly into the Title Tool window.

2. Edit the title using techniques described in Chapter 6.

3. Save the title using one of the following options:

¥ Save Title: To save the title with the same name and media 
parameters (AVR, target bin, and target disk), choose Save 
Title from the File menu.

The revised Title Effect clip replaces the previous clip in the 
bin. The clip also appears in the Source monitor. 

The Title Tool remains open. You can continue making addi-
tional titles, or choose Close from the File menu.

¥ Save Title As: To rename the title or change any of the media 
parameters (AVR, target bin, and target disk):

a. Choose Save Title As from the File menu.

The Save Title To Bin dialog box appears.

b. Rename the title or choose other options from the Bin, Target 
Disk, and Resolution pop-up menus.

n If you keep the same name for the title, the system retains the original Title 
Effect clip in the bin and creates a new clip with the same name plus a two-
digit extension that adds incremental numbering for each revision.
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c. Select or deselect the Fast Save option, depending on your 
needs. For more information, see ÒUsing the Fast Save 
OptionÓ on page 193.

d. Click OK to save the title and exit the Title Tool.

Saving Title Styles

As you begin to work with a title, you may set up some basic title 
parameters you will use again for other titles. You can save the follow-
ing style parameters in the form of a title style:

¥ Font, style, size, justiÞcation, kerning, and leading

¥ Fill color and transparency

¥ Shadow color, transparency, depth, direction, and type

¥ Border color, transparency, and width

The following illustration shows the two menus that allow you to 
choose and deÞne title styles.

To save title parameters to a Style sheet:

1. Choose the Selection Tool so that the cursor becomes an arrow.

2. Select the object that you want to use as a basis for the title style.

3. Click the triangle to the right of the Styles button.

A menu appears that allows you to choose either an existing title 
style name or Save As.

Save parameters to a Style sheet

Display and select Styles
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4. Choose Save As.

The Title Style Sheet dialog box appears. The following illustration 
shows an example.

5. Check the parameters that you want to include in the style. The 
Avid Composer system uses the values from the currently selected 
object or from the current defaults if no object is selected.

6. Enter a name in the text box, and click Done when you are ready 
to exit the dialog box and save the values.

Recalling a Title Style

After you have saved your title style, you can recall the style and use 
the attributes as the defaults in subsequent Title Tool sessions.

To recall title style attributes as the defaults for creating titles:

1. Click the Styles button to display the Styles tear-off menu.

Style Sheet 
Name text 
box
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The menu contains a scaled visual representation of each style.

2. Drag the cursor to the chosen style and release the mouse button.

3. The style attributes appear in the Title Tool tool bar.

Applying Title Styles to Text Objects

To apply a title style directly to text objects:

1. Select one or more text objects.

2. Click the Styles button to display the Styles tear-off menu.

3. Choose a title style.

Managing Title Styles

The Avid Composer system lists the available title styles in the Project 
window. Click Settings in the Project window as shown in the follow-
ing illustration:

Arrows on the right 
and left allow you to 
scroll back and forth.

Sample 
title styles
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¥ To delete a style, select the style in the Project window and press 
the Delete key or choose Delete from the Edit menu.

¥ To copy a style, select the style in the Project window and choose 
Duplicate from the Edit menu. 

¥ To rename a title style, either change the name in the Project win-
dow or perform a Save As operation as described in ÒSaving Title 
StylesÓ on page 197 and change the name in the Style Sheet Name 
text box.

Exporting a Title as a Graphics File

You can export a title in PICT Þle format.

1. Choose Export Title from the File menu. 

A dialog box appears.

2. Select the folder for the location where you want to export the Þle, 
enter a Þle name, and click Save.

The title is saved as a PICT Þle.
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CHAPTER 6

Editing with Titles

Editing with titles involves placing Title Effect clips in a sequence and 
then adjusting parameters or revising the title in the Title Tool. The fol-
lowing sections provide guidelines for editing with title media.

¥ Task Overview Ñ Editing with Titles

¥ Before You Begin

¥ Editing a Title into a Sequence

¥ Trimming the Duration of Rolling and Crawling Titles

¥ Removing Titles

¥ Replacing Titles

¥ Fading a Title

¥ Adjusting Title Effect Parameters

¥ Revising a Title in a Sequence

¥ Replacing Fill Tracks

¥ Rendering Titles

¥ Re-creating Title Media

¥ Promoting a 2D Title to 3D

¥ Troubleshooting Titles
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Task Overview — Editing with Titles

The following is an overview of the tasks you will perform to edit a 
title into a sequence:

¥ Edit the title into the sequence. You can load a title into the 
Source window or drag the Title Effect icon from the bin to a seg-
ment in the Timeline. Title effects play in real time, using the Avid 
Composer systemÕs downstream key (DSK) capabilities.

¥ Adjust the titleÕs parameters. With a title edited into a sequence, 
you can use the Effect Editor to alter the appearance or position of 
the title. You can also open the title again in the Title Tool at any 
time to revise the title elements.

¥ Revise the title. After editing the title and adjusting parameters, 
you can revise elements of the title in the Title Tool, or replace Þll 
tracks to create various effects.

These basic procedures are described throughout this chapter. For 
information on creating titles, see Chapter 5.
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Before You Begin

The following sections provide guidelines for working effectively with 
DSK titles, non-DSK titles, and title effect media.

Downstream Keying of Titles and Graphics

By default, all titles are created using the Avid Composer systemÕs 
DSK capabilities. Graphic elements imported with an alpha channel 
are also created as DSK clips. 

Downstream keying allows you to add uncompressed titles or graph-
ics over multiple streams of compressed media and continue to play 
the sequence in real time. The beneÞts of downstream keying include:

¥ High-quality lossless images. Because the DSK title or graphic is 
uncompressed, the image retains its full quality.

¥ Real-time adjustment of key frames and title parameters. When 
you adjust key frames or effect parameters for the DSK title effect, 
the title continues to play back in real time.

¥ Layering of titles over real-time or rendered effects. You can 
apply a DSK title over a rendered effect or a real-time effect such 
as a transition, and all effects continue to play back in real time.

¥ Smooth motion. Downstream keying uses subpixel placement for 
smooth motion in rolling or crawling titles. Subpixels are units 
smaller than pixels.

n To learn more about editing with DSK titles, see ÒRestrictions of Down-
stream Key TitlesÓ on page 204.
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Restrictions of Downstream Key Titles

The following are a few restrictions to keep in mind with DSK titles:

¥ Rolling or crawling titles are always DSK titles, unless you render 
them. You can convert a still DSK title to a non-DSK title. See 
ÒConverting Downstream Key TitlesÓ on page 205.

¥ You can play in real time only one DSK title at a time in a nested 
effect. The DSK title must be on the top layer of the nested tracks.

¥ Titles promoted to 3D are no longer DSK. Keep a copy of the origi-
nal title if you want to continue using the DSK version. For more 
information, see ÒPromoting a 2D Title to 3DÓ on page 228.

¥ DSK titles become non-DSK titles when you replace the Þll track. 
For more information, see ÒReplacing Fill TracksÓ on page 226.

¥ All DSK titles must be created within (or cropped to within) the 
safe title area to guarantee real-time playback.

¥ Rolling or crawling titles might jitter slightly at certain speeds. 
You can adjust the duration slightly to Þx the problem. See ÒTrim-
ming the Duration of Rolling and Crawling TitlesÓ on page 213.

If you experience an underrun error with a DSK title, do one or more 
of the following:

¥ Render the DSK or underlying effects.

¥ Slow the roll or crawl by extending the duration of the clip.

¥ Add Þller to separate DSK clips in the sequence.

¥ Store title and video media on separate disks, or use faster disks.
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Converting Downstream Key Titles

All newly created titles and graphics imported with alpha channel are 
DSK clips by default. You can convert static DSK titles and graphics to 
non-DSK titles and Matte Key effects. 

You might want to convert a DSK title to a non-DSK title in situations 
like the following:

¥ If you want to replace the Þll track with a graphic or video

¥ If you want to play two titles simultaneously. The top title can 
remain DSK, but the bottom title or titles must be non-DSK.

¥ If you want to resize a 2D Title effect.

¥ If you want to play a title that causes a ÒDSK image too largeÓ 
error message. For more information, see ÒTroubleshooting 
TitlesÓ on page 229.

c You cannot convert rolling or crawling titles to non-DSK. You can 
render them, as described in ÒRendering TitlesÓ on page 227.

To convert a DSK title to a non-DSK title:

1. Place the blue position indicator on the DSK title or graphic in the 
Timeline.

2. Click the Effect Mode button to open the Effect Editor.

3. Deselect the Downstream Key button.

The Downstream Key button changes from pink to gray and the 
effect is now a non-downstream key effect.

4. To re-enable the DSK capabilities, open the Effect Editor and select 
the Downstream Key button again.

c If you replace the Þll track of a non-DSK title, you cannot restore the 
DSK capabilities.
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Restrictions of Non-Downstream Key Titles

n DSK titles and non-DSK titles have different real-time playback capabilities 
during editing and adjustment of key-frame parameters. For more informa-
tion, see ÒPlayback Capabilities of DSK and Non-DSK TitlesÓ on 
page 207.

Depending on the complexity of the title and the video it is keyed over, 
not all non-DSK titles can be played in real time. When you attempt to 
play too complex a title, the following conditions might occur:

¥ Background video might jitter.

¥ Title might ßash.

¥ Title might display a gray slide.

¥ Video might shift left or right.

¥ Video might display a gray slide.

¥ Vista missed frame advance error might occur.

¥ Video underrun error might occur.

¥ Audio underrun error might occur.

If you encounter any of these conditions, try one or more of the 
following:

¥ Render the title or underlying effects.

¥ Simplify the title by removing text or drop shadows or by select-
ing different colors.

It is possible that a title with background video can be so complex that 
you can neither play it in real time nor render it.

It is also possible that you cannot play rendered titles because the 
resulting frames are too complex. You can control the complexity of 
titles by using the projectÕs Render settings. See ÒRendering TitlesÓ on 
page 227 for an explanation of the Render settings.
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Playback Capabilities of DSK and Non-DSK Titles

DSK titles and non-DSK titles behave differently in terms of real-time 
playback during editing and adjustment of effect parameters. The 
following table lists the different playback capabilities in different 
circumstances.

c All DSK titles must be cropped to within the safe title area to 
guarantee real-time playback. If you create a title that extends to 
the edges of the screen, for example, real-time playback cannot be 
guaranteed.

Table 6-1 DSK and Non-DSK Title Playback Capabilities

Operation DSK Title Playback Non-DSK Title Playback

Adjust foreground level parameter Real-time Real-time

Adjust scale parameters Not available Non-real-time

Adjust position (vertical, horizontal) Real-time Non-real-time

Adjust scroll position
(rolling and crawling titles only)

Real-time Not available

Adjust cropping Real-time Not available

Adjust top, bottom softness
(rolling titles only)

Real-time
(two-Þeld AVRs only)

Not available

Replace the alpha track Not available Real-time

Apply to a layer above a non-DSK title Real-time Non-real-time

Apply to a layer below a DSK title Non-real-time Real-time

Key over extremely complex images Real-time Non-real-time
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About Title Effect Clips

When a title is saved, the Avid Composer system creates a Title Effect 
clip and saves it in the selected bin. One media object, referred to as a 
precompute, has references to the RGB and alpha channel information. 
Every time you make a change to a title effect, the Avid Composer sys-
tem creates two additional media Þles. The original media Þles are left 
unchanged.

n By default, the bin display does not show rendered effects. You can view ren-
dered effects in the bin by choosing Set Bin Display from the Bin menu and 
selecting Rendered Effects. 

For more information, see ÒManaging Your Media FilesÓ on page 121.

Title Effect clip Rendered effect (precompute)

Media volume

RGB and alpha channel 
media files

Bin – Frame view

Rendered effect
(precompute)

Bin – Text view

Title Effect clip

Media volume

RGB and alpha channel 
media files
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Editing a Title into a Sequence

After preparing the sequence with a second track for the title, there are 
two basic methods for editing the title into place:

¥ Splice or overwrite method: Mark IN and OUT points in the 
sequence, and perform a splice or overwrite edit. See ÒSplicing or 
Overwriting a Title into a SequenceÓ on page 210.

¥ Drag and drop method: Use add edits to mark off a segment in 
the sequence, and drag the Title Effect clip from the bin to the seg-
ment in the Timeline using one of the Segment Mode buttons. See 
ÒDragging and Dropping a Title into a SequenceÓ on page 212.

About Setting Marks in Rolling and Crawling Titles

By default, a rolling or crawling title clip begins with the visible title 
just off screen. The clip ends just after the last element disappears off 
screen.

You can set IN and OUT marks in the Source monitor to change the 
start and Þnish points; that is, you might want the title to begin with a 
the screen full of text rather than start off screen. 

You can play and mark a title clip in the Source monitor by using stan-
dard procedures. For more information, see the Avid Media Composer 
UserÕs Guide or Avid Film Composer UserÕs Guide.

If you want to use the complete roll or crawl in the sequence, do not 
set marks. For information about adjusting the duration of the roll or 
crawl, see ÒTrimming the Duration of Rolling and Crawling TitlesÓ 
on page 213.
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Adding a Video Track

In most cases, you edit a title onto a second video track above the 
video that forms the background.

To add a second track:

1. If you have not already done so, load the sequence into the Record 
monitor.

2. Choose New Video Track from the Clip menu.

The system adds the next video track for the sequence to the Timeline. 
For example, if the sequence includes only V1, the system adds V2.

n If you apply a title directly to a video clip on the main video track (for exam-
ple, V1), the title replaces the video clip, and the titleÕs video background is 
replaced by a black background.

Splicing or Overwriting a Title into a Sequence

To splice or overwrite a title into a sequence:

1. If the title you created is not in the Source window, drag the Title 
Effect icon there from the bin.

n To replace the Title Effect icon in Frame mode temporarily with a frame from 
the title clip, click the Title Effect icon in the bin and press the Home key or 
End key on the keyboard. This feature is helpful if you have multiple titles in 
a bin.

2. Patch the title source to the video track in the sequence by clicking 
and dragging from the V1 source track to the V2 record track.

n You can use any three-point editing method to edit a title into a sequence. The 
steps below are just one editing method. Refer to the Avid Media Composer 
UserÕs Guide or the Avid Film Composer UserÕs Guide for other methods.
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3. In the Source window, set the mark IN point.

n You should set the mark IN position toward the middle of a still title clip, so 
you can trim the title, if necessary. For rolling or crawling titles, set no marks 
and place the position indicator at the beginning of the clip if you want to use 
the full roll or crawl. The Avid Composer system uses the position indicator to 
determine the IN point on rolling or crawling titles.

4. In the Record monitor, set the mark IN and mark OUT points.

5. Make sure the V1 record track is deselected in the Track Selector 
panel.

6. Click either the Splice-in or Overwrite button to edit the title into 
the sequence.

This adds the Title Effect segment to the top video track.

Overwrite buttonSplice-in button

Title Effect segment in the Timeline
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Dragging and Dropping a Title into a Sequence

To drag a title clip directly into the Timeline:

1. Place a mark IN in the sequence at the point you want the title to 
begin, and a mark OUT where you want it to end.

2. Click the red Lift/Overwrite button at the bottom of the Timeline 
window to enter Segment mode.

3. Click the Title Effect icon in the bin, and drag it to the marked seg-
ment and release.

The following illustration shows the title edited into the Timeline:

IN and OUT marksSegment Mode button
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Trimming the Duration of Rolling and Crawling Titles

When you edit the title clip into a marked segment of a sequence, the 
clip plays back from beginning to end regardless of the duration of the 
segment. In other words, the entire roll or crawl shrinks to Þt within 
the duration of the marked segment in the sequence.

Once the clip is edited into the sequence, you can trim the duration of 
the segment at any time, and the rolling or crawling title adjusts to Þt 
the new duration. 

Unlike trimming other segments, trimming a rolling or crawling title 
does not remove any part of the title contents. As a result, the duration 
of the title determines how fast it plays. For example, the shorter you 
trim the title, the faster it rolls or crawls.

n Rolling or crawling titles might jitter slightly at certain speeds. You can trim 
the duration slightly to Þx the problem.

To trim the duration of a rolling or crawling title:

1. Enable the track containing the title and disable all other tracks by 
using the Track Selector panel.

2. Click the Trim Mode button to enter Trim mode.

3. Select either the head or the tail of the title segment for trimming.

4. Trim the title segment to the duration you want by using standard 
trim procedures.

The entire roll or crawl plays back within the new duration.

c If you trim your rolling or crawling title very short, it scrolls very 
fast and canÕt display in real time; it must be rendered. The maxi-
mum speed it can scroll is one screen per second.
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Removing Titles

To remove the title segment:

1. Click either the yellow Extract/Splice-in button to extract the title 
and shorten the track accordingly, or the red Lift/Overwrite but-
ton to lift the title out and maintain the track duration.

2. Select the title segment and press the Delete key twice to delete the 
Title effect and its alpha channel media Þle.

To remove only the Title effect:

1. Click the Effect Mode button to open the Effect Editor.

2. Click the Title effect in the Timeline to select it.

3. Click the Remove Effect button either on the Fast menu or in the 
row of buttons below the Record monitor.

This removes the Title effect from the segment. The alpha channel 
media Þle remains.

n The Title Effect remains in the bin. To remove the Title Effect from the bin, 
select the effect in the bin and press the Delete key.

Replacing Titles

To replace a title in a sequence:

1. Click the red Lift/Overwrite button in the Timeline tool bar.

2. Click the Title segment currently in the sequence to select it.

3. Click the Mark Clip button to place an IN mark at the beginning of 
the Title segment and an OUT mark at the end of the segment.

4. Drag the new Title Effect clip from the bin to the marked segment 
and release.

The new title replaces the old title.
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Fading a Title

You can use the Fade Effect button to fade a title quickly and easily. A 
dialog box appears that allows you to enter the number of frames to 
fade up and fade down.

The Fade Effect feature automatically creates key frames for the title 
segment. You can access the key frames in the Effect Editor.

To fade a title:

1. Load the sequence if you havenÕt already done so.

2. To fade a single title, place the blue position indicator in the title 
segment.

To fade multiple titles in a sequence, click either the yellow 
Extract/Splice-in button or the red Lift/Overwrite button at the 
bottom of the Timeline window to enter Segment mode, hold 
down the Shift key, and click the desired title segments in the 
Timeline.

3. Click the Fade Effect button.

n You can map the Fade Effect button to the Record monitor or the User Com-
mand palette. For more information on mapping buttons, see the Avid Media 
Composer UserÕs Guide or the Avid Film Composer UserÕs Guide.

4. In the dialog box that appears, enter the number of frames to fade 
up and fade down, and click OK.
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This fades the selected title or titles. You can immediately view the 
Fade effect by playing the title segment.

Adjusting Title Effect Parameters

After editing a title into a sequence, you can open the Effect Editor and 
reÞne the title with full key-frame control over effect parameters such 
as Position, Scaling, Crop, and Softness for rolling and crawling titles.

n DSK titles and non-DSK titles have different playback capabilities when you 
adjust effect parameters. For more information, see ÒPlayback Capabilities 
of DSK and Non-DSK TitlesÓ on page 207.

To access the effect parameters for a Title effect:

1. Click the Effect Mode button.

The Effect Editor appears.

2. Click the title in the sequence to select it.

The Effect Editor displays the parameter controls.
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Using Title Key Frames

See the Avid Media 
Composer Products Refer-
ence for details about 
how many key frames 
you can set with your 
system conÞguration.

A key frame is a point in the titleÕs Timeline (or the Timeline of any 
effect) at which you can set parameters. You can use multiple key 
frames to gradually change a parameter over time. Key-frame indica-
tors appear in the effectÕs Timeline under the Record monitor. For 
more information, see ÒUsing Key FramesÓ on page 99.

Adjusting the Effect Profile

The ProÞle window in the Effect Editor is a graphical representation of 
the foreground level and acceleration applied to key frames:

¥ Foreground level affects the opacity of the Title effect. You can use 
the ProÞle graph to adjust level by selecting the appropriate key 

Rolling Title icon

Add Key Frame

Scroll Position slider

Horizontal position slider
(for a rolling title)

button

 Crop sliders

Effect Profile

Softness slider

 Acceleration slider

 Foreground slider
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frame in the effectÕs Timeline, and then clicking on the ProÞle key 
frame and dragging it up or down. For more information, see 
ÒAdjusting Foreground LevelÓ on page 218.

¥ Acceleration affects the rate of movement into and out of key 
frames. The greater the acceleration, the more rounded the line 
appears in the ProÞle window. For more information, see ÒAdjust-
ing AccelerationÓ on page 218.

Adjusting Foreground Level

Foreground level determines the opacity of the title at the selected key 
frame or key frames. You can change the overall transparency of the 
title itself, or you can change the transparency over time by adjusting 
levels for individual key frames.

Move the Foreground slider to change the transparency of the title. 

¥ The 0 setting is completely transparent.

¥ The 100 setting gives you fully opaque characters.

Adjusting Acceleration

Acceleration changes the speed of movement into and out of key 
frames. This is also known as ease in and ease out. Zero on the slider is 
no acceleration for linear transition parameters between key frames; 
100 maximizes ease in/out.

n Acceleration applies to every key frame in the same way. The last time you 
change this parameter determines the acceleration for all key frames in the 
sequence.

c Acceleration is not recommended for rolls or other DSK titles with 
vertical motion, due to anti-aliasing effects which cause ßicker.
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Adjusting Position

The horizontal position (H Pos) and vertical position (V Pos) sliders 
allow you to change the position of the title on screen. Rolling and 
crawling titles have additional scroll position (Scroll Position H or 
Scroll Position V) parameters.

If the position you determined when you created the title needs 
adjustment, you can change it here without revising the title itself:

¥ Move the V Pos or H Pos slider to adjust the position of the title on 
the screen.

¥ For rolling and crawling titles, you can also move the Scroll Posi-
tion slider to adjust your location in the title. 

¥ For rolling and crawling titles, you can change the scrolling direc-
tion with the Reverse button. Unlike clips of footage, title clips do 
not play smoothly when you press the J key or click the Play 
Reverse button. Click Reverse to change scrolling direction.

c If you select all key frames when changing the scroll position on a 
rolling or crawling title, all key frames will be set to that position 
and the title will no longer move. Make sure you select the appropri-
ate key frames.

Cropping Titles

Move the following Crop sliders to adjust the cropping of your title:

¥ T Ð Top

¥ B Ð Bottom

¥ L Ð Left

¥ R Ð Right

For rolling and crawling titles, cropping produces two different effects 
depending upon whether you crop parallel to or perpendicular to the 
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motion of the title. These two types of crops are refered to as source 
and destination crops:

¥ Source cropping a rolling or crawling title trims the title itself 
regardless of where the title appears on the screen. This is similar 
to cropping a still title, and occurs when you crop the title parallel 
to the direction of the motion.

Source cropping does not move the location of the title. Cropping 
titles parallel to the scroll direction is a source crop. For example, if 
you set the left Crop slider of a rolling title to 30, you trim the left 
boundary of the title toward the center by 30 points.

Figure 6-1 Source Cropping for a Rolling Title

n Because the title comes out of the Title Tool already cropped in size fairly close 
to the text, using a source crop might begin to cut the title itself.

¥ Destination cropping changes the size of the window the title 
appears in. Destination cropping occurs when you crop perpen-

Parallel to
the scrolling
direction

Left Source crop Right Source crop



221

dicular to the direction of the motion (across the scroll direction). 
For example, if you set the top Crop slider of a rolling title to 30, 
you shorten the size of the window the title rolls through.

Figure 6-2 Destination Cropping for a Rolling Title

Rolling and crawling titles have opposite destination and source crop 
effects, as Table 6-2 shows. Keep in mind that destination cropping 
takes place across the scroll direction.

Top Destination crop

Bottom Destination crop

Across the scrolling direction

Table 6-2 Destination and Source Cropping

Title Type Left Right Top Bottom

Rolling Source Source Destination Destination

Crawling Destination Destination Source Source
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Softening Edges on Rolling Titles

You can soften the top and bottom edges of rolling titles so that the 
title does not enter the screen abruptly from the top and bottom of the 
screen, but appears out of regions of gradual transparency. This fea-
ture is available only for two-Þeld resolutions (AVRs 70 to 77 and 
AVR 12).

¥ Move the Soft slider to adjust the level of softness.

The numbers represent the number of lines of pixels to fade in and 
out at the top and bottom of the rolling title. Zero leaves the title 
unsoftened. The maximum number of lines of pixels you can 
soften a title with is 255.

Softening applies equally to both the top and bottom of the rolling 
title.

n You cannot soften crawling titles.

Saving a Title Effect Template

If you edited a Title effect into a sequence and applied changes using 
the Effect Editor, you can save the both the Title effect and the parame-
ters to a bin for use in other sequences or projects. You can also save 
just the parameters without the title media, and apply the parameters 
to an entirely different title. This allows you to store standard title 
moves and effects that you use often.

To save the Title effect and parameters in a bin:

1. Open a bin where you want to store the Title Effect template.

2. Load the sequence containing the title into the Record monitor.

3. Click the Effect Mode button to open the Effect Editor.

4. Click the Title effect in the sequence to select it.

5. Drag the Title Effect icon from the Effect Editor to the desired bin.
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To save just the Title Effect parameters without the title media, 
press the Option key and drag the Title Effect icon from the Effect 
Editor to the bin.

n For more information on using effect templates, see ÒUsing an Effect Tem-
plateÓ on page 112.

Revising a Title in a Sequence

If you want to revise a title after you have edited it into a sequence and 
adjusted parameters with the Effect Editor, you can reopen the title in 
the Title Tool directly from the sequence.

c If you have already edited a title into a sequence, or have made 
adjustments to the effect parameters for that title, you must revise 
the title in the sequence (not the Title Effect clip in the bin).

To change a title in a sequence:

1. Click the Effect Mode button. 

The Effect Editor appears.

2. Select the Title effect in the sequence.

3. Click the Other Options button on the Effect Editor.

The Title Tool appears. 

Title Effect icon

Other Options button
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4. Edit the title using techniques described in Chapter 5.

5. Save the title using one of the following options:

¥ Save Title: To save the title with the same name (numbered 
incrementally) and media parameters (AVR, target bin, and 
target disk):

a. Choose Save Title from the File menu.

A dialog box appears.

b. Click Save.

The Title Tool closes, and the revised Title Effect clip replaces 
the previous clip in the sequence. The new clip also appears in 
the bin and the Source monitor, with the name of the previous 
clip plus a two-digit extension that adds incremental number-
ing for each revised title. The previous Title Effect clip is pre-
served in the bin.

¥ Save Title As: To rename the title or change any of the media 
parameters (AVR, target bin, and target disk):

a. Choose Save Title As from the File menu.

The Save Title To Bin dialog box appears.
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b. Rename the title or choose other options from the Bin, Target 
Disk, and Resolution pop-up menus.

n You cannot select Fast Save when revising a title in a sequence.

c. Click OK to save the title and exit the Title Tool.

The Title Tool closes, and the revised Title Effect clip replaces 
the previous clip in the sequence. The new clip also appears in 
the bin and the Source monitor with the new name. The previ-
ous Title Effect clip is preserved in the bin.
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Replacing Fill Tracks

All newly created titles and graphics imported with alpha channel are 
DSK clips by default. When you replace the Þll track with a graphic or 
video, the title is converted automatically to a non-DSK title. 

c After replacing the Þll track, you cannot restore the DSK capabilities 
of a title.

n You cannot replace the Þll track on a rolling or crawling title.

To replace the Þll track:

1. Click the Step In button on the Timeline tool bar to step into the 
effect.

2. Load the video you would like to use as replacement Þller into the 
Source monitor.

3. Drag the source track selector button to the Þller track selector but-
ton in the Track Selector panel to patch the new source video to the 
title Þll track.

4. Using standard editing methods, edit the video from the Source 
monitor onto the Þll track.

An alert box appears, warning you that the DSK capabilities of the 
title will be disabled.

5. Click OK to replace the Þll track and convert the title to a non-DSK 
title; or, click Cancel to cancel the operation and retain the DSK 
capabilities of the title.
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Rendering Titles

The following are a few situations in which you might want to render 
titles:

¥ If you want to layer DSK rolling or crawling titles in a sequence

¥ If you want to layer multiple effects, particularly more than one 
layer of DSK titles

¥ If you want to place other effects over a DSK title

¥ If you encounter an alert box with a message about audio or video 
underrun when playing a complex layered effect

For more information on rendering title effects, see ÒRendering an 
EffectÓ on page 116.

Re-creating Title Media

You can use the Recreate Title Media command to regenerate media 
that is ofßine, or to change the Avid Video Resolution (AVR) of the 
title. If you have batch digitized a sequence at a resolution different 
from the resolution at which the sequence was originally created, for 
example, you can use this command to re-create the titles at the new 
resolution.

c The Recreate Title Media command removes any nested edits made 
inside a title, replacing the edits with the new titleÕs graphic and 
alpha tracks.

To re-create title media:

1. (Option) If you want to re-create title media in a different resolu-
tion, choose Compression from the Tools menu, and choose the 
AVR you would like to use for the re-created title media.

2. Load the sequence containing the titles into the Record monitor.
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3. Mark the IN and OUT points in the sequence surrounding all the 
titles that you want to re-create.

4. Select the tracks where the title or titles are located.

5. Choose Recreate Title Media from the Clip menu.

Promoting a 2D Title to 3D

If your system is equipped with 3D effect capabilities, you can pro-
mote a Title effect to 3D to create additional effects with the title. For 
more information, see ÒPromoting 2D Effects to 3D EffectsÓ on 
page 331.
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Troubleshooting Titles

This section describes several errors that might occur when working 
with Title effects, and includes recommendations for resolving the 
problems.

No Title and Video Background Display

If the Title Tool is unable to display the title and the video background, 
increase the Avid Composer systemÕs application memory allocation, 
as follows:

1. Quit the Avid Composer and go to the Macintosh Finder.

2. Click the Avid Composer application icon to select it.

3. Choose Get Info from the File menu.

4. Type larger numbers in the application Memory Requirements. 
The Minimum Size should be 12,000 K and the Preferred Size 
should be 32,000 K.

5. Click the close box to leave the Get Info window.

6. Open the Avid Composer application.

The next time you open the Avid Composer application, it will use the 
Preferred Size, if available. If it is not available, the Avid Composer 
system will take as much memory as possible. If less than the Mini-
mum Size is available, an error message appears.
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Downstream Key Error Messages

When you edit with DSK titles or graphics, you might experience an 
underrun error message or an Òimage too largeÓ error message. Table 
6-3 describes the causes and possible solutions for these problems.

Table 6-3 Downstream Key Errors and Solutions

Error Problem Possible Cause Possible Solutions

DSK underrun error The graphic key 
could not be 
loaded in time.

InsufÞcient disk 
speed, or the title is 
rolling or crawling 
too fast, or a series of 
DSK graphics are too 
close together.

Render the DSK clip and underlying 
video.

Slow down the rolling or crawling 
title.

Store the DSK clip media on a drive 
other than the drive containing the 
underlying media.

Add Þller between sequential DSK 
clips.

(Crawl only) Decrease the visible 
graphic height by cropping or by 
revising the title in the Title Tool.

Use faster drives.

DSK image too 
large

A moving title 
does not play 
correctly.

The system has limita-
tions that restrict the 
size of the graphic to 
the safe title area of the 
screen.

Crop the title to fall within the safe 
title area.

Soften the top and bottom of a rolling 
title to fall within the safe title area.

Revise the title in the Title Tool to fall 
within the safe title area.

If appropriate, eliminate the motion 
of the title.

Reduce the Record monitor video size 
by using the enlarge/reduce button.

Render the Title effect.
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Wrong Title Format

If you see the following image in a monitor, it means that the resolu-
tion of the Title effect is not compatible with the resolution of video 
clips used in the sequence. You will have to determine the resolution 
of the video clip. Then, you must regenerate the title at the same reso-
lution as the video clip.

To determine the AVR of the current video clip:

1. Load a sequence with the title that has the wrong format into the 
Record monitor.

2. In Source/Record mode, click the track selector in the Timeline for 
the track on which video appears.

3. Place the blue position indicator on a video clip in the Timeline.

4. Hold the Option key, and click the Find Bin.

The video source clip is highlighted in the bin.

5. Select bin Text view. The video source clipÕs AVR appears in the 
Video column.

To correct a titleÕs AVR to match the AVR used in the video clips in the 
sequence, use the procedure described in ÒRe-creating Title MediaÓ 
on page 227.
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CHAPTER 7

Intraframe Editing

This chapter describes the Intraframeª Editing option. This option 
includes the Paint effect and the AniMatteª effect. The Paint effect 
and the AniMatte effect share many of the same concepts, which are 
introduced in the following sections.

¥ Editing with Intraframe Capability

¥ Using an Optional Pen Tool

¥ Editing with Single-Field Step

¥ Rendering Intraframe Effects

¥ Applying the Paint Effect to a Sequence

¥ Applying an AniMatte Effect to a Sequence

¥ Working with the Intraframe Editing Interface

¥ Using Effect Templates with the Intraframe Effects

¥ Working with Intraframe Editing Parameters

¥ Working with Vector-Based Objects

¥ Using the Paint Tools

¥ Moving and Manipulating Painted Objects and Mattes
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Editing with Intraframe Capability

While many of the tools and parameters are the same for the Paint 
effect and the AniMatte effect, the result of applying each effect is dif-
ferent. The Paint effect enables you to paint an object directly on an 
individual frame or series of frames (a segment of a sequence or subse-
quence). The AniMatte effect enables you to draw a matte on one or 
more frames to create multilayer matte keys and single-layer organic 
matte wipes. 

With Intraframe editing, you can remove and edit defects, such as 
dropouts and scratches, that appeared on the original source video-
tape or Þlm footage. Intraframe editing frees you from having to 
export images from the Avid Composer system, edit them in third-
party applications, and import them back into the system.

Intraframe editing offers many creative possibilities. On individual 
frames, you can draw various shapes, paint brushstrokes, and create 
freehand objects or mattes, which you can reshape, rescale, move, and 
adjust the color values of to meet your needs.

For more information, 
see ÒWorking with Vec-
tor-Based ObjectsÓ on 
page 255.

When you use the Intraframe Editing tools, the Avid Composer system 
draws vector-based objects on the screen. Vector-based objects are 
composed of mathematically described lines and Bezier curves. You 
can edit the lines, curves, and other attributes of vector-based graphics 
with greater control and efÞciency than you can with bitmapped 
objects, which are drawn on the screen as a pattern of dots, or pixels. 

Additionally, any changes you make to a Paint or AniMatte effect is 
not limited to an individual frame. Instead, any object you paint and 
any changes you make to it appear for the duration of the entire seg-
ment or clip. In most cases, you can change the parameters of the effect 
between key frames.
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Using an Optional Pen Tool

The Avid Composer system supports the addition of a pen tool and 
graphics tablet for use with the Intraframe Editing option. For installa-
tion and conÞguration instructions, see the documentation that ships 
with your pen tool and tablet.

Editing with Single-Field Step

To locate defects on individual Þelds of a frame for correction with the 
Paint and AniMatte effects, use the single-Þeld step feature. For infor-
mation on using single-Þeld step, see ÒUsing Single-Field StepÓ on 
page 76.

Rendering Intraframe Effects

When you paint an object or draw a matte on a single frame in a 
sequence, the Avid Composer system applies the effect to the entire 
segment. While working in Effect mode, you can see the object as you 
step through each frame in the segment. To view the painted object in 
Source/Record mode, enable Render-On-The-Fly in the Special menu. 

You also can use the Play Preview function to see an off-speed preview 
of a Paint effect while you are working in Effect mode. For more infor-
mation, see ÒEffect Editor ButtonsÓ on page 91.

Intraframe effects are not real-time effects. When you have Þnished 
painting or drawing a matte on a segment, you must render the effect 
to play it in real time. Regardless of how many objects you add to an 
individual segment, the Avid Composer system plays back the effect 
as a single stream of video.
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Rendering Paint Effects

Painted objects are rendered to the screen starting with the bottom 
layer (closest to the video background). Keep this concept in mind as 
you use different paint modes in combination and layer painted 
objects to generate new effects in a sequence. You also can combine the 
Paint effect with AniMatte effect to create custom effects.

Rendering AniMatte Effects

A multitrack AniMatte effect is rendered to the screen starting with the 
top video track (farthest from the video background and appearing 
closest to you in three-dimensional space). For example, if the video 
background is on V1, and the AniMatte effect is applied to V2, the sys-
tem renders the effect starting with the image on V2. 

However, if you draw multiple mattes in the same segment, these 
mattes are all objects that appear in the same foreground space; they 
interact with each other much like multiple painted objects do in the 
same segment. For more information, see ÒLayering Objects and 
Matte KeysÓ on page 287.

Keep these concepts in mind as you use different key modes in combi-
nation and layer them to generate new effects in a sequence. You also 
can combine the AniMatte effect with the Paint effect to create custom 
effects.

Applying the Paint Effect to a Sequence

A Paint effect is a 
segment effect only. You 
cannot apply a Paint 
effect to a transition in a 
sequence.

You access the Paint effect by clicking the Paint Effect icon from the 
Image category in the Effect Palette and dragging it to a segment in a 
sequence. 



236

To apply a Paint effect to a sequence:

1. Load a sequence into the Record monitor.

2. Open the Effect Palette by choosing Effect Palette from the Tools 
menu.

3. Click the Image category.

4. Click the Paint Effect icon and drag it to a segment in the 
sequence, and release the mouse button.

5. Enter Effect mode by clicking the Effect Mode button.

The Effect Editor appears with the default Paint effect settings.

Applying an AniMatte Effect to a Sequence

You can apply an AniMatte effect to segments and transitions in a 
sequence. Which method you choose depends on the effect you are 
trying to create. 

For information on 
creating keys and 
wipes, see Chapter 4.

When you are working with multiple tracks of video, you can apply 
the AniMatte effect as a segment effect to key in or key out selected 
areas of an image or to build an organic matte wipe. You also can 
apply the AniMatte effect to a transition to create a wipe between two 
adjacent shots in the same video track (single stream of video).

The AniMatte effect is accessible through the Key category in the Effect 
Palette. 

To apply an AniMatte effect to a sequence:

1. Load a sequence into the Record monitor.

2. Open the Effect Palette by choosing Effect Palette from the Tools 
menu.

3. Click the Key category.
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4. Click the AniMatte Effect icon and drag it to a segment or transi-
tion in the sequence, and release the mouse button.

5. Enter Effect mode by clicking the Effect Mode button.

The Effect Editor appears with the default AniMatte settings.

Working with the Intraframe Editing Interface

Most of the functions that you need to create and apply Þnishing 
touches to the Intraframe effects appear in the Effect Editor. Menu 
options also provide another method of accessing some of these func-
tions. For more information on working with the Effect Editor, see 
ÒUsing the Effect EditorÓ on page 90.

When you apply a Paint or AniMatte effect to a segment and enter 
Effect mode, the Effect Editor appears. The cursor is an arrow when 
you select tools and options from the Effect Editor. When you select a 
paint or editing tool and position the cursor over the Record monitor, 
the cursor becomes a crosshair. The crosshair indicates that you can 
begin to paint or draw a matte on the frame.

n After you use the Rectangle, Oval, Polygon, and Curve Tools, the 
Avid Composer system reverts to the Selection Tool, and the cursor becomes 
an arrow. After you use the Brush Tool, it remains the active tool, and the cur-
sor remains a crosshair.

The painting and editing tools enable you to paint shapes or draw 
mattes, quick masks, and other vector-based objects on frames in a 
sequence. When you apply an Intraframe effect, the object or matte 
appears for the duration of the entire segment. 

The Effect Editor also includes tools for manipulating painted objects 
and mattes, playback buttons, and collapsible panes. Each collapsible 
pane contains a category of parameters you can use to modify the 
appearance of an Intraframe effect. To open an effect category, click the 
triangle next to the category name or double-click the category name.
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Using the Effect Editor with the Paint Effect

The following illustration identiÞes the different sections of the Effect 
Editor that are available when you apply a Paint effect to a segment 
and enter Effect mode.

Painting and Editing Tool

Bring Forward and Send
Backward buttons

Reshape Tool button

Z-Rotation Tool button

Selection Tool button

Reduce and Enlarge

Play Loop button

Dual Split button

Brush Template

Brush Preview

buttons

Add Key Frame
button

Render Effect
button

Outline/Path

Grid button

Transition Effect Alignment

Transition Effect Duration

Effect parameter

 Play Preview
 button

Previsualization Marker Tool
button for film projects

window

Grid parameter
category for film

categories buttons

buttons

button

projects
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Table 7-1 brießy describes the functions of the Effect Editor for the 
Paint effect.

Table 7-1 Intraframe Editing Elements 

Tool Description

Effect parameter categories Enable you to change the parameters of an effect.

Brush Template buttons Change the shape of the brush.

Brush Preview window Displays the brush head with the parameters you have selected, such as 
color, softness, and shape. You also can use the window to reshape the 
brush head by dragging its control points.

Grid parameter category In Þlm projects only, provides localized control of the Effect Grid parame-
ters and access to the GridSettings dialog box.

Add Key Frame button Adds a key frame to an effect at the location of the position indicator in the 
effectÕs Timeline.

Play Preview button Plays back a preview of an unrendered effect in the Record monitor.

Render Effect button Renders effects on selected tracks at the location of the position indicator in 
the effectÕs Timeline.

Outline/Path button Displays wire-frame representations of effects in a sequence. Illustrates the 
movement of an effect from the Þrst key frame through the last key frame.

Grid button Displays a grid for precise placement of effects in the image and for the 
snap-to-grid function.

Transition Effect 
Alignment

Enables you to choose whether a transition effect starts, ends, or is centered 
on a cut; not applicable to the Paint effect.

Transition Effect Duration Enables you to enter the length of a transition in seconds and frames; not 
applicable to the Paint effect.

Painting and Editing Tools Enable you to paint shapes or draw mattes on frames in a sequence with 
freehand capability or with preset shapes.
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Using the Effect Editor with the AniMatte Effect

The following illustration shows the Effect Editor as it appears when 
you apply an AniMatte effect to a segment in a video project and enter 
Effect mode.

Previsualization Marker 
Tool

In Þlm projects only, enables you to add markers that track the path of an 
effect based on the coordinates provided when you activate the Grid.

Bring Forward and Send 
Backward buttons

Brings a painted object one layer forward on the screen or sends an object 
one layer backward on the screen. With the Option key pressed, brings a 
painted object to the front or sends an object to the back.

Reshape Tool button Reshapes objects by manipulating anchor points at locations where new 
curves begin or straight lines intersect. Inserts additional control points.

Z-Rotation Tool button Rotates an object around the Z axis.

Selection Tool button Selects an object so you can change its parameters, move it, or delete it. 
With the Shift key pressed, selects multiple objects. 

Reduce and Enlarge 
buttons

Reduces or enlarges the screen.

Dual Split button Splits the screen in half to show the image with and without effects applied 
to it.

Play Loop button Plays back a transition or a segment effect in Effect mode.

Table 7-1 Intraframe Editing Elements (Continued)

Tool Description
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When you are working with an AniMatte effect, the categories that are 
available in the Effect Editor are the same as those for the Paint effect 
with the following exceptions:

¥ The Reverse option in the Foreground category enables you to 
swap the foreground and background video images for matte keys 
composed of multiple video tracks. When you are building a 
single-track wipe, the Reverse button enables you to swap the 
incoming and outgoing segments in the sequence.

¥ With the AniMatte effect, you use Magic Mask to choose a key 
color when you create a matte. (With the Paint effect, you use 
Magic Mask or the Color category to make color selections.)

Foreground category

Magic Mask category
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Using Effect Templates with the Intraframe Effects

As you can do with many other effects, you can save a template of a 
Paint or AniMatte effect and apply it to other video segments in a 
sequence at a later time. For more information on saving and applying 
an effect template, see ÒUsing an Effect TemplateÓ on page 112.

Working with Intraframe Editing Parameters

The outcome of applying a Paint effect to a sequence is different from 
the result of applying an AniMatte effect to a sequence. However, 
many of the parameters available to both effects function similarly. 
The following sections describe how to work with the parameters that 
are common to both the Paint effect and the AniMatte effect.

n For information on working with parameters speciÞc to the Paint and 
AniMatte effects, see Chapter 8.

Using the Selection Tool

The Selection Tool is one of the most frequently used tools. You use 
this tool to select a painted object or matte on the screen when you 
want to make changes to it. After you select an object, you can move it 
in the frame, rescale it, and change its parameters.

To select an object, choose the Selection Tool and click an object. Selec-
tion handles appear around the object. 

To select multiple objects, Shift-click the additional objects with the 
Selection Tool, or click and drag the cursor to draw a lasso around the 
objects. When you select multiple objects, one set of selection handles 
appears around all the objects, which enables you to move, rescale, or 
otherwise change the parameters of all the selected objects simulta-
neously.
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n When a segment contains multiple objects, you can change your selection 
from one object to another by clicking one of the following buttons: Fast For-
ward, Rewind, Go to Next, or Go to Previous. To use these buttons in Effect 
mode, you must map them to your keyboard. For more information on these 
buttons, see the Avid Media Composer and Film Composer Quick Reference.

Global and Key-Frame Parameters

The Paint effect is divided into two logical groups:

¥ Global parameters that apply to all key frames

¥ Key-frame parameters that can change on an individual key-frame 
basis

Global Parameters

Global parameters cannot change between key frames. When you 
change one of these parameters, the Avid Composer system automati-
cally sets the value for all key frames in the segment. 
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The following global parameters cannot change between key frames:

¥ Acceleration

¥ Paint Modes

¥ Layering 

¥ Lock and Unlock

¥ Group and Ungroup

Key-Frame Parameters

All the effects in this category can change between key frames. This 
category includes the remainder of the Paint effect parameters, 
including:

¥ Opacity (in Mode category)

¥ Feathering (all parameters in category)

¥ Magic Mask (all parameters in category)

¥ Color (all parameters in category)

¥ Brush (all parameters in category)

¥ Z-Rotation

¥ Scaling (size)

¥ Shape of the object

¥ Position of the effect in the frame or relative to the frame

Opacity

Opacity, which appears in the Mode category, refers to the transpar-
ency level of:

¥ A painted object created with the Paint effect

¥ The image within the border of a matte or wipe created with the 
AniMatte effect
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You can adjust the level of opacity for individual key frames in a seg-
ment. When you establish different values of opacity for adjacent key 
frames, the opacity level is interpolated from the Þrst key frame to the 
next key frame in the segment.

For the Paint effect, a level of 0 makes a painted object completely 
transparent; a level of 50 makes an object 50 percent transparent; and a 
level of 100 makes an object opaque.

For the AniMatte effect, a level of 0 makes a keyed image completely 
transparent; a level of 50 makes a keyed image 50 percent transparent; 
and a level of 100 makes a keyed image opaque.

For example, if you create a matte that keys out a rectangular portion 
of a segment on V2, the image on V1 defaults to 100 percent opacity 
(opaque) and appears in the matte key without any traces of the image 
on V2. If you adjusted the opacity to 50, the image on V1 would be 
blended with the image on V2. Adjusting the opacity to 0 would make 
the image on V1 completely transparent and show only the image 
from V2 within the borders of the matte.

To adjust the opacity, do one of the following:

¥ Drag the Opac. slider to attain the desired value.

¥ Click the Opac. slider, and use the keyboard to enter a value 
from 0 to 100.

Object Visibility

The Object Visible button in the Mode parameter pane enables you to 
add a key frame to a segment or transition and have a painted object 
or matte suddenly ÒpopÓ onto the screen at the position marked by the 
key frame. You must have at least three key frames for an Intraframe 
effect to create this effect. 
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To pop a painted object or matte key onto the screen:

1. Paint an object with the Paint effect or draw a matte with the 
AniMatte effect on a segment or transition.

2. Select the object with the Selection Tool.

3. Drag the position indicator to the position in the effectÕs Timeline 
where you want the object to pop onto the screen, and click the 
Add Key Frame button.

n There must be at least one more key frame in the segment or transition follow-
ing the one you created in step 3.

4. Click the Object Visible button if it is not selected already.

5. Click the previous key frame to select that key frame, and then 
deselect the Object Visible button.

6. Repeat steps 1 to 5 for each object you want to pop onto the screen.

n You can perform this procedure on different objects, or mattes in a segment or 
transition, to create an effect in which the objects or mattes pop onto the 
screen at the intervals and positions you determine.

Feathering

Feathering adds soft edges to a painted object or a matte key. Adding a 
soft edge can make a composited object look more natural against the 
background. Feathering softens edges by diffusing the border of the 
object by the pixel width you want.
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To adjust the feathering:

1. Select an object or matte with the Selection Tool. 

If you do not select an object, the feathering values will be applied 
to the next object you create.

2. Click the triangle next to Feathering if the Feathering category is 
not open.

3. Adjust the Bias, Anti-alias, and Horizontal and Vertical parame-
ters as described in the following sections. 

Bias

The Bias slider in the Feathering category increases control over the 
dissipation of pixels around the edges of a painted object or matte. 
When you are applying a Paint effect, adjusting bias is especially effec-
tive when you trace an element on the screen.

A Bias setting of 0 feathers pixels starting at the outside edge; a setting 
of 50 starts feathering at the center portion of the edge; and a setting of 
100 starts feathering at the inner portion of the edge. The default set-
ting for Bias is 50.

To adjust the Bias, do one of the following:

¥ Drag the Bias slider to attain the desired value.

¥ Click the Bias slider, and use the keyboard to enter a number 
from 0 to 100.
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Horizontal and Vertical Parameters

The Hor and Vert sliders enable you to choose the dominant direction 
in which feathering of an object or matte appears. 

Increasing the Horizontal parameter extends feathering in both the 
positive and negative directions along the X axis (right to left and left 
to right on the screen). The minimum horizontal value is 0 pixels; 
maximum horizontal feathering is achieved by choosing a value of 
255 pixels.

Increasing the Vertical parameter extends feathering in both the posi-
tive and negative directions along the Y axis (upward and downward 
on the screen). The minimum vertical value is 0 pixels; maximum 
feathering is achieved by choosing a value of 255 pixels.

To adjust the Hor or Vert sliders:

¥ Drag either the Hor or Vert slider to attain the desired value.

¥ Click either the Hor or Vert slider, and use the keyboard to 
enter a number from 0 to 255.

Fixed Aspect

The Fixed Aspect parameter gangs the Hor and Vert sliders together. 
When you drag one of the sliders, the other slider moves in unison. 
The Fixed Aspect button toggles the option on or off.

n When you enable the Fixed Aspect option, horizontal is the dominant value.

Anti-Aliasing

You also can select Anti-alias in the Feathering category, which 
decreases the jagged appearance of an objectÕs borders. Anti-aliasing 
smooths the objectÕs edges and can improve its image quality. You can 
use anti-aliasing in combination with feathering. The Anti-alias button 
toggles the option on or off.
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Acceleration

Acceleration adjusts the effectÕs speed over time by having the effect 
ease in and ease out. This gives the effect a more natural appearance. 
The Acceleration parameter applies to the entire effect, not to speciÞc 
key frames. For more information on adjusting the Acceleration, see 
ÒAdjusting the AccelerationÓ on page 110.

Brush

The Brush parameters enable you to deÞne the shape, size, and soft-
ness of the brush for creating brushstrokes on an image. Additionally, 
you can customize the shape and rotate the head of the Brush Tool to 
create a variety of new effects. 

n The parameters in the Brush category apply only to the Brush Tool.

The Brush category includes Path, Soft, and Size sliders, a Spin slider 
for adjusting the rotation of the brush head, templates for preset brush 
head shapes, and a Brush Preview window for previewing the custom 
brush head you create. You can apply the parameters described in this 
section in any order you like.
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Path

The Path slider controls the percentage of paint or the matte that is vis-
ible from the initial point of pressure to the completion of the brush-
stroke. Path values range from 0 (no paint visible) to 100 (opaque). 

n As you paint on a segment, the object always appears opaque. Unlike other 
Paint Effect parameters, you adjust Path after you have Þnished painting.

Using Path to Create a Signature Effect

The Path parameter is useful for creating a ÒsignatureÓ effect with the 
Paint effect, in which a signature gradually appears on the screen as if 
written with an invisible pen.

To create the signature effect:

1. Apply the Paint effect to a segment.

2. Click the Brush Tool button if the brush is not already active.

3. Choose Solid from the Mode Fast menu.

4. Click and drag the cursor on the Record monitor to paint a signa-
ture or other string of text.

5. Release the mouse button when you Þnished painting.

6. Click the Þrst key frame in the segment to select it.

7. Select the painted object if it is not selected already.

8. Click the Path slider, enter 0, and click Return.

9. Click the last key frame in the segment to select it.

10. Click the Path slider, enter 100, and click Return.

n Alternatively, you can add key frames at different locations in the effectÕs 
Timeline and change the percentage of the Path parameter at each key frame 
to modify how the effect appears over the course of the segment.

11. Render the Paint effect to play it back in real time.
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Soft

The Soft slider adjusts the softness of the brush head. Softness ranges 
from a value of 0 (hard center) to 100 (softest overall head).

To adjust the softness:

1. Click the Brush Tool button if the brush is not already active.

2. Do one of the following:

¥ Drag the Soft slider to attain the desired value.

¥ Click the Soft slider, and enter a value from 0 to 100.

Size

You can use the Size slider to adjust the size of the brush head. Size is 
measured in terms of pixel width. The widths range from 0 to 100 
pixels.

To adjust the brush head size:

1. Click the Brush Tool button if the brush is not already active.

2. Do one of the following:

¥ Drag the Size slider to attain the desired value.

¥ Click the Size slider, and use the keyboard to enter a value 
from 0 to 100.

The new size of the brush head is reßected in the Brush Preview 
window.

Shape

The Brush templates enable you to choose from a variety of preset 
shapes. Clicking one of the buttons changes the brush head to the new 
shape.
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To adjust the shape of the brush head:

1. Click the Brush Tool button if the brush is not already active.

2. Click the desired template.

The shape is reßected in the brush head in the Brush Preview 
window.

Creating a Custom Brush Head from a Template

You can change the brush head to a custom shape by modifying the 
brush head in the Brush Preview window.

To create a custom brush head:

1. Click the Brush Tool button if the brush is not already active.

2. Click a template that will provide the basis for your custom brush 
head.

The template is displayed as the brush head in the Brush Preview 
window.

3. Click the brush head in the Brush Preview window.

Anchor points appear on the brush head where curves merge or 
straight lines intersect.

4. Click an anchor point and drag it to change the shape of the brush 
head.

5. Repeat step 4 with other anchor points as needed.
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n For brush shapes with rounded edges and curves, such as the oval, the ellipse, 
and the circle, clicking an anchor point creates direction bars and handles that 
enable you to edit the Bezier curve. For information on working with Bezier 
curves, see ÒWorking with Vector-Based ObjectsÓ on page 255. You can 
use the direction bars and handles, and you can drag the objectÕs control 
points, but, you cannot use the modiÞer key variations.

Spin

The Spin slider enables you to rotate the brush head 360 degrees in the 
clockwise and counterclockwise directions. The range of clockwise 
rotation is from 0 to Ð360 degrees, and the range of counterclockwise 
rotation is from 0 to 360 degrees. The default position for the brush 
head in the Brush Preview window is 0.

To rotate the brush head:

1. Click the Brush Tool button if the brush is not already active.

2. Click the button for the template as needed.

The shape is reßected in the Brush Preview window.

3. Do one of the following:

¥ Drag the Spin slider to the right (clockwise rotation) or to the 
left (counterclockwise rotation) to rotate the brush head to the 
desired position.

¥ Click the Spin slider, and use the keyboard to enter a value 
from Ð360 to 360.

Rotation 0 degrees Rotation 180 degrees
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Saving a Brush Template

You can save a template of a custom brush to a bin so that you can 
reuse the parameters of the brush with a Paint or AniMatte effect at a 
later time.

To save the brush template:

1. Click the Brush Template icon in the Brush category and drag it to 
a bin.

A brush template appears in the bin, and the name of the template 
defaults to Brush.

2. Click the name of the template in the bin, enter a unique name for 
the template, and click Return.

3. To use the template at a later time, click the template in the bin, 
drag it onto the Brush Preview window, and release the mouse 
button.

4. The brush in the Brush Preview window assumes the same 
parameters as the brush template you saved to the bin.

Brush Template icon
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Working with Vector-Based Objects

Before you begin working with the paint and editing tools included in 
the Paint and AniMatte effects, you must understand the basics of 
working with vector-based objects and Bezier curves. The vector-
based graphics technology of the Intraframe Editing option enables 
you to create and edit objects and mattes with a precision that you can-
not achieve when you work with bitmapped objects. 
Vector-based objects are not subject to problems such as artifacting 
when you rescale them.

The Elements of Vector-Based Objects

The objects you paint, the matte keys you draw, and the brush tem-
plates that appear in the Brush Preview window include a control 
point at the midpoint of each line or curve, also known as a join. The 
portion of the line or curve on each side of the control point is called a 
segment. The control point controls the direction of each segment as it 
passes through the join. 

Control points for a painted object are visible when you select an 
object with the Selection Tool and then click the Reshape Tool button. 
Also, when you click a brush template in the Effect Editor, the brush 
head displays visible control points in the Brush Preview window.

 JoinControl point

Segment

Segment
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A painted object can include three types of joins that describe its 
shape: 

¥ The straight-edge join

¥ The smooth join

¥ The corner join

A control point associated with a smooth join or a corner join describes 
a Bezier curve. Clicking a control point makes it the active join. Tan-
gents called direction bars appear on each side of the control point asso-
ciated with a Bezier curve. At the end of each direction bar is a 
direction handle. Dragging a direction handle changes the way the 
segments pass through the control point to deÞne the curve.

When you drag a direction handle, you change the height and angle of 
the curve. The curve responds as if you were gently tugging it like a 
piece of string. The segments remain anchored to the control points on 
either side of the active join.

In contrast, straight-edge joins do not display direction bars and han-
dles when you click them. To reshape an object composed of one or 
more straight edges:

Corner joinStraight-edge join Smooth join

Control point

Direction bar

Direction handle

Active curve join

Anchor point

Anchor point
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¥ Select the object with the Selection Tool, click the Reshape Tool 
button, and then drag one or more control points. For information 
on manipulating control points, see ÒMoving a Control PointÓ on 
page 265.

¥ Convert straight-edged joins to Bezier curves, and manipulate the 
curves as described in the following sections.

Getting Started with Bezier Curves

If you have never worked with Bezier curves, learning how to work 
with them requires a willingness to experiment. As you practice work-
ing with Bezier curves, you will gain greater control over painted 
objects and mattes, and the process will become more intuitive. The 
following sections describe how to paint a rectangular object with the 
Paint effect and use the Reshape Tool to convert corners into Bezier 
curves. You then will modify the curves to change the shape of the 
object. 

Transforming a Rectangle into a Circle 

To create a rectangle and transform it into a circle with Bezier curves:

1. Apply the Paint effect to a segment in a sequence and enter Effect 
mode.

2. Click the Rectangle Tool button in the Effect Editor.

3. Choose Solid from the Fast menu in the Mode category.

4. Click and drag in the Record monitor to paint a rectangular object. 
Do not worry about picking a color or other parameters for this 
exercise.

5. Click the Selection Tool button and select the object you just 
painted.
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6. Click the Reshape Tool button or double-click the object.

Notice that each corner of the rectangle displays a control point.

7. Control-click the control point at the top left corner of the 
rectangle.

Notice that the straight-edge join becomes a smooth join with 
direction bars and handles.

8. Working in a counterclockwise direction, Control-click each con-
trol point until they have all been transformed into smooth joins.

The resulting shape is a circle. The control point at the top right of 
the circle is the active join and displays direction bars and handles.

Control points
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Experimenting with Direction Handles

To experiment with the direction handles:

1. Click the bottom direction handle and drag away from the control 
point to increase the length of the direction bar.

Notice how the curve changes. Also, the direction bar and seg-
ment on the opposite side of the control point move in unison with 
the direction bar you are dragging. The control points adjacent to 
the active join serve as anchor points for the segments that com-
pose the curve.

2. Drag the direction handle toward the control point to shorten the 
direction bar.

Anchor point

Anchor point

Active join
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Notice how the curve changes as you shorten the direction bar.

3. Control-click the direction handle and drag it away from the con-
trol point.

Notice that the length of the direction bar on the opposite side of 
the control point does not change; this prevents the height of its 
associated segment from changing. However, the opposite direc-
tion bar does move in unison with the direction handle you are 
dragging, thereby changing the angle of the segment in unison.

4. Control-click the direction handle to revert the direction bars to 
their previous functionality.

5. Click the bottom direction handle and drag it in a counterclock-
wise direction.

Notice the how the curve changes as you drag the direction bar.

Opposite segment
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6. When you have Þnished experimenting, adjust the direction bar so 
that the object again resembles a circle.

Creating a Corner Join

The painting tools do not create corner joins by default; you can 
change an existing smooth join into a corner join as described in this 
section. Also, if you want to transform a straight-edge join into a cor-
ner join, you must transform the straight-edge join into a smooth join 
Þrst.

To transform a smooth join into a corner join:

1. Option-click the bottom direction handle.

Although you might not notice it immediately, the smooth join is 
transformed into a corner join.

2. Drag the direction handle away from the control point.

Notice the how the active segment behaves as you lengthen the 
direction bar. The direction bar and segment on the opposite side 
of the control point do not move in unison with this direction han-
dle. Also, notice that the active segment remains anchored to the 
adjacent control point.
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3. Drag the direction handle in a counterclockwise direction.

Notice the how the segment changes as you drag the direction bar.

4. When you are Þnished experimenting, Option-click the direction 
handle.

The control point reverts to a smooth join.

Anchor point
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Modifying Lines and Curves Summarized

Table 7-2 summarizes how you can modify lines and Bezier curves 
(smooth joins or corner joins) by using the mouse and the modiÞer 
keys on the keyboard.

Table 7-2 Methods of Modifying Lines and Curves 

Illustration Description Action

Transform a straight-edge join into a 
smooth join. 

Control-click the control point.

To change it back to a straight-edge 
join, Control-click the smooth join.

Smooth join: Drag one direction han-
dle so that the direction bar on the 
opposite side of the control point 
moves and changes length in unison.

You do not have to press any of the 
modiÞer keys. Click and drag one of 
the direction handles.

Smooth join: Drag one direction han-
dle so that the direction bar on the 
opposite side of the control point 
moves in unison but does not change 
in length.

Control-click a direction handle.

To change it back, Control-click the 
direction handle.

Straight-edge join

Smooth join

Direction handle

Direction bar

Active direction handle
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Painting a New Object with Bezier Curves

When you paint a freehand object to mask, colorize, or otherwise mod-
ify an image in a frame, you can achieve extraordinary precision when 
you know how to control Bezier curves. Being able to visualize curves 
and where you need to place their associated control points before you 
begin painting can make the process of tracing shapes easier. 

The following tools paint new objects that are composed of Bezier 
curves:

¥ Oval Tool

¥ Polygon Tool

¥ Curve Tool

Transform a smooth join into a corner 
join.

Option-click one of the direction han-
dles.

Control-click the corner join to change 
it back to a smooth join.

Corner join: Drag one direction handle 
so that the direction bar on the oppo-
site side of the control point moves 
independently of the bar on the oppo-
site side of the control point.

You do not have to press any of the 
modiÞer keys. Click and drag one of 
the direction handles.

Table 7-2 Methods of Modifying Lines and Curves (Continued)

Illustration Description Action

Smooth join

Corner join

Active direction handle
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For information on how to use these tools to paint new objects with 
Bezier curves, see the description for each tool in the section ÒUsing 
the Paint ToolsÓ on page 268. Keep in mind that you are not limited to 
using these tools to create curved objects because you can transform 
the straight-edge joins in any painted object into Bezier curves as 
described in ÒModifying Lines and Curves SummarizedÓ on 
page 263.

Moving a Control Point

If a control point is not in the desired location, you can move it. 
Table 7-3 describes how you can change the shape of an object by 
moving its control points.

Adding a Control Point

Placing more control points on an object enables the object to trace 
more detailed images. For example, if a segment of an object does not 
follow a curved section on a frame as well as you would like, and 
adjusting the control points and direction bars do not help, you can 
add a new control point.

Table 7-3 Methods of Moving a Control Point

To move Do the following

A control point freely Drag the control point to its new location. The 
control pointÕs direction bars do not change 
orientation.

Multiple control points Click one control point, and then Shift-click or 
lasso additional control points that you want to 
move. (Press kÐA to select all control points.) 
Drag one of the selected control points. All other 
selected control points move in unison.
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To add a control point:

1. Select the object with the Selection Tool button. 

2. Click the Reshape Tool button or double-click the object.

3. Click the selected object where you want to add a new control 
point.

A new control point appears and is calculated so that the original 
object, as you drew it, does not change dramatically in shape. The 
new control point appears as part of the object for all key frames in 
the segment. 

Any changes you make to a control point, such as moving it or 
changing the angle of the associated curve, affects the key frames 
you have selected in the segment. If you change a control point at 
a selected key frame or add a key frame to make changes, the 
changes are interpolated between the selected key frame and adja-
cent key frames.

Moving to Adjacent Control Points

You can move from a control point to an adjacent control point 
without having to click the mouse. To use this feature, you must map 
the Fast Forward and Rewind buttons to your keyboard or a user-
selectable button palette. 

To move to an adjacent control point:

1. Select a control point.

2. Click Fast Forward to move in a clockwise fashion to the next con-
trol point, or click Rewind to move in a counterclockwise fashion 
to the next control point.
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Moving Control Points and Objects in Small Increments

You can ÒnudgeÓ one or more control points or an entire object in 
small increments by pressing and holding the Option key as you press 
one of the four arrow keys on your keyboard. You can use this feature 
to move any object or control point that is currently selected.

The Effect Preview monitor must be the active window for this feature 
to work. Additionally, if you have remapped the arrow keys on your 
keyboard, this feature might not function properly.

Removing a Control Point

Avid recommends that you remove a control point if the object does 
not need the control point to adequately deÞne its shape. It is better to 
have fewer control points and to manipulate the direction bars to gain 
the same effect because fewer control points mean less work if you 
need to modify an object later.

To remove a control point, click the control point and press Delete. You 
also can Shift-click multiple control points and then delete them.

The Avid Composer system attempts to reconstruct the object so that it 
does not change. The results you see might vary because of the inter-
nal mechanics and geometry of Bezier curve technology. However, 
adding and then removing the same control point should not dramati-
cally change the curve of that section of an object.

Unnecessary number of control points

Minimum number of control points
needed to describe this curve

to describe this curve
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Using the Paint Tools

The Paint effect and the AniMatte effect include the following six paint 
tools:

¥ Brush Tool

¥ Rectangle Tool

¥ Oval Tool

¥ Polygon Tool

¥ Curve Tool

¥ Previsualization Marker Tool for Þlm projects

You can use these tools for creating preset shapes or for painting with 
freehand capability to create vector-based objects and mattes with 
editable lines and Bezier curves. Additionally, the Selection Tool 
enables you to select painted objects and mattes to move them, rescale 
them, and change their parameters.

Brush Tool

With the Brush Tool, you can use the mouse or a pen tool with a tablet 
to paint objects or mattes with precision directly on the images in a 
sequence. You also can change and customize the brush shape, as well 
as determine the opacity of the paint or matte, adjust the outline feath-
ering and softness values, and, for the Paint effect, deÞne the color.

For the Paint effect, the Brush Tool includes twenty-one styles called 
modes that offer many creative and corrective possibilities. Available 
modes include solid (for traditional brushstrokes), erase, clone, col-
orize, emboss, and more.

The AniMatte effect provides the Key In and Key Out modes. These 
modes enable you to key in or key out an image in a sequence.
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n For more information on the characteristics of each paint mode, see ÒPaint 
ModesÓ on page 297. For more information on the Key In and Key Out 
modes, see ÒKey ModesÓ on page 315.

To paint an object with the Brush Tool:

1. Click the Brush Tool button in the Effect Editor.

2. Select a paint mode or key mode and parameters in the Effect 
Editor.

3. Position the cursor where you want to begin painting in the frame.

4. Press and hold the mouse button to begin painting. 

5. Release the mouse button to complete the painted object.

6. Adjust the objectÕs parameters if needed.

n For information on the shortcut method of selecting a color for the Brush Tool, 
see ÒShortcut for Selecting a Color with the Brush ToolÓ on page 301.

Rectangle Tool

With the Rectangle Tool, you can paint rectangular shapes or mattes 
on images in a sequence. All the paint modes and parameters in the 
Effect Editor are accessible to the Rectangle Tool with the exception of 
the Brush category.

To paint with the Rectangle Tool:

1. Click the Rectangle Tool button in the Effect Editor.

2. Select a paint mode or key mode and parameters in the Effect 
Editor.

3. Position the cursor where you want to begin painting in the frame.

4. Press and hold the mouse button and drag the cursor to create the 
rectangle.
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As you drag, you describe the diagonal of the rectangle. For exam-
ple, if you drag to the right and in a downward fashion, the rectan-
gle is anchored to its upper left corner.

5. Release the mouse button to complete the rectangle.

6. Adjust the objectÕs parameters if needed.

Oval Tool

With the Oval Tool, you can paint oval shapes or mattes on images in a 
sequence. All the paint modes and parameters in the Effect Editor are 
accessible to the Oval Tool with the exception of the Brush category.

To paint with the Oval Tool:

1. Click the Oval Tool button in the Effect Editor.

2. Select a paint mode or key mode and parameters in the Effect 
Editor.

3. Position the cursor where you want to begin painting in the frame.

4. Press and hold the mouse button and drag the cursor to create an 
oval.

As you drag, you describe the diameter of the oval. For example, if 
you drag to the right and in a downward fashion, the oval is 
anchored to its upper left corner.

Anchor Anchor
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5. Release the mouse button to complete the oval.

6. Adjust the objectÕs parameters if needed.

Polygon Tool

With the Polygon Tool, you can paint a variety of geometric objects 
and trace images in a frame. All the modes and parameters in the 
Effect Editor are accessible to the Polygon Tool with the exception of 
the Brush category. You can use the Polygon Tool to create objects and 
mattes composed of straight-line segments, curved segments, or a 
combination of both.

To take full advantage of the power of the Polygon Tool, you should be 
familiar with the concepts behind vector-based graphics. If you are not 
familiar with these principles, see ÒWorking with Vector-Based 
ObjectsÓ on page 255 for more information. 

It is helpful to visualize the shape and the position of the polygon 
within the frame before you begin painting. By visualizing the object 
Þrst, you will gain more control over the objectsÕs attributes when you 
edit it later. 

The general workßow for working with the Polygon Tool is:

1. Visualize the object you want to create.

2. Determine a location in the frame to begin painting and click that 
location to create the initial control point.

3. Click additional control points as you continue to deÞne the shape 
of the object.

Anchor Anchor
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4. Double-click to create the Þnal control point or click the initial con-
trol point to create the closed polygon.

n Try to create the object with as few control points as possible. Fewer control 
points will eliminate more work if you need to modify the object later.

Creating Polygons with Straight-Line Segments

To create a polygon with straight-line segments:

1. Click the Polygon Tool button in the Effect Editor.

2. Select a paint mode or key mode and parameters in the Effect 
Editor.

The control points do 
not appear as tiny rect-
angles while you are 
painting the object.

3. Click in the frame where you want to place the initial control 
point.

4. Click in the frame where you want to place the next control point.

Segments appear as 
wire frames until you 
Þnish painting the 
object.

A straight-line segment is drawn between the initial control point 
and the control point you just created.

5. Click in the frame to create additional control points that further 
deÞne the shape of the object.

Initial control point

Second control point

Initial
segment
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A straight-line segment appears between each pair of adjacent 
control points.

6. When you are satisÞed with the shape of the object, double-click in 
the frame to create the Þnal control point or click the initial control 
point.

The object becomes a closed polygon.

7. Adjust the parameters of the polygon if needed.

Creating Polygons with Curved Segments

To create a polygon with curved segments:

1. Click the Polygon Tool button in the Effect Editor.

2. Select a paint mode or key mode and parameters in the Effect
Editor.
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The control points do 
not appear as tiny rect-
angles while you are 
painting the object.

3. Click in the frame where you want to place the initial control 
point, and release the mouse button.

4. Drag the cursor to the location where you want to place the next 
control point.

5. Click and hold the mouse button to begin creating the Þrst curved 
segment.

Direction bars with handles appear as a tangent to the curved seg-
ment. The cursor ÒleadsÓ the direction handle that you will use to 
determine the direction and height of the curve.

6. Drag the cursor, which is attached to the direction handle, to 
adjust the direction and height of the curved segment.

7. Release the mouse button when you are satisÞed with the height 
and angle of the curved segment.

8. Drag the cursor to the next location where you want to create a 
curved segment.

9. Repeat steps 3 to 8 to create additional curves if needed.

10. When you are satisÞed with the shape of the object, double-click in 
the frame to create the Þnal control point or click the initial control 
point. 
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The object becomes a closed polygon.

11. Adjust the parameters of the polygon if needed.

Creating a Straight Line Following a Curve

To create a straight line following a curved segment:

1. Create one or more curved segments as described in ÒCreating 
Polygons with Curved SegmentsÓ on page 273.

2. Drag the cursor to the location where you want to begin painting 
the straight line.

3. Click and then release the mouse button to create the control 
point.

4. Drag the cursor to the location where you want the straight-line 
segment to end.

5. Click and then release the mouse button to create the control 
point.
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6. Continue to create additional lines and curves.

7. When you are satisÞed with the shape of the object, double-click in 
the frame to create the Þnal control point or click the initial control 
point. 

The object becomes a closed polygon.

8. Adjust the parameters of the polygon as desired.
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Curve Tool

With the Curve Tool, you can trace curved objects with freehand capa-
bility. All the paint modes and parameters in the Effect Editor are 
accessible to the Curve Tool with the exception of the Brush category.

To paint with the Curve Tool:

1. Click the Curve Tool button in the Effect Editor.

2. Select a paint mode or key mode and parameters in the Effect 
Editor.

3. Position the cursor where you want to begin painting in the frame.

4. Press and hold the mouse button and drag the cursor as you paint 
a freehand curved shape on the frame.

5. When you are satisÞed with the shape of the object, release the 
mouse button to complete the curved object.

6. Adjust the objectÕs parameters if needed.

Previsualization Marker Tool for Film Projects

The Previsualization Marker Tool enables you to place a Marker effect 
in a segment that represents an effect that will be processed at an opti-
cal facility. This tool is applicable to 24-fps projects only and appears in 
the Effect Editor only when you are working in a Þlm project with the 
Paint effect.

For information on opti-
cal lists, see the Avid 
Film Composer UserÕs 
Guide.

When you create an optical list, each Marker, along with its positions 
in the segment in terms of key frames and color values, appears as an 
optical event. The editor at the optical facility can refer to the event as 
a cue for creating a visual effect, such as a rotoscoped object.
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For more information 
on the Effect Grid, see 
ÒWorking with the 
Effect GridÓ on 
page 78.

For example, the optical editorÕs assignment is to create an airplane 
that ßies through the scene. He can use the key-frame information 
from the optical list to plot the exact path of the effect as it moves 
through the scene. The MarkerÕs position at each key frame is 
described with coordinates derived from the Effect Grid. Position is 
described in terms of compass coordinates (N, S, E, and W for North, 
South, East, and West) and X, Y coordinates.

Additionally, you can add multiple Markers to a single scene to repre-
sent different effects, and you can establish a unique color for each 
marker. The resulting optical list will display each Marker and its 
unique color values, which enables the optical editor to distinguish 
each Marker.
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Applying the Marker Effect

To add a Marker effect to a segment:

1. Enable the Effect Grid and set the appropriate parameters for 
image scan size, aspect ratio, and Þlm format.

2. Click the Previsualization Marker Tool button in the Effect Editor.

3. Adjust the sliders in the Color category to determine the color of 
the Marker.

4. Position the cursor at the location in the frame where you want to 
place the Marker, and click the mouse.

For information on key 
frames, see ÒUsing Key 
FramesÓ on page 99.

5. Use key frames to move the Marker throughout the segment.

6. To add more Markers, repeat steps 2 to 5.

Creating a Cut List with Effect Grid Information
d. This example shows how to move a Marker through an effect 

and save the results in a cut list. You could do the same with 
an object you draw with the Paint effect or with a matte you 
create with the AniMatte effect.

To create a cut list that contains the Effect Grid information for the 
Marker effect:

1. Choose Cut List from the Output menu.

The Cut List Tool appears.



280

2. Select the following options:

a. Choose Get Sequence and select the sequence.

b. Select the appropriate video tracks.

c. Select Optical and choose Key Frames as the source data.

3. Choose View.

The Avid Composer system displays the cut list. The following 
illustration shows an example cut list.

Video
track

Key-frame
source
data
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Grid information

Marker 
coordinates for 
each key frame

Marker name and 
color values
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Moving and Manipulating Painted Objects and Mattes

The Paint and AniMatte effects include editing tools and additional 
parameters that enable you to perform the following operations on 
painted objects and mattes:

¥ Reshape

¥ Z-rotation 

¥ Rescale

¥ Movement around the screen and in relation to time

¥ Layers

¥ Group and ungroup

¥ Lock in place and unlock

Reshape

The Reshape Tool enables you to modify the shape of a painted object 
or matte on the screen. You also can change the shape of an object over 
time by making changes to the object on an individual key-frame 
basis. For information on working with key frames, see ÒUsing Key 
FramesÓ on page 99.

To reshape objects you paint with the Avid Composer system, you 
should be familiar with the concepts behind working with vector-
based graphics. For more information, see ÒWorking with Vector-
Based ObjectsÓ on page 255.

Selecting an Object or Matte with the Reshape Tool

To reshape a painted object or matte:

1. Select an object or matte with the Selection Tool.
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2. Click the Reshape Tool button in the Effect Editor or double-click 
the selected object.

The outline of the object becomes highlighted, and control points 
appear at the midpoint of each straight line and curve.

n If you want to drag the control points only, you can Option-click the Reshape 
Tool button to hide the direction handles.

Changing the Shape of an Object or Matte with the Reshape Tool

To edit an object or matte with the Reshape Tool:

¥ Click and drag one or more of the objectÕs control points. For infor-
mation on moving control points, see ÒMoving a Control PointÓ 
on page 265.

¥ Edit the object by manipulating the direction bars at one or more 
control points. For information on editing straight-line segments 
and curved segments, see ÒModifying Lines and Curves Summa-
rizedÓ on page 263.
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Editing Objects and Mattes Created with the Curve Tool

The default behavior of control points in an object or matte created 
with the Curve Tool differs slightly from those created with the Poly-
gon Tool. When you drag one of the direction handles, the direction 
bar on the opposite side of the control point moves in unison but the 
length does not change in unison. The dimensions of the curved seg-
ments on each side of the control point are not equal because the 
Curve Tool creates curves with freehand capability, not with a mathe-
matical formula that describes a Bezier curve in the way that the Poly-
gon Tool does.

You can transform the direction bars at a control point so that their 
lengths change in unison when you drag one of the direction handles. 
To do so, Control-click one of the direction handles. For more informa-
tion, see ÒModifying Lines and Curves SummarizedÓ on page 263.

Z-Rotation

With the Z-Rotation Tool, you can select an object or matte and rotate it 
around the Z axis (clockwise or counterclockwise direction). You also 
can change the rotation of an object over time by rotating the object on 
an individual key-frame basis.

For an illustration of Z-rotation, see ÒRotation Ñ Rotating an EffectÓ 
on page 495.

To rotate an object or matte around the Z axis:

1. Click the Z-Rotation Tool button in the Effect Editor.

2. Click the object you want to rotate.

The object outline becomes highlighted, and a rotation handle 
appears within the object.
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The X on the rotation handle marks the default center of the Z axis 
for the object. You can click the X and drag it anywhere on the 
screen to change the center of the objectÕs rotation.

3. Click the rotation handle and drag the mouse to rotate the object 
in either a clockwise or a counterclockwise direction.

Scaling Paint Objects and Mattes

You can rescale any object or matte that you create. Rescaling increases 
or decreases all dimensions of the object proportionately.

To rescale an object or matte:

1. Click the Selection Tool button in the Effect Editor.

2. Click the object you want to rescale.

The object outline becomes highlighted, and four selection points 
appear around the object.

3. Rescale the object by using one of the following methods:

¥ Click and drag any of the selection points. 

Dragging toward the center of the object decreases the overall 
size, while dragging away from the center increases the over-
all size. When you drag a selection point, the object is 

Z-Rotation
handle

Center of
rotation
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anchored by the selection point that is diagonal to the one 
you are dragging.

¥ Option-click and drag any of the selection points to rescale the 
object using the center of the object as the anchor.



287

Moving Painted Objects

The Selection Tool also enables you to drag objects or mattes around 
the screen and in relation to the screen when you zoom out from a 
frame. You also can animate the object over time by changing the 
objectÕs position on an individual key-frame basis. For more informa-
tion on using key frames, see ÒUsing Key FramesÓ on page 99.

To move a painted object or matte:

1. Click the Selection Tool button in the Effect Editor.

2. Click the object you want to move.

The object outline becomes highlighted, and four selection points 
appear around the object.

3. Click the center of the object and drag it to a new location.

4. Release the mouse button when the object is positioned in the 
desired location.

Layering Objects and Matte Keys

The methods for moving painted objects forward and backward are 
described in the following sections.

Layering with the Paint Effect

When you paint on a frame, the paint appears as an object in the fore-
ground, seeming closer to you in three-dimensional space than the 
video frame. You can change the parameters of each painted object 
independently, including the objectÕs orientation in relation to another 
object. For example, if you have three painted objects, you can stack or 
cascade them over each other to create three separate layers of objects 
in the foreground. 
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All compositing of painted objects takes place in the foreground and is 
not destructive to the video background. Keep in mind that when you 
composite various Paint effects on a frame, the Avid Composer system 
renders the Paint effects to the screen beginning with the bottom layer. 

Layering with the AniMatte Effect

Layering works similarly for matte keys, but the image that appears in 
the foreground is the video that you have chosen to key in or key out. 
Even though matte keys are rendered by the Avid Composer system 
starting with the highest track in a multilayer matte key, compositing 
of multiple AniMatte effects in the same segment occurs in the fore-
ground and is not destructive to the video background.

Using the Outline/Path Button to Locate Layered Objects and Mattes

You can use the Outline/Path button to locate an object or matte that 
might be obscured by others on the screen. The Outline/Path button 
creates a wire-frame representation of each object, which enables you 
to locate, select, and manipulate the desired object. Clicking the Out-
line/Path button toggles the Path on or off.

To locate objects or mattes with the Path function:

1. Click the Outline/Path button in the Effect Editor.

Each object painted on the frame appears as a wire frame.

2. Select an object and change its location or parameters.

3. Click the Outline/Path button to return to normal viewing mode.

Bringing Objects and Mattes Forward by One Layer

You can use the Bring Forward function to bring a single object or 
matte forward by one layer (appearing closer to you in three-
dimensional space). 
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To bring an object or matte forward by one layer:

1. Select an object on the screen with the Selection Tool. 

If the object is obscured by other objects, use the Outline/Path fea-
ture to locate it as described in ÒUsing the Outline/Path Button to 
Locate Layered Objects and MattesÓ on page 288.

2. Click the Bring Forward button, or choose Bring Forward from the 
Object menu.

The object moves one layer forward in the foreground.

Sending Objects and Mattes Backward by One Layer

You can use the Send Backward function to send a single object or 
matte backward by one layer (appearing farther away from you in 
three-dimensional space). 

To send a painted object or matte backward by one layer:

1. Select an object on the screen with the Selection Tool. 

If the object is obscured by other objects, use the Path function to 
locate it as described in ÒUsing the Outline/Path Button to Locate 
Layered Objects and MattesÓ on page 288.

2. Click the Send Backward button, or choose Send Backward from 
the Object menu.

The object moves one layer backward into the layers of objects that 
appear in the foreground.

Bringing Objects and Mattes to the Front

You can use the Bring To Front function to bring a single object or 
matte to the front of the foreground layers (appearing closest to you in 
three-dimensional space).
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To bring a painted object or matte to the front:

1. Select an object on the screen with the Selection Tool. 

If the object is obscured by other objects, use the Path function to 
locate it as described in ÒUsing the Outline/Path Button to Locate 
Layered Objects and MattesÓ on page 288.

2. Option-click the Bring Forward button, or choose the Bring To 
Front option from the Object menu.

The object becomes the top layer in the foreground.

Sending Objects or Mattes to the Back

You can use the Send To Back function to send an object or matte to the 
bottom layer (appearing farthest away in three-dimensional space).

To send a painted object or matte to the back:

1. Select an object on the screen with the Selection Tool. 

If the object is obscured by other objects, use the Path function to 
locate it as described in ÒUsing the Outline/Path Button to Locate 
Layered Objects and MattesÓ on page 288.

2. Option-click the Send Backward button, or choose the Send To 
Back option from the Object menu.

The object becomes the bottom layer in the layers of painted 
objects that make up the foreground.

Grouping and Ungrouping Objects or Mattes

The Avid Composer system enables you to group objects or mattes so 
that they behave as a single object. You then can move the new group 
and change its parameters as if it were a single object. If you want to 
separate the group and revert to working with the individual objects, 
you can do so by using the UnGroup function.
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To group and ungroup painted objects or mattes:

1. Select an object on the screen with the Selection Tool. 

If the object or matte is obscured by other objects, use the Path 
function to locate it as described in ÒUsing the Outline/Path But-
ton to Locate Layered Objects and MattesÓ on page 288.

2. Shift-click any additional objects you want to include in the group.

3. Choose Group from the Object menu.

The objects become grouped together, and you can manipulate the 
group as if it were a single object.

4. To ungroup the objects, select the group and choose UnGroup 
from the Object menu.

n You also can group together groups of objects. If you then select the new 
group and choose UnGroup, all objects become ungrouped completely.

Locking and Unlocking Objects and Mattes

By using the lock feature, you can lock an object or a group in place on 
the screen. When you lock an object, the Avid Composer prevents you 
from moving the object accidentally while you add more effects and 
make additional edits to your sequence.

To lock and unlock a painted object or matte:

1. Select an object or group on the screen with the Selection Tool.

If the object is obscured by other objects, use the Path function to 
locate it as described in ÒUsing the Outline/Path Button to Locate 
Layered Objects and MattesÓ on page 288.

2. Choose Lock from the Object menu.

3. To unlock the object at any time, select the object and choose 
Unlock from the Object menu.
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CHAPTER 8

Using the Paint and 
AniMatte Effects

This chapter includes information on how to get started with the Paint 
and AniMatte effects and describes parameters that are speciÞc to 
these effects. Before you begin reading this chapter, read Chapter 7 
to familiarize yourself with basic Intraframe Editing concepts and 
techniques.

¥ Using the Paint Effect

¥ Using the AniMatte Effect
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Using the Paint Effect

The Paint effect enhances the creative and corrective powers of the 
Avid Composer system by providing the following features:

¥ Customizable paint brushes with preset templates and parameters 
for adjustable softness and rotation

¥ Creation of vector-based objects that you can animate and edit

¥ A variety of paint modes including Erase, Clone, Colorize, 
Darken, Lighten, Blur, Unsharp Mask, Emboss, and more

¥ Object selection with rescale, lock/unlock, and group/ungroup 
capabilities

¥ Z-rotation of painted objects

¥ Outline feathering with bias control

¥ Magic Mask for quick and easy colorization

¥ Previsualization of painted objects in a Þlm project for improving 
effects processing at the visual effects facility

Getting Started with the Paint Effect

The Avid Composer system provides twenty-one painting styles 
(modes) and a variety of painting tools and options. This section 
brießy describes how to use the Brush Tool and how to adjust the Paint 
effect parameters to get you started with the Paint effect.

When you paint an object in a sequence, you paint on the frame dis-
played in the Record monitor. The painted object is superimposed 
over the video background, appearing closer to you in three-dimen-
sional space. Each object you paint creates a foreground layer that you 
can work with individually or group with other painted objects in the 
segment.

Video background

Paint
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Painting with the Brush

To begin painting:

1. Apply the Paint effect to a segment in the sequence as described in 
ÒApplying the Paint Effect to a SequenceÓ on page 235.

2. Click the Brush Tool button to activate the Brush Tool.

3. Click one of the Brush Shape buttons in the Brush parameter pane 
of the Effect Editor.

The default shape of the brush head changes to your selection. 

4. Position the cursor over the image in the Record monitor. 

Notice that the cursor becomes a crosshair.

5. Click and drag to paint freehand style on the video background.

6. Release the mouse button when you have Þnished painting the 
object.

Painting Using Different Effect Parameters

To experiment with painting objects using different parameters:

1. Apply the Paint effect to a segment in the sequence as described in 
ÒApplying the Paint Effect to a SequenceÓ on page 235.

Brush Shape Brush Shape buttons
buttons
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2. Click the Brush Tool button to activate the Brush Tool.

3. Click one of the Brush Shape buttons in the Brush parameter pane 
of the Effect Editor.

For information on con-
trol points, see ÒWork-
ing with Vector-Based 
ObjectsÓ on page 255.

Notice that the brush head in the Brush Preview window appears 
with control points where curves or straight lines meet.

4. Click and drag the control points to create a custom shape for the 
brush head.

5. Position the cursor over the Record monitor, and click and drag to 
paint an object on the screen.

6. Release the mouse button when you have Þnished painting the 
object.

7. Drag the Size slider to adjust the size of the brush head in the 
Brush Preview window.

8. Drag the Spin slider to rotate the brush head to a new position.

9. Drag the Soft slider to adjust the softness of the brush.

10. Position the cursor over the image in the Record monitor, and then 
paint a new object on the screen. Paint the new object anywhere 
you want on the screen, including on top of any previously 
painted objects.

For information on 
using the Rectangle, 
Oval, Polygon, and 
Curve Tools, see ÒUsing 
the Paint ToolsÓ on 
page 268.

11. Release the mouse button when you have Þnished painting the 
object.

Brush Preview window
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Changing the Parameters of a Painted Object

To change the parameters of an object you already have painted:

1. Click the Selection Tool button to activate it, and click an object 
you already have painted. 

The Avid Composer system outlines the object and displays four 
selection handles for the object.

2. To move the object, click anywhere within the outline and drag the 
object to a new location.

Press and hold the 
Option key to rescale 
the object from its 
center.

3. To rescale the object, click and drag any one of the selection 
handles.

4. Click the triangle next to the Color category.

Selection
handles
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5. Drag the Hue, Sat, and Lum sliders to change the color of the 
object.

6. Click the triangle next to the Feathering category.

7. Drag the sliders in the Feathering parameter pane to change the 
edge feathering.

8. Press the Delete key to delete the object.

9. To undelete the object, choose Undo from the Edit menu.

Paint Effect Parameters

Many of the parameters you use with the Paint effect function simi-
larly with the AniMatte effect. Chapter 7 includes complete descrip-
tions of these common parameters. The following sections describe 
parameters that are speciÞc to the Paint effect.

Paint Modes

The Paint effect provides twenty-one modes that you can use to paint 
with a variety of styles. When you click a painting tool for the Þrst 
time, the default setting is Solid mode, which enables you to paint an 
opaque object on the video background with a brushstroke. 

To change the paint mode:

1. Select an object with the Selection Tool. If you do not select an 
object, the paint mode will be applied to the next object you create.
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2. Click the triangle next to Mode if the Mode parameter pane is not 
open already.

3. Choose a mode from the Mode Fast menu. 

When you Þnish painting, the mode you have chosen becomes the 
new default paint mode.

Table 8-1 brießy describes the characteristics of each mode.

Table 8-1 Paint Mode Descriptions 

Mode Description

Solid Applies paint as an opaque object superimposed on the video background.

Erase Removes paint from a frame.

Outline Creates an outline that is useful for tracing images in a frame.

Clone Duplicates an area from a frame and applies it to another area of the frame.

Colorize Changes the tint in a selected area to the foreground color.

Hue Changes the hue in a selected area to the foreground color without affecting 
the saturation and luminance levels.

Saturation Changes the saturation in a selected area to the foreground color without 
affecting the luminance levels and the hue.

Luminance Changes the luminance in a selected area to the foreground color without 
affecting the saturation levels and hue.

Darken Only Reduces the luminance levels in a selected area only if the result would be 
darker than the background color.
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Choosing a Color

You can choose the color you want to paint with by using the eyedrop-
per, the Color sliders, or the Macintosh Color Picker. You can select the 
color before you begin painting or after you have painted an object.

Lighten Only Increases the luminance levels in a selected area only if the result would be 
lighter than the background color.

Darken Reduces the luminance levels in a selected area.

Lighten Increases the luminance levels in a selected area.

Add Adds more of the foreground color to the colors in a selected area.

Subtract Extracts the foreground color in a selected area.

Invert Inverts the RGB values of the selected area.

Mosaic Applies a tile effect to a selected area with horizontal and vertical controls.

Blur Blurs a selected area with horizontal and vertical controls.

Median Changes a selected area to the most typical (median) color value within the 
selection.

Unsharp Mask Sharpens a selected area of an image to create more deÞned edges with hori-
zontal and vertical controls.

Gradient Dissipates the paint with controls to establish the direction of dissipation.

Emboss Creates a three-dimensional extrusion effect in a selected area with controls 
for height and angle.

Table 8-1 Paint Mode Descriptions (Continued)

Mode Description
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Using the Eyedropper

To use the eyedropper:

1. Select an object with the Selection Tool. 

If you do not select an object, the color will be applied to the next 
object you create.

2. Position the cursor over the Color Preview window.

The cursor becomes an eyedropper.

3. Click and hold the mouse button, drag the eyedropper to the loca-
tion in the Record monitor that contains the color you want to 
pick, and release the mouse button.

The Avid Composer system applies the color to the selected object, 
and the color you picked becomes the new default color shown in 
the Color Preview window.

Selecting a Color with the Color Sliders

To select a color with the Color sliders:

1. Select an object with the Selection Tool. 

If you do not select an object, the color will be applied to the next 
object you create.

2. Adjust the Hue, Sat, and Lum sliders to select a color.

The Avid Composer system applies the color to the selected object, 
and the color you picked becomes the new default color shown in 
the Color Preview window.

Color Preview window
Other Options button
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Selecting a Color from the Macintosh Color Picker

The Macintosh Color Picker is a standard application that ships with 
Macintosh systems. Its appearance varies depending on the current 
release of the Macintosh operating system. You can access the 
Macintosh Color Picker as follows:

1. Select an object with the Selection Tool. 

If you do not select an object, the color will be applied to the next 
object you create.

2. Click the Other Options button in the Color parameter pane.

The Macintosh Color Picker dialog box appears.

3. Select a color as described in ÒUsing the Macintosh Color PickerÓ 
on page 105.

Shortcut for Selecting a Color with the Brush Tool

When you use the Brush Tool to paint an object, you can select a color 
quickly from a video segment as follows:

1. Click the Brush Tool button to make it the active paint tool.

2. Press and hold the Option key, and drag the cursor to the Record 
monitor.

The cursor becomes an eyedropper.

3. Position the eyedropper over the color you want to select, and 
release the mouse button.

The color you picked becomes the new default color shown in the 
Color Preview window.

Using Magic Mask with the Paint Effect

Magic Mask enables you to isolate pixels within a speciÞed color range 
in an image and apply the Paint effect to the chosen pixels. While you 
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can use Magic Mask in conjunction with any of the paint modes to 
generate custom effects, the primary beneÞt of this feature is localized 
colorization, which enables you to create garbage mattes and other 
chroma key functions.

The Magic Mask category contains a Color Preview window for use 
with the eyedropper and parameters for adjusting the hue, saturation, 
luminance, gain (color tolerance), and softness. These parameters are 
described in the following sections.

The general workßow for using Magic Mask is:

1. Select a paint mode, such as Lighten, Darken, or Colorize, that 
provides the colorization capabilities you desire.

2. Use one of the paint tools to trace the area of the image that you 
want to modify.

3. Click the Outline/Path button so you have an unobscured view of 
the object you want to colorize.

4. Use the eyedropper to pick the color that you want to change from 
your selection.

5. Click the Outline/Path button to disable Outline/Path mode.

6. Adjust the Magic Mask parameters, such as Gain and Softness, if 
necessary.

7. Use the sliders in the Color parameter pane in conjunction with 
the paint mode you have chosen to change the color you picked.
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Getting Started with Magic Mask and the Paint Effect

To get started with Magic Mask:

1. Load a sequence into the Record monitor. 

The video frame in this selection includes a young man wearing a 
yellow vest that we want to modify.

2. Select a paint mode that provides color modiÞcation, such as Hue.

3. Click the Curve Tool button. 

n For more information on using the Curve Tool, see ÒCurve ToolÓ on 
page 277.

4. Click and drag to trace a freehand outline around the area in the 
Record monitor that you want to colorize.

5. Release the mouse button when you are Þnished with the outline.

6. Click the Outline/Path button to view the painted object as a wire 
frame.

The wire frame provides an unobscured view of the area in which 
you want to make the color change.
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7. Position the cursor over the Color Preview window in the Magic 
Mask parameter pane.

The cursor becomes an eyedropper.

8. Click and hold the mouse button, drag the eyedropper to the loca-
tion in the Record monitor that contains the color you want to 
modify, and release the mouse button. 

n For best results, pick the color from the center of the area that contains the 
color you want to change.

The color you picked becomes the new default color shown in the 
Color Preview window in the Magic Mask parameter pane.

9. Click the Outline/Path button to restore the painted object to the 
normal view.

10. Use the Hue, Sat, and Lum sliders in the Color parameter pane 
(not the Magic Mask parameter pane) to modify the hue of the 
color you picked.

Color Preview window
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Magic Mask Hue, Saturation, and Luminance Parameters

After you choose Magic Mask and pick a color with the eyedropper, 
you can adjust the Hue, Sat, and Lum sliders to reÞne the color selec-
tion. In most cases, you do not need to adjust these parameters, but the 
values reported by the sliders provide a useful reference.

The Hue slider affects the tint of the color selection. The tint refers to 
the name commonly associated with a color, such as red, green, or 
blue. The slider values range from 0 to 255.

The Sat (Saturation) slider affects the purity or intensity of the color 
selection. The color gray has no saturation at all; a fully saturated color 
produces the most intense representation of that color. The slider val-
ues range from 0 to 255.

The Lum (Luminance) slider affects the brightness of the color selec-
tion. The color black has 0 brightness. The slider values range from 0 
to 255.

n Keep in mind that the Hue, Sat, and Lum sliders in the Magic Mask parame-
ter pane enable you to reÞne the color you select from the video background. 
Use the sliders in the Color parameter pane in conjunction with one of the 
paint modes to colorize your selection.

To adjust the Magic Mask Hue, Sat, and Lum sliders:

¥ Drag either the Hue, Sat, or Lum slider to attain the desired 
value.

¥ Click either the Hue, Sat, or Lum slider, and use the keyboard 
to enter a number from 0 to 255.

Gain

Use the Gain slider to increase or decrease the range of pixels sur-
rounding the color you pick that Magic Mask will enable you to mod-
ify in conjunction with your chosen paint mode. Gain includes or 
excludes pixels surrounding the color you pick that fall within a speci-
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Þed color range, or tolerance. The tolerance you adjust with the Gain 
slider is relative to the RGB values of the color you picked. 

Decreasing the gain lessens the color range and includes fewer pixels 
contiguous to your color selection. Increasing the gain expands the 
range and includes more pixels surrounding the color you picked. 

To adjust the Gain slider, do one of the following:

¥ Drag the Gain slider to attain the desired value.

¥ Click the Gain slider, and use the keyboard to enter a number 
from 0 to 63.

Softness

You can use the Soft slider to increase or decrease the dissipation of the 
pixels in your color selection that Magic Mask will enable you to mod-
ify with the painting tools. The amount of dissipation you adjust with 
the Soft slider is relative to the RGB values of the color you picked in 
your selection. 

To adjust the Soft slider, do one of the following:

¥ Drag the Soft slider to attain the desired value.

¥ Click the Soft slider, and use the keyboard to enter a number 
from 0 to 63.
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Using the AniMatte Effect

The AniMatte effect enables you to generate custom matte effects that 
you can apply to a segment or transition in a sequence. You can use a 
variety of brushes and painting tools to create matte effects that you 
can animate Ñ all from within Effect mode. The AniMatte effect
including the following features:

¥ Modes for keying in and keying out images

¥ Key-frameable animation of matte effects

¥ Creation of mattes as vector-based objects that allow you to move, 
rescale, and reshape the mattes during a segment or transition

¥ Freehand painting ability to create organic matte wipes

¥ Magic Mask, Brush Shapes, Z-rotation, feathering, and more

¥ Export of mattes to create keys in third-party applications

¥ No additional hardware required

Getting Started with the AniMatte Effect

The AniMatte effect provides the Key In and Key Out modes for creat-
ing mattes. You use the same set of painting tools that are available to 
the Paint effect to build a variety of multitrack and single-track effects, 
including traditional matte keys, animated matte keys, chroma keys, 
and organic matte wipes.

For more information 
on creating matte keys, 
see Chapter 4.

When you use the AniMatte effect as a multitrack effect, you isolate a 
region of the highest video track (foreground image) with the painting 
tools and then key in or key out the region. Keying in a region ensures 
that the selection is displayed over the image on the lower track (back-
ground image). Keying out a region ensures that the lower track is vis-
ible through the selection.

The following sections brießy describe how to use the AniMatte effect 
to create popular matte keys.
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Creating a Multitrack Matte Key

To create a multitrack matte key:

1. Create a sequence with two video tracks. Edit the image you want 
to use as the background on V1 and the image you want to use as 
the foreground on V2.

2. Monitor V2 by clicking the video monitor column next to V2.

3. Apply the AniMatte effect to the segment on V2, and click the 
Effect Mode button.

4. Click the Reduce Tool button if necessary to obtain a better view of 
the entire image.

5. Click the Curve Tool button.

6. Choose Key In from the Mode Fast menu in the Effect Editor.

7. Click and drag on the image on V2 to draw a matte with freehand 
capability.

8. When you are satisÞed with the shape of the matte, release the 
mouse button.

The area outside the border of the matte reveals the underlying 
image on V1, and the area inside the border of the matte displays 
the image on V2.

V1 background image V2 foreground image
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9. Click the Reverse button in the Foreground parameter pane.

The area outside the border of the matte reveals the image on V2, 
and the area inside the border reveals the underlying image on V1. 
By enabling the Reverse option, you have changed the view of the 
matte from key in to key out. 

n Using the Reverse option provides a useful reference when you need to see the 
image on the track that becomes obscured when you apply the AniMatte 
effect. You might need to see these obscured areas to track the motion of the 
images so you can edit the matte to follow their movement.

10. Click the Reverse button to disable the Reverse option.

This restores your selection to a matte that keys in your selection.
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Animating the AniMatte Effect

When you apply the AniMatte effect and create a matte key, the shape 
and location of the matte remain Þxed over the course of the segment. 
The parameters of the matte are the same at both the Þrst and last key 
frames in the segment.

When you have moving video on V1 and V2, the images are changing 
from frame to frame. Consequently, you must change the shape and 
location of the matte in order to follow the changes of the video over 
the course of the segment. You can add a key frame at each location in 
the segment where you make changes to the shape and position of the 
matte. Alternatively, you can make changes to the matte at various 
locations in the effectÕs Timeline, and the Avid Composer system 
inserts a new key frame where each change is made.

To animate a Matte Key effect:

1. Click the Step Forward button or the Step Backward button as 
many times as necessary to park on a frame in which the matte no 
longer provides a clean key due to the motion of the foreground or 
background image.

2. Click the Add Key Frame button.

3. Click the Reverse button to swap the view of the foreground and 
background images.

Subject has moved relative to the key.
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4. To reposition the matte:

a. Click the Selection Tool button and select the matte.

b. Click within the border of the matte and drag the matte to the 
new location.

c. When you are satisÞed with the position of the matte, release 
the mouse button.

5. To change the shape of the matte:

a. Select the matte with the Selection Tool.

b. Click the Reshape Tool button in the Effect Editor, or 
double-click the matte.

The outline of the matte becomes highlighted, and control 
points appear at the midpoint of each straight line and curve.

c. Do one or more of the following to adjust the shape of the 
matte:

- Click and drag one or more of the objectÕs control points. For 
information on moving control points, see ÒMoving a Control 
PointÓ on page 265.

- Edit the object by manipulating the direction bars at one or 
more control point. For information on editing straight-line 
segments and curved segments, see ÒModifying Lines and 
Curves SummarizedÓ on page 263.

6. Repeat steps 1 to 5 as needed to create a matte that keys the images 
cleanly over the course of the segment. A clean and accurate matte 
tracks the movement of the foreground and background images.
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Creating a Single-Layer Organic Matte Wipe

While the Avid Composer system includes a wide variety of wipes in 
the Effect Palette, you can use the AniMatte effect to draw your own 
custom matte wipe. Additionally, you can create soft edges and other 
useful variations by adjusting the parameters of the AniMatte wipe. 
Multiple video tracks are not necessary. You apply the AniMatte effect 
to a transition on a single track of video and then draw the matte wipe 
as described in this section.

7. To create an organic matte wipe:

1. Create a sequence that contains a transition (an incoming and an 
outgoing segment). 

2. Apply the AniMatte effect to a transition as described in ÒApply-
ing an AniMatte Effect to a SequenceÓ on page 236.

3. Click the Effect Mode button to enter Effect mode.

4. Choose Key In from the Mode Fast menu.

5. Click the Reduce Tool button three times to reduce the image to 
25 percent of its normal viewing size.

6. Click the Þrst key frame in the effectÕs Timeline.

Outgoing segment Incoming segment
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The Þrst key frame is highlighted, and the last key frame is 
deselected.

7. Click the Curve Tool button.

Draw a matte that is 
at least as wide as the 
frame in the Record 
monitor.

8. Press and hold the mouse button and drag to draw a custom 
shape to the right of the image displayed in the Record monitor.

9. When you are satisÞed with the shape of the object, release the 
mouse button to complete the matte wipe.

10. Click the last key frame in the effectÕs Timeline.

The last key frame is highlighted, and the Þrst key frame is 
deselected.

11. Click the matte wipe within its borders and drag it so that it covers 
the frame in the Record monitor. Make sure to position the leading 
edge of the wipe so that it is beyond the left border of the frame.
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12. Click the Enlarge Tool button three times to restore the video 
image to 100 percent.

Adding a Soft Edge to the Organic Matte Wipe

To add a soft edge to the organic matte wipe:

1. Shift-click the Þrst key frame in the effectÕs Timeline so that both 
the Þrst and last key frames are selected.

2. Select the matte wipe with the Selection Tool if it is not selected 
already.

3. Drag the position indicator under the monitor to the midpoint of 
the effectÕs Timeline.

The leading edge of the wipe appears in the Record monitor.
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4. Click the triangle next to Feathering if the Feathering parameter 
pane is not open already.

5. Click the Anti-Alias button in the Feathering parameter pane.

6. Click the Fixed Aspect button in the Feathering parameter pane if 
it is not selected already.

7. Click the Hor slider, enter 50 by using the keyboard, and press 
Return.

Both the Hor and Vert sliders change to a value of 50.

8. Render the effect to play back the custom wipe with a soft edge in 
real time.

AniMatte Effect Parameters

Many of the parameters you use with the AniMatte effect function 
similarly with the Paint effect. Chapter 7 includes complete descrip-
tions of these common parameters. The following sections describe 
parameters that are speciÞc to the AniMatte effect.

Key Modes

The AniMatte effect provides two modes, Key In and Key Out, that 
you can use to create matte keys and matte wipes. 
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Table 8-2 brießy describes the characteristics of each mode.

To change the Key mode:

1. Select an object with the Selection Tool. 

If you do not select an object, the Key mode will be applied to the 
next object you create.

2. Click the triangle next to Mode if the Mode parameter pane is not 
open already.

3. Choose Key In or Key Out from the Mode Fast menu. 

When you Þnish drawing a matte, the mode you have chosen 
becomes the new default Key mode.

Table 8-2 Key Mode Descriptions

Mode Description

Key In Displays the image on the higher track (foreground) within the matte selec-
tion while revealing the image on the lower track (background) outside the 
matte selection for two-track video effects; displays the incoming segment 
within the matte selection for single-track matte wipes.

Key Out Displays the image on the lower track (background) within the matte selec-
tion while revealing the image on the higher track (foreground) outside the 
matte selection for two-track video effects; displays the outgoing segment 
within the matte selection for single-track matte wipes.
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Using Magic Mask with the AniMatte Effect

Using Magic Mask with the AniMatte effect provides an alternative to 
the YUV Chroma Key effect in the Effect Palette. You isolate pixels 
within a speciÞed color range in a matte to key in or key out those 
pixels. You can modify the color range to reÞne the key and to include 
contiguous pixels that fall within the color range in the key.

The Magic Mask parameter pane contains a Color Preview window 
for use with the eyedropper and parameters for adjusting the hue, sat-
uration, luminance, gain (color tolerance), and softness. These parame-
ters are described in the following sections.

The general workßow for using Magic Mask is:

1. Select either the Key In or Key Out mode.

2. Use one of the paint tools to draw a matte key.

3. Choose the opposite Key mode to view the foreground image 
within your matte selection.

4. Use the eyedropper to pick the color that you want to use as the 
basis for your chroma key.

5. Switch back to the original Key mode.

6. Adjust the Magic Mask parameters, such as Gain and Softness, as 
necessary.

Getting Started with Magic Mask and the AniMatte Effects

To get started with Magic Mask to create a chroma key:

1. Create a sequence with two video tracks. Edit the image you want 
to use as the background on V1 and the image you want to use as 
the foreground on V2.
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2. Monitor V2 by clicking the video monitor column next to V2.

3. Apply the AniMatte effect to the segment on V2, and click the 
Effect Mode button.

4. Click the Curve Tool.

5. Click the triangle next to Mode if the Mode parameter pane is not 
open already.

6. Choose Key Out from the Mode Fast menu.

7. Click the Reduce Tool button if necessary to obtain a better view of 
the entire image.

8. Click and drag on the image on V2 to draw a matte with freehand 
capability. 

9. When you are satisÞed with the shape of the matte, release the 
mouse button.

The area inside the border of the matte reveals the underlying 
image on V1, and the area outside the border of the matte displays 
the image on V2.

V1 Background image V2 Foreground image
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10. Choose Key In from the Mode Fast menu.

Now you can see the foreground image within the borders of the 
matte key.

11. Position the cursor over the Color Preview window in the 
Magic Mask parameter pane.

The cursor becomes an eyedropper.

V1 Background image

Off-white will be the color selection.

Color Preview window
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12. Click and hold the mouse button, drag the eyedropper to the loca-
tion in the matte key that contains the color you want to key out, 
and release the mouse button. 

n For best results, pick the color from the center of the area that contains the 
color you want to correct. In the example, the off-white color of the sky is the 
color selection.

The color you pick becomes the new default color shown in the 
Color Preview window in the Magic Mask parameter pane.

13. Choose Key In from the Mode Fast menu.

The foreground image is keyed out based on your color selection.

14. Adjust the Hue, Saturation, Luminance, Gain, and Softness 
parameters to reÞne your key. The following sections describe 
these parameters.

Hue, Saturation, and Luminance Parameters

After you use Magic Mask to pick a key color with the eyedropper, 
you can adjust the Hue, Sat, and Lum sliders to Þne-tune the color 
selection. If you do not need to adjust these parameters, the values 
reported by the sliders provide a useful reference to the values that 
make up your color selection.
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The Hue slider affects the shade of the color. The shade refers to the 
name commonly associated with a color, such as red, green, or blue. 
The slider values range from 0 to 255.

The Sat (Saturation) slider affects the purity or intensity of the color. 
The color gray has no saturation at all; A fully saturated color pro-
duces the most intense representation of that color. The slider values 
range from 0 to 255.

The Lum (Luminance) slider affects the brightness of the color. The 
color black has 0 brightness. The slider values range from 0 to 255.

To adjust the Hue, Sat, and Lum sliders:

¥ Drag either the Hue, Sat, or Lum slider to attain the desired 
value.

¥ Click either the Hue, Sat, or Lum slider, and use the keyboard 
to enter a value from 0 to 255.

Gain

You can use the Gain slider to increase or decrease the effect of Magic 
Mask on pixels that are contiguous to your color selection within the 
borders of a matte key. Gain applies color correction to pixels that fall 
within the speciÞed color range, or tolerance, of the color you pick 
with the eyedropper. The tolerance you adjust with the Gain slider is 
relative to the RGB values of the color picked in your selection. 

Decreasing the gain tightens the color range and restricts the key to 
fewer contiguous pixels. Increasing the gain expands the range and 
includes more pixels contiguous to the picked color in the key. You 
probably will need to make adjustments to gain to obtain a clean key.

To adjust the Gain slider, do one of the following:

¥ Drag the Gain slider to attain the desired value.

¥ Click the Gain slider, and use the keyboard to enter a number 
from 0 to 63.
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Softness

You can use the Soft slider to increase or decrease the amount of
softness applied to your color selection and contiguous pixels that fall 
within a speciÞed tolerance. The tolerance you adjust with the Soft 
slider is relative to the RGB values of the color picked in the selection. 

To adjust the Soft slider, do one of the following:

¥ Drag the Soft slider to attain the desired value.

¥ Click the Soft slider, and use the keyboard to enter a number 
from 0 to 63.

Exporting a Matte PICT File

For more information 
on creating matte keys, 
see ÒMatte KeyÓ on 
page 423.

You can create a matte with the AniMatte effect and export it from the 
Avid Composer system as a high-contrast matte Ñ without having to 
leave Effect mode. The exported image is a high-contrast 32-bit PICT 
Þle that includes an alpha channel.

You can use the exported PICT Þle in the following ways:

¥ Import the Þle back into the Avid Composer system to create a 
real-time matte key clip that you can edit into a sequence. You can 
use this clip as a garbage matte or, if you have the 3D Effects 
option, promote the clip to 3D.

¥ Open the Þle in a third-party graphics application, edit the Þle, 
and import the Þle back into the Avid Composer system.

¥ Use the Þle as a graphic in an application other than Media 
Composer or Film Composer.

When you import the PICT Þle back into the Avid Composer system, 
the system creates a matte key clip in the bin that you select. You can 
load the matte key clip into the Source monitor and edit it into a 
sequence as you can with any other imported matte key. The matte key 
clip appears as a high-contrast matte with transparent (black) and 
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opaque (white) components. For more information on editing a matte 
key clip into a sequence, see ÒEditing with Imported Matte Key 
ClipsÓ on page 129.

When you open the high-contrast PICT Þle in a third-party application 
that supports alpha channels, select the ÞleÕs alpha channel to view the 
high-contrast components of the matte. However, if you open the 
PICT Þle in an application that does not support alpha channels, the 
image appears completely white.

To export a matte key created with the AniMatte effect:

1. Create a matte key using the AniMatte effect in Effect mode.

n To follow the remaining steps in this procedure, you must be working in 
Effect mode.

2. Move the position indicator in the effectÕs Timeline to the frame 
you want to export.

3. Choose Export Matte PICT from the File menu.
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A dialog box appears.

4. Use the Directory pop-up menu to choose the location where you 
want to save the PICT Þle.

5. Click Save.

The system saves the PICT Þle to the location you chose.

6. If necessary, open the PICT Þle in a third-party application and 
make changes to the Þle.

7. Select the bin into which you will import the PICT Þle, and choose 
Import from the File menu.

8. The Select Files to Import dialog box appears.

9. Click Options.

10. To use the existing alpha channel, deselect Ignore Existing Alpha 
Channel. 

Depending on your needs, you might have to select Invert Exist-
ing Alpha; in a high-contrast matte key with an alpha channel on 
an Avid Composer system, the white regions are opaque, and the 
black regions are transparent. For more information on importing 
a matte key, see the ÒImporting FilesÓ chapter in the Avid Media 
Composer UserÕs Guide or Avid Film Composer UserÕs Guide.

11. When you are Þnished selecting the options you need, click OK.

Text box

Directory
Pop-up menu
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12. Continue with the instructions in the ÒImporting FilesÓ chapter in 
the Avid Media Composer UserÕs Guide or Avid Film Composer UserÕs 
Guide to complete the import of the Þle into the bin.

The PICT Þle appears as a Matte Key Effect clip in the bin you 
chose.

13. Click the Source/Record Mode button.

14. Load the matte key clip into the Source monitor.

The clip appears in the Source monitor as a black-and-white, high-
contrast image.

15. Edit the matte key into the sequence as described in ÒEditing with 
Imported Matte Key ClipsÓ on page 129.
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CHAPTER 9

Working with 3D Effects

This chapter describes procedures for creating and manipulating 3D 
effects for systems equipped with the 3D Effects option. For reference 
information on the various parameters that apply to 3D effects and all 
the available 3D shapes, see Chapter 11, Ò3D Effects Reference.Ó

¥ About the 3D Effects Option

¥ Accessing 3D Effects

¥ Understanding the 3D Effects Interface

¥ Creating Custom 3D Effects

¥ Using Avid Xpress 3D Effects

About the 3D Effects Option

The 3D Effects option delivers a wide range of digital video effects, 
including the following.

¥ Image effects such as blur (defocus) and resize with rotation and 
perspective

¥ Two-channel segment effects including smooth motion 
picture-in-picture 

¥ Shapes, including 3D spheres and four-way page curls



328

¥ Positioning, scaling, skewing, and rotation, with perspective

¥ Source cropping

¥ Internal borders including beveled and rounded edges

¥ Soft borders

¥ Trails and drop shadows with varying opacity

¥ Highlights, wipe generator, chroma keys, and luma keys

The 3D Effects option allow you to play effects in reverse, or to step 
through an effect frame by frame without any preroll. The 3D Effects 
option can also handle multiple layers of 3D effects through rendering.

n For information on the hardware requirements for the 3D Effects 
option, see the Avid Media Composer Products Setup Guide.

Turning the 3D Effects Option On and Off

The 3D Effects option is on by default. However, the 3D Effects option 
is not compatible with multicamera AVRs 2m Ð 6m. In addition, 24-fps 
Þlm projects are not compatible with the 3D Effects option.

If you need to use these AVRs, or if your 3D system is equipped with 
Film Options and you need to work on a 24-fps Þlm project, you can 
temporarily disable the 3D Effects option.

n While the 3D Effects option is disabled, the standard set of real-time 2D 
effects are available. For example, dissolves, superimpositions, and titles are 
real-time effects.

There are two methods for disabling the 3D Effects option, depending 
on your needs:

¥ You can disable the 3D Effects option during startup using a key 
sequence. In this case, the 3D Effects option will be re-enabled 
automatically the next time you start the system.
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¥ You can disable the 3D Effects option with a Console command. In 
this case, the 3D Effects option will remain disabled until you 
enter another Console command.

c The Console window gives you access to low-level commands that 
can alter the operation of the Avid Composer system. Use only Con-
sole commands that are documented in Avid Tech Notes or user 
manuals.

To turn off the 3D Effects option during startup:

1. Press and hold the F and X keys on the keyboard while launching 
the Avid Composer application.

A dialog box appears, with buttons for enabling or disabling the 
3D Effects option.

2. Click the button for disabling 3D.

The system proceeds to start up with the 3D Effects option dis-
abled.

After the application starts, the 3D Effect category is no longer avail-
able. The next time you relaunch the application, the 3D Effects option 
will be available unless you again press and hold the F and X keys.

To turn off the 3D Effects Option in the Console:

1. Choose Console from the Tools menu. The Console window 
appears.

2. Type the following command into the command line at the bottom 
of the Console window and press Return:

Disable3D 

A message appears stating that the 3D Effects option is disabled.

3. Quit the Avid Composer system application, and restart it.

During startup a message indicates that the 3D effects are dis-
abled. To re-enable the 3D effects, repeat this procedure and type 
ÒEnable3DÓ into the Console Window command line.
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c Any effects that were created with the 3D Warp option play as cuts 
(unless rendered) while the 3D Effects option is disabled.

Accessing 3D Effects

There are two basic ways to access the 3D effects parameters and con-
trols: you can apply the 3D Warp effect to a transition or segment, or 
you can promote an existing 2D effect to 3D.

Applying a 3D Warp Effect

All the 3D Effects features are accessible through the 3D Warp effect in 
the Blend category.

n This procedure assumes that you are familiar with adding effects to a 
sequence. For more information, see ÒApplying Effects to a SequenceÓ on 
page 46.

To apply the 3D Warp effect:

1. Create a sequence in the Record monitor using the standard Avid 
Composer system editing procedures.

2. Choose Effect Palette from the Tools menu, or press kÐ8.

3. In the Effect Palette, drag the 3D Warp Effect icon to the transition 
or a segment in the Timeline and release the mouse button. The 3D 
Warp Effect icon appears in the Timeline as shown in the follow-
ing illustration.
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4. In the Timeline, move the blue position indicator to the 3D Warp 
effect and click the Effect Mode button.

The Effect Editor and Effect Preview monitor appear. The two default 
key-frame indicators appear under the Effect Preview monitor. Now 
you can begin adjusting the 3D Warp parameters to customize your 
effects.

Promoting 2D Effects to 3D Effects

You can use 2D effects as building blocks for 3D effects. For example, if 
you have a 2D Picture-in-Picture effect, you can add 3D features like 
3D borders, drop shadow, page curls, smooth curve movement, and 
rotation. You can also promote a Title effect created with the Title Tool 
to a 3D effect.

n For information on creating a 2D Title effect, see Chapter 5, ÒCreating 
Titles and Graphic Objects.Ó

Effect Palette

Timeline
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To promote a 2D effect or title to a 3D effect:

1. Click the Effect Mode button to open the Effect Editor.

2. Click the effect icon in the sequence to select it.

3. Double-click the 3D Warp icon in the Effect Palette, or click the 3D 
Promote button in the Effect Editor.

n You cannot demote a 3D effect to a 2D effect. If you play a 3D effect on a sys-
tem that does not have 3D hardware, the effect plays as a cut (unless the effect 
was rendered on the 3D system).

Using Matte Keys with 3D Effects

You can promote a 2D matte key to a 3D effect. A matte key is an effect 
made up of three components: the high-contrast image or matte, the 
background image (the image that shows through the lightest part of 
the matte), and the foreground image (the image that shows through 
the darkest part of the matte).

n For more information on matte key clips, see ÒCreating a Matte Key 
EffectÓ on page 127. 

Use the following procedure to create a matte key for use with 3D 
effects:

1. Import a graphic Þle containing an alpha channel. The system cre-
ates a matte key clip when you import the Þle as shown in the fol-
lowing illustration.

Matte Key Effect clip 
with alpha channel

Graphic master clip 
with no alpha channel
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2. Edit the matte key clip into your sequence as an overlay.

Make sure Render On-The-Fly is enabled (displays a check mark 
in the Special menu) so you can see the matte key as you are work-
ing with it.

3. Promote the matte key clip to a 3D Warp effect as explained in the 
section ÒPromoting 2D Effects to 3D EffectsÓ on page 331.

n You cannot promote matte keys created using the Matte Key effect from the 
2D Effect Palette to a 3D matte key.

n You should reimport any matte keys you created in releases earlier than Media 
Composer or Film Composer Version 5.50 in order to promote them.

Understanding the 3D Effects Interface

This section provides basic information for using the 3D effects param-
eters and the Effect Preview monitor and controls.

Moving in 3D Space

You donÕt need to use a lot of math to create most 3D effects, but you 
do need some basic understanding of degrees of motion and geometry, 
as described in this section.

n Moving objects in 3D space requires an understanding of each of the 3D 
effects parameters and their correct order in the effects parameters hierarchy. 
For more information, see ÒAbout 3D Effects ParametersÓ on page 336.

The 3D Coordinate System

Throughout this chapter, the terms X, Y, and Z refer to the three axes or 
dimensions of the image that can be manipulated in the 3D effects 
coordinate space.
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¥ X refers to the imageÕs left/right direction.

¥ Y refers to the imageÕs up/down direction.

¥ Z refers to the imageÕs front/back dimension.

Rotation Axes

The Shape and Rotation parameters allow you to rotate the image 
around the X, Y, and Z axes. Note that you can rotate more than 360 
degrees between key frames. The following illustration shows how 
angles of rotation are distributed around a circle.

Z Axis

X Axis

Y Axis

X Axis — values increase from left to right

Y Axis — values increase from bottom to top

Z Axis — values increase from back to front

X0, Y0, Z0
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The following illustration shows several rotation examples.

– +

–90 degrees

–45 degrees

–180 degrees
+180 degrees

+135 degrees–135 degrees

0 degrees

+45 degrees

+90 degrees

A

0 degrees

A

+180 degrees
–180 degrees

A

A
+45 degrees

–45 degrees
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About 3D Effects Parameters

The following sections provide a basic introduction to 3D effects 
parameters. For speciÞc information on each of the parameters avail-
able in the Effect Editor for the 3D Warp effect, see Chapter 11, Ò3D 
Effects Reference.Ó

n Manipulating 3D effects parameters requires a basic understanding of 
degrees of motion and the system of geometry used in the Avid Composer sys-
temÕs 3D Effects interface. For more information, see ÒMoving in 3D SpaceÓ 
on page 333.

The 3D Warp parameters list displays effect parameters grouped in 
collapsible panes. Each item in the list represents a speciÞc type of 
manipulation, called a category, that you can apply to an image. You 
can apply effect parameters adjustments either individually or in 
combination.

3D Warp parameter 
categories

Effect Editor buttons
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For a description of the Effect Editor buttons, see ÒEffect Editor But-
tonsÓ on page 91. Effect Editor buttons are the same for both 2D and 
3D effects.

Opening Parameter Panes

When a parameter pane is collapsed, only the triangular opener, cate-
gory name, Fast menu (if any), and Enable button are visible.

Click the triangle next to the category name or double-click the cate-
gory name to open the pane and view the parameter controls. When 
you open a parameter pane, a scroll bar appears, allowing access to 
other categories hidden from view.

To close a parameter pane, click the triangle or double-click the cate-
gory name.

n Option-click one triangle to open or close all the parameter panes.

Using the Enable Button

When you click the Enable button, the parameters of that category 
become active for all key frames and affect the displayed image. When 
the Enable button is not highlighted, the category is inactive and the 
Avid Composer system uses default values for those parameters. In 
this case, the Avid Composer system saves any changes to the parame-
ters along with the effect but does not apply them to the image.

Triangular
opener

Category
name Fast menu

Enable
button
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Resetting Default Values

To reset the parameters for a category to their default values, Option-
click the Enable button. This operation affects only selected key 
frames.

Using Effect Templates

Once you create a 3D effect and adjust parameters, you can save the 
adjustments as a template for later use. This allows you to use the 
same effect parameters in multiple places in a sequence or in different 
sequences.

¥ Dragging and dropping an effect template onto the Effect Preview 
monitor or onto the effect segment in the Timeline applies all the 
values from the template.

¥ Dragging and dropping an effect template onto an open parame-
ter pane resets the parameters of the category to those of the Þrst 
key frame of the effect template. This allows you to use selected 
portions of effect templates.

For more information, see ÒApplying an Effect TemplateÓ on 
page 113.

The Hierarchy of Parameters

The Avid Composer system processes 3D Effects parameters in a spe-
ciÞc order. Knowing the order will help you understand why some-
thing looks a particular way or why an object behaves the way it does 
on a motion path.

The hierarchy of 3D Effects parameters, and the relationships between 
them, are as follows:
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¥ Parameters that are lower in the hierarchy, like Crop, are not 
affected by parameters that are higher in the hierarchy, such as 
Rotation. In an effect that has both rotation and cropping, for 
example, the same four edges are always cropped the same way 
no matter what angle you have chosen for the rotation.

¥ Parameters that are higher in the hierarchy will always take into 
account the parameters lower in the hierarchy when processing. 
For example, before an object is rotated, the system looks to see 
where the object is positioned in the frame to display the correct 
3D point of view with the new angle.

¥ You always end up with the same effect no matter the order in 
which you change parameters. However, building an effect from 
the bottom of the hierarchy up will be easier to control. If you 
rotate an object, for example, and then move the axis (a lower 
parameter), your object may jump off the screen. It would be bet-
ter to move the axis Þrst, and then rotate the object.

¥ Parameters operate as 2D, 3D, and post-transformation. All these 
choices affect the 3D path of the object differently. 2D parameters, 
such as Scaling, are lowest in the hierarchy and do not affect the 
path through space. 3D parameters, such as Position, directly 
affect the shape of the motion path. Post-transformation parame-
ters, such as Target, move the entire path.

Lower

Higher
Target 

Perspective

Position 

Rotation

Axis

Scaling

Crop
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Effect Parameters with 2D and 3D Versions

Several 3D effects parameters such as Position, Crop, and Border have 
corresponding 2D versions. In most cases, the 3D versions have more 
options and allow for Þner adjustments. All the 3D-speciÞc parameters 
are described in this chapter. 

The following parameters have 2D and 3D versions:

¥ Position

In the 3D version, you can move images in the X, Y, and Z axes.

¥ Scaling (Size)

¥ Border

In the 3D version, you have multiple types of borders to choose.

¥ Crop

¥ Luma and Chroma Keys

Use Luma Key and Chroma Key from the Foregnd (foreground) 
category Fast menu.

¥ Matte Key

You can create 3D matte keys from imported PICT Þles as you can 
with 2D effects; see ÒUsing Matte Keys with 3D EffectsÓ on 
page 332.

When performing dissolves in 3D, use the Opac (opacity) slider in the 
Foregnd parameter pane.

n All effects that were real time in 2D are still real time when you upgrade to 
3D with the exception of Dip to Color. Dip to Color is not a real-time effect 
with the 3D Effects option. In addition, all Peel effects are now real time with 
the 3D Effects option.
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Manipulating 3D Effects in the Effect Preview Monitor

You can perform a number of operations on an image by clicking and 
dragging handles attached to the image in the Effect Preview monitor.

Zooming In or Out on the Effect Preview Monitor

Because you can move the bounds of a 3D effect outside the bounds of 
the enclosing frame, the Avid Composer system lets you view an out-
line of the image area at a reduced scale. Use the Enlarge and Reduce 
buttons under the Effect Preview monitor. These buttons serve the 
same function as the Enlarge Outline Scale and Reduce Outline Scale 
selections on the Edit menu.

Manipulating Effect Handles

You determine the direction and type of manipulation performed in 
the Effect Preview monitor by selecting one of the image manipulation 
buttons on the Effect Editor.

To manipulate a 3D effect handle in the Effect Preview monitor:

1. Click one of the image manipulation buttons on the Effect Editor 
to activate the speciÞc handles.

2. Click and drag the handles to manipulate the image.

3. Click the image manipulation button a second time to turn off the 
handles.

Z Rotation

X Rotation

XY Position

XZ Position

Enlarge

Reduce

Axis

Scale

Y Rotation

Crop

Corner Pin
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The following illustration shows the handles for several of the image 
manipulation buttons.

Using the Motion Path Editor

Use the Outline/Path button when you want to see the path an image 
takes on the screen (for example, moving a Picture-in-Picture effect). 
The motion path editor displays the path between key frames as either 
a straight line or a smooth curve. Click the Spline category Enable but-
ton to switch between a straight line and smooth curve. For a descrip-
tion of the Spline parameters, see ÒSpline Ñ Moving the Image 
Along a Smooth PathÓ on page 498. For an example, see ÒUsing the 
Spline ParametersÓ on page 356.

Scale X and Y at 
same time

Scale X

Scale Y

Rotate around Z AxisRotate around X Axis Rotate around Y Axis

Rotation AxisScale Position
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Creating Custom 3D Effects

This section provides examples of some basic 3D effects, including the 
steps and values used in creating the effects. You can use them to prac-
tice creating 3D effects or you can use them to get ideas for building 
your own effects. Examples of both segment effects and transition 
effects are included.

If you need more information while you are trying to complete the 
examples shown here, refer to the following sources:

¥ Chapter 2, for basic information on effects editing

¥ ÒUnderstanding the 3D Effects InterfaceÓ on page 333 for infor-
mation on the 3D interface, moving in 3D space, and descriptions 
of all the parameter panes and shapes

¥ Chapter 11, for reference information on all 3D Warp Effect 
parameters and controls

¥ The Avid Media Composer UserÕs Guide or Avid Film Composer UserÕs 
Guide, for basic information on using the Media Composer and 
Film Composer

In addition to re-creating the examples in this chapter, you can experi-
ment with the default shape effects. Each Shape effect has default val-
ues for the Þrst and last key frames. Examples of the default shapes are 
provided in Chapter 11.

Some Tips for Creating 3D Effects

The following tips apply to the examples in this chapter:

¥ Creating the segment: Transition effects require only a two-clip 
sequence. Some of the segment effects require at least two tracks.

¥ Avoiding InsufÞcient Source errors: Several of these examples 
assume that you are creating a transition effect centered on the cut 
between the incoming and outgoing video. Make sure you leave 
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enough material for the overlapping portions of the transition 
when you mark the source material. For example, the following 
illustration shows the Source monitor position bar for the outgo-
ing video clip.

If you get an ÒInsufÞcient SourceÓ message when you apply the 
3D Warp effect to the transition, it means you didnÕt leave enough 
source material behind for the system to create the transition.

¥ Using the Swap Sources button: When you use the 3D Warp 
effect as a transition and click on the effect for the Þrst time, the 
Avid Composer system applies the effect to the incoming video. 
To apply the effect to the outgoing video, click the Swap Sources 
button in the Foregnd (Foreground) parameter pane. Click any-
where in the effectÕs Timeline to view the results.

The following illustration shows the display for ÒCreating a Page Curl 
TransitionÓ on page 346, and identiÞes several areas that are referred 
to throughout the chapter.

Video material used for segment Material left behind for
transition to next clip

Source monitor position bar

Swap Sources button
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Effect icon 3D Warp 
parameters list

Effect Preview monitor

Key-frame 
indicators in 
the effect’s 
Timeline

3D Warp used as a transition effect 

Incoming 
video

Outgoing 
video

A simple two-clip sequence

Effect name 
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Creating a Page Curl Transition

This example uses the Page Curl effect. This effect treats the fore-
ground video channel as though it were a sheet of paper being rolled 
up to reveal another page beneath. Page Curl supports two highlights 
on the curl. The following illustrations show the effect created in this 
example.

To create the Page Curl effect:

1. Create a sequence and apply the 3D Warp effect as described in 
the previous section.

2. In the 3D Warp parameter list, click the triangle for Shape, and 
choose Page Curl from the Shape Fast menu.

Page Curl, 45 degrees

Incoming videoOutgoing video
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The default Page Curl effect appears on the incoming video. To 
apply the effect to the outgoing video, swap the video sources as 
follows:

a. Scroll down to display the Foregnd category, and click the tri-
angle.

b. Click the Swap Sources button.

c. Click anywhere in the effectÕs Timeline, and the Avid Com-
poser system displays the effect on the outgoing video.

3. Locate the Highlight category and click the Enable button.

4. Click the Þrst key-frame indicator.

The 3D Warp parameters list for the Þrst key frame is now active. 

5. In the Shape parameter pane, set the Curl slider to 0 (no curl).

6. Click the last key-frame indicator.

7. Set the Curl slider to 80. This takes the curl completely off the 
underlying video.

8. Click the Play button to preview the effect.

Triangular
opener

Category
name

Fast menu

Enable
button

Enable button

First key frame Last key frame
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n You might want to use the Transition parameters to lengthen the effect. See 
ÒUsing the Transition ParametersÓ on page 59 for more information.

A Simple Variation on the Page Turn Transition

This example describes how to make some simple changes to the Page 
Turn transition to create a dramatically different effect. To create this 
variation, use the example you created in the previous section.

For the previous example, you used the default No Split option on the 
Split Fast menu. This example uses the Quad Split option.

1. Click the Þrst key-frame indicator, and choose Quad Split from the 
Split Fast menu for the Shape parameter.

2. Click the Angle slider, type 135 on the numeric keypad, and press 
Enter to set the Angle for the Þrst key frame to 135 degrees. 

3. Click the last key frame and set the Angle to 135. The following 
table shows the values for each key frame.

Now step through or play the effect. The following illustrations show 
the effect.

Effect Parameter First Key Frame Last Key Frame

Shape
  Page Curl

Curl = 0

Radius = 15

Angle = 135

Quad Split

Curl = 80

Radius = 15

Angle = 135

Quad Split

Highlight Enabled Enabled
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Creating a Splash Dissolve

This example creates a Splash effect and uses it as a dissolve. Use the 
Opac. (opacity) slider in the Foregnd (foreground) parameter pane to 
create the dissolve. Changing the opacity value from solid to transpar-
ent creates the same effect as a dissolve.

The following illustrations show the effect and the outgoing and 
incoming video.

Page Curl effect 
Quad Split 135 degree angle

Splash dissolve

Incoming videoOutgoing video
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Here are some tips for creating this effect:

¥ Use the Multi Wave shape and increase the radius throughout the 
effect, starting at 0 and ending at 55.

¥ Add a new key frame (shown as the second key frame below) to 
provide a starting point for the dissolve. The complete dissolve 
occurs between the second and last key frames.

For information on working with key frames, see ÒUsing Key FramesÓ 
on page 99.

To create the Splash effect:

1. Create a sequence with two video clips as you did in the Page Curl 
examples, and drag the 3D Warp effect onto the transition point in 
the Timeline.

2. Click the effect in the Timeline and enter Effect mode (click the 
Effect Mode button).

3. Choose Multi Wave from the Shape Fast menu. The Avid Com-
poser system displays the default Multi Wave effect on the incom-
ing video.

4. Enable the Swap Sources button in the Foregnd parameter pane to 
display the effect on the outgoing video. 

Now click anywhere in the effectÕs Timeline, and the Avid Com-
poser system displays the effect on the outgoing video.

5. Click the Þrst key-frame indicator.

6. In the Shape parameter pane, set the Radius value to 0.

7. Click the last key-frame indicator.

8. In the Shape parameter pane, set the Radius value to 55.

First key frame Last key frameSecond key frame
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9. With the last key frame still selected, set the Opac value to 0 in the 
Foregnd parameter pane.

10. Add a new key frame approximately three-quarters of the way 
through the effect. 

This key frame will have a predetermined radius value (calculated 
by the Avid Composer system to create a smooth splash between 
radius values 0 and 55). You donÕt need to change this value.

11. For the key frame you just added, set the Opac. slider to 100 in the 
Foregnd parameter pane. 

12. Click the Play or Play Loop button to preview the effect.

The following table shows the nondefault key-frame values for this 
example.

Try experimenting with the Highlight parameter for this effect. Open 
the Highlight parameter pane and adjust the Inty (intensity) value.

Effect
Parameter

First Key 
Frame

Second Key 
Frame

Last Key 
Frame

Shape
  Multi Wave

Radius = 0 Let the Avid 
Composer system 
set the Radius.

Radius = 55

Foregnd
  Full Key

Opac = 100 Opac = 100 Opac = 0
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Turning a Splash into a Flat Image

The following techniques show two different ways to turn a Splash 
into a ßat image.

¥ Set the Radius value to 0. This setting conceals the ripples entirely. 
It allows you to create splash sequences simply by increasing the 
Radius.

¥ Bring Amplitude and Automatic Highlight intensity down to 0. 
Lowering the amplitude reduces the distortion. Reducing the 
highlight intensity to 0 eliminates highlights and shading. This 
allows you to:

- Bring up a full-sized Splash from beneath the center of the pic-
ture by keeping the Radius constant and increasing the Ampli-
tude and Highlight intensity settings.

- Create a Splash that starts small, becomes a full-sized Splash, 
and then changes to a ßat picture. The following example 
shows how to do this.

This example creates a splash that grows from the center of the screen. 
As the splash begins to cover the screen, the splash slowly fades away 
so that the Þnal scene is completely ßat. Fade the splash by lowering 
the Amplitude and Highlight intensity values to 0. The following illus-
trations show several stages of the effect.

Multi Wave Splash starts at center Splash at peak Splash slowly fades to flat
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To turn a Splash into a ßat image:

1. Apply the 3D Warp effect as a segment effect as shown in the fol-
lowing illustration.

2. Click the Effect Mode button to enter Effect mode. 

3. Choose Multi Wave from the Shape Fast menu.

4. Set Highlight parameter values for the Þrst and last key frames by 
using values from the following table.

5. Create a new key frame in approximately the center of the effectÕs 
Timeline. This new key frame is shown as the second key frame in 
the following illustration.

Effect
Parameter

First Key 
Frame 

Second Key 
Frame

Last Key 
Frame

Shape
  Multi Wave

Radius = 0

Freq = 70

Ampl = 36

Let the Avid 
Composer sys-
tem set the 
Radius.

Freq = 70

Ampl = 36

Radius = 50

Freq = 70

Ampl = 0

Highlight Inty = 20 Inty = 20 Inty = 0
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The Avid Composer system automatically calculates a radius size 
for this new key frame in order to continue the smooth transition 
from 0 radius to a radius of 50. 

6. Set the Shape and Highlight values for the second key frame as 
shown in the above table.

7. Step through or play the effect.

Experiment with the X Pos and Y Pos Shape parameter values to repo-
sition the splash on the screen. Also experiment with the Aspct and 
Angle parameters to stretch and rotate the splash.

Creating a Scaled Picture-in-Picture

This example shows how to create a picture-in-picture sequence that 
you can use to experiment with different 3D Warp parameters. It is 
particularly useful to scale the top video image because it allows you 
to easily view the effects of spinning, rotating, and distorting the 
image. This example uses two video tracks.

First key frame Last key frameSecond key frame
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To create a scaled picture-in-picture:

1. Apply the 3D Warp effect to the top video track.

2. Click the top video segment, and click the Effect Mode button to 
enter Effect mode. 

Now you are ready to select and adjust the 3D Warp parameters.

3. If both key-frame indicators are not already highlighted, press kÐ
A or kÐclick one key frame to select both key frames. 

Now you can change parameters for both key frames at the same 
time.

4. Open the Scaling parameter pane, and set the scale to 75 percent in 
X and Y. 

The easiest way to set a slider to an exact value is to click the 
slider, type the number on the numeric keypad, and press Enter.

5. Open the Border parameter pane.

6. Click the Enable button, and use the eyedropper to choose a color 
from the Effect Preview monitor.

Top video track Bottom video track
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7. Click the Color Preview window to activate the eyedropper.

For a description of how to use the eyedropper, see ÒAdjusting a 
Color ParameterÓ on page 104.

8. Select a border style from the Fast menu and use the H, S, and L 
sliders to adjust the color. Adjust the width to the size you want.

9. Click the Play or Play Loop button to preview the effect.

You can modify this effect by changing the size (scaling) of the image 
at different key frames or by changing the position so the image moves 
up or down across the screen.

Using the Spline Parameters

This example shows how to use the Spline parameters to create a 
smooth path for moving a Picture-in-Picture effect. The example uses 
the Picture-in-Picture effect that you created in the previous example.

The following illustrations show the motion path editor with the 
Spline parameter turned on and off.

Color Preview window 

Motion path editor with

Spline turned off Spline turned on

Motion path editor with
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1. Enter Effect mode and click the Þrst key-frame indicator (on the 
left side of the effectÕs Timeline). 

2. Click the Outline/Path button in the Effect Editor. 

A dot appears in the center of the image, and the arrow indicator 
appears to show the orientation of the image.

3. Click anywhere on the foreground video, and move the image to 
the bottom left corner of the Effect Preview monitor.

4. Click the last key-frame indicator, and move the image for that key 
frame to the top right corner of the monitor. Notice that the two 
dots are connected by a straight line.

5. Add a key frame approximately halfway through the effectÕs 
Timeline.

6. Move the image for the center key frame to the top left corner of 
the monitor.

7. Play the effect. Notice that the image moves along straight lines.

8. Click the Enable button in the Spline parameter pane. 

Notice that the straight line connecting the dots turns into a curve.

9. Play the effect again and notice the smooth movement.

Experiment with the XY Position and XZ Position buttons at any one 
of the key frames. Also experiment with the Rotation buttons.

n You can move the image for a key frame by Þrst clicking the dot instead of the 
key-frame indicator.

Enable button
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Corner Pinning an Image

Corner pinning is a way of precisely positioning a foreground image 
over an image in the background video track. This example shows the 
background and foreground videos used to create a segment transition 
using corner pinning. The segment starts with an image appearing on 
a TV screen; the image then moves off the TV and eventually Þlls the 
screen. 

If you want to leave the image static Ñ that is, to have it playing just 
on the TV screen Ñ you need to corner pin only the foreground video. 
However, to have the foreground image move off, as the example 
shows, you must position it in 3D space Þrst to get the trajectory you 
want. Once it is positioned correctly, then you corner pin it so that it 
looks at Þrst as though it is playing on the TV screen.

Foreground video corner pinned 
to background image

Foreground video moving off 
background image

Foreground video continuing to
move off background image

Background video Foreground video
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To corner pin an image:

1. Create a segment with two video tracks, placing the foreground 
video on the top track.

2. Apply the 3D Warp effect to the top track.

3. Enter Effect mode.

4. Scale your image if necessary.

5. Position the corners using one of the methods described in the fol-
lowing sections.

6. To review your edit, click the Play or Play Loop button.

n To return a corner to the default position, click the corresponding corner but-
ton in the parameter pane, and Option-click the Enable button in the Corner 
Pin parameter pane.

To use the Corner Pin button:

1. Click the Corner Pin button in the Effect Editor to activate the 
handles.

2. Click and drag the handles to manipulate the image.

3. Click the Corner Pin button a second time to turn off the handles.

To use the Quick Pin Feature:

1. Click the Corner Pin button in the Effect Editor to activate the 
handles.
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2. Press and hold the Control key, position the cursor where you 
want the highlighted corner to be corner pinned, and click.

The next corner is highlighted. 

3. Continue using the Control key and clicking until the image is 
positioned where you want it.

The next corners continue to be highlighted in a clockwise rotation 
each time you click.

4. Click the Corner Pin button a second time to turn off the handles.

To use the parameter pane:

1. Click the Corner Pin Enable button.

2. Use the X and Y sliders in the Corner Pin parameter pane to posi-
tion the image.

The Corner Pin parameter pane has a button for each corner, let-
ting you pin one corner at a time.

Creating a Stamp

In the example below, three Title effects are applied sequentially on the 
top track, each containing one of the words. Each one has Stamp 
enabled on the last key frame. Enabling Stamp lets each word remain 
in place as the next word moves across the screen. 

All three words will remain stamped in place, and you could add 
additional stamps until you enable Clear to clear the Stamp buffer.



361

To create a stamp:

1. Create the image you want to use as a stamp.

For example, you can use the Title Tool to create a title or you 
could import a PICT image.

2. Create a segment with at least two video tracks. 

If you want the stamp to be in the foreground, it has to be on the 
top track.

3. Add the track with your stamp image to the segment.

4. Enter Effect mode.

5. Click the 3D Promote button to turn on 3D effects.

6. Select the key frame where you want the stamp to occur.

If you donÕt want to use the Þrst or last key frame, add a key frame 
where you want the stamp to occur.

7. Click the Enable button in the Stamp parameter pane.

Title one stamped in place
Title two moving into position

Titles one and two stamped in place
Title three moving into position

All three titles stamped in place
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You can enable Stamp on more than one key frame by repeating 
steps 6 and 7.

8. To review your edit, click the Play or Play Loop button.

To clear a stamp:

1. Select the key frame where you want the stamp to be cleared.

2. Click the Clear button in the Stamp parameter pane.

Everything in the Stamp buffer is cleared.

Using Axis for a Transition

The effect created in this example uses changes to axis and rotation to 
create a transition. If you move the axis in Z, the point of rotation 
moves off the object and creates a Òbarrel rollÓ effect as if the object is 
inside a rolling barrel. By breaking the move into two parts, you can 
add another shot on the reverse side of the image. 

To use axis for a transition:

1. Create a two-track sequence.

2. Apply the 3D Warp effect to the segment on the second track. 

3. Make the effect at least Þve seconds long.

4. With both key frames selected, set Z to Ð90 in the Axis parameter 
pane.

5. Select the second key frame and set Y to Ð180 in the Rotation 
parameter pane.

6. Play the effect to see the simple YZ barrel roll.

7. Go back three seconds from the end of the effect and add a new 
key frame.

8. Copy the last key-frame values to the new key frame.

9. Duplicate this new key frame one second later by copying and 
pasting so that the last three key frames are identical.
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The frame stays at the half barrel roll position for three seconds.

10. Select the last key frame and set Z to 180 in the Position parameter 
pane.

This should bring the frame full screen for the new ending 
position.

11. Play the effect.

It should do a half barrel roll back, stay in position, and then move 
forward.

12. Find the point during the half barrel roll where the image is edge 
on to the viewer. 

The image should disappear and reappear with the back of the 
image showing.

13. Perform an add edit at this point. 

This divides the effect in two with the correct key frames being 
sent to the correct parts of the clip.

14. Load the incoming video into the Source monitor, and mark it so 
that you can use it for the back of the image.

15. Step into the second part of the effect until all you see in the 
Timeline is the original video.

16. Mark the clip and replace it with the new shot.

17. Step out and play the effect.

Notice that the new incoming shot is reversed.

18. Step back in and apply a Flop to the incoming image.

19. Render the Flop.

20. Step out again and watch the effect. 

The incoming shot correctly transitions to full screen at the end of 
the effect.
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Applying a Chroma Key

Like matte keys, chroma keys are used to replace an area of one shot 
with another shot. However, unlike matte keys, the area of replace-
ment is determined by a single highly saturated color, usually a dis-
tinctive blue or green. The foreground object, such as a person, is shot 
in a studio in front of a screen of the selected color. Then the back-
ground is keyed out with a more desirable background, such as a 
weather map, an outdoor scene, or computer-generated animation.

Chroma keys work better when you use component sources that have 
been digitized as a component signal. You can achieve this by using a 
component format, such as Betacam SP or D1, and a transcoder or the 
Avid video I/O baseboard. Proper lighting is also crucial to separating 
the foreground image from the chroma key color background.

To apply a Chroma Key effect:

1. Edit the foreground image onto V2 and the background image 
onto V1 in the Timeline.

2. Apply the 3D Warp effect to V2.

3. Choose Chroma Key from the Fast menu in the Foregnd (Fore-
ground) parameter pane.

4. Click the Color Preview window, and press and hold the mouse.

5. When the eyedropper appears, drag it to the most representative 
area of color to be keyed and release the mouse.

When choosing a color, stay away from corners of the frame or the 
area immediately around the foreground because these areas may 
contain subtle shades of gray.

When you are Þnished, the system replaces the color with the 
video on V1.

Since it is often difÞcult to create a perfect key on the Þrst try, use the 
sliders on the Foregnd parameter pane to make value adjustments.



365

Using Avid Xpress 3D Effects

The Effect Palette Ñ on systems equipped with the 3D Effects option 
Ñ contains an Xpress 3D Effect category.

The Xpress 3D effects have the following uses:

¥ Xpress 3D effects are completely compatible with Avid Xpress sys-
tems that are also equipped with the 3D Effects option. As a result, 
you can move sequences containing Xpress 3D effects between 
Avid Composer systems and Avid Xpress systems.

c To maintain compatibility when transferring sequences between 
Avid Composer systems and Avid Xpress systems, use only Xpress 
3D effects (do not use the 3D Warp effect to create 3D effects).

¥ Xpress 3D effects provide a fast way to apply basic 3D effects to 
your sequence, without making custom adjustments using the 3D 
Warp effect. For example, the 3D Page Curl effect automatically 
creates a page curl effect when you apply it. 

n You can further adjust Xpress 3D effects in the Effect Editor; use the 3D 
Warp effect, however, when you need Þner control of 3D effects parameters.
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CHAPTER 10

2D Effects Reference

This chapter describes 2D parameters and summarizes 2D effects in 
alphabetical order within each effect category. For information on 
effects editing, see ÒApplying Effects to a SequenceÓ on page 46.

¥ 2D Effect Parameters Reference

¥ Plug-in Effects

¥ Blend Effects

¥ Conceal Effects

¥ Film Effects

¥ Image Effects

¥ Key Effects

¥ L-Conceal Effects

¥ Motion Effects

¥ Peel Effects

¥ Push Effects

¥ Spin Effects

¥ Squeeze Effects

¥ Wipes

¥ Comparison of Similar Effects
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2D Effect Parameters Reference

This section provides a general description of all 2D parameters, in 
alphabetical order. Each effect includes a subset. If there is information 
about a parameter that is unique to a speciÞc effect, it is explained in 
the description of that effect in this chapter. Some parameters have 
corresponding 3D versions. The 3D versions are described in Chapter 
11, Ò3D Effects Reference.Ó

Effect parameters are grouped in the following categories:

¥ Acceleration Parameter (see 3D version on page 497)

¥ Background Parameter (see 3D version on page 518)

¥ Border Parameters (see 3D version on page 505)

¥ Color Effect Parameters

¥ Crop Parameters (see 3D version on page 491)

¥ Foreground Parameter

¥ Key Control Parameters (see 3D version on page 511)

¥ Matrix Parameters

¥ Motion Effect Parameters

¥ Position Parameters (see 3D version on page 496)

¥ Blowup Parameters (see 3D version on page 519)

¥ Transition Parameters (see 3D version on page 492)

For effect parameters speciÞc to the Color Effect, see ÒColor EffectÓ on 
page 407.

For an explanation of how to change a parameter, see ÒChanging a 
ParameterÓ on page 96.
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Acceleration Parameter

Acceleration adjusts the effectÕs speed over time by having the effect 
ease in and ease out. This gives the effect a more natural appearance. 
The Acceleration parameter applies to the entire effect, not to speciÞc 
key frames.

The overall speed of an effect is determined by the duration of the 
effect, which is determined by the length of the clip in the sequence. 
If you want to slow down or speed up the movement of an effect, you 
will need to change the length of your sequence; or use add edits to 
limit the portion of the clip affected by the effect.

n If your system has the 3D Effects option, see the 3D version on page 497.
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AniMatte Parameters

The AniMatte effect parameters allow you to adjust a drawn matte on 
one or more frames to create multilayer matte keys and single-layer 
organic matte wipes.

For an in-depth discussion of AniMatte parameters, see ÒWorking 
with Intraframe Editing ParametersÓ on page 242 and ÒAniMatte 
Effect ParametersÓ on page 315.

Background Parameter

The Background parameter sets the color for the background in effects 
that display a background. For example, the background parameters 
determine the color to be used in a Fade to Color, Fade from Color, or 
Dip to Color effect, and the color to be replaced with video in a 
Chroma Key effect.
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n If your system has the 3D Effects option, see ÒBackground Ñ Add a Back-
ground ColorÓ on page 518.

Other Options Button

The Other Options button in the Background parameter opens the 
Macintosh Color Picker for precise color selection. For more informa-
tion on using the Macintosh Color Picker, see ÒUsing the Macintosh 
Color PickerÓ on page 105.

Hue

Hue identiÞes the background color. The Hue parameter is measured 
as values on a color wheel ranging from 0 to 255. The start (0) and end-
ing (255) values are both red.

Saturation (Sat)

Saturation speciÞes the amount or intensity of the color. Values range 
from 0 to 255, where 0 is no chrominance and 255 is a fully saturated 
color.

Luminance (Lum)

Luminance speciÞes the brightness of the color. Values range from 0 to 
255, where 0 is black and 255 is full brightness or white.

Border Parameters

Many effects allow you to place a border on the inner or incoming pic-
ture in the effect. The Border parameters allow you to specify color, 
softness, and width of the border. Some effects also include Blend 
Color parameters for blending border color.
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n If your system has the 3D Effects option, see the 3D version on page 505.

Other Options Button

The Other Options button in the Border parameter opens the Macin-
tosh Color Picker for precise color selection. For more information on 
using the Macintosh Color Picker, see ÒUsing the Macintosh Color 
PickerÓ on page 105.

Hue

Hue identiÞes the border or blend color. The Hue parameter is mea-
sured as values on a color wheel ranging from 0 to 255. The start (0) 
and ending (255) values are both red.

Saturation (Sat)

Saturation speciÞes the amount or intensity of the color. Values range 
from 0 to 255, where 0 is no chrominance and 255 is a fully saturated 
color.

Luminance (Lum)

Luminance speciÞes the brightness of the color. Values range from 0 to 
255, where 0 is black and 255 is full brightness or white.

Border with the Blend 
Color parametersBorder without the Blend 

Color parameters

Other 
Options 
button
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Width

Border Width speciÞes the width of the border. Values range from 0 
(no border) to 63 (widest border).

Softness (Soft)

Border Softness blends the border with the background image, giving 
the border a soft appearance. Values range from 0 (no softness) to 63 
(maximum softness).

Color Effect Parameters

For an explanation of the parameters listed below, see ÒColor EffectÓ 
on page 407.

¥ Luma Adjust Ð brightness, contrast, and clip

¥ Chroma Adjust Ð hue and saturation

¥ Color Style Ð posterization and solarization

¥ Color Gain Ð red, green, and blue

Crop Parameters

The Crop parameters remove video from the top, bottom, left, and 
right edges of the video. 

n Cropping is available only if your Avid Composer system has an Advanced 
JPEG compression board and, on some systems, a Mandrill DVE daughter 
board.
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Top

Removes video from the top of the inner or incoming video. Values 
range from 0 to 999; 0 is the top of the screen, 500 is the middle of the 
screen, and 999 is the bottom of the screen.

Bottom

Removes video from the bottom of the inner or incoming video. Val-
ues range from Ð999 to 0; 0 is the bottom of the screen, Ð500 is the mid-
dle of the screen, and Ð999 is the top of the screen.

Left

Removes video from the left side of the inner or incoming video. Val-
ues range from 0 to 999, 0 is the left side; 500 is the middle, and 999 is 
the right side.

Right

Removes video from the right side of the inner or incoming video. Val-
ues range from Ð999 to 0; 0 is the right side, Ð500 is the middle, and Ð
999 is the left side.

n If your system has the 3D Effects option, see the 3D version on page 491.

Foreground Parameter

The Foreground parameter is used, together with key frames, to set 
the relative amount of the effect to be displayed over time. 
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The Foreground Level slider controls the opacity of the foreground 
image. A Level of 0 is 0 percent opacity (the foreground is transpar-
ent), a Level of 50 is 50 percent opacity, and a Level of 100 is 100 per-
cent opacity (no transparency).

Select the Reverse option to reverse the background and foreground 
video, with the same opacity setting.

Key Control Parameters

Key control parameters appear only in YUV Chroma Key and Luma 
Key effects, and control the primary key color and the amount of video 
replacement for the key. Secondary Key and Spill Suppression param-
eters appear when you use the YUV Chroma Key effect.

n If your system has the 3D Effects option, see the 3D version on page 511.

Use Key, Secondary Key, and Spill Supression as follows:

¥ Use the Key parameters to select the primary key color to be 
replaced by video.

Other Options button
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¥ Use the Secondary Key parameters to key out a second back-
ground color. For example, for bluescreen footage, the ßoor may 
be a slightly different shade of blue than the background. You can 
choose the ßoor color as your secondary color and key it out. The 
secondary color is also useful when uneven lighting introduces 
additional shades of the background color.

¥ Use the Spill Suppression key color to Þx the following problems:

- Remove background color spill from the foreground image. 
Color spill occurs when the background color is present in the 
foreground image due to backdrop reßection.

- If the foreground object retains an outline of the chroma key 
color, you can use spill suppression to reduce the color effect 
in the outline.

The spill suppression key neutralizes the selected color without affect-
ing the luminance. The Avid Composer system changes the spill color 
to a gray-scale, allowing it to blend more easily with the foreground 
image.

Other Options Button

The Other Options button in the Key parameter opens the Macintosh 
Color Picker for precise color selection. For more information on using 
the Macintosh Color Picker, see ÒUsing the Macintosh Color PickerÓ 
on page 105.

Hue

Hue identiÞes the key color. The Hue parameter is measured as values 
on a color wheel ranging from 0 to 255. The start (0) and ending (255) 
values are both red.

Saturation (Sat)

Saturation speciÞes the amount or intensity of the color. Values range 
from 0 to 255, where 0 is no chrominance and 255 is a fully saturated 
color.
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Luminance (Lum)

Luminance speciÞes the brightness of the color. Values range from 0 to 
255, where 0 is black and 255 is full brightness or white.

Gain

The Gain parameter speciÞes how much of the foreground and the 
background video will be displayed. Values range from 0 to 63. A Gain 
of 0 shows only the foreground. A Gain of 63 replaces all the fore-
ground video with the background video.

Softness (Soft)

The Softness parameter determines how the bordering colors along 
the edge of the key are processed in the effect. Colors that border the 
luminance or chroma speciÞed for the key are displayed as a blend of 
the foreground and the background video. The higher the Softness 
value, the more of the background video will be blended in the border 
colors. Use the Soft slider to improve the appearance of the edges of 
the keyed areas.

Matrix Parameters

Matrix effects are effects that use a grid to deÞne the position or 
progress of the effect over time. The Matrix parameters deÞne the grid 
to be used in the effect.

Other Options Button

The Other Options button in the Matrix effects opens the Matrix 
effectÕs dialog box shown below. 
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You can select a standard grid or enter a custom number of rows and 
columns. The minimum number of rows and columns is 2 x 2.

Columns

Number of columns in the effect.

Rows

Number of rows in the effect.

Motion Effect Parameters

Motion effect parameters apply to freeze frame, variable speed, and 
strobe motion effects. For information applying and editing Motion 
effects, see ÒCreating Motion EffectsÓ on page 64.

Freeze Frame Parameters

You access Freeze Frame parameters by choosing Freeze Frame from 
the Clip menu.

Columns Rows

Graphical
representation
of the grid
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Duration

The Duration parameter speciÞes the length of the freeze frame clip 
that will be created in the Source monitor. You can either select a dura-
tion from the Freeze Frame pop-up menu or select Other to enter a 
custom duration.

Other

Other opens a dialog box that allows you to specify a custom duration 
for the freeze frame clip.

Two Field Freeze Frames

The Two Field Freeze Frames parameter determines how two-Þeld 
media will be processed to create the Motion effect.

¥ Using Duplicated Field Ñ A single Þeld is displayed in the effect.

¥ Using Both Fields Ñ Both Þelds are displayed in the effect.

Duration

Custom duration
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¥ Using Interpolated Field Ñ A second Þeld is created for the effect 
by combining scan line pairs from the Þrst Þeld in the original 
media.

Variable Speed and Strobe Motion Parameters

You access Variable Speed and Strobe Motion parameters by clicking 
the Motion Effect button to open the Motion Effect Parameters dialog 
box.

Variable Speed

Select Variable Speed, and set the parameters based on the following:

¥ Duration Ñ The duration of the effect in frames. Doubling the 
number of frames causes the frame rate to be half the current rate.

¥ Rate Ñ The rate of speed in frames per second (fps) at which the 
video will be played. Normal speed is 30 fps for NTSC video, 25 
fps for PAL video, and 24 fps for Þlm.

Variable Speed 
effect 



380

¥ % speed Ñ The percent of speed at which the video will be played. 
100% is normal speed.

¥ Fit To Fill Ñ Sets the Variable Speed parameters, so the duration of 
the Motion effect will match the IN to OUT duration marked in 
the Record monitor.

n To indicate reverse motion at full play rate, slow or fast, enter a negative play 
rate or a percent.

Strobe Motion

Select Strobe Motion and specify the update rate in frames for the 
Strobe effect. For example, a rate of 5 causes every Þfth frame to be dis-
played in the Strobe effect.

Render 2-Field Motion Effect

The Render 2-Field Motion Effect parameter determines how two-Þeld 
media will be processed to create the Motion effect.

¥ Duplicated Field Ñ A single Þeld is displayed in the effect.

¥ Both Fields Ñ Both Þelds are displayed in the effect.

¥ Interpolated Field Ñ A second Þeld is created for the effect by 
combining scan line pairs from the Þrst Þeld in the original media.
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Paint Effect Parameters

The Paint effect parameters provide control when painting an object 
directly on an individual frame or series of frames (a segment of a 
sequence or subsequence).

For an in-depth discussion of Paint effect parameters, see ÒWorking 
with Intraframe Editing ParametersÓ on page 242 and ÒPaint Effect 
ParametersÓ on page 297.

Position Parameters

Position parameters set horizontal and vertical position.

n If your system has the 3D Effects option, see the 3D version on page 496.
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Horizontal Position (H Pos)

Moves the video from side to side. Values range from Ð999 to 999. 
Negative values move the image to the left. Positive values move the 
image to the right.

Vertical Position (V Pos)

Moves the video up and down. Values range from Ð999 to 999. 
Negative values move the image to the top. Positive values move the 
image to the bottom.

Blowup Parameters

The Blowup effect for Þlm projects uses the following parameters to 
set the effectÕs position and size:

Field

The Field parameter controls the size of the image. A Þeld of 1 leaves 
the image size unchanged, and a Þeld of 10 increases the image to the 
maximum size.

X Position (X Pos)

The X Pos slider allows you to position the image horizontally on the 
screen. The X Position varies on a scale of West 20 to East 20, where 0 is 
unchanged. This matches the description in the cut list.



383

Y Position (Y Pos)

The Y slider allows you to position the image vertically on the screen. 
The Y Position varies on a scale of North 20 to South 20, where 0 is 
unchanged. This matches the description in the cut list.

Profile

The ProÞle window in the Effect Editor is a graphical representation of 
the foreground level and acceleration applied to effect key frames:

¥ Foreground level affects the opacity of the effect. The greater the 
opacity, the closer to the top of the ProÞle graph the key frame 
appears. For more information, see the following section, ÒAdjust-
ing Foreground Level in the ProÞle Window.Ó

¥ Acceleration affects the rate of movement into and out of key 
frames. The greater the acceleration, the more rounded the lines 
appear in the ProÞle window. You can adjust Acceleration with the 
Acceleration slider only. For more information, see ÒAcceleration 
ParameterÓ on page 368.

Adjusting Foreground Level in the Profile Window

Foreground level controls the opacity of a 3D effect layer. You can 
adjust levels for various key frames directly in the ProÞle window. 
This is the same as using the Level slider in the Foreground parameter 
pane, as described in ÒForeground ParameterÓ on page 373. Adjust-
ments you make with the Level slider are also represented in the Pro-
Þle graph.

100% level (foreground is opaque)

0% level (foreground is transparent)

Straight lines indicate no acceleration. 
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To adjust foreground level within the ProÞle window:

1. Select the appropriate key frame in the effectÕs Timeline.

2. Click on the round white key-frame indicator that appears on the 
ProÞle graph, and drag it up or down to increase or decrease the 
opacity of the foreground image.

Scaling Parameters

Scaling involves resizing the effect by adjusting height and width.

Width (Wid)

Controls the width of the image when the Fixed Aspect parameter is 
disabled. Values range from 0 to 400.

Height (Hgt)

Controls the height of the image when the Fixed Aspect parameter is 
disabled. Values range from 0 to 400.

Fixed Aspect

The Fixed Aspect parameter determines which position and size 
parameters are displayed. When the Fixed Aspect parameter is 
enabled, the aspect ratio of the picture cannot be changed, and the 
Width and Height parametersÕ sliders are replaced with a Size param-
eter slider.
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Transition Parameters

The Transition parameters appear in the bottom tool bar of the Effect 
Editor.

Transition Effect Alignment

The Transition Effect Alignment parameters specify the start of the 
transition effect relative to the cut point in the sequence. Click the but-
ton to the left of the Transition Effect Duration parameter, and select a 
position from the Transition Effect Alignment pop-up menu:

¥ Ending at Cut Ñ The transition effect will start a number of 
frames before the cut deÞned by the duration, such that the effect 
completes at the cut point in the video.

¥ Centered on Cut Ñ The transition will be centered on the cut so 
that half the effect will occur before the cut point and half will 
occur after the cut point in the sequence.

¥ Starting at Cut Ñ The transition effect will start immediately after 
the last frame of the outgoing video is displayed.

¥ Custom Start Ñ Allows you to specify the number of frames 
before and after the cut to be included in the effect.

Transition Effect Duration

The Transition Effect Duration parameter speciÞes the length of time 
that the effect will span the transition. The duration of a segment effect 
is determined by the length of the segment. The Transition Effect 
Duration format that is displayed (for example, 1:00 is one second and 

Click the Transition 
Effect Alignment but-
ton to select a posi-
tion from the pop-up 
menu.

Transition Effect Duration
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0 frames) is determined by the Transition Effect Duration setting you 
selected at the top of the Source/Record mode window.

n For more information about using transition effects, see ÒWorking with 
Transition EffectsÓ on page 58.

Plug-in Effects

If you install third-party plug-in effects that are compatible with 
Adobe Photoshop Version 2.50 or greater, those effect categories will 
appear in the Effect Palette. For information on installing and using 
third-party plug-in effects, see ÒInstalling Third-Party Plug-in 
EffectsÓ on page 35.

Blend Effects

Blend effects are general two-channel effects. They include:

¥ Dip to Color

¥ Dissolve

¥ Fade from Color

¥ Fade to Color

¥ Picture-in-Picture

¥ Superimpose

n If your system has the 3D Effects option, see ÒUnderstanding the 3D 
Effects InterfaceÓ on page 333 for a description of the 3D Warp effect.
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Dip to Color  

 

Effect Category Blend

Apply to Transitions

Parameters ProÞle Ð Foreground level

Foreground Ð level

Background Ð hue, saturation, and luminance

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible No

Description Fades from the outgoing video to black, white, or 
any color and then fades up to the incoming video. 
Color is speciÞed using the Lum, Chroma, and Sat 
sliders.

Dip to Color effect Image dips to white

Incoming videoOutgoing video
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Dissolve  

Effect Category Blend

Apply to Transitions

Parameters ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible No

Description Blends images from the outgoing video with the 
incoming video over time.

Dissolve effect

Incoming video Outgoing video
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Fade from Color  

Fade to Color  

Effect Category Blend

Apply to Transitions

Parameters ProÞle Ð Foreground level

Foreground Ð level

Background Ð hue, saturation, and luminance

Acceleration

Transition Ð Transition effect alignment and duration

Reversible Yes

Description Fades from any color to incoming video.

Effect Category Blend

Apply to Transitions

Parameters ProÞle Ð Foreground level

Foreground Ð level

Background Ð hue, saturation, and luminance

Acceleration

Transition Ð Transition effect alignment and duration

Reversible Yes

Description Fades from the outgoing video to any color.
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Picture-in-Picture  

Effect Category Blend

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Scaling Ð height, width, and Þxed aspect

Position Ð horizontal position, vertical position

Crop Ð left, right, top, and bottom

Transition Ð Transition effect alignment and 
duration

Reversible No

Description Creates a picture within a picture. Video from the 
higher layer, where the effect is applied, is dis-
played inside the video on the lower layer. When 
used on a transition, the incoming video appears 
inside outgoing video.
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Superimpose  

Picture-in-Picture effect

Video layer 2Video layer 1

Effect Category Blend

Apply to Multilayer segments

Parameters ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Reversible No

Description Blends the image from the upper video track 
(where the effect is applied) with the image from 
the lower video track over time. Level set at 100 
percent shows only the video image from the upper 
track where the effect is applied. Level set at 0 per-
cent shows only the video image from the lower 
video track.
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Superimpose effect

Video layer 2Video layer 1
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Conceal Effects

Conceal effects overlap one video channel over another video channel 
using a predeÞned path. They include:

¥ Bottom Left to Top Right

¥ Bottom Right to Top Left

¥ Bottom to Top

¥ Left to Right

¥ Right to Left

¥ Top Left to Bottom Right

¥ Top Right to Bottom Left

¥ Top to Bottom

For an example of a Conceal effect, see ÒTop Left to Bottom RightÓ on 
page 397.

For examples of similar effects, see ÒComparison of Similar EffectsÓ 
on page 487.

Bottom Left to Top Right  

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments
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Bottom Right to Top Left  

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The outgoing video slides on top of the incoming 
video from the bottom left to the top right of the 
screen.

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The outgoing video slides on top of the incoming 
video from the bottom right to the top left of the 
screen.
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Bottom to Top  

Left to Right  

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video slides on top of the outgoing 
video from the bottom to the top of the screen.

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration
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Right to Left  

Reversible Yes

Description The incoming video slides on top of the outgoing 
video from the left edge to the right edge of the 
screen.

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video slides on top of the outgoing 
video from the right edge to the left edge of the 
screen.
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Top Left to Bottom Right  

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and duration

Reversible Yes

Description The incoming video slides on top of the outgoing 
video from top left corner to bottom right corner of 
the screen.

Conceal effect

Incoming videoOutgoing video
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n For examples, see ÒComparison of Similar EffectsÓ on page 487.

Top Right to Bottom Left  

Effect Category Conceal

Apply to Transitions, single-layer and multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video slides on top of the outgoing 
video from the top right corner of the screen to the 
bottom left corner of the screen.
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Top to Bottom  

Effect Category Conceals

Apply to Transitions, single-layer and multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video slides on top of the outgoing 
video from the top of the screen to the bottom of the 
screen.
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Film Effects

Film effects emulate many of the effects an optical house can produce. 
They include:

¥ 1:1.66 Mask

¥ 1:1.85 Mask

¥ 1:2.35 Mask

¥ 16 x 9 Mask

¥ Blowup

¥ Film Dissolve

¥ Film Fade

¥ Mask

n Film effects are available only on Media Composer systems with Film Options 
and on Film Composer systems.

1:1.66 Mask  

Effect Category Film

Apply to Single-layer segments

Parameters Background Ð hue, saturation, luminance

Scaling Ð height, width, and Þxed aspect

Position Ð horizontal position, vertical position

Reversible No
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1:1.85 Mask  

Description Masks out any area of the image that is not inside a 
centered rectangle. The centered rectangle is 1.66 
times wider than it is tall. The area surrounding the 
rectangle is masked by a black background.

Effect Category Film

Apply to Single-layer segments

Parameters Background Ð hue, saturation, luminance

Scaling Ð height, width, and Þxed aspect

Position Ð horizontal position, vertical position

Reversible No

Description Masks out any area of the image that is not inside a 
centered rectangle. The centered rectangle is 1.85 
times wider than it is tall. The area surrounding the 
rectangle is masked by a black background.

1:1.85 Mask effectOriginal image
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1:2.35 Mask  

16 x 9 Mask  

Effect Category Film

Apply to Single-layer segments

Parameters Background Ð hue, saturation, luminance

Scaling Ð height, width, and Þxed aspect

Position Ð horizontal position, vertical position

Reversible No

Description Masks out any area of the image that is not inside a 
centered rectangle. The centered rectangle is 2.35 
times wider than it is tall. The area surrounding the 
rectangle is masked by a black background.

Effect Category Film

Apply to Single-layer segments

Parameters Background Ð hue, saturation, luminance

Scaling Ð height, width, and Þxed aspect

Position Ð horizontal position, vertical position

Reversible No

Description Masks out any area of the image that is not inside a 
centered rectangle. The centered rectangle is 16 units 
wide by 9 units high. The area surrounding the rect-
angle is masked by a black background.
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Blowup  

Effect Category Film

Apply to Single-layer segments

Parameters Background Ð hue, saturation, luminance

Blowup Ð Þeld, X position, and Y position

Reversible No

Description Blowup modiÞes the size and portion of the picture 
that is displayed.

The X Position varies on a scale of 20 West to 20 East, 
where 0 leaves the image unchanged.

The Y Position varies on a scale of 20 North to 
20 South, where 0 leaves the image unchanged.

The Field slider increases the size of the picture 
and is set from 0 to 10, where 0 leaves the image 
unchanged and 10 increases the image to the maxi-
mum size.

Blowup effectOriginal image
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Film Dissolve  

Effect Category Film

Apply to Transitions

Parameters ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible No

Description Blends the outgoing frame to the incoming frame 
over time. The Level parameter has been preset 
according to Kodak speciÞcations. Avid does not 
recommend adjusting the Level parameter on this 
effect.

The Level set at 0% shows all of the outgoing frame. 
The Level set at 100% shows all of the incoming 
frame. 

This dissolve has preset parameters that emulate 
ÞlmÕs response to light when dissolving to another 
(nonblack) picture.
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Film Fade  

Film Dissolve effect

Incoming video Outgoing video 

Effect Category Film

Apply to Transitions

Parameters ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Reversible No
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Mask  

Description Blends the outgoing pictures to the incoming pic-
tures over time. The Level parameter has been preset 
according to Kodak speciÞcations. Avid does not 
recommend adjusting the Level parameter on this 
effect. 

The Level set at 0% shows all of the outgoing frame. 
The Level set at 100% shows all of the incoming 
frame.

This dissolve has preset parameters that emulate 
ÞlmÕs response to black material. Use this effect for 
fade ins and fade outs.

Effect Category Film

Apply to Single-layer segments

Parameters Background Ð hue, saturation, luminance

Scaling Ð height, width, and Þxed aspect

Position Ð horizontal position, vertical position

Reversible No

Description Masks out any area of the image that is not 
inside a rectangle deÞned by the Scaling, Fixed 
Aspect, and Position parameters of the effect.

The area surrounding this rectangle is masked 
by the effectÕs background color.
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Image Effects

Image effects are general effects that apply to a single stream of video. 
They include:

¥ Color Effect

¥ Flip

¥ Flip-Flop

¥ Flop

¥ Mask

¥ Paint Effect

¥ Resize

¥ Submaster

Color Effect  

Effect Category Image

Apply to Single-layer segments

Parameters Luminance Ð brightness, contrast, range, clip, and 
invert

Chroma Ð hue, saturation, and invert

Color Style Ð posterization and solarization

Color Gain Ð red, green, and blue

Reversible Both Luma Adjust and Chroma Adjust can be 
reversed.

Description The Color Effect modiÞes the luminance, chroma, 
style (posterized or solarized), and color gain of the 
segment.
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Luminance (Luma Adjust)

Brightness (Bright)

Brightness changes the brightness of the picture. The parameter 
ranges from Ð100 to +100, where a value of 0 indicates no change. A 
value of Ð100 darkens the image; a value of +100 brightens the image.

Color Effect parameters

Original – Brightness 0 Brightness –50 Brightness +50
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Contrast (Cont)

Contrast controls the contrast of light and dark areas in the picture. 
Values range from Ð100 to +100, where a value of 0 indicates the image 
is unchanged. A negative value is less contrast; a positive value is 
more contrast.

Invert

Invert reverses the imageÕs brightness, such that the brightest parts 
become the darkest and the darkest parts become the lightest.

Luma Range

Luma Range parameters allow you to determine the range of bright-
ness from black to white:

¥ Fast Menu Ð there are two selections: Ò16 to 235Ó and Ò0 to 255.Ó 
This menu allows you to specify the output range of the Black 
Point and White Point parameters. It is set to 16 to 235 by default, 
which is the default for video images.

Select 0-255 if you want to map normal video to alpha ranges. This 
is useful if you have a high-contrast image that you want to 
expand to the full dynamic range. For example, use this value 
when you want to convert video to alpha for Matte Key effects.

¥ W Point (White Point) Ð allows you set the white point in the 
image. All pixels with that value become white, and all pixels with 

Original – Contrast 0 Contrast –50 Contrast +50
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higher values are also clipped to white. The default is 235 (the 
broadcast value for white).

¥ B Point (Black Point) Ð Allows you set the black point in the image. 
All pixels with that value become black, and all pixels with lower 
values are also clipped to black. 

For example, you could use the eyedropper to select a shadow on 
the ßoor and change it from gray to black, clipping everything 
below that shade to black. The default is 16 (the broadcast value 
for black).

¥ Gamma Ð Allows you to adjust the midtones in an image without 
affecting the extreme white or black values. Lowering the value 
darkens midtones and brings the image closer to black. Raising 
the value lightens the midtones and brings the image closer to 
white.

For example, a person shot in front of a window in daylight may 
be very dark, almost in silhouette. You can use gamma correction 
to increase the midtones without changing the blacks or whites. 
Values range from Ð100 to +100 with 0 being no change. 

The number of shades of gray in an image are determined by the 
W Point, B Point, and Luma Clip sliders. The Gamma point allows 
you to move the distribution of the shades closer to black or closer 
to white. Negative values move the distribution closer to black. 
Positive values move the distribution closer to white.

Raising the Black Point and lowering the White Point values increases 
the contrast by reducing the number of shades of gray in an image. 
The number of shades are reduced because you map some to extreme 
black and others to extreme white.

n When you change the Luma Range to 0 to 255, the system attempts to go 
from 0 to 255 but will be clipped by the Low Clip and High Clip values. If it is 
your intent to Òopen upÓ the image to the full dynamic range, you need to 
change the Low Clip and High Clip values to 0 and 255, respectively.
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n Black Point control does not change the Black setup level. That is done on the 
Video Output Tool.

Luma Clip

Luma Clip parameters allow you to determine the levels at which 
the Avid Composer system limits the brightness or darkness in the 
picture:

¥ High Ð Provides a simple clip function for brightness values. 
When you specify a value for High, no pixel in the image can be 
brighter than that value. The default is 235 (the broadcast value for 
white).

¥ Low Ð Provides a simple clip function for darkness values. When 
you specify a value for Low, no pixel in the image can be darker 
than that value. The default is 16 (the broadcast value for black).

When preparing video for broadcast, normally you do not adjust 
these values. They allow you to adjust the brightness and contrast 
(using other controls in the Color Effect) while still maintaining 
legal broadcast values for black and white.

Chrominance (Chroma Adjust)

Hue

Hue varies the tint of all colors in the image. The Hue parameter is 
measured as degrees on a color wheel from Ð180 to +180, where 0 does 
not change the hue. Changing the value of the Hue causes all colors in 
the image to rotate around the color spectrum. For example, a Hue set-
ting of Ð20 causes skin tones to look more red, while a Hue setting of 
+20 causes skin tones to look more green.

Saturation (Sat)

Saturation varies the amount of all colors in the image. The Saturation 
parameter has a value of Ð100 to +100. Zero is the default. A value of Ð
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100 displays as gray tones. Positive values display all colors with more 
saturation.

Invert 

Invert reverses the colors in both Hue and Saturation such that all 
colors display as their complement.

Color Style

Posterization (Post)

Posterization allows you to limit the number of colors in the image by 
controlling the number of luminance steps that are displayed. This 
gives the image a graphic appearance. The range of values is 0 to 25, 
where 0 displays all colors and 25 displays the least number of colors.

Solarization (Solar)

Solarization allows you to make the lightest points in the image dark 
to achieve a partial inversion of the luminance. Values above the 
threshold set for the parameter will be inverted. Solarization can have 
a value of 0 to 255, where 0 is normal luminance and 255 inverts all 
luminance values in the picture. Values of 0 to 127 display the lightest 
points in the image as dark. Values of 128 to 255 display both the light-
est points as dark and the darkest points as light, which gives the 
appearance of overexposed Þlm.

Posterization 18Original image
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Color Gain

The Color Gain parameters allow individual control of the Color Gain 
for each of the three color components: red, blue, and green. The value 
range for each Color Gain parameter is a percentage with a range from 
0 to 200, where a value of 100 indicates that the color is unchanged.

Red

Changes the amount of red in the whole image.

Blue

Changes the amount of blue in the whole image.

Green

Changes the amount of green in the whole image.

Original image Solarization 100 Solarization 150
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Flip  

Flip-Flop  

Effect Category Image

Apply to Single-layer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

Reversible No

Description Video image is ßipped vertically.

Effect Category Image

Apply to Single-layer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

Reversible No

Description Video image is ßipped both horizontally and 
vertically.
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Flop  

Mask  

Effect Category Image

Apply to Single-layer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

Reversible No

Description Video image is ßipped horizontally, which reverses 
the camera angle.

Flop effectOriginal image

Effect Category Image

Apply to Single-layer segments
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Paint Effect  

Parameters Background Ð hue, saturation, luminance

Scaling Ð height, width, and Þxed aspect

Position Ð horizontal position, vertical position

Reversible No

Description Masks out any area of the image that is not inside a 
rectangle deÞned by the Scaling, Fixed Aspect, and 
Position parameters of the effect. The area sur-
rounding the rectangle is masked by the effectÕs 
background color.

Effect Category Image

Apply to Singe-layer or multiple segments

Parameters Acceleration

Mode

Feathering

Magic Mask

Color

Brush

Reversible No

Description Enhances the creative and corrective powers of the 
Avid Composer system by allowing you to create 
vector-based objects that you can animate and edit 
with customizable paint brushes on one frame or a 
series of frames.
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Resize  

Effect Category Image

Apply to Single-layer segments

Parameters Background Ð hue, saturation, luminance

Scaling Ð height, width, and Þxed aspect

Position Ð horizontal position, vertical position

Crop Ð top, bottom, left, and right

Reversible No

Description Resize modiÞes the size and position of the video. 
The background color displays where no video is 
present. Use the H Posand V Pos and Size sliders to 
specify the size and position of the video. Use the 
Crop parameters to remove the edges of the 
picture.

Original image Resize effect – reduced image Resize effect – enlarged image
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Submaster  

n Because the Submaster effect does not render each track separately, after ren-
dering you cannot play each track separately.

Key Effects

Key effects combine two streams of video using components from one 
of the streams. They include:

¥ AniMatte

¥ YUV Chroma Key

¥ Luma Key

¥ Matte Key

Effect Category Image

Apply to The top video track under which are the video 
tracks that will be included in the Submaster 
effect.

Parameters None

Reversible No

Description When rendered, the Submaster effect creates a 
single media Þle for all the video on the layers 
below the Submaster effect. This allows you to 
group several effects, that reside on different 
video layers, and render them as one effect 
which is quicker than rendering each effect 
separately.
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n If your system has the 3D Effects option, see the 3D version on page 511.

AniMatte  

Effect Category Key

Apply to Transitions, multilayer segments

Parameters Acceleration

Foreground

Mode

Feathering

Magic Mask

Brush

Reversible Yes Ð foreground

Description Enables you to generate custom matte effects that 
you can apply to a segment or transition in a 
sequence. You can use a variety of brushes and 
painting tools to create matte effects that you can 
animate.
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YUV Chroma Key  

Effect Category Key

Apply to Transitions, multilayer segments

Parameters Key Ð hue, saturation, luminance, gain, and 
softness

Secondary Key Ð hue, saturation, luminance, gain, 
and softness

Spill Suppression Ð hue, saturation, luminance, 
gain and softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Scaling Ð height, width, and Þxed aspect

Position Ð horizontal position, vertical position

Crop Ð top, bottom, left, and right

Transition Ð Transition effect alignment and 
duration

Reversible Yes Ð inverts the key

Description Replaces one part of the video image with another 
video image based on color. The key color in the 
video on the higher track is replaced with the video 
from the lower track number. Chroma Key is used 
most frequently with a foreground image shot in 
front of a highly saturated color screen.
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Luma Key  

Chroma Key effect

Key image – video layer 2Background – video layer 1

Effect Category Key

Apply to Transitions, multilayer segments
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Parameters Key Ð hue, saturation, luminance, gain and softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Scaling Ð height, width, and Þxed aspect

Position Ð horizontal position, vertical position

Crop Ð top, bottom, left, and right

Transition Ð Transition effect alignment and 
duration

Reversible Yes Ð inverts the key

Description Replaces one part of the video image with another 
video image based on luminance.

Luma Key effect

Background imageKey image
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Matte Key  

Effect Category Key

Apply to Multilayer segments

Parameters ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Scaling Ð height, width, and Þxed aspect

Position Ð horizontal position, vertical position

Crop Ð top, bottom, left, and right

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description A three-layer track effect. The bottom layer (V1) is 
the background image, the middle layer (V2) is the 
foreground image, and the top layer (V3) contains 
the matte or alpha channel. The bottom layer shows 
through the lightest part of the matte. The middle 
layer shows through the darkest part of the matte. 
The darker the matte, the more the middle layer 
will show through.
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Matte Key effect

Video layer 3 – matte key

Video layer 2 – foreground

Matte key original PICT

Video layer 1 – background
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L-Conceal Effects

L-Conceal effects overlap one video channel over another using a pre-
deÞned L-shaped path. They include:

¥ Bottom Left

¥ Bottom Right

¥ Top Left

¥ Top Right

Bottom Left  

Effect Category L-Conceal

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video slides, in an L-shape, on top of 
the outgoing video from the bottom left to the top 
right of the screen.
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Bottom Right  

Top Left  

Effect Category L-Conceal

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video slides, in an L-shape, on top of 
the outgoing video from the bottom right to the top 
left of the screen.

Effect Category L-Conceal

Apply to Transitions, multilayer segments
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Top Right  

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video slides, in an L-shape, on top of 
the outgoing video from the top left to the bottom 
right of the screen.

Effect Category L-Conceal

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video slides, in an L-shape, on top of 
the outgoing video from the top right to the bottom 
left of the screen.
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Motion Effects

A motion effect is applied to a clip in the Source monitor and controls 
the rate at which the video channel is played. Motion effects include:

¥ Freeze Frame

¥ Variable Speed

¥ Strobe Motion

n When you use motion effects to slow down a clip, the effect is real time. When 
you use motion effects to speed up a clip, the effect is non-real-time and must 
be rendered before it can be played.

Freeze Frame

Effect Category Motion

Apply to Current frame in the Source monitor

Parameters Motion effects Ð duration and two-Þeld media

Reversible No

Description This effect repeats the current frame in the Source 
monitor for the speciÞed duration.
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Variable Speed and Strobe Motion

Peel Effects

Peel effects treat one video channel as though it were a sheet of paper 
being peeled from the other video channel. They include:

¥ Bottom Left Corner

¥ Bottom Right Corner

¥ Bottom to Top

¥ Left to Right

¥ Right to Left

¥ Top Left Corner

¥ Top Right Corner

¥ Top to Bottom

For an example of a Peel effect, see ÒTop Left CornerÓ on page 433.

Effect Category Motion

Apply to The clip marked by the IN and OUT marks in the 
Source monitor.

Parameters Motion effects Ð variable speed, strobe motion, and 
two-Þeld media

Reversible Yes, by typing a minus sign (Ð) in front of the speed 
percent.

Description Variable Speed creates slow motion, fast motion, or 
reverse motion. Strobe Motion creates a stuttering 
effect. The Strobe Motion effect can be used in com-
bination with the Variable Speed effect.
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Bottom Left Corner  

Bottom Right Corner  

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video material is peeled from outgoing 
video from the bottom left corner to the top right 
corner of the screen.

Effect Category Peel

Apply to Transitions, multilayer segments
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Bottom to Top  

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video material is peeled from outgoing 
video from the bottom right corner to the top left 
corner of the screen.

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video material is peeled from outgoing 
video from the bottom edge to the top edge of the 
screen.
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Left to Right  

Right to Left  

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video material is peeled from outgoing 
video from the left edge to the right edge of the 
screen.

Effect Category Peel

Apply to Transitions, multilayer segments
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Top Left Corner  

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video material is peeled from outgoing 
video from the right edge to the left edge of the 
screen.

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video material is peeled from outgoing 
video from the top left corner to the bottom right 
corner of the screen.
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Top Right Corner  

The following example includes a Border Color and 
Border Blend.

Peel effect with border

Incoming videoOutgoing video

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration
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Top to Bottom  

Push Effects

Push effects move one video channel to Þll the screen while the other 
video channel is pushed out of the screen. They include:

¥ Bottom Left to Top Right

¥ Bottom Right to Top Left

Reversible Yes

Description Incoming video is peeled from outgoing video from 
the top right corner to the bottom left corner of the 
screen.

Effect Category Peel

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video material is peeled from outgoing 
video from the top to the bottom of the screen.
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¥ Bottom to Top

¥ Left to Right

¥ Right to Left

¥ Top Left to Bottom Right

¥ Top Right to Bottom Left

¥ Top to Bottom

For an example of a Push effect, see ÒTop Left to Bottom RightÓ on 
page 440.

For examples of similar effects, see ÒComparison of Similar EffectsÓ 
on page 487.

Bottom Left to Top Right  

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video pushes out outgoing video from 
the bottom left corner to the top right corner of the 
screen. Border is on incoming video.
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Bottom Right to Top Left  

Bottom to Top  

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video pushes out outgoing video from 
bottom right corner to top left corner of the screen. 
Border is on incoming video.

Effect Category Push

Apply to Transitions, multilayer segments
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Left to Right  

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video pushes out outgoing video from 
the bottom to the top of the screen. Border is on 
incoming video.

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video pushes out outgoing video from 
the left edge to the right edge of the screen. Border 
is on incoming video.
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Right to Left  

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video pushes out outgoing video from 
the right edge to the left edge of the screen. Border 
is on incoming video.



440

Top Left to Bottom Right  

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video pushes out outgoing video from 
the top left corner to the bottom right corner of 
screen. Border is on incoming video.

Push effect

Incoming videoOutgoing video
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n For examples of similar effects, seeÒComparison of Similar EffectsÓ on 
page 487.

Top Right to Bottom Left  

Top to Bottom  

Effect Category Push

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video pushes out outgoing video from 
the top right corner to the bottom left corner of the 
screen. Border is on incoming video.

Effect Category Push

Apply to Transitions, multilayer segments
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Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video pushes out outgoing video from 
the top to the bottom of the screen. Border is on 
incoming video.
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Spin Effects

Spin effects rotate one or more video channels. They include:

¥ X Spin

¥ Y Spin

¥ Z Spin

X Spin  

Effect Category Spin

Apply to Transitions

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Outgoing video is squeezed until it appears as a 
vertical line. The incoming video then expands 
from that vertical line until it Þlls the screen. Border 
appears only on the incoming video. See the follow-
ing example.
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Y Spin  

X Spin effect with pink background

Incoming videoOutgoing video

Effect Category Spin

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes
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Z Spin  

Description Outgoing video is squeezed until it appears as a 
horizontal line. The incoming video then expands 
from that horizontal line until it Þlls the screen.

Effect Category Spin

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video starts as a dot in the center of 
the screen and then enlarges to full screen while 
rotating counter clockwise one full revolution 
covering the outgoing video.
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Z Spin effect inverted

Outgoing video Incoming video
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Squeeze Effects

Squeeze effects expand a video channel from a single point or line 
until it Þlls the screen, obscuring the second video channel. They 
include:

¥ Bottom Centered

¥ Bottom Left

¥ Bottom Right

¥ Bottom to Top

¥ Centered Zoom

¥ Horizontal Centered

¥ Left Centered

¥ Left to Right

¥ Right Centered

¥ Right to Left

¥ Top Centered

¥ Top Left

¥ Top Right

¥ Top to Bottom

¥ Vertical Centered

For an example of a Squeeze effect, see ÒTop LeftÓ on page 455.

For examples of similar effects, see ÒComparison of Similar EffectsÓ 
on page 487.
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Bottom Centered  

Bottom Left  

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video squeezes over the outgoing video, 
beginning as a rectangle in the center bottom edge 
of the screen and expanding to Þll the screen.

Effect Category Squeeze

Apply to Transitions, multilayer segments
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Bottom Right  

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video squeezes over the outgoing video, 
beginning as a rectangle in the bottom left corner 
and expanding to Þll the screen.

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video squeezes over the outgoing video, 
beginning as a rectangle in the bottom right corner 
and expanding to Þll the screen.
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Bottom to Top  

Centered Zoom  

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video squeezes over the outgoing video, 
beginning at the bottom of the screen and Þlling to 
the top of the screen.

Effect Category Squeeze

Apply to Transitions, multilayer segments
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Vertical Centered  

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video starts as a rectangle in the center of 
the screen and zooms to Þll the screen.

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video starts as a horizontal band 
squeezed in the center of the screen and expands 
horizontally to Þll the screen.
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Left Centered  

Left to Right  

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video squeezes over the outgoing video, 
beginning as a rectangle in the center left edge of 
the screen and expanding to Þll the screen.

Effect Category Squeeze

Apply to Transitions, multilayer segments



453

Right Centered  

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video squeezes over the outgoing video, 
beginning at the left edge of the screen and Þlling to 
the right edge of the screen.

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video squeezes over the outgoing video, 
beginning as a rectangle in the center right edge of 
the screen and expanding to Þll the screen.
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Right to Left  

Top Centered  

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video squeezes over the outgoing video 
beginning at right edge of the screen and Þlling to 
the left edge of screen.

Effect Category Squeeze

Apply to Transitions, multilayer segments
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Top Left  

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video squeezes over the outgoing video, 
beginning as a rectangle in the center top edge of 
the screen and expanding to Þll the screen.

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video squeezes over the outgoing video, 
beginning as a rectangle in the top left corner and 
expanding to Þll the screen.
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n For examples of similar effects, see ÒComparison of Similar EffectsÓ on 
page 487.

Top Right  

Squeeze effect

Incoming videoOutgoing video

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration
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Top to Bottom  

Horizontal Centered  

Reversible Yes

Description Incoming video squeezes over the outgoing video, 
beginning as a rectangle in the top right corner and 
expanding to Þll the screen.

Effect Category Squeeze

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video squeezes over the outgoing video, 
beginning at the top edge of the screen and Þlling 
to the bottom edge of the screen.

Effect Category Squeeze

Apply to Transitions, multilayer segments
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Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video starts as a vertical band squeezed 
in the center of the screen and expands vertically to 
Þll the screen.
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Wipes

A wipe is an effect in which a transition line literally ÒwipesÓ across 
the screen to reveal the incoming video. The transition line can be in 
many shapes and can come from many directions, hence the numer-
ous types of wipe effects listed in this section. You can also apply 
many of these wipes to segments to form split-screens and other 
segment effects.

Box Wipes

Box Wipes reveal one video channel on top of another video channel, 
using predeÞned growing rectangular shapes. They include:

¥ Bottom Box

¥ Left Box

¥ Lower Right Corner

¥ Lower Left Corner

¥ Upper Right Corner

¥ Right Box

¥ Top Box

¥ Upper Left Corner

¥ Upper Right Corner

For an example of a Box Wipe effect, see ÒUpper Left CornerÓ on 
page 464.

For examples of similar effects, see ÒComparison of Similar EffectsÓ 
on page 487.



460

Bottom Box  

Left Box  

Effect Category Box Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as a rectangle in the center 
of the bottom edge of the screen and wipes out 
outgoing video as it expands to Þll screen.

Effect Category Box Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration
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Lower Left Corner  

Reversible Yes

Description Incoming video begins as a box in the center of the 
left edge of the screen. The incoming video wipes 
out the outgoing video as the box expands to Þll the 
screen.

Effect Category Box Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as a box in the bottom left 
corner of the screen. The incoming video wipes out 
the outgoing video as the box expands to Þll the 
screen.
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Lower Right Corner  

Right Box  

Effect Category Box Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as a box in the bottom right 
corner of the screen. The incoming video wipes out 
the outgoing video as the box expands to Þll the 
screen.

Effect Category Box Wipe

Apply to Transitions, multilayer segments
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Top Box  

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as a box on the right edge of 
the screen. The incoming video wipes out the out-
going video as the box expands to Þll the screen.

Effect Category Box Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as a rectangle in the center 
of the top edge of the screen and wipes out outgo-
ing video as it expands to Þll the screen.
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Upper Left Corner  

Effect Category Box Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as a box in the top left cor-
ner of the screen. The incoming video wipes out the 
outgoing video as the box expands to Þll the screen.

Box Wipe effect

Incoming videoOutgoing video
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Upper Right Corner  

Edge Wipes

Edge Wipes reveal one video channel on top of another video channel 
by wiping an edge across the screen. They include:

¥ Vertical

¥ Vertical Open

¥ Lower Left Diagonal

¥ Lower Right Diagonal

¥ Upper Left Diagonal

¥ Upper Right Diagonal

¥ Horizontal

¥ Horizontal Open

Effect Category Box Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and duration

Reversible Yes

Description Incoming video begins as a box in the top right cor-
ner of the screen. The incoming video wipes out the 
outgoing video as the box expands to Þll the screen.
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Vertical  

Effect Category Edge Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins at the left edge of the screen 
and moves to the right edge, wiping out the outgo-
ing video.

Edge Wipe effect

Incoming videoOutgoing video
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Vertical Open  

Lower Left Diagonal  

Effect Category Edge Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video begins as a vertical band in the 
center of the screen. This band expands to the left 
and right edges of the screen, wiping out the outgo-
ing video.

Effect Category Edge Wipe

Apply to Transitions, multilayer segments



468

Lower Right Diagonal  

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video begins in the bottom left corner 
of the screen and wipes out the outgoing video as a 
diagonal line moves from the bottom left corner to 
the top right corner of the screen.

Effect Category Edge Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video begins in the bottom right cor-
ner of the screen and wipes out the outgoing video 
as a diagonal line moves from the bottom right cor-
ner to the top left corner of the screen.
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Upper Left Diagonal  

Upper Right Diagonal  

Effect Category Edge Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video begins in the top left corner of 
the screen and wipes out the outgoing video as a 
diagonal line moves from the top left corner to the 
bottom right corner of the screen.

Effect Category Edge Wipe

Apply to Transitions, multilayer segments
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Horizontal  

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video begins in the top right corner 
of the screen and wipes out the outgoing video as a 
diagonal line moves from the top right corner of the 
screen to the bottom left corner.

Effect Category Edge Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins at the top edge of the screen 
and expands downward to Þll the screen.
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Horizontal Open  

Matrix Wipes

Matrix Wipes reveal one video channel on top of another video chan-
nel, using blocks or bands that appear in a predeÞned position or path. 
They include:

¥ Block Spiral

¥ Grid

¥ One-Way Row

¥ Speckle

¥ Zig-Zag

For an example of a Matrix Wipe, see ÒGridÓ on page 472.

Effect Category Edge Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as a horizontal band in the 
center of the screen. This band expands up and 
down to Þll the screen.
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Block Spiral  

Grid  

Effect Category Matrix Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

Other Option buttons Ð Matrix columns and rows

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video spirals over and wipes out the 
outgoing video using blocks of screen space start-
ing in the bottom left corner of the screen, and spi-
rals inward in a counterclockwise movement.

Effect Category Matrix Wipe

Apply to Transitions, multilayer segments
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Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

Other Options buttons Ð Matrix columns and rows

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as blocks in a grid pattern 
that wipe out the outgoing video as the blocks 
expand to Þll the screen. The Columns and Rows 
parameters change the size of the grid.

Grid Wipe effect

Incoming videoOutgoing video
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One-Way Row  

Speckle  

Effect Category Matrix Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

Other Options buttons Ð Matrix columns and rows

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as a block at the top left cor-
ner of the screen that wipes out the outgoing video 
as the band expands horizontally across the screen 
from left to right. When the Þrst horizontal band 
has reached the right edge of the screen, a second 
band appears on the left edge of the screen, just 
below the Þrst band, and repeats the process until 
the incoming video has wiped out all of the outgo-
ing video.

Effect Category Matrix Wipe

Apply to Transitions, multilayer segments
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Zig-Zag  

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

Other Options buttons Ð Matrix columns and rows

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The incoming video appears in a random series of 
blocks that wipe out the outgoing video until the 
blocks have Þlled the screen.

Effect Category Matrix Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance (includes Color 
Blend), width, and softness 

Other Options buttons Ð Matrix columns and rows

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes
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Saw Tooth Wipes

Saw Tooth Wipes are described in this section. They include:

¥ Vertical Open Saw Tooth

¥ Vertical Saw Tooth

¥ Horizontal Open Saw Tooth

¥ Horizontal Saw Tooth

For an example of a Saw Tooth Wipe effect, see ÒHorizontal Open Saw 
ToothÓ on page 478.

Description Incoming video begins as a single block at the top 
left corner of the screen that wipes out the outgoing 
video as the band expands horizontally across the 
screen from left to right. When the Þrst horizontal 
band reaches the right edge of the screen, a second 
band appears and expands horizontally across the 
screen from right to left. Succeeding bands repeat 
the process until the wipe is completed.



477

Vertical Open Saw Tooth  

Vertical Saw Tooth  

Effect Category Saw Tooth Wipe

Apply to Transitions, multilayer segments

Parameters ProÞle Ð Foreground level

Foreground Ð level

Background Ð hue, saturation, luminance

Other Options button Ð Matrix columns and rows

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as a vertical saw tooth in the 
center of the screen. The saw tooth then expands 
outward to the left and right edges of the screen to 
display the incoming video in the center while cov-
ering the outgoing video.

Effect Category Saw Tooth Wipe

Apply to Transitions, multilayer segments
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Horizontal Open Saw Tooth  

Parameters ProÞle Ð Foreground level

Foreground Ð level

Background Ð hue, saturation, luminance

Other Options button Ð Matrix columns and rows

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video appears with a saw tooth on the 
left edge of the screen. The saw tooth edge moves 
to the right edge of the screen, revealing the incom-
ing video.

Effect Category Saw Tooth Wipe

Apply to Transitions, multilayer segments

Parameters ProÞle Ð Foreground level

Foreground Ð level

Background Ð hue, saturation, luminance

Other Options button Ð Matrix columns and rows

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as a horizontal saw tooth in 
the center of the screen. The saw tooth expands up 
and down revealing the incoming video.
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Horizontal Saw Tooth  

Saw Tooth Wipe effect

Incoming videoOutgoing video

Effect Category Saw Tooth Wipe

Apply to Transitions, multilayer segments

Parameters ProÞle Ð Foreground level

Foreground Ð level

Background Ð hue, saturation, luminance

Other Options button Ð Matrix columns and rows

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description The saw tooth edge moves from the top of the 
screen down, covering the outgoing video and dis-
playing the incoming video above the saw tooth.
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Shape Wipes

Shape Wipes reveal one video channel on top of another video chan-
nel, using a growing or moving geometric shape. They include:

¥ Center Box

¥ Circle

¥ Clock

¥ Diamond

¥ Ellipse

¥ Four Corners

¥ Vertical Bands

¥ Vertical Blind

¥ Horizontal Blind

Center Box  

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Scaling Ð height, width, Þxed aspect

Position Ð horizontal position, vertical position

Transition Ð Transition effect alignment and 
duration
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Circle  

Reversible Yes

Description Incoming video begins as a box in the center of the 
screen and wipes out the outgoing video as it 
expands to Þll the screen.

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Scaling Ð height, width, Þxed aspect

Position Ð horizontal position, vertical position

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as a circle in the center of 
the screen and wipes out the outgoing video as it 
expands to Þll the screen.
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Clock  

Incoming videoOutgoing video

Circle Wipe effect

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters ProÞle Ð Foreground level

Foreground Ð level

Background Ð hue, saturation, luminance

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video appears as a vertical line from the 
center of the screen to the top edge. The incoming 
video replaces the outgoing video in a clockwise 
motion as if it were the hand on a clock.
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Diamond  

Ellipse  

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters ProÞle Ð Foreground level

Foreground Ð level

Background Ð hue, saturation, luminance

Acceleration

Scaling Ð height, width, Þxed aspect

Position Ð horizontal position, vertical position

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as a diamond in the center 
of the screen and wipes out the outgoing video as it 
expands to Þll the screen.

Use the Position and Size parameters to change the 
size, shape, and position of the diamond.

Effect Category Shape Wipe

Apply to Transitions, multilayer segments
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Four Corners  

Parameters Border Ð hue, saturation, luminance, width, and 
softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Scaling Ð height, width, Þxed aspect

Position Ð horizontal position, vertical position

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as an ellipse in the center of 
the screen and wipes out the outgoing video as it 
expands to Þll the screen.

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width (with 
Color Blend), and softness

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes
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Vertical Bands  

Vertical Blind  

Description Incoming video begins as blocks in four corners of 
the screen and wipes out the outgoing video as the 
blocks expand to Þll the screen.

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width (with 
Color Blend), and softness

Other Options Ð Matrix rows and columns

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Horizontal bands expand toward the center of the 
screen to reveal incoming video between alternate 
shrinking bands of outgoing video.

Effect Category Shape Wipe

Apply to Transitions, multilayer segments
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Horizontal Blind  

Parameters Border Ð hue, saturation, luminance, width (with 
Color Blend), and softness

Other Options Ð Matrix rows and columns

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Vertical bands expand horizontally to Þll the screen 
with the incoming video.

Effect Category Shape Wipe

Apply to Transitions, multilayer segments

Parameters Border Ð hue, saturation, luminance, width (with 
Color Blend), and softness

Other Options Ð Matrix rows and columns

ProÞle Ð Foreground level

Foreground Ð level

Acceleration

Transition Ð Transition effect alignment and 
duration

Reversible Yes

Description Incoming video begins as horizontal bands on the 
screen that wipe out the outgoing video as the 
incoming bands expand vertically to Þll the screen. 
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Comparison of Similar Effects

There are four effects that have a similar result: Box Wipe, Conceal, 
Push, and Squeeze. Examples of these effects are shown here to assist 
you in using these effects. Each of these effects was created with the 
same outgoing and incoming video.

Box Wipe – Upper Left Corner

Incoming videoOutgoing video

Box Wipe effect
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Conceal – Top Left to Bottom Right

Push – Top Left to Bottom Right

Squeeze – Top Left

Conceal effect

Push effect

Squeeze effect
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CHAPTER 11

3D Effects Reference

This chapter provides reference information on parameters and effect 
shape options that appear in the Effect Editor when you apply the 3D 
Warp effect to a transition or segment. For information on applying 
and editing 3D effects, see Chapter 9, ÒWorking with 3D Effects.Ó

¥ Basic 3D Effects Parameters

¥ 3D Shape Effects
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Basic 3D Effects Parameters

The parameters described in this section are available for all 3D effects, 
regardless of the shape of the effect. The parameters and controls 
appear in the Effect Editor after you apply the 3D Warp effect to a tran-
sition or segment.

Setup Versus Key-Frame Parameters

3D Effects parameters are divided into two logical groups:

¥ Setup parameters cannot change between key frames. When you 
change one of these parameters, the Avid Composer system auto-
matically sets the value for all key frames. The list below describes 
the setup parameters that cannot change between key frames.

- Acceleration

- Shape selection and highlight type

- Border type and border color

- Foregnd (foreground) Swap Sources button

- Chroma key gain, threshold, hue, or high and low saturation

¥ Key-frame parameters are adjustable on an individual key-frame 
basis, so that the parameters can change over time. This category 
includes the remainder of the 3D Effects parameters. Most of these 
parameters interact with each other. For example, you can rotate 
the image with perspective, skew the image so that it slants to the 
right, apply a page curl, and add highlights and a semitransparent 
drop shadow Ñ all of which can change over time, independent of 
each other.
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Corner Pinning

Corner pinning is a way of positioning a 3D effect in a foreground 
video track over an object in a background video track. For example, 
you might want to have the foreground video appear to be playing on 
a TV set in the background video.

X pins the image along the X axis.

Y pins the image along the Y axis.

Follow Crop lets you pin the corners of a cropped image rather than 
pinning the corners of the whole frame.

Crop — Cropping the Image

At the bottom of the effects parameters hierarchy is Crop. It always 
crops the same four edges of the object no matter what orientation the 
object has. Cropping works only in 2D space so that 3D parameters 
such as Rotation and Position, which are higher in the hierarchy, take 
effect later in the processing. You donÕt need to adjust cropping before 
the other parameters, but it is difÞcult to crop edges if they are rotated 

Corner Pin button

Crop button
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to the vanishing point. Use Crop to trim an imageÕs top, bottom, left, 
or right edges.

T (top) crops the top edge of the image. Values range from Ð999 (bot-
tom) to 999 (top).

L (left) crops the left edge of the image. Values range from Ð999 (left) to 
999 (right). 

B (bottom) to crop the bottom edge of the image. Values range from Ð
999 (bottom) to 999 (top).

R (right) crops the right edge of the image. Values range from Ð999 
(left) to 999 (right).

For cropping, the values Ð999 to 999 are relative to the edges of the 
image. Zero is the center of the image.

Scaling — Changing the Size

Just above Crop, near the bottom of the effects parameters hierarchy, is 
Scaling. Scaling an image also takes place in 2D but it may create the 
illusion that the image has moved away from the screen. This is 
because the surface of the video monitor, in reality, is only a 2D surface 
and there is no way of turning the monitor sideways to see if an object 
is smaller or has Òmoved awayÓ from the screen. You can create many 
moves with Scaling that appear to move toward or away from the 
screen. In fact, because of its ease of use, the Scale button on the tool 
bar may be the most direct method to create moves that appear to 
move toward or away from the screen.

The difference between Scaling and other motion parameters, such as 
Position, is that the point of view of the object does not change. Point 

Scale button
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of view changes only when you move an object in 3D space. Therefore, 
if you want to change only the size of an object, Scaling is an appropri-
ate choice. For example, if you have rotated an object and it is too 
large, Scaling resizes it while maintaining the same position and point 
of view on the screen.

You can change X and Y together or separately. If you change values 
separately, you change the aspect ratio of the image.

X stretches or compresses along the X axis (horizontally). Values range 
from 0 to 400, where 100 indicates 100 percent scaling.

Y stretches or compresses along the Y axis (vertically). Values range 
from 0 to 400, where 100 indicates 100 percent scaling.

To adjust X and Y at the same time (and maintain the aspect ratio), use 
the Scale button.

Axis — Moving the Center of Rotation

Axis is the center of the rotation for X, Y, and Z rotation parameters. It 
defaults to the center of the object at the beginning of any effect. An 
image has no Þxed rotation axis. The axis is independent of the image, 
and movable. For example, the rotation axis can be placed in the center 
of, on the edge of, or off the image.

You should enable the Axis button on the direct manipulation tool bar 
when working with axis to see easily where the crosspoint will be. It is 
also useful to zoom out with the Enlarge tool to graphically see the 
movement of the axis over time. ÒZooming In or Out on the Effect 
Preview MonitorÓ on page 341

Axis button
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Axis precedes Rotation in the hierarchy for the very important reason 
that Rotation requires an axis point to be set Þrst. If you set Rotation 
and then move the axis point, the object will jump to an unpredictable 
place based on the new center of rotation.

If the axis moves to the bottom corner of the object, then that is the 
point of rotation for the object. If the axis moves off the actual object, 
then the radius of the rotation gets larger.

You can move the axis between key frames to allow a shape to rotate in 
on one axis and rotate out on another. Generally there should be a pair 
of static frames to allow the axis to move invisibly. There are, however, 
some interesting effects in which the axis moves during the motion. 
This is an easy way to make an otherwise normal move have an 
unusual path.

X moves the center of rotation along the X axis (right or left). Values 
range from Ð999 to +999, where 0 is the center of the X axis.

Y moves the center of rotation along the Y axis (up or down). Values 
range from Ð999 to +999, where 0 is the center of the Y axis.

Z moves the center of rotation along the Z axis. Values can range from 
Ð999 to +999, where 0 is the center of the Z axis. Positive values are 
closer and negative values are farther away. Adjusting the Z value 
moves the center of rotation off the plane of the video screen.

Skew — Tilting the Image

Use Skew to skew or tilt an image in the X or Y direction.

X skews the image along the X axis. The orientation of the top and bot-
tom edges remains Þxed, while the left and right edges are tilted along 
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the X axis into a parallelogram. Values range from Ð999 to +999, where 
0 represents no change.

Y skews the image along the Y axis. The orientation of the left and 
right edges remain Þxed, while the top and bottom edges are tilted 
along the Y axis into a parallelogram. Values range from Ð999 to +999, 
where 0 represents no change.

Rotation — Rotating an Effect

You can rotate an object on the X, Y, and Z axes. Once an object is 
rotated, the perspective changes depending on Position, the lower 
parameter in the hierarchy.

Rotation does not affect the path of the object. Thus, you will not see 
changes in Rotation when you click the Outline/Path button. This 
means that Spline does not smooth out rotational stops and starts.

Because you are working with the illusion of 3D space in a 2D environ-
ment, a certain anomaly occurs when an object rotates until you see it 
from the side. If the edge is straight on to the viewer, the object actu-
ally disappears from sight. This can be a useful way to rotate an object 
into view or to change the backside of an object as it ßips around.

Z rotates the image around the Z axis (clockwise or counterclockwise). 
Values range from Ð720 to +720, where 0 is the default.

X rotates the image around the X axis. Values range from Ð720 to +720, 
where 0 is the default.

Rotation buttons

Z

X

Y
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Y rotates the image around the Y axis. Values range from Ð720 to +720, 
where 0 is the default.

The 720-degree value allows you to spin the image more than once 
between two key frames. For an explanation of rotation angles, see 
ÒRotation AxesÓ on page 334.

Position — Moving the Image

Position is a true 3D parameter because it allows you to move objects 
away from the screen and change the perspective when the object 
begins to rotate. This more closely simulates human perception of 
objects in space. The difference in perspective between an object that is 
scaled and an object that is moved backward on the Z axis is subtle but 
is a factor when rotation and perspective are important. Notice how 
the point of view changes if you rotate an object and then move it with 
Position on any axis.

To create a smooth landing when an object is moving away or toward 
the screen, use Position in conjunction with Spline. See ÒSpline Ñ 
Moving the Image Along a Smooth PathÓ on page 498

X moves the image along the screenÕs X axis (horizontally). Values 
range from Ð3000 to +3000, where 0 is the center of the X axis. Negative 
values move the image to the left and positive values move the image 
to the right.

Y moves the image along the screenÕs Y axis (vertically). Values range 
from Ð3000 to +3000, where 0 is the center of the Y axis. Negative val-
ues move the image down and positive values move the image up.

Position buttons

XY

XZ
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The large X and Y values allow you to move the image completely off 
the screen if you have Z perspective turned on and you are using a 
large Z value.

Z moves the image along the screenÕs Z axis (front/back). Values range 
from Ð999 to +249, where 0 is the center of the Z axis. Relative to the 
ÒplaneÓ of the video screen, positive values move the image closer to 
you, and negative numbers move the image farther away.

For an illustration of the XYZ coordinate system, see ÒThe 3D Coordi-
nate SystemÓ on page 333.

The perspective point remains Þxed when you use Position. For more 
information, see ÒPerspective Ñ Moving the Perspective PointÓ on 
page 503.

The Position parameter pane and the Position buttons create pretrans-
formation effects. This means that if you apply a perspective to the 
image and then move it with Position, the foreshortening changes. 
To move an image without changing the foreshortening effect, use the 
Target parameters as described in ÒTarget Ñ Post-Transformation 
Position and ScalingÓ on page 503.

Acceleration — Smoothing Out Key-Frame Transitions

Acceleration changes the speed of movement into and out of key 
frames. This is also known as ease in and ease out. Zero on the slider is 
no acceleration; 100 is full acceleration.

n Acceleration applies to every key frame in the same way. The last time you 
change this parameter determines the acceleration for all key frames in the 
effect.
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You can apply acceleration to a number of 3D Effects parameters. For 
example, you can use key frames and acceleration to adjust the speed 
of a rotating Picture-in-Picture effect. 

Acceleration affects the following 3D Effects parameters:

¥ Shape (X and Y position)

¥ Position (if Spline is disabled)

¥ Scaling

¥ Rotation

¥ Axis

¥ Target

¥ Perspective

¥ Skew

¥ Crop

¥ Shadow (X and Y position)

Spline — Moving the Image Along a Smooth Path

Spline is the parameter that smooths the Position changes between key 
frames. It helps to reproduce the natural motion path of an object 
through 3D space.

Sometimes you want objects to settle gently into place at each key 
frame and other times you may want objects to move in a swooping 
arc, connecting the key frames. Spline helps to achieve both. It looks 
ahead and takes into account the motion approaching a key frame and 

Outline/Path button
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the motion immediately after a key frame and averages the changes 
for the smoothest possible transition.

When you are working with Spline, it is a good idea to click the Out-
line/Path button in the direct manipulation tool bar. This displays the 
wire-frame line that represents the path between key frames. It also 
shows how the change in the Spline settings affects the motion. 

Enabling Spline automatically smooths the motion between key 
frames. Even when all the Spline settings are 0, the optimum smooth-
ing results. Therefore, Spline is often helpful for putting the Þnishing 
touches on a move.

You cannot turn Spline on or off for individual key frames but you can 
set it to behave as though it had been turned off by changing the set-
tings. You may Þnd that two key frames with no changes between 
them now have some slight motion when Spline is turned on. This is 
usually undesirable and is the main reason why you would want to 
change the settings to behave as if Spline had been turned off between 
those key frames.

To achieve more variations to the ÒstandardÓ way Spline operates, you 
can adjust the Spline settings for tension, continuity, and bias, as 
described in the following sections. 

Tension (Tens.)

Tension controls how sharply the curve bends at a key frame. The 
default or 0 setting is the average of the changes before and after the 
key frame. Decreasing it to Ð100 doubles the amount of bending from 
the original 0 position and creates more slack in the curve. Increasing it 
to 100 tightens the curve and makes the change in direction more 
severe.
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Continuity (Cont.)

Continuity controls the amount of direction change between the 
incoming motion and outgoing motion around the key frame. Usually 
the motion should be as smooth as possible, reducing sharp, unnatural 
corners (the default setting of 0). However, when you want to simulate 
bouncing or punching, you must turn the Continuity down (Ð100) to 
make the quick, hard direction changes more obvious. Turning it up to 
100 forces the motion to begin going in the opposite direction at the 
previous key frame, changing to the new direction for the outgoing 
motion.

Difference Between Tension and Continuity

There appears to be no difference between the motion path of an object 
with maximum Tension and an object with minimum Continuity. The 
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motion dynamics of the two moves, however, are quite different. Even 
though both motion paths have severe direction changes, Tension 
causes the object to start slowly, speed up, slow down, and pause at 
the key frame, then speed up and slow down again at the next key 
frame. This is referred to as an ease in/ease out motion.

Bias

Bias assigns a different weight to either the incoming or the outgoing 
motion. Set at 0, it averages both incoming and outgoing motion. 
When set to Ð100, it ÒundershootsÓ the key frame; at 100 it Òover-
shootsÓ the key frame. This causes the curve to occur either before or 
after the key frame it passes through.

Tens.
Cont.
Bias

0
–100

0

Tens.
Cont.
Bias

100
0
0

Continuity Tension
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n You can use a combination of the Tens., Cont., and Bias sliders to achieve 
effects similar to the 2D Acceleration feature described in ÒAdjusting the 
AccelerationÓ on page 110.

n To move the entire curve, use the Target category as described in ÒTarget Ñ 
Post-Transformation Position and ScalingÓ on page 503.

Adding a New Point to a Spline Curve

If you add a key frame 
when using the Spline 
category, the Avid Com-
poser system displays 
the new point on the 
curve. However, it does 
not recalculate the 
curve until you use one 
of the Position parame-
ters to move one of the 
points.

Mathematically speaking, when you add a point to a spline curve, the 
curve changes shape, even if the new point is on the curve. Sometimes 
you will want to add a new point on the curve to change the path. 
However, sometimes you may simply want to add a new key frame to 
change a parameter such as Rotation or Scaling without affecting the 
curve. In order to account for both cases, the Avid Composer system 
uses the following rule: 

Once you move one of the points, the Avid Composer system incorpo-
rates all the existing key frames into the curve. You can move any of 
the points to readjust the curve. 
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Perspective — Moving the Perspective Point

Use Perspective to move the perspective point (where parallel lines 
appear to converge) along the screenÕs X, Y, and Z axes. This changes 
the way the image is visually projected onto the video screen.

X and Y move your horizontal or vertical Òpoint of view.Ó An X adjust-
ment moves the projected screen image farther to the left or right. Y 
adjustments allow you to view the image from a higher or lower 
angle. Values range from Ð999 to +999, where 0 is the default.

Z moves the perspective point closer to and farther from the observer. 
Perspective increases as the point moves inward, and decreases as the 
point moves outward from the screen. Moving the perspective point in 
Z changes the amount of foreshortening on an image that is rotated 
around the X or Y axis.

Target — Post-Transformation Position and Scaling

Use Target to change the X Y positioning and the sizing and to main-
tain the current perspective.

Target is a post-transformation parameter. In other words, it is the last 
step of the hierarchy and affects objects after all the other parameters 
have affected it. If an object has been rotated and has perspective 
added to it, Target moves the object without changing the relationship 
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of the other parameters. Think of it as moving the entire 3D world 
where point of view does not change.

Target can be used in many cases as a global parameter. If you have 
already created an effect and want the whole effect to move higher 
across the frame or to appear inside another frame, such as a television 
on a set, Target is the way to move it. It is also good for offsetting 
another track slightly if you want to use a black graphics image as a 
drop shadow.

The following illustrations compare the Target and Position effects:

In the above illustrations, notice the differences between the top and 
bottom edges of the image. The foreshortening does not change on the 
image moved with Target. 

After moving with PositionBefore

After moving with TargetBefore
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The following operations were performed on the image in this exam-
ple before applying the Target or Position effects:

¥ The foreground image was scaled to create a Picture-in-Picture 
effect. 

¥ The image was rotated +55 degrees around the Y axis.

¥ The image was moved with the XY Position button to the 
bottom-left corner.

¥ A Z Perspective value of 232 was applied.

The Target parameter pane contains the following parameters:

X moves the image along the screenÕs X axis (horizontally). Values 
range from Ð999 to +999, where 0 is the default.

Y moves the image along the screenÕs Y axis (vertically). Values range 
from Ð999 to +999, where 0 is the default.

Size scales the image and maintains the aspect ratio. Values range 
from 0 to 400, where 100 is the default scale of 100 percent.

Border

You can blend the fore-
ground video with the 
background video if 
you enable Border, 
choose zero width, 
and adjust the Soft 
parameter.

Use Border to place a border around the image. Use the Fast menu to 
select the border style. Border style options include Plain (the default), 
Metal, Bevel 1, Bevel 2, 3D Frame, and Round.

Width changes the width of the border. Values range from 0 (no bor-
der) to 100, where 50 is the default.

Move the mouse to the Color Preview 
window to activate the eyedropper.
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Soft (softness) values range from 0 (hard edge) to 255 (a very soft 
edge), where 0 is the default. Border softness blends the border with 
the background image, giving the border a soft appearance.

Use the following color parameters or use the eyedropper to select a 
color from the video in the Effect Preview monitor:

H (hue) speciÞes the hue or shade of the color. Values range from 0 to 
255. 

S (saturation) speciÞes the amount or intensity of the color. Values 
range from 0 (no chrominance) to 255 (fully saturated color). 

L (luminance) speciÞes the brightness of the color. Values range from 0 
(black) to 255 (full brightness).

The default border color is black for Plain borders and shades of gray 
for other border types.

For a description of how to use the eyedropper, see the topic ÒAdjust-
ing a Color ParameterÓ on page 104.

Highlight

The Highlight window allows you to:

¥ Enable Automatic Highlighting for Shapes and adjust the intensity 
of automatic highlighting
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¥ Adjust the highlights for Manual Highlighting and Rev (reverse) 
Manual Highlighting

You can use manual highlights even when a shape is not active. The 
default manual highlight creates a blurred disk in the center of the 
image.

Soft (softness) controls the softness of the highlightÕs edge. Softness 
values range from 0 (hard edge) to 100 (a very soft edge), where 50 is 
the default.

Inty (intensity) controls the brightness of the highlight. Values range 
from 0 to 100, where 50 is the default intensity.

Rad (radius) controls the size of the highlight. Values range from 0 to 
100, where 50 is the default radius.

Angle rotates the highlight. This has an effect only when the aspect 
ratio is not zero. Values range from Ð180 degrees to +180 degrees, 
where 0 is the default.

Aspct (aspect ratio) changes the shape of the highlight from a perfect 
circle (0) to an oval or a band. Values range from Ð100 to +100, where 0 
is the default. The Ð100 band is at right angles to the +100 band.

X moves the center of the highlight from left to right. Values range 
from Ð999 to +999, where 0 is the default. Positive values move the 
highlight to the right.

Y moves the center of the highlight from top to bottom. Values range 
from Ð999 to +999, where 0 is the default. Positive values move the 
highlight up.
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Defocus — Controlling the Sharpness of Focus

Use Defocus to control the imageÕs sharpness. This gives you the abil-
ity to blur the picture both horizontally and vertically in order to simu-
late a cameraÕs focus.

Horz (horizontal) increases or decreases horizontal sharpness. Values 
range from 0 to 15, where 0 represents no change.

Vert (vertical) increases or decreases vertical sharpness. Values range 
from 0 to 15, where 0 represents no change.

n When you enable Defocus, the default values are 10 for Horz and Vert. This 
produces a slight softening effect.

Shadow

Use Shadow to place a shadow beneath an image, adjust its offset, and 
adjust its transparency.

Opac. (opacity) changes the shadowÕs opacity from fully transparent 
(0) to fully opaque (100), where 50 is the default.

X changes the shadowÕs left/right offset. Values range from Ð100 to 
+100, where 50 is the default.

Y changes the shadowÕs top/bottom offset. Values range from Ð100 to 
0, where Ð50 is the default.
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n Shadow, Trail, and Stamp (described in the following sections) are mutually 
exclusive. This means that you can have only one enabled at a time.

Trail — Adding a Trail to a Moving Image

Use Trail to add a trail to an effect as it moves across the screen.

Decay changes the rate of the trailÕs decay, from a quick decay (close to 
0) to a slower decay (close to 100), where 75 is the default.

Use Sparkle instructs the Avid Composer system to paint a trail with 
sparkles. When Use Sparkle is not selected, the Avid Composer system 
paints a trail using the image itself.

n You do not see the trail when you step through the effect because it is a cumu-
lative effect. Also, you cannot render a Trail effect.

Stamp

Stamp lets you imprint a video or graphic element into an indepen-
dent Stamp buffer. You can Òßy onÓ multiple elements of video, text, 
and graphics, stamping them over the foreground image to create 
effects that would otherwise require rendering or additional real-time 
streams of video. For an example of how to create a stamp, see ÒCreat-
ing a StampÓ on page 360.

Three of the most common uses for Stamp are:

¥ Real-time title builds: You ßy on multiple text, graphic, and video 
elements and stamp them over or under the foreground image 
when they come to rest. Once the image is stamped, you can ßy on 
additional layers. 
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¥ Downstream key: You add an image that stays in place. For exam-
ple, you could create a logo that you want to just stay on the 
screen.

¥ Video montage: You bring in a variety of video images, where 
each one stays in place as you continue to add new ones.

The illustration below shows the Stamp parameter pane.

Opac. (opacity) changes the stampÕs opacity from fully transparent (0) 
to fully opaque (100), where 100 is the default.

Foregnd. On Top (foreground on top) switches the Stamp buffer to the 
background; without Foregnd. On Top enabled, the Stamp buffer is 
always in the foreground.

Clear lets you clear the stamp buffer of everything in it.

n You cannot render Stamp effects; they are real-time effects. Also, the Stamp, 
Shadow, and Trail parameters are mutually exclusive. This means that you 
can only have only one enabled at a time.

Foreground — Selecting Between Full, Chroma, and Luma 
Keys

The Foregnd (foreground) Fast menu has three choices as shown in the 
illustration below. Each of the three keys has different values you can 
adjust. When you enable a key, its value options are automatically 
revealed. The values are described in the sections that follow.
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Full Key

Full Key is the default for all 3D effects. Use Full Key to:

¥ Create dissolves using the Opac. slider

¥ Switch an effect from one video track or segment to another by 
using the Swap Sources button

Opac. (opacity) modiÞes the transparency of the foreground image. 
Values range from 0 (transparent) to 100 (opaque).

n You can also use the Level slider to adjust the foreground opacity. See 
ÒAdjusting Foreground Level in the ProÞle WindowÓ on page 519.

You cannot rotate the 
key independently of 
the image.

Invert inverts the key. This setting is most noticeable for effects that 
scale the foreground video, such as a Picture-in-Picture effect. The bot-
tom track shows through the Picture-in-Picture effect key unscaled. 
The area outside the Picture-in-Picture effect key is black.

Swap Sources switches the effect to the top or bottom track. 
For example:

¥ If you use the Scaling parameter to create a 3D Picture-in-Picture 
effect, you can use Swap Sources to swap the image in the 
Picture-in-Picture effect.

¥ For 3D transition effects, you can use this function to apply the 
effect to either the incoming or outgoing video tracks.
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Luma Key

Use Luma Key to replace portions of the foreground video with the 
background video based on brightness or luminance. The Luma Key 
sliders allow you to select a brightness value or a range of brightness 
values in the foreground video. The system replaces the correspond-
ing portions of the foreground video with background video.

Opac. (opacity) adjusts the transparency of the foreground image from 
0 (transparent) to 100 (opaque).

Luma Key effect

Background videoForeground video
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Thres (threshold) identiÞes either the brightness threshold for the 
foreground image or the center of the luma range.

Soft (luma softness) allows you to soften the edge of the cutoff line. 
Pixel values slightly above or below the threshold are included, 
depending on the softness value.

Lum Range turns the Range slider on and off.

Range slider works as follows.

¥ When Lum Range is not active, the Thres value is a cutoff point. 
All brightness values above the Thres value are displayed (you see 
the foreground). Values below the Thres value are not displayed 
(you see the background). 

¥ When Lum Range is active, Thres becomes the median point of the 
range. This allows you to leave in a speciÞc range of brightness 
values as shown in the following illustration.
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Invert inverts the key. Portions of the foreground that were visible are 
now invisible and vice versa.

Swap Sources switches the effect to the top or bottom track.
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Chroma Key

Use Chroma Key to replace one part of the video image with another 
video image based on color. The key color in the video on the higher 
track is replaced with the video from the lower track.

Chroma keys are often used with a foreground image shot in front of a 
highly saturated color screen as shown in the following illustrations.

Move the mouse to the Color Preview 
window to activate the eyedropper.

Chroma Key effect

Key image – video layer 2Background – video layer 1



516

Opac (opacity) varies the foregroundÕs opacity from fully transparent 
(0) to fully opaque (100), where 100 is the default.

When you use the eye-
dropper, the Avid Com-
poser system uses the 
hue only from the 
selected color. It 
ignores the saturation 
and luma values.

Hue identiÞes the color. The hue color is replaced with video from the 
lower track. Either use the slider to select the hue, or use the eyedrop-
per with the Color Preview window. 

H Tol. (hue tolerance) controls how many similar shades of the hue 
will be replaced by the background (the bottom video track). Use this 
when the ranges of luminance and saturation of the chroma key color 
are too wide.

H Soft (hue softness) allows you to soften edges that are too aliased or 
sharp.

S Low (low saturation) allows you to remove low saturation colors by 
raising the lower limit. For example, sometimes portions of clothing or 
faces may contain subtle variations of a hue. To keep these portions of 
the image visible, you can try adjusting the S Low value.

S High (high saturation) allows you to remove high saturation colors 
by moving the upper limit down. For typical chroma keys with high 
saturation colors, you usually leave this value at the default of 255.

Invert inverts the chroma key. Portions of the foreground that were 
visible are now invisible and vice versa.

Swap Sources switches the effect to the top or bottom track.

The following parameters are used only for special applications. These 
parameters actually create a mask rather than a key. They determine a 
range of values to retain rather than deÞning a range of values to key 
out.

Lum Range (luma range) allows you to retain values within a certain 
luminance range.
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L Tol (low tolerance) speciÞes a tolerance level Ñ retain everything 
below the level.

L Soft (low softness) softens the key created by L Tol.

Using the Chroma Key Sliders

The most common procedure for using Chroma Key sliders is:

1. Use the eyedropper to select a hue. 

For best results, pick a color that is well within the Þeld of color. 
For example, the following illustration shows a good area to select 
for the purest hue. The area near the Þgure may contain grada-
tions of the desired hue. Corner areas often contain subtle shades 
of gray.

2. Adjust H Tol (hue tolerance) to replace the hue with the back-
ground.

3. If low saturation grays are keyed out (for example, portions of 
faces or clothing), try adjusting S Low (low saturation) to put them 
back into the foreground.

4. Use L Soft (low softness) to Þne-tune the edges of the key.

You usually keep the S High, L Tol., and L Soft at their default settings.

Good area for eyedropper selection of hue

Not good areas for eyedropper 
selection of hue
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Background — Add a Background Color

You can achieve inter-
esting effects on a two-
track sequence by 
using a background 
color for the bottom 
track and using a luma 
key on the top track.

Use Backgnd (background) Color parameters to replace the bottom 
video track with a background color.

Use the eyedropper to select a color from the video in the Effect Pre-
view monitor, or use the following color parameters:

H (hue) identiÞes the color. Values range from 0 to 255.

S (saturation) speciÞes the amount or intensity of the color. Values 
range from 0 (no chrominance) to 255 (fully saturated color). 

L (luminance) speciÞes the brightness of the color. Values range from 0 
(black) to 255 (full brightness). 

For a description of how to use the eyedropper, see ÒAdjusting a 
Color ParameterÓ on page 104.

Move the mouse to the Color Preview 
window to activate the eyedropper.
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Profile

The ProÞle window in the Effect Editor is a graphical representation of 
the foreground level and acceleration applied to effect key frames:

¥ Foreground level affects the opacity of the effect. The greater the 
opacity, the closer to the top of the ProÞle graph the key frame 
appears. For more information, see the following section, ÒAdjust-
ing Foreground Level in the ProÞle Window.Ó

¥ Acceleration affects the rate of movement into and out of key 
frames. The greater the acceleration, the more rounded the lines 
appear in the ProÞle window. You can adjust Acceleration with the 
Acceleration slider only. For more information, see ÒAcceleration 
Ñ Smoothing Out Key-Frame TransitionsÓ on page 497.

Adjusting Foreground Level in the Profile Window

Foreground level controls the opacity of a 3D effect layer. You can 
adjust levels for various key frames directly in the ProÞle window. 
This is the same as using the Opac. slider in the Forgnd (foreground) 
parameter pane, as described in ÒForeground Ñ Selecting Between 
Full, Chroma, and Luma KeysÓ on page 510. Adjustments you make 
with the Opac. slider are also represented in the ProÞle graph.

To adjust foreground level within the ProÞle window:

1. Select the appropriate key frame in the effectÕs Timeline.

2. Click on the round white key-frame indicator that appears on the 
ProÞle graph, and drag it up or down to increase or decrease the 
opacity of the foreground image.

100% level (foreground is opaque)

0% level (foreground is transparent)

Straight lines indicate no acceleration. 
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3D Shape Effects

3D shape effects allow you to map the foreground video channel to 
various geometric shapes. You do this by selecting a shape from the 
Fast menu in the Shape parameter pane. The following illustration 
shows the Shape menu and the Þve main categories of shapes.

Each shape has its own parameter pane containing controls that are 
speciÞc to that shape. In addition, you can use any of the other 3D 
Effects parameters such as Border, Scaling, Position, and Trail. To 
experiment with the parameter controls, create a test sequence similar 
to the one in ÒCreating a Scaled Picture-in-PictureÓ on page 354.

Page turns Splashes Ball

Offset shapes

Scaling shapes
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Page Turns

A Page Turn effect treats the foreground video channel as though it 
were a sheet of paper being turned over or rolled up to reveal another 
page beneath. You can think of the paper as a clear sheet of plastic or 
Mylarª because you can see the video on either side when you rotate 
the image or curl the edges.

The portion of the image that folds over or rolls up is referred to as the 
ßap. The ßap folds over the top portion of the image.

There are three Page Turn shapes accessible from the Fast menu on the 
Shape Parameter pane.

¥ Page Turn creates the illusion of the top image rolling up into a 
scroll. This effect has one highlight.

¥ Page Curl is the same as Page Turn except that there are two high-
lights. One highlight is slightly wider and more intense than the 
other.

¥ Page Fold creates an illusion similar to turning a page in a book. 
The top image curls over and then becomes ßat. 

Page Fold

Top

Flap
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Page Turn Parameters

To soften the edges of a 
Page Turn, enable the 
Border parameter and 
adjust the Soft slider. 
You can soften a border 
of zero width.

This section describes parameters that are common to all three Page 
Turn effects. For example, the following illustration shows the Shape 
parameter pane with Page Turn selected:

The following slider parameters are common to all Page Turn effects:

¥ Curl controls the amount of the rollup. It speciÞes how far the 
Òrolling upÓ has progressed. Values range from 0 to 100, where 0 
represents no rollup. Vary the Curl value from 0 to 100 with the 
default radius to take the page from a ßat, centered image to one 
that is completely off the screen.

¥ Radius controls the tightness of the curl. Values range from 0 to 
100, where 15 is the default.

¥ Angle controls the direction of the fold or scroll. Values range 
from Ð180 degrees to +180 degrees, where 45 degrees is the 
default.

In addition, there are three Fast menus: No Split, Tuck Over, and Auto 
Highlight. These Fast menu values are described in the sections that 
follow.

Use other parameters such as Border, Scaling, Position, Rotation, or 
Trail to enhance the effect.
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Page Fold Angle Values

The following illustration shows how the Avid Composer system 
interprets several angle values for the Page Fold with the default No 
Split option. Experiment with incremental angle values. Also experi-
ment with changing angle values at different key frames.

While you are experimenting with angle and offset values, it is useful 
to scale down the top video layer. This allows you to see the full effect 
as the video peels off the screen. For example, scaling 75 percent in 
both X and Y axes displays the page fold as a Picture-in-Picture effect.

–45 degrees +45 degrees +135 degrees –135 degrees

–90 degrees 0 degrees
+180 degrees
–180 degrees +90 degrees

Page Fold Angles
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Splitting a Page Turn or Page Fold Effect

You can access the splitting options through the No Split Fast menu 
on the Shape parameter pane. A split gives the illusion of cutting the 
top image with a pair of scissors and folding or scrolling the resulting 
pieces. Splitting options include:

¥ No Split (default) folds or scrolls a single corner or edge, depend-
ing on the angle.

¥ Horizontal Split cuts the image in half horizontally. The two 
images are tied together so that they appear to scroll or fold in 
unison. The image separates from left to right.

¥ Rev Horizontal Split (reverse horizontal split) is similar to Hori-
zontal Split except that the image folds or scrolls from opposite 
sides at the same time.

¥ Vertical Split cuts the image in half vertically. The two images are 
tied together so that they appear to scroll or fold in unison. The 
image separates from top to bottom.

¥ Rev Vertical Split is similar to Vertical Split except that the image 
folds or scrolls from opposite sides at the same time.

¥ Quad Split divides the image into four equal parts. Results 
depend on the starting and ending angle values (specify the start-
ing and ending angles on different key frames). For example, for a 
starting and ending angle of 135 degrees, the split begins in the 
center and the four inside corners roll outward.

¥ Doubled Split displays two scrolls of live video on the screen at 
the same time. Both scrolls roll off the video underneath.

No Split Fast menu
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The following illustrations show how the Horizontal Split and 
Rev Horizontal Split options interpret angles.

Page Fold
Horizontal Split

Page Fold
Rev Horizontal Split

–45 degrees

+45 degrees

–135 degrees

+135 degrees
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Page Fold
Horizontal Split 
(continued)

Page Fold
Rev Horizontal Split 
(continued)

–90 degrees
(same for both)

+90 degrees
(same for both)

–180 degrees
+180 degrees

0 degrees
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Manipulating the Flap and Bottom of a Page Fold

You can access the tuck and ßap options through the Tuck Over Fast 
menu on the Shape parameter pane. Tuck and ßap options include:

¥ Tuck Over (default) folds the ßap over the top.

¥ Tuck Under folds the ßap under the top.

¥ Show Top Only shows the top without the ßap.

¥ Show Bottom Only shows the ßap (bottom) without the top.

Use Show Top Only and Show Bottom Only when you want to control 
the image in the ßap or top. These are commonly used with two video 
channels. One channel shows the top and the other shows the bottom 
(the ßap).

For example, if you want an opaque top and a partially transparent 
ßap, set a transparency value for the video channel containing Show 
Bottom Only. Use the opacity value in the Foregnd parameter pane to 
adjust transparency. Note that in this example you would have to ren-
der one of these effects to see the result.

Show Top Only and Show Bottom Only are also useful when you want 
to apply an effect such as Defocus on just the ßap or the top.

Top

Bottom (flap)

Tuck Over Fast menu
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Highlight Options

You can access the Highlight options through the Auto Highlight Fast 
menu on the Shape parameter pane. Tuck and ßap options include:

¥ Auto Highlight (default) lets the Avid Composer system control 
the highlighting. It applies to all shapes except for the Ball shape. 
You need to enable highlighting in the Highlight parameter pane 
in order for highlights to appear. You can also vary the intensity of 
the highlight in the parameter pane. The system takes care of the 
positioning automatically.

¥ Manual Highlight lets you use the Highlight parameter pane to 
control the highlighting. In this case you need to set the angle, 
aspect ratio, radius, and so forth.

Use the Highlight window (located near the bottom of the 3D 
Warp parameter list) to control manual highlighting. See ÒHigh-
lightÓ on page 506.

¥ Rev Manual Highlight reverses the effect of manual highlighting 
you set up.

Manual Highlight and Rev Manual Highlight work for all shapes, 
including the Ball shape.

Auto Highlight Fast menu
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Splashes

Splashes create a wave effect as if you dropped a stone into still water. 
There are two choices on the Shape Fast menu:

¥ Single Wave creates a splash with one wave, as if you dropped a 
pebble into a very still pool.

¥ Multi Wave creates a splash with many waves or ripples, as if you 
dropped a stone into a pond.

The following parameters apply to the Splash effects:

¥ Radius controls the size of the waves and, therefore, the move-
ment of the waves through the video. Values range from 0 to 100.

¥ Freq (frequency) differs for each Splash effect:

- For Single Wave, the Frequency parameter determines the 
width of the single wave. Reduce the Frequency value to 
increase the width of the wave.

- For Multi Wave, Frequency controls the width and number of 
waves present at any given time. Increase the Frequency value 
to increase the number of waves. Decrease the Frequency 
value to create fewer, wider waves.

Frequency values range from 0 to 100.
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¥ Ampl (amplitude) controls the depth of the troughs of the ripples, 
and the height of the crests of the waves. You can think of this as 
the depth to which the image is distorted to produce the Splash 
effect. Values range from 0 to 100. 

The Splash shapes 
allow you to move the 
effect on the video 
image. The effect uses a 
2D coordinate system 
that has its origin in the 
center of the image. X 
increases as you move 
to the right and Y 
increases as you move 
down.

¥ X Pos moves the splash to the right or left. The values range from Ð
999 to +999, where 0 is the center of the image. Values increase to 
the right and decrease to the left.

¥ Y Pos moves the splash up or down. Values range from Ð999 to 
+999, where 0 is the center of the image. Values increase as you go 
down and decrease as you go up.

¥ Aspct (aspect) distorts the shape from a circle to variations on an 
oval shape. Values range from Ð100 to +100, where 0 is a circle.

¥ Angle rotates the splash. This parameter has a visible effect only 
when the aspect ratio is other than zero. Values range from Ð180 to 
+180.

Limitations to Splashes

The following limitations apply to splashes:

¥ You cannot apply the Z perspective to a Splash effect.

¥ The X and Y direct manipulation handles do not work for a Splash 
effect. Use the Rotation sliders in the Rotation parameter pane 
instead.

For a visual explanation of this limitation, see ÒLimitations to Ball 
ShapesÓ on page 532.
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Ball

Use Manual Highlight 
to apply highlights to a 
Ball shape.

The Ball shape lets you treat the video as a rubbery, rectangular sheet 
stretched around a sphere. If the radius of the sphere is very large, the 
corners of the sheet curve along the surface like a rubber patch on a 
ball. If the radius is small, the corners disappear, wrapping completely 
around the sphereÕs surface.

The following parameters apply to a Ball effect:

¥ Radius changes the size of the ball. Values range from 0 to 100.

¥ Curve gives the ball a 3D effect. A value of zero looks like a ßat cir-
cle (and can be used as a circle wipe). Higher values give more 
depth to the ballÕs shape. Values range from 0 to 100.

The Ball shape allows 
you to move and rotate 
the ball. The effect uses 
a 2D coordinate system 
that has its origin in the 
center of the image. X 
increases as you move 
to the right and Y 
increases as you move 
down.

¥ X Pos moves the shape to the right or left in relation to the image. 
The values range from Ð999 to +999, where 0 is the center of the 
image. Values increase to the right and decrease to the left.

¥ Y Pos moves the shape up or down in relation to the image. Values 
range from -999 to +999, where 0 is the center of the image. Values 
increase as you go down and decrease as you go up.

¥ Aspct (aspect) changes the shape from perfectly round to a dis-
torted shape. Values range from Ð100 to +100, where 0 is a circle.

¥ Angle rotates the axis of the shape. This effect is visible only when 
the aspect ratio is not zero. Values range from Ð180 to +180.
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Limitations to Ball Shapes

The following limitations apply to Ball shapes:

¥ You cannot apply the Z perspective to a Ball.

¥ The X and Y direct manipulation handles do not work for a Ball. 
Use the Rotation sliders in the Rotation parameter pane instead.

n Once you rotate a Radial effect in X or Y using the sliders, no direct manipu-
lation other than XY position will work. To regain access to the direct manip-
ulation Z handle, reset the X and Y Rotation sliders to 0.

Offset Shapes

Offset shapes are separate portions of a live video image moving at the 
same time, in different directions, and at varying speeds. Offset shapes 
are shown below. You can access the Offset shapes through the Fast 
menu on the Shape parameter pane. 

Rotate around Z Axis Rotate around X Axis Rotate around Y Axis

Direct manipulation in Z 
works for Radial 
shapes.

Direct manipulation in X and Y does not work for 
Radial shapes. Use the Rotation sliders instead.



533

The slider parameters are common to all Offset shape effects. For 
example, the following illustration shows the Shape parameter pane 
with Slats selected.

When experimenting 
with these shapes, start 
with a Frequency value 
of 1 and an Amplitude 
of 0. This makes it eas-
ier to see how changes 
in these values affect 
the image.

¥ Ampl (amplitude) controls the distance the shape moves. For tran-
sition effects, increase the amplitude to take the effect off the 
screen.

¥ Angle changes the line along which the video pieces move. Values 
can range from Ð180 to +180. Use 0 for horizontal and 90 for 
vertical.

¥ Freq (frequency) controls how many copies of the offset shape 
appear on the screen.

¥ Offset repositions the shape on the image.

¥ Sk Am (skew amplitude) weaves the image through the slats. 
Think of this as weaving a Òvideo clothÓ through a loom.

¥ Sk Ang (skew angle) rotates the image through the slats.

Slats Arrow One Burst Center Burst Saw Tooth Sine Wave

Bumps
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Slats

Slats split the image into thin parallel rectangles of separated live 
video. The rectangles are stacked on top of each other in tight rows. 
Change the Amplitude to make the slats move in opposite directions.

Arrow

You can think of Arrow as a specialized form of Slats. Each arrow con-
tains seven rectangles that move at slightly different speeds. The dif-
ference in speed creates the arrow shape. Use Frequency to change the 
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number of arrows that appear on the screen at any given time. 
SeeÒOffset ShapesÓ on page 532 for a description of the other sliders.

One Burst

This is a burst in one direction. The Avid Composer system separates 
the image into many straws, each with a height of one line. All straws 
move in the same direction but at different (random) speeds. Use 
Amplitude to increase the speed.

Center Burst
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This is similar to One Burst except that the burst begins in the center of 
the image and the straws move in opposite directions rather than in 
one direction. Use Amplitude to increase the speed. See ÒOffset 
ShapesÓ on page 532 for a description of the other sliders.

Saw Tooth

This is similar to a Saw Tooth Wipe except that you have more control 
over the shape. Amplitude changes the tilt of the slats. Frequency 
changes the size and number of the slats. Higher values increase the 
number of slats.
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Sine Wave

This effect applies the image to a general sine curve, as seen on a math-
ematical graph. You can also think of it as a progression of connected 
waves. Amplitude stretches or compacts the waves. Frequency 
increases the number of waves.

Bumps

You can think of this effect in terms of a sheet of video fabric tacked to 
an imaginary fence. The fence is made up of horizontal beams, placed 
at regular, parallel intervals. As the wind pushes from behind, those 
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areas not held Þrmly down by the beams blow forward into rounded, 
uniform bumps.

¥ Amplitude stretches or compacts the bumps. Think of this as mak-
ing the wind blow harder against the video fabric.

¥ Frequency increases the number of bumps (puts more beams on 
the fence).

¥ Change the Angle to change the line along which the video pieces 
move.

Scaling Shapes

The following illustration shows the Scaling shapes. They are called 
Scaling shapes because they give the illusion of the video ÒpouringÓ 
from one portion of the shape to the other. The image is scaled as it 
pours through a narrower or wider portion of the shape.

Scaling shapes are shown below. You can access the Scaling shapes 
through the Fast menu on the Shapes parameter pane.

The slider parameters are common to all Scaling shapes. For example, 
the following illustration shows the Shape parameter pane with Hour 
Glass selected.

Hour Glass Bow Tie Octagon Hexagon Rain Drop

Hour Glass 2 Hex Med Hex Wide Circle Ellipse Goblet
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Ampl (amplitude) controls the width of the shape. Negative values 
ßip the image within the shape. Values range from Ð100 to +100.

Freq (frequency) controls how many copies of the shape appear on the 
screen. Values range from Ð100 to +100.

Offset moves the shape along the image from bottom to top. As one 
shape moves down, another shape Òpulls downÓ from above. For an 
example, see the illustrations on the next page. Values range from Ð100 
to +100.

Skew moves the shape and the image together to the left or right. Val-
ues range from Ð999 to +999, where 0 is the center of the display area.

n The interactive scaling feature is very useful when working with these effects.

Scaling shapes scroll down over the image as you increase the Offset 
value. The following illustrations show the progression using an Octa-
gon shape. Notice how the shape moves down and the image ßows 
through the shape.
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The following illustrations show examples of Scaling shapes and the 
values used to obtain the image shown. 

1

2

4

6

5

3
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Hour Glass

Bow Tie
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Octagon

Hexagon
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Rain Drop

Hour Glass 2
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Hex Medium

Hex Wide
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Circle

Ellipse
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Goblet

Avid Xpress 3D Effects

The Effect Palette Ñ on systems equipped with the 3D Effects option 
Ñ contains an Xpress 3D Effect category.

The Xpress 3D effects are completely compatible with Avid Xpress sys-
tems that are also equipped with the 3D Effects option. As a result, you 
can move sequences containing Xpress 3D effects between Avid Com-
poser systems and Avid Xpress systems.
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c To maintain compatibility when transferring sequences between 
Avid Composer systems and Avid Xpress systems, use only Xpress 
3D effects (do not use the 3D Warp effect to create 3D effects).

The Xpress 3D effects include:

¥ 3D Arrow

¥ 3D Ball

¥ 3D Bumps

¥ 3D Center Burst

¥ 3D Multi Wave

¥ 3D PIP

¥ 3D Page Curl

¥ 3D Page Fold

¥ 3D Quad Split

¥ 3D Sine Wave

¥ 3D Slats

Xpress 3D Effects Parameters

Xpress 3D effects use a subset of the parameters that are available for 
the 3D Warp effect. For more information about a speciÞc parameter 
that appears in the Effect Editor for an Xpress 3D effect, see ÒBasic 3D 
Effects ParametersÓ on page 490.
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Numerics
1:1.66 film mask 400
1:1.85 film mask 401
1:2.35 film mask 402
16 x 9 film mask 402
2D effects

See also 3D effects
parameters for 367, 367
promoting to 3D 331
types of 366

2D Effects board
required for cropping 372
required for real-time effects 27

3D coordinate system 333
3D effects

See also 2D effects
keys 332, 511, 515
parameters 518
parameters, using 336
promoting 2D effects 331
real time 340
shapes 520 to 546
turning on and off 328
with 2D and 3D versions 340

3D space, moving in 333
3D Warp as transition 330

A
Acceleration parameter (2D) 368
Acceleration parameter (3D) 497
Add Dissolve command 60
Add Edit function

Submaster effects 138, 140
title editing 212

Add Page, in Title Tool 176
Adding a spline point (3D) 502
Adding highlights (3D) 506
Adding shadows (3D) 508
Advanced JPEG compression

cropping capabilities and 372
real-time effects 27, 41

Align Objects command 189, 190
Align to Frame command 189, 190
Alpha channel

media relatives 208
real-time matte keys 332
title creation 152

AniMatte effect
animating 8-310
applying 236, 8-308
described 8-307
exporting as PICT file 8-322
for matte wipes 8-312
modes for 8-316

Index

A B C D E F G H I K L M N O P Q R S T U V W X Y Z 
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AniMatte effect, continued
parameters for 240
rendering 235

Anti-aliased elements in title 152
Applying 3D Warp transition 330
Arrow effect (3D) 534
Aspect ratio

See also Fixed aspect
defined 384
grid options 89
image size 503

Auto Size mode in Title Tool 172
AVR (Avid Video Resolution)

3D Effects option 328
recreating title media 227
render settings 42

AVR compatibility 192
Axes, rotation (3D) 334
Axis as a transition 362
Axis parameter (3D) 493

B
Background color (3D) 518
Ball effects (3D) 531
Batch digitizing and effect resolutions 227
Bezier curves

described 255
manipulating 257

Bias setting for Spline 501
Bin column headings 82
Bins

autosaving 202
effect templates in 34, 112
Text view in 208

Blend effects
3D Warp 330
Dip to Color 387
Dissolve 388
Fade from Color 389

Fade to Color 389
palette for 58
Picture-in-Picture 390
Superimpose 391

Block Spiral Matrix Wipe 472
Blowup effect (film) 403
Blowup parameters (2D) 382
Blue dot 140

See  Color coding for real-time effects 33
Border parameter (3D) 505
Borders parameter (2D) 370
Bottom Box Wipe 460
Bottom Centered Squeeze 448
Bottom Left Corner Peel 430
Bottom Left L-Conceal 425
Bottom Left Squeeze 448
Bottom Left to Top Right Conceal 393
Bottom Left to Top Right Push 436
Bottom Right Corner Peel 430
Bottom Right L-Conceal 426
Bottom Right Squeeze 449
Bottom Right to Top Left Conceal 394
Bottom Right to Top Left Push 437
Bottom to Top Conceal 395
Bottom to Top Peel 431
Bottom to Top Push 437
Bottom to Top Squeeze 450
Bow Tie effect (3D) 541
Box Wipes

Bottom Box 460
Left Box 460
Lower Left Corner 461
Lower Right Corner 462
Right Box 462
Top Box 463
Upper Left Corner 464

comparable alternative to 487
Upper Right Corner 465

Brightness
See  Luminance

Bring To Front command 186
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Brush Tool
creating a custom shape for 252
painting with 268
parameters 249
shapes for 8-295
templates for 254

Bumps effect (3D) 537

C
C button for Crawling mode 173
Center Box Shape Wipe 480
Center Burst effect (3D) 536
Centered on Cut option 385

See also Transition effects
described 60

Centered Zoom Squeeze 450
Changing image size (3D) 493
Changing perspective (3D) 503
Chroma Key effect 126, 419, 420

3D 515
control parameters for 374
working with 364

Chrominance with Color Effect 411
Circle effect (3D) 545
Circle Shape Wipe 481

nested effects 132
Circles, drawing in titles 165
Clearing a stamp 362
Clip

alpha channel 128
edit markers 131, 211
Matte keys 128

Clock Shape Wipe 482
Collapsing layers, and Submaster effects 141
Color coding for real-time effects 26, 33, 33
Color Effect 407 to 413
Color effects

background colors 145, 153
Dip to Color 387

Fade from Color 389
Fade to Color 389

Color gain with Color Effect 413
Color parameter 104
Color Picker 178, 8-301
Color Picker, Macintosh 105
Color selection, background (3D) 518
Color, choosing for Paint effect 8-299
Column headings in bin 82
Commands

Add Dissolve 60
Align Objects 189, 190
Align to Frame 189, 190
Bring To Front 186
Copy 186
Cut 185
Duplicate 186
Export Picture File 200
New Title 147
Play Preview 115
Recreate Title Media 227
Remove Effect 56, 214
Render On-The-Fly 117
Safe Colors 153
Select All 186
Send To Back 186
Set Bin Display 208
Snap to Grid 155
Text formatting 158
Visible Grid 155

Comparison of 2D effects 487
Compatible AVRs 192
Compressed media with uncompressed 

material 146, 203
Compression Tool 227
Conceal effects

Bottom Left to Top Right 393
Bottom Right to Top Left 394
Bottom to Top 395
comparable alternative to 488
Left to Right 395
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Conceal effects, continued
Right to Left 396
Top Left to Bottom Right 397
Top Right to Bottom Left 398
Top to Bottom 399

Console commands
Disable3D 329
Enable3D 329

Continuity vs. Tension in motion path 500
Continuity with Spline 500
Control points

adding 265
deleting 267
described 255
moving 265, 267
removing 267
selecting 266

Controlling image sharpness (3D) 508
Coordinate system, 3D 333
Copy command 186
Corner pinning

an image 359
parameter (3D) 491

Crawling title
acceleration 218
cropping 219, 220
defined 170
foreground transparency 218
position 219
soft edges 222

Creating 3D effects
Axis as a transition 362
Page Turn transition 346
Picture-in-Picture 354
Quad Split Page Turn 348
Stamp 361

Crop parameter 109
Crop parameter (2D) 372
Crop parameter (3D) 491
Crop sliders 219
Cropping across scroll direction 221

Curve Tool
in AniMatte effect 8-308
painting with 277

Custom Start option 385
See also Transition effects

Cut command 185
Cut list with grid information 279

D
Defocus parameter (3D) 508
Destination cropping 220
Diamond Shape Wipe 483
Dip to Color effect 387

with Add Dissolve button 60
Disabling 3D 329, 329
Dissolve effect 388

application of 58
duration of 58

Dissolve effect (Film Composer) 404
Dissolve effects

Add Dissolve button 60
creating splash as 349

Downstream keying
See DSK

Drawing tools
circles and ovals 165
lines 165 to 169
squares and rectangles 165

DSK (downstream keying)
defined 26
of titles and graphics 146, 203
one title per nesting 204

Duplicate command 186
Duration and speed of title 213
DVE board

See 2D Effects board
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E
Edge Wipes

Horizontal 466
Horizontal Open 467
Lower Left Diagonal 467
Lower Right Diagonal 468
nested edits 133
Upper Left Diagonal 469
Upper Right Diagonal 469
Vertical 470
Vertical Open 471

Editing
imported matte key 129
Submaster effects 138, 138
titles 214
titles into sequence 209
track selectors 210

EDL (edit decision list), Submaster effects in 138
Effect categories 30
Effect Editor 216

described 90
effect parameter sliders 91
key frames in 94
Other Options button in 91

Effect Grid
adding information to cut lists 279
described 78
displaying in Effect mode 83
in a film project 80, 84
options for 79

Effect mode, enabling 73
Effect Palette

displaying 30, 31
dissolve effects in 59
effect categories in 30
third-party plug-in display 35

Effect parameters
See also Parameters (2D), Parameters (3D)
2D and 3D versions 367
basic adjustments for 103

replacing 98
reversing 97
transitions 385

Effect template
applying 113
displaying in bin 34
for intraframe effects 242
on 3D effects 338
saving 112

Effects
applying multiple 49
applying one 48
creation tools, described 25
settings for 41
types of 23

Effects types 366
Ellipse effect (3D) 545
Ellipse Shape Wipe 483
Ending at Cut option 385

See also Transition effects
described 60

Export Picture File command 200
Export, Matte PICT file 8-322
Eyedropper

activating 104
current window 178
with Paint effect 8-299

F
Fade Effect button 56, 215
Fade from Color effect 389
Fade to Color 389
Fade, film 405
Fast motion effect 429

See also Variable speed motion effect
reversal of 68, 68, 380

Fast Save in Title Tool 193
Fast titles, playing 213
Feathering for Paint effect 8-297
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Field parameter for Blowup effects 382
Files, importing

animation formats 131
graphics 128, 131

Film effects
1:1.66 Mask 400
1:1.85 Mask 401
1:2.35 Mask 402
16 x 9 Mask 402
aspect ratio grid 89
Blowup 382, 403
Dissolve 404
Fade 405
Mask 406
simulation of, with solarization 412

Fixed aspect
in 3D scaling parameters 493
in 3D target parameters 503
in Scaling parameter 384

Flip 414
Flip-Flop 414
Flop 415
Foreground keys (3D)

Chroma 515
Full 511
Luma 512

Foreground parameter (2D) 103, 373
Foreground parameters (3D) 510
Foreground slider 218
Four Corners Shape Wipe 484
Frames

effect duration in 61
fades in 215
real-time effects 227
title background 202

Freeze Frame effect parameters 377
Freeze Frame motion effect 428

See also Motion effects
Full key on 3D effects 511

G
Gain with color effect 413
Gain with key effects 376
Global vs. key-frame parameters 243
Goblet effect (3D) 546
Graphics

alignment of 189, 190
displaying grid for 155
drawing 165
importing without alpha channel 131
layering of 186
matte key editing 129
shadows 183
uncompressed, adding to compressed 

media 26, 146, 203
Green dot

See  Color coding for real-time effects 33
Grid

See Effect Grid
Grid Matrix Wipe 472
Grid settings 79
Grid values

display options 155
snapping to 155

Grouping and ungrouping
paint objects 290
title objects 187

H
Handles, for 3D effects 341
Hex Medium effect (3D) 544
Hex Wide effect (3D) 544
Hexagon effect (3D) 542
Hierarchy of parameters 338
Highlight parameter (3D) 506
Hollow drag handles for locked objects 188
Horizontal Bands Shape Wipe 485
Horizontal Blind Shape Wipe 485
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Horizontal Centered Squeeze 451
Horizontal Edge Wipe 466
Horizontal Open Edge Wipe 467
Horizontal Open Saw Tooth Wipe 477
Horizontal position (H Pos)

adjusting 107
Horizontal Saw Tooth Wipe 477
Hour Glass 2 effect (3D) 543
Hour Glass effect (3D) 541
Hue, defined 370

I
Icons

for imported graphics 131
Timeline display of 43, 47
Title effect 202, 222

Image effects
Color 407 to 413
Flip 414
Flip-Flop 414
Flop 415
Mask 415, 416
Resize 417
Submaster 418

Insufficient Source message 62, 343
Intraframe editing

See also Paint effect, AniMatte effect
described 233, 237
parameters for 238
parameters, using 242
rendering during 234
single-field step with 234

Inverting color effects 409
Inverting keys

Chroma 516
Full 511
Luma 514

K
Kerning of title text 162
Key effects

Chroma 126, 419, 420, 515
control parameters for 374
creating 125
Full 511
imported graphics 131
Luma 125, 421, 512
Matte 127, 332, 423
settings for 41

Key Frame button 217
Key frames 217

3D parameters with 490
copying and pasting 101
creating and selecting 100
defined 99
deleting 102
moving or changing 101
titles, fading 215

Key modes for AniMatte effect 8-316
Key parameter (2D) 374

L
Layering objects 186
Layering paint objects 287
Layers

See Segment effect
L-Conceals

See also Conceal effects
Bottom Left 425
Bottom Right 426
Top Left 426
Top Right 427

Left Box Wipe 460
Left Centered Squeeze 452
Left to Right 395, 438
Left to Right Peel 432
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Left to Right Squeeze 452
Limitations

DSK title on top 204
playing backwards 219
playing fast titles 213

Limits, size of rolling and crawling titles 171
Lines

attribute options 167 to 169
titles 165

Locked objects, hollow handles indicating 188
Locking and unlocking

paint objects 291
title objects 188

Lossless images, described 26, 146, 203
Lower Left Corner Box Wipe 461
Lower Left Diagonal Edge Wipe 467
Lower Right Corner Box Wipe 462
Lower Right Diagonal Edge Wipe 468
Luma Key effect 421

See also Key effects
control parameters for 374
with 3D effects 512

Luminance of color effect 408
Luminance, defined 370

M
Macintosh Color Picker 105
Magic Mask

described 8-302
parameters for 8-305, 8-320
with AniMatte effect 8-317
with Paint effect 8-303

Mask effect (Film Composer) 400 to 402, 406
Mask image effect 415, 416
Matching resolutions 192
Matrix parameter (2D) 376
Matrix Wipes

Block Spiral 472
Grid 472

One-Way Row 474
Speckle 474
Zig-Zag 475

Matte Key effect 423
alpha channel 128
creating 127
editing with imported 129
on 3D effects 332

Matte wipe, with AniMatte effect 8-312
Media files

deleting 121
insufficient source material 62
managing 121
titles 208

Media object
alpha channel 208
precompute 208

Motion Effect parameters 377
Motion effects

defined 24
Freeze Frame 428
rendering requirements for 64, 428
Variable Speed 429

Motion path editor 342
Moving 3D images 496
Moving perspective point (3D) 503
Multi Wave splashes (3D) 529
Multiple-layer effects

applying 49
Box Wipes 459 to 465
Conceals 393
creating 125
defined 24
Edge Wipes 465 to 471
Matrix Wipes 471 to 476
overlapping of 28
Peels 429 to 435
Picture-in-Picture 390
Push 435 to 442
Saw Tooth Wipes 476 to 479
Shape Wipes 480
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Multiple-layer effects, continued
Spins 443 to 445
Squeezes 447 to 458
Submaster 138, 139, 418
Superimpose 391

N
Nesting effects

alternative techniques 135
defined 132
expanding effect 135 to 137
recreated title media 227
split screen effects 133
Submaster effects 138
video layers 132

New Title command 147
Non-real-time effects, rendering of 28, 116
NTSC frame and safe title/action guidelines 

152

O
Objects, graphic

See also Graphics
alignment of 189, 190
copying 186
cutting 185
duplicating 186
grouping and ungrouping 187
layering 186
locking and unlocking 188
selecting all 186
shadow definition 183
titles 165

Octagon effect (3D) 542
Offset shapes (3D)

Arrow 534
Bumps 537

Center Burst 536
defined 532
One Burst 535
Saw Tooth 536
Sine Wave 537
Slats 534

One Burst effect (3D) 535
One-Way Row Matrix Wipe 474
Orange dot

See Color coding for real-time effects
Other Options button 97, 223
Outline/Path button

with 3D effects 342
Oval Tool for intraframe editing 270
Ovals 165

P
Page number display, in Title Tool 175
Page Turn

as transition 346
creating quad split 348

Page Turns (3D)
defined 521

Paint effect
applying 236, 8-294
brush shapes for 8-295
changing parameters for 8-296
described 8-293
modes, described 8-298
parameters 238
parameters, described 8-297
rendering 235

Paint objects
moving 287
scaling 285

PAL frame and safe title/action guidelines 152
Parameters (2D)

Acceleration 368
AniMatte effect 240, 8-315
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Parameters (2D), continued
Blowup 382
Border 370
Crop 372
Foreground 373
Key 374
listed 367
Matrix 376
Motion Effect 377
Paint effect 238, 8-297
Position 381
Scaling 384
Secondary Key 374
Spill Suppression 374
Transition 59, 385

Parameters (3D)
Axis 493
Border 505
Corner pinning 491
Crop 491
Defocus 508
Foreground 510
hierarchy of 338
Highlight 506
key frame 490
Perspective 503
Position 496
Rotation 495
Scaling 493
Shadow 508
Skew 494
Spline 498
Stamp 509
Target 503
Trail 509

Path for intraframe editing effects 249, 250
Path, motion 342
Peel effects

Bottom Left Corner 430
Bottom Right Corner 430
Bottom to Top 431

Left to Right 432
Right to Left 432
Top Left Corner 433
Top Right Corner 434

Pen tool for intraframe editing 234
Perspective parameter (3D) 503
Picture-in-Picture effect 390

3D example 354
Pinning corners (3D) 491
Play Preview button 115
Playback of effect

real-time effect renderings 27, 33, 33
Submasters and 418
titles 215
wire-frame preview 115

Plug-ins
See Third-party plug-ins

Polygon shapes, creating 272
Polygon Tool for intraframe editing 271
Position indicator

positioning for title creation 147
Position of effect

parameters for 62
Position parameter 106
Position parameter (2D) 381
Position parameter (3D) 496
Posterization of color effect 412

nested edits 132
Precompute

described 208
Precomputes, deleting 121
Previewing anti-aliased titles 152
Previsualization Marker 277
Promoting 2D effects to 3D 331
Push effects

Bottom Left to Top Right 436
Bottom Right to Top Left 437
Bottom to Top 437
comparable alternatives to 488
Left to Right 438
Right to Left 439
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Push effects, continued
Top Left to Bottom Right 440
Top Right to Bottom Left 441
Top to Bottom 441

Q
Quad Split Page Turn, creating 348

R
R button for Rolling mode 173
Radial shapes

See Ball, Splashes
Raindrop effect (3D) 543
Real-time effects

color coding for 33
combined with rendered effects 116
defined 26
overlapping of 27 to 29, 116 to 117
rendering of 116
settings options 41
Submasters 138, 139
titles and rendering 27
user setting requirements for 41

Real-time title parameter changes 203
Rectangle in titles 165
Rectangle Tool for intraframe editing 269
Remove Effect command 56, 214
Render On-The-Fly command 117
Rendering of effects

bin displays 208
color coding 33, 33, 140
during intraframe editing 234
Matte Key effects 130
procedure for multiple effects 119
real-time effects

overlapping/combining parameters 117
titles 27, 206

settings options 41
Submasters 138, 140, 418
third-party plug-ins 121

Reshape Tool for intraframe effects 282
Resize effect 417
Reversal of effect parameter 97
Reversing motion effects 68, 380
Right Box Wipe 462
Right Centered Squeeze 453
Right to Left Conceal 396
Right to Left Peel 432
Right to Left Push 439
Right to Left Squeeze 454
Rolling and crawling titles, size limits for 171
Rolling title

acceleration 218
cropping 219
defined 170
foreground 218
position 219

Rotation (3D)
axes (3D) 334
moving axis of 493
parameter 495

S
Safe Colors command 153
Safe title/action area

defined 152
displaying 87
for aligning objects 189

Saturation of color effect
titles 153

Saturation, defined 370
Saving titles 193
Saw Tooth effects (3D) 536
Saw Tooth Wipes

Horizontal 477
Horizontal Open 477
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Saw Tooth Wipes, continued
Vertical 479
Vertical Open 478

Scaling paint objects and mattes 285
Scaling parameter (2D) 109, 384
Scaling parameter (3D) 493
Scaling shapes (3D)

Bow Tie 541
Circle 545
defined 538
Ellipse 545
Goblet 546
Hex Medium 544
Hex Wide 544
Hexagon 542
Hour Glass 541
Hour Glass 2 543
Octagon effect 542
Raindrop 543

Scroll position slider 219
Secondary Key parameter (2D) 374
Segment effect

See also Multiple-layer effects
Conceals 393 to 399
defined 24
deletion of 55
fading 56
film 400 to 402
multiple layer

Box Wipes 459 to 465
chroma key 515
Conceal effects 393
creating 49
Edge Wipes 465 to 471
key effects 126, 419, 420
L-Conceal effects 425 to 427
luma key 512
Matrix Wipes 471 to 476
matte key 332
Peels 429 to 435
Picture-in-Picture 390

Push 435 to 442
Saw Tooth Wipes 476 to 479
Shape Wipes 480
Submasters 138, 139
Superimpose 391

single layer
Color Effect 407
Conceal effects 393
Film Blowup 403
Film Masks 400 to 402, 406
Flip 414
Flip-Flop 414
Flop 415
Mask effect 415, 416
Resize 417

Spins 443 to 445
Squeezes 447 to 458
Submaster 418
title editing 212, 215

Select All command 186
Selection Tool

defined 151
for grouping/ungrouping objects 187
text options for titles 159

Send To Back command 186
Sequence

real-time effects in 27, 28
title editing 154, 209

Set Bin Display command 208
Shadow parameter (3D) 508
Shadows, for title graphics 183
Shape Wipes

Center Box 480
Circle 481
Clock 482
Diamond 483
Ellipse 483
Four Corners 484
Horizontal Bands 485
Horizontal Blind 485
Vertical Blind 486
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Shapes (3D)
about 520
Ball 531
Offset 532 to 537
Page Turns 521 to 528
Scaling 538 to 546

Ellipse 545
Splashes 529

Sharpness of focus, controlling (3D) 508
Sine Wave effect (3D) 537
Single Wave splashes (3D) 529
Single-field step 234
Single-layer segment effects

See also Multiple-layer effects; Segment 
effect

Conceals 393
Image effects 407 to 418

Size of effect
adjusting 493, 503
fixed aspect 493,  505
source media 62

Sizing an image (3D) 493
Skew parameter (3D) 494
Slats effect (3D) 534
Slow motion effect 429

See also Variable Speed motion effect
Slow motion effect, reversal of 68, 68, 380
Smooth motion in downstream keyed titles 203
Smoothing a path (3D) 498
Snap to Grid command 155
Soft edges 222
Softening of effect media 43
Softness parameter, for borders 372
Solarization of color effect 412
Source cropping 220
Source/Record mode

duration setting 386
Speckle Matrix Wipe 474
Speed of an effect

video underruns 117
Spill Suppression parameter (2D) 374

Spin effects
X Spin 443
Y Spin 444
Z Spin 445

Splash
creating dissolve 349
making a flat image 352

Splashes (3D) 529
Spline parameter (3D)

adding a point 502
Bias setting 501
Continuity setting 500
defined 498
Tension setting 499
using 356

Split Screen effects 133
Squares in titles 165
Squeeze effects

Bottom Centered 448
Bottom Left 448
Bottom Right 449
Bottom to Top 450
Centered Zoom 450
Horizontal Centered 451
Left Centered 452
Left to Right 452
Right Centered 453
Right to Left 454
Top Centered 454
Top Left 455

comparable alternatives to 488
Top Right 456
Top to Bottom 457
Vertical Centered 457

Stamp (3D)
clearing 362
creating 361

Stamp parameter (3D) 509
Starting at Cut option 385

See also Transition effects
Step In button 226
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Strobe Motion Effect parameters 379
Style of Color effect 412
Submaster editing 138, 139
Submaster image effect 418
Superimpose 391
Superimpose effects in titles 145
Swapping effect tracks 511

T
Target parameter (3D) 503
Templates

See Effect template
Tension setting for Spline (3D) 499
Tension vs. Continuity in motion path 500
Text for titles

aligning 189, 190
kerning 162
layering of 186
leading 164
repositioning of 157
shadow options for 183

Text formatting commands 158
Third-party plug-ins

applying to a sequence 53
compatibility of 386
installing 36
rendering 121

Tilt parameter (3D) 494
Timeline

effect icons 140
real-time effects, color coding 26, 140
segment deletions in 55
segment editing

titles 209, 211, 214
showing effect icons in 43, 47
title development 146

Title
adding real-time effect to 203
adding soft edges to 222

color of background 145, 153
complexity of 206
editing 209
fading 215
fast saving 193
removing 214
uncompressed, adding to compressed 

media 203
Title duration 209
Title effect

alpha channel 208, 214
exiting Title Tool 194, 195
media file relatives of 208

Title parameters, changing in real time 203
Title Tool

Add Page option 176
Auto Size mode 172
background options 153
creating a new title with 146 to 147
creating multiple titles 146
defined 145
window 148

Title, speed of play 213
Top Box Wipe 463
Top Centered Squeeze 454
Top Left Corner Peel 433
Top Left L-Conceal 426
Top Left Squeeze 455
Top Left to Bottom Right 397
Top Left to Bottom Right Push 440
Top Right Corner Peel 434
Top Right L-Conceal 427
Top Right Squeeze 456
Top Right to Bottom Left Conceal 398
Top Right to Bottom Left Push 441
Top to Bottom Conceal 399
Top to Bottom Push 441
Top to Bottom Squeeze 457
Tracks, video

for titles 210
nested edits 132
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Tracks, video, continued
real-time effects on

overlapping of 27, 28
Submaster effects 139
swapping effects on (3D) 511
titles 202

Trail parameter (3D) 509
Transition effects

applying 3D Warp as 330
Blends 387 to 391
Box Wipes 459 to 465
Conceals 393 to 399
creating Page Turn 346
defined 24
deleting 55
dissolves 58
Edge Wipes 465 to 471
fades 389, 389
Film

Dissolve 404
Fade 405

keys 419, 420
L-Conceals 425 to 427
Matrix Wipes 471 to 476
Peels 429 to 435
positioning defined 385
Push 435 to 442
Saw Tooth 476 to 479
Shape Wipes 480
Spins 443 to 445
Squeezes 447 to 458
trimming 63
using Axis for 362

Transition parameters (2D) 385
Transparency (foreground parameter) 373
Transparency of an effect, adjusting 103
Trim mode

settings for 45
transition effects in 63

Turning 3D on and off 328

Two-channel effects
See Blend effects

Types of effects 366

U
Ungrouping objects 187
Unlocking objects 188
Unrendered titles 193
Update rate of Strobe effect 380
Upgrading 2D effects to 3D 331
Upper Left Corner Box Wipe 464
Upper Light Diagonal Edge Wipe 469
Upper Right Corner Box Wipe 465
Upper Right Diagonal Edge Wipe 469

V
Variable Speed motion effect 429
Variable Speed Motion Effect parameters 379
Variable Speed motion effect

See also Motion effects
Vector-based objects

creating 257
described 255

Vertical Blind Shape Wipe 486
Vertical Centered Squeeze 457
Vertical Edge Wipe 470
Vertical Open Edge Wipe 471
Vertical Open Saw Tooth Wipe 478
Vertical Saw Tooth Wipe 479
Video in nested edits 132
Video background updating, in Title Tool 154
Video layers

background in Title Tool 153
foreground (3D) keys on 510, 517
gain levels 376
nested effects 124, 132
Submaster effects 138, 139
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Video layers, continued
swapping incoming/outgoing (3D) 344
titles 146 to 153, 202

Video mixdown 143
Video tracks

See Tracks
Video Underrun error messages 117
Visible Grid command 155

W
Wipe effects

Box Wipes 459 to 465
Edge Wipes 465 to 471
Matrix Wipes 471 to 476
nested edits 133
Saw Tooth Wipes 476 to 479
settings for 41
Shape Wipes 480

X
X Spin 443
X, Y, Z coordinate system 333

Y
Y Spin effect 444

Z
Z Spin effect 445
Zig-Zag Matrix Wipe 475
Zoom effect 450
Zooming, in Effect Preview monitor 341
Z-rotation Tool for intraframe effects 284
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